8966 Pro

1099 Pro provides secure and intuitive FATCA Form 8966 software capable of tax form management and IRS XML reporting.

The IRS is quickly finalizing the FATCA reporting requirements and will require Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966, the FATCA report, directly to the IRS. FFIs from Model 1 countries, that must report to their host country who in turn transmits to the IRS, still must manage their FATCA Reports in one centralized location for ease of reporting.
Disclaimer

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.
# Table of Contents

**Foreword**

**Part I Getting Started**

1. Disclaimer ................................................................. 13
2. About 1099 Pro, Inc....................................................... 13
3. Quick Tour ..................................................................... 16
4. Registration & Upgrades ........................................... 17
5. Software Updates ....................................................... 18
6. System Requirements .................................................. 19

**Part II Important Dates**

1. Filing Deadlines .......................................................... 19

**Part III The User Interface**

1. 1099 Pro Central .......................................................... 20
2. Task Panel ...................................................................... 20
   Preparing My Forms .................................................. 21
   Printing & Mailing ...................................................... 21
   Filing My Forms ......................................................... 22
3. Keyboard Shortcuts ..................................................... 24

**Part IV Helpful Hints**

1. Adobe Acrobat ........................................................... 25
2. Alternative Import Layout ........................................... 25
3. Canadian Postal Code Rules ......................................... 25
4. Compliance Seminars .................................................. 25
5. Map by Name Import .................................................. 26
6. Master Tax Form ........................................................ 26
7. Menu Bar ...................................................................... 26
8. Registration Code ........................................................ 26
9. Welcome Wizard ........................................................ 26

**Part V Support**

1. Technical Support & Maintenance ................................. 27
2. Online Help Options .................................................... 28
3. Single-User Installation ............................................... 28
<table>
<thead>
<tr>
<th>Part</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part VI</td>
<td>Browse Filers</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>1. Add a Filer</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>2. Change a Filer</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>3. Sponsored Entity / Intermediary</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>4. Contact Persons</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>5. Delete a Filer</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>6. Filer Record Details</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>7. Filer Reports</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>8. Select Another Filer</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>9. Tag Filers</td>
<td>42</td>
</tr>
<tr>
<td>Part VII</td>
<td>Browse Recipients</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>1. Recipient Record Details</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>2. Add Recipients</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>3. Select Recipients</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>4. Change a Recipient</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>5. Delete Recipients</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>6. Forms Issued Report</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>7. Recipient Listing Report</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>8. Group Actions</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>9. Multiple Recipients - One TIN</td>
<td>48</td>
</tr>
<tr>
<td>Part VIII</td>
<td>Corrections</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>1. Correction of a Correction (CS Version only)</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>2. Corrected Options</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>3. Create Corrections</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>4. Delete Corrected Forms</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>5. Protected Forms</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>6. Reprint Corrections</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>7. Reprint Originals</td>
<td>55</td>
</tr>
<tr>
<td>Part IX</td>
<td>Account Generation Wizard</td>
<td>56</td>
</tr>
</tbody>
</table>
Part X Security and Administration

1 Security Overview ........................................................................................................... 59
   System Security Settings/Password Requirements: Step 1 ........................................... 59
   Security - Access Groups: Step 2 .................................................................................. 60
   Security - Manage Profiles: Step 3 ................................................................................ 60
   Security - Add/Update Individual Users: Step 4 .......................................................... 62
   Security - Add Users to a Profile: Step 5 ........................................................................ 62
   Turn On/Off Security ..................................................................................................... 63
   Passwords ....................................................................................................................... 63
   Security Reports ............................................................................................................ 64
   Security Access Log ....................................................................................................... 64

2 Data Maintenance ........................................................................................................... 65
   Backup Data .................................................................................................................. 65
   Restore Data .................................................................................................................. 66

3 Rules and Options ........................................................................................................... 67
   1099 Module Preferences .............................................................................................. 67
      Global ......................................................................................................................... 67
      Local .......................................................................................................................... 67
      Limits .......................................................................................................................... 68
      Update Options ......................................................................................................... 68
      RCP Options ............................................................................................................. 69
   Preferences ................................................................................................................... 72
      Custom Tax Form Validation Rules ........................................................................... 73

4 Reporting Thresholds ..................................................................................................... 75
   State Reporting Thresholds ............................................................................................ 75
   State Reporting - Manage State CFS Limits and Settings (CS Only) ............................... 78

5 SUTA Information (CS Version only) ........................................................................... 79
   Browse Region Code/SUTA State Table ....................................................................... 79
   Edit Region Code/SUTA State - CS ............................................................................. 79

6 Create and Manage Custom Codes (CS Version only) .................................................. 80
   Update or Change Custom Code .................................................................................. 80

7 Installing ......................................................................................................................... 81

8 Logging in as a Different User ....................................................................................... 82

9 Optional Field Filters .................................................................................................... 83

10 1099-MISC Optional Fields ......................................................................................... 83

11 Set Aggregation Rules (CS Version only) .................................................................... 85

12 Un-Installing ................................................................................................................. 86

Part XI Audit Trails ............................................................................................................ 87

1 Audit Trails Activity Report ............................................................................................ 88

2 Deleted Record Detail .................................................................................................... 89

3 Master Audit Trail Browser ............................................................................................. 89

4 Purge .............................................................................................................................. 89

5 Record History ............................................................................................................... 89
Part XII Browse Records

1 Browse IRS Instructions
2 Entry Forms
   1099 Aggregation Feature (CS Version only)
   Viewing Transactions (CS Version only)
   Updating Transactions (CS Version only)
3 Browsing by Form
   State Status
4 Void Records
5 Browse Notes/Attachments
   Update Notes
6 GIIN Validation
7 GIIN Composition
8 Capitalization
9 Cascading Changes
10 Add a Record
11 Change a Record
12 Delete a Record
13 Form Status Overview
14 Department
15 Options for Tax Form Data Entry
16 Print/View Reports
17 Search
18 Select a Form
19 Select Form Type
20 Tagging Records
21 Zip Code Lookup
22 IRS Codes

Part XIII Current Sort/View

1 Current Sort/View
2 Custom Sort Order
3 Dynamic Queries (CS Version Only)

Part XIV Error & Validation Checking

1 Warnings and Errors Scan Screen
2 Filing Problems
3 Penalties
### Part XV Exports

1. Export ASCII Wizard ................................................................. 119
2. Export Map Wizard ................................................................. 120
3. Bulk TIN Matching 
   - IRS Incorrect TIN Flowchart ........................................... 123
   - IRS Missing TIN Flowchart .............................................. 124
   - IRS Bulk TIN Export Wizard ............................................ 124
   - Bulk TIN Results ............................................................. 125

### Part XVI Filing via IDES

1. IDES Packager ................................................................. 126
2. IDES Overview ................................................................. 128
3. NIL Report ....................................................................... 129

### Part XVII Form Status Overview

1. Printed ................................................................................. 130
   - Electronic Sessions Summary Report ........................... 130
   - Print Sessions ................................................................ 131
   - Printed Status ............................................................... 131
2. Print Status Overview ........................................................ 132
3. Forms Status Values .......................................................... 133

### Part XVIII Imports Overview

1. Import Data .......................................................................... 135
   - * SAMPLE IMPORT FILES * .......................................... 135
     - Import Wizard ............................................................ 136
       - Manage Import Maps .............................................. 136
       - Delimited or Excel Import Map Wizard .................. 137
       - Map by Name Method ............................................ 140
       - Drag & Drop Method .............................................. 140
       - Export Map Wizard ............................................... 141
       - Custom Record Filter ............................................ 142
       - Customize a Fixed Field ........................................ 143
       - Modifying an Existing Import Map ....................... 145
     - Step 1: Import Data, Filers or Recipients ................ 147
       - Import Status Options .......................................... 149
       - Import Session Status .......................................... 150
     - Step 2: Validate Data ................................................ 151
       - Review Import Records ........................................ 152
   - Step 3: Final Import / Post Results ............................... 153
   - Reset (Void) Import Session ........................................ 154
   - Country Codes Table ..................................................... 155
   - Country Alias .............................................................. 155
   - Transactional Imports (CS Version Only) .................... 157
   - Transactional Items (CS Version Only) ....................... 158
   - States Code Table ......................................................... 159
2. Import File Conventions ..................................................... 160
Part XIX  Printing Overview .......................................................... 170
  1  Advanced Print Options ............................................................ 171
     Inserting a Custom Print Message ........................................... 172
     Forcing an X ...................................................................... 172
  2  Form Limits Overview ............................................................. 173
  3  PDF File Generation Overview ............................................... 173
     Initial PDF Options ............................................................. 174
  4  Printing Blank Forms Overview .............................................. 175
     Print IRS Form & Instructions .............................................. 175
  5  Email: Email Tax Forms .......................................................... 175
  6  Email: No Email Client ........................................................... 177
  7  Assigning a Printed Status ....................................................... 177
  8  Field Sizes ........................................................................... 178
  9  Margin Alignments .................................................................. 179
 10  PCL Printing ........................................................................ 180
 11  Print Session Report .............................................................. 182
 12  Printing Tax Forms Wizard ..................................................... 183
 13  Puerto Rico Compliant Tax Forms (CS Version Only) .......... 185
 14  Quick-Print Individual Record ............................................... 189
 15  Reprint Print Sessions ............................................................ 190
 16  Reset Print Session ................................................................ 191
 17  Troubleshoot Printer Issues .................................................... 191
 18  View Selected Records .......................................................... 193

Part XX  Queries ............................................................................. 193
  1  Custom Query using Manual Override .................................... 194
  2  Custom Query Wizard .............................................................. 195
  3  Form Status Values: Database Queries .................................... 195
  4  Select a User ........................................................................ 196

Part XXI  Reports ........................................................................... 196
  1  Form Control Totals .............................................................. 196
     Troubleshooting Control Totals ............................................ 198
## Part XXVII Glossary

### 1. Alignment
- Page: 256

### 2. Business Rules
- Page: 256

### 3. ASCII
- Page: 256

### 4. Cascading updates
- Page: 257

### 5. Corrected options
- Page: 257

### 6. End of Payer "C" Record
- Page: 257

### 7. End of Transmission "F" Record
- Page: 257

### 8. Filer
- Page: 257

### 9. Hotspot
- Page: 257

### 10. Import Map
- Page: 257

### 11. Location code
- Page: 258

### 12. Payee "B" Record
- Page: 258

### 13. Payer "A" Record
- Page: 258

### 14. Pending Status
- Page: 258

### 15. Recipient Employee
- Page: 258

### 16. Rule-of-250
- Page: 258

### 17. SSAE 16 SOC I Type II
- Page: 259

### 18. SSN
- Page: 259

### 19. State Totals "K" Records
- Page: 260

### 20. Tag
- Page: 260

### 21. Task Panel
- Page: 260

### 22. TCC
- Page: 260

### 23. TIN
- Page: 261

### 24. TIN (SSN) Masking
- Page: 261

### 25. Transmitter "T" Record
- Page: 261

### Index
- Page: 262
1 Getting Started

Welcome to 8966 Pro 2017

8966 Pro Basic Software Functionality
Add a Filer
Sponsored Entity / Intermediary
Add a Record
Add a Recipient
Import Data || Sample Import Files ||
Roll Forward Data
Software Updates
Support

- - - - - - - - - - - -

Important Dates
Penalties
Create XML
IDES Overview
IDES Packager

8966 Pro Changes
• New - Effective January 2017, the FATCA XML Schema v2.0 replaces v1.1 and the FATCA Notification XML Schema v2.3 replaces v2.2. All International Data Exchange Service (IDES) users are required to submit FATCA Reports using v2.0 as v1.1 will no longer be supported. 8966 Pro 2016 fully supports these changes.

• New - Part II "Account Holder or Payee Information" determination. The XML treats the Account Holder as either an Individual or Entity based on the following logic:
  1) Box 1b - Individual or Entity as checked. If not checked, or both are checked, then see #2 below.
  2) Box 4 TIN type - If 2 dashes it is an Individual; if 1 dash it is an Entity. If no dashes then see #3 below.
  3) If the option Birth Date is present it is an Individual. If no date see #4 below.
  4) If Box 5 Specified U.S. person is checked then it is an Individual, otherwise it is an Entity.

• New - Part III "Identifying Information of US Owners that are specified US Persons" determination. Owner is assumed to be an Individual unless #4 “TIN of Owner” has a “–” (hyphen) in the third position of a 10 character string (e.g., 12-4567890). If so, then the XML reports as an Organization (not as an Individual).

• New - P2 Birth Date and P3 Birth Date variables are Optional Fields where:
  o P2 Birth Date relates to Part II Account Holder or Payee Information which populates the <AccountHolder> element.
o P3 Birth Date relates to Part III Owner Information which populates the <SubstantialOwner> element.
  • Note 1 - This change was requested by Japan.
  • Note 2 - The <sfa: Contact> information may have to be manually removed.

- New - Increased field size lengths for Recipient Name and Address in tax form fields.
  o Expanded name field to 180 characters to accommodate Financial Institution name. If there is a First Name (account holder...) fill it in separately as required by the IRS - the field accommodates 180 characters.
  o Address Field allows AddressFree formatting and accepts up to 180 characters. However, the City/State or Province/Zip or Postal and ISO Country Name fields are still required for the Address Fixed portion.

- IDES Packager™ creates and encrypts/decrypts the IDES package. Requires .NET 4.0 (included with Windows 7/8), your digital certificate, private key and pass phrase (if used).

V. 8/10/2017

1.1 Disclaimer

Disclaimer

The 1099 Pro, Inc. methodology of flagging errors and warnings is merely a tool to help detect some of the possible inconsistencies or omissions in your data. 1099 Pro, Inc. does not assert that our system of detecting Errors and Warnings matches that of the IRS/SSA or that our system will detect any or all errors in your data. You may in fact have records that flag no Errors or Warnings and the IRS/SSA may both reject your files and or records and assess significant penalties on the data or lack of data that you submitted or did not submit. 1099 Pro, Inc. assumes no responsibility or liability for the detection of errors, omissions, inconsistencies, warnings, formatting, accuracy or complete filing or processing of your data. This software application identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this application. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

1.2 About 1099 Pro, Inc.

About 1099 Pro, Inc.

1099 Pro, Inc.

Founded in 1989, 1099 Pro, Inc. is a market-leading provider of information-reporting solutions and services for 1099, W-2 and 1042-S filers. 1099 Pro develops and markets a comprehensive range of products that enable any size business or institution to effectively manage and be compliant with IRS requirements. 1099 Pro products range from Client Server / ASP applications (capable of filing over 100 million records) utilizing an MS SQL back end with a multi-year presentation of forms via Internet Explorer, to desktop software products for filing from 20 – 100,000 forms, to www.eFileMyForms.com for internet filing of < 20 forms. Adjunct products include secure Hosting and Services for information processing, printing, filing and penalty abatement. With the ever-changing IRS laws and regulations, 1099 Pro develops new services, solutions, and software enhancements, remaining ahead of the curve of the industry. 1099 Pro is a Microsoft Certified Partner; MBE certified and has received SSAE 16 SOC I
Type II certification.

**Software offered by 1099 Pro, Inc.**

**1099 Pro Professional**
Professional edition offers a streamlined and cost effective answer to your tax season. Prepares printing and paper filing for all forms in the 1098, 1099, 3921, 3922, 5498 and W-2G series. For an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

**1099 Pro Enterprise**
Enterprise software is a powerful information reporting solution designed with simplicity in mind. Enterprise supports the processing, printing, and paper or electronic filing of forms from series 1098, 1099, 3921, 3922, 5498, and W-2G. Through the software users may generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

**W-2 Pro**
Prepares forms W-2, W-2C, W-3 and W-3C transmittals. Supports printing to blank or preprinted forms. Through the software users can generate a formatted transmittal file for the SSA site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

**1042-S Pro**
Prepares form 1042-S on plain paper and allows users to print recipient copies B, C, and D on one page with instructions on a separate page. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

**1099 Pro Corporate Suite**
The 1099 Pro, Inc. Corporate Suite software combines the power of our Professional and Enterprise software with the speed, performance, and security of Microsoft's SQL Server technology, making it the ultimate solution for businesses. Corporate Suite supports the processing, printing, and paper or electronic filing of forms from series 1095 (ACA Compliance), 1097, 1098, 1099, 3921, 3922, 5498, 592-B*, W-2, W-2G, 1042-S and Puerto Rico. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS.

**8966 Pro**
1099 Pro provides secure and intuitive FATCA Form 8966 software capable of tax form management and IRS XML reporting. The IRS is quickly finalizing the FATCA reporting requirements and will require Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966, the FATCA report, directly to the IRS. FFIs from Model 1 countries, that must report to their host country who in turn transmits to the IRS, still must manage their FATCA Reports in one centralized location for ease of reporting.

**CRS PRO**
CRS Pro allows a Filer/Reporting FI (defined as the unique combination of the Jurisdiction being reported to AND the associated Reporting Financial Institution) to report Account Holder information to a Reporting Country in an XML schema format to fulfill their CRS obligation per the OECD.

**The 1099 Pro Service Bureau**
The 1099 Pro, Inc. Service Bureau was established for the purpose of helping companies successfully
ease through the tax season. The Service Bureau features a highly secure SSAE 16 SOC I Type II and PCI Compliant environment, configured to process an unlimited amount of records and form types. The Service Bureau can print and mail records to your recipients, display records online securely via the Web Presentment service, and electronically file your records with the IRS. Continue reading to learn more about the services that 1099 Pro offers. Using the simple upload wizard and secure FTP agent available in your 1099 Pro software, users can easily transmit records for printing, mailing, or filing. To make sure users are taking full advantage of our information reporting solutions, we offer free technical support via phone or live chat.

**Services offered by 1099 Pro and the Service Bureau Include:**

**Filing**
We can handle any volume of records for electronic filing. An upload feature, which safely sends your file directly to our Service Bureau, is built-in to every version of the 1099 Pro, Inc. software.

**Print & Mail Services**
Printing, mailing, and electronic delivery services are available! Our SSAE 16 SOC I Type II Service Bureau offers a secure, efficient, and friendly solution.

**Bulk TIN Matching**
The Service Bureau can transmit your file to the IRS Bulk TIN Matching Program. A transmission of up to 100,000 records is simple via the 1099 Pro software’s upload wizard and secure FTP agent.

**Hosting**
Our hosted service provides unparalleled speed, security, and bandwidth in which to run 1099 Pro software. Our Qwest CyberCenter facilities are connected with OC-768 bandwidth to our state-of-the-art fiber optic IP network.

**Electronic Delivery**
Give your recipients the option to access their forms from a secure internet site instead of receiving a mailed form. The electronic delivery option significantly reduces costs.

**Printing & Mailing with Web Presentment**
The Service Bureau can make your forms available for online viewing and reprinting via our secure internet site.

**Web Presentment Only**
Print and mail your forms in-house and have them available to view via our secure internet site.

**Pressure Seal Printing**
Our Pressure Seal paper stock, for customers uploading forms for printing and mailing, adds additional security for recipients. This eliminates the possibility for information to be viewed through an envelope window.

**Full Service**
Throughout the year, our regulatory team will work with your team to process your payee and payment information, imports, and balances, as well as reconcile posted information to your business areas. Additionally, we will produce all federal/state returns, act as a transmitter on your company’s behalf, and generate payee statement files, B Notices, and management reports for you.

*The Service Bureau does not print, mail or electronically file Form 592-B.*
1.3 Quick Tour

Quick Tour

Overview of Information Reporting

What is a 1099 Form?
According to the IRS and Federal tax law, you must report to the IRS payments totaling $600 or more made to independent contractors over the course of the calendar year. When a person is paid on the form, 1099-MISC for example, all money earned by the individual is paid on an untaxed basis. It is then the responsibility of the individual to file and pay the appropriate taxes. These taxes can be owed to Federal, State and Local governments. Workers compensation and unemployment issues also must be addressed independently.

Who Are We?
1099 Pro, Inc. provides award-winning 1099 software for filing tax forms 1099, 1098, W-2, 1042-S and many others. For your convenience, 1099 Pro carries a complete line of tax supplies including: 1099 forms, W-2 forms, 1042-S forms and envelopes. We also offer Print/Mail/E-Filing services through our Service Bureau. To save you time and money, 1099 Pro continues to offer complimentary technical support with the purchase of any of our software products.

The 1099 Pro Service Bureau
The Service Bureau is a Print/Mail/E-Filing service offered to users of 1099 Pro software. All of our software products allow the creation of a data UPLOAD file which can be easily transmitted to our Service Bureau. We can then print and mail the appropriate forms on your behalf and/or electronically submit your file to the IRS. We can process any number of filers, recipients, and form types.

Why should I Use the Service Bureau?
The 1099 Pro Service Bureau has provided Print/Mail/E-Filing services to thousands of our users. Our customers utilize the Service Bureau to save money, minimize administrative headaches, safeguard their sensitive data, and benefit from our extensive experience. We've made the process simple:

1. Purchase the appropriate 1099 Pro software package.
2. Call or E-Mail our Service Bureau to set an appointment date. We must have your data by the agreed upon appointment date to ensure that it is mailed or filed by the IRS deadline.
3. Manually enter or import your data into the 1099 Pro software.
4. Create an upload file within 1099 Pro software.
5. E-Mail or FTP your upload file to us on or before your appointment date.

Why Is It Important to Comply?
If you don't file information returns, you face various penalties.

For example, failing to file correct information returns by the due date results in penalties that range from $50 to $260 per Form W-2 or Form 1099, depending on how late you file the return, and the size of your business. The maximum annual penalty ranges from $532,000 to $3,193,000 ($186,000 to $1,064,000 for small businesses).

There are three exceptions to these filing penalties:

- If you can demonstrate that your omission was due to an event that was beyond your control or due to some significant mitigating factor and was not willful neglect, you may avoid the penalty. You must also show that you acted in a responsible manner and took steps to avoid the failure.
to file.

- An inconsequential error or omission is not considered a failure to include correct information because it doesn't prevent or hinder the SSA/IRS from processing the Form W-2, or from correlating the information required to be shown on the form with the information shown on the payee's tax return.

- The IRS also has a *de minimis* rule for corrections when certain requirements are met. Basically, if the value provided to an employee is less than it would cost to fix the return, it may sink beneath notice. See the IRS Topic: De Minimis (Minimal) Benefits.

**Filing Accurate Information Returns**

The IRS issues very detailed and exacting instructions for filling out information returns. For instance, the IRS has very definite preferences for which forms can be used, what font you should use (no script characters), where you should place the data in the blocks, and where you can use zeros.

So follow the instructions carefully. If the IRS can't interpret your forms, you may be subject to a penalty of $50 for each return in an improper format.

*Return to Getting Started*

### 1.4 Registration & Upgrades

**Registration & Upgrades**

**Software Activation**

To activate a "DEMO" version of software, users must enter their 14 character authorization code. Activating a demo provides the user access to all software features and retains their existing data. Purchase the software online or contact Sales to obtain an authorization code. Follow these steps to activate your software:

1. From within the software, at the top of the menu bar click Utilities > Registration And Upgrades.
2. At the Product Registration Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct version of the purchased software is installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation.

**How To Obtain an Authorization Code**

**Internet:** go to [www.1099pro.com](http://www.1099pro.com) and purchase the software from our web site.

**Phone:** call toll-free (888) 776-1099 or (888) pro-1099 from 5AM-5PM PST or call (818) 876-0200

**E-Mail:** sales@1099 Pro.com

**Upgrading Transaction Limits**

Transactions are the number of actual tax forms that may be entered or imported—regardless of print status—into 1099 Pro, 1042-S Pro, W-2 Pro or 8966 Pro. A standard installation allows for 5,000 transactions. To enter additional transactions users must upgrade your software installation with a bump code. Bump codes can be purchased online at [www.1099pro.com](http://www.1099pro.com) or by contacting Sales at (888) 776-1099.

**To Upgrade Transactions (Bump Codes)**
1. At the menu bar go to Utilities > Registration And Upgrades.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.
   - In multi-user environments, the Bump Code must be entered at the Admin or Web Update workstation; this option may not be available at individual work stations (depending on access rights).

How Many Transactions Do I Have?
To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. At the menu bar go to Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.

1.5 Software Updates

Software Updates

1099 Pro, Inc. regularly publishes software updates to keep up with the evolving rules and regulations of the IRS, SSA, and state agencies. To ensure your compliance, frequently check for software updates. By default, the software checks for updates occasionally during the summer, more frequently as tax season approaches and every day at the height of tax season. Users are strongly encouraged to take advantage of this process; an active internet connection is required.

Users may verify they are running the most up-to-date version of 8966 Pro2017 software the following ways:
- When starting any version of the software, a pop-up prompts to run a software update, OR
- Perform a Manual Update (as discussed below), OR
- Visit our WIKI download site at host.1099pro.com

Manual Updates
There are two methods to manually check for software updates.

Method 1
1. From the menu bar select Help > Check for Updates to 8966 Pro.
2. Use the "Check for Updates" button to run an update. Your computer must have an active Internet connection.

Method 2
1. Close the 8966 Pro software.
2. Use the Windows Start button to locate your 8966 Pro software and select "Check for Updates" to initiate the Web Update Wizard.
3. Follow the prompts by clicking "Next". If there is a new version, a message displays the version number and provides a brief summary of items included in the update. Download the update and allow the update to install. This process should begin automatically.
4. After the process is finished, confirm that the new version number of the software corresponds with the version number of the update by opening 8966 Pro and at the menu bar selecting Help > About.

Users experiencing issues downloading updates may have a firewall on their network or local machine preventing them from retrieving updates. Check with your Administrator, IT personnel or temporarily disable the firewall.
All updates are available for download at the 1099 Pro WIKI site host.1099pro.com.

**Update Options**
Users can modify the frequency and/or type of software updates performed by 8966 Pro. To edit these settings see Preferences.

Considerations:
- If an installation of 8966 Pro has Security enabled, the User must have Administrator level access to modify the Checking for Updates options.
- For multi-user installations only the Server (not the Workstations) can view and modify the Checking for Updates option.
- Workstations cannot run the actual web update process -- they can only check for new versions.
  Once your Server has been updated, each workstation automatically updates itself the next time 8966 Pro is run on that machine.

### 1.6 System Requirements

**System Requirements**

8966 Pro minimum system requirements include:

- Windows 7, 8 or higher with MS .NET Framework 4.0 - NEW
- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 256MB RAM (512MB or more preferred)
- 100+MB free hard drive space
- For use with ANY Windows compatible printer
- Windows compatible network (optional)

1099 Pro also requires display settings of 800x600 and small fonts to properly display windows and type. Some Deskjet, Inkjet or Bubblejet printers may not print to the bottom 1/2-inch of paper.

### 2 Important Dates

#### 2.1 Filing Deadlines

**Filing Deadlines**

1099 Pro, Inc. strongly recommends verifying all filing deadlines and addresses and assumes no liability for inaccuracies or changes contained herein.

- See Penalties

**Form 8966 Filing Deadline**

Form 8966 is required to be filed for the 2017 calendar year on or before March 31, 2018. A Reporting
Model 2 FFI must file Form 8966 on the same filing dates that apply to a PFFI, unless a different reporting date is specified in an applicable Model 2 IGA.

**Electronic Filing Requirement**
An entity that is a financial institution is required to file Form 8966 electronically, irrespective of the number of Forms 8966 filed. All other entities that file 250 or more Forms 8966 for the calendar year are required to electronically file Form 8966.

**Extensions To File**
An automatic 90-day extension of time to file Form 8966 may be requested. To request an automatic 90-day extension of time to file Forms 8966, file Form 8809-I, Application for Extension of Time to File FATCA Form 8966. You should request an extension as soon as you are aware that an extension is necessary, but no later than the due date for filing Forms 8966. No extension of time to file is permitted for Forms 8966 filed by a Reporting Model 2 FFI to report a non-consenting U.S. account or a non-consenting nonparticipating FFI. A Reporting Model 2 FFI should refer to the applicable Model 2 IGA for the due dates for those filings.

For more information on filing Form 8966 please review the Instructions for Form 8966.

## 3 The User Interface

### 3.1 1099 Pro Central

**8966 Pro Central**

The 8966 Pro Central Screen provides rapid access to important information!

**Overview:**
General layout of the tax form filing process from start to finish!

**To-Do:**
Keeps track of important dates/form status. Also allows users to create custom notes and To-Do Lists!

**Help/Videos:**
Provides links to technical support resources, contact information for support, and Online Tutorials.

**Compliance:**
Information on tax form compliance such as additional services, tools, consultation, support, and Online Tutorials.

**Services:**
1099 Pro, Inc. offers many additional services such as our Service Bureau.

### 3.2 Task Panel

**Task Panel**
The task panel is the blue bar on the left side of the 8966 Pro screen and provides quick access to common tasks. Click on the links for details on the options contained within each task panel area.

Select Filer
Reporting F1
Preparing My Forms
Create XML
Utilities
Help & Extras

3.2.1 Preparing My Forms

Preparing My Forms

From the Preparing My Forms task panel users can:

Work With My Tax Forms
View records, Add or Change a record, Delete a record, Void a record, Quick-Print Forms, Email Tax Forms and run various reports.

Import New Tax Forms
View import sessions, Void import sessions, Import comma delimited files or tab delimited files.

Form Totals Reports
Customize a Control Totals report with the option to generate a listing of any errors and/or warnings.

3.2.2 Printing & Mailing

Printing & Mailing Task Panel

From the Printing & Mailing task panel section users can:
Printing/Mail:
Print via the Print Wizard, Reset Print Sessions.

Via the Service Bureau:
Access the Printing, Mailing, Filing and Bulk TIN Matching screen where users can begin a new Service Bureau session for Printing & Mailing or E-Delivery Upload or Bulk TIN Matching Upload as well as Reset Uploads.

Export Forms for Print/Mail:
Export Forms to an ASCII text file suitable for opening in Excel, Access, etc.

3.2.3 Filing My Forms

Filing My Forms

From the Filing My Forms task panel users can:

3.2.4 Reporting F1

Reporting F1

From the Reporting F1 task panel, users can access:

My Filers List:
Add, edit or delete Filers and run various reports.

Intermediary/Sponsored Entity:
Access the Sponsored Entity or Intermediary Lookup screen and add/edit/delete information.

Transmitter:
Edit Transmitter information.
3.2.5  Create XML

Create XML

From the Create XML task panel users can access:

XML V1.1 File:
Create FATCA XML files and/or NIL reports, view eFile sessions and run reports, and access the IDES upload site.

IDES Packager:
Quickly package XML data files or decrypt an IDES notification package. See IDES Packager

3.2.6  Help & Extras

Help & Extras

From the Help & Extras task panel users can access:

Help and Tutorials:
Go directly to the 1099 Pro Central Help/Videos Screen.

Correcting Filed Forms:
Create Corrections, Reprint Corrected or Original Forms

About the Service Bureau:
Offers more help regarding the 1099 Pro, Inc. Service Bureau

IRS Pubs & Links
View a list of IRS publications included with 1099 Pro, plus links to the IRS and SSA websites

3.2.7  Print Preview Toolbar

Print Preview Toolbar

The Preview screen allows users to view a form or a report and check it for accuracy before printing. Use the following icons located at the top of the Preview screen:

- Use to print THIS page only.
- Use to VIEW the previous page.
Use to view the NEXT page.

Use to toggle STAY after printing.

Use to Search for characters within a report.

Use the "Print" icon to access the "Print Setup" screen to print the entire report. See Duplex Printing.

Use to exit the preview report WITHOUT printing.

Use to view the preview report in full WIDTH view.

Use to view the preview report in full HEIGHT view.

Use to save in PDF format when printing.

Additional options available for this screen include:
- "Zoom PCT" defaults to 98% (may vary depending on monitor) and adjusts from 25 - 250% viewing.
- If the preview consists of more than one page, scroll forward / backward with the double arrow icons.

3.3 Keyboard Shortcuts

Keyboard Shortcuts

<Alt>:
Use the <Alt> key and the underlined letter (or number) of any menu bar item to access a drop menu. For example, ALT + R to access "Reports".

<F1>:
Access context-sensitive help at any screen.

<F2> or Right-Click Mouse:
With your cursor in the appropriate box, use the <F2> key or right-click your mouse to access box specific data:
- Recipient TIN field: Access the Select a Recipient database.
- State/Payer's State ID No.: Access the Select Filer State & ID database (available at 1099-MISC
box 17, 1099-R box 11 and W-2G box 13)
- **Calendar**: Access a multi-year calendar (available at 1099-A box 1, 1099-B box 1, 1099-C box 1, 1099-S box 1, W-2G box 4 and 1099-LTC).

**Incremental Search:**
Access any recipient or filer via the Search Name field.

**Drop Menu***:
Right click your mouse to view a pop-up box with options to add, change or delete records.

*Available at the Recipients List, Filers List (Manage) and Work With My Tax Forms screens only.

---

4 **Helpful Hints**

4.1 **Adobe Acrobat**

Adobe Acrobat

Use Acrobat Reader to open/view a PDF file. Download Acrobat Reader for free at the Adobe website.

4.2 **Alternative Import Layout**

Alternative Import Layout

**Standard Import vs. Alternative Import Layout**
The standard import layout (as used in the sample import files) provides distinct City, State and Zip fields. The alternative import layout makes use of a single Combined City/ST/Zip field. Use one or the other layout in your import file.

See **Sample Import Files**

4.3 **Canadian Postal Code Rules**

Canadian Postal Code Rules

- Must be 7 characters
- Character 4 must be a blank
- Format is letter-number-letter, a space, then number-letter-number
- For the first letter (position 1), acceptable letters include: ABCEGHJKLMNPRSTVXY
- For the letters in positions 3 and 6, acceptable letters include (adds W and Z):
  ABCEGHJKLMNPRSTVWXYZ
- Valid example is **C3H 4W9**

4.4 **Compliance Seminars**

Compliance Seminars
For information about 1099 Pro, Inc. sponsored seminars and conferences, visit our web site at http://www.1099 Pro.com/servTrainingSeminars.asp for more information.

4.5 Map by Name Import

Map By Name Import Method

Use if your import file incorporates header records from one of our sample import files. Simply click the "Map By Name" button and the fields automatically assign themselves.

For more information see the Import Wizard and Map By Name topics.

4.6 Master Tax Form

Master Tax Form

In terms of Aggregating data, the master tax form is considered to be the first tax form entered at the top of the transactions list.

4.7 Menu Bar

Menu Bar

The menu bar is a traditional navigational tool located at the top of the 8966 Pro screen. For example, use ALT + R to access "Reports".

4.8 Registration Code

Registration Code

A registration code (activation code) is provided upon proof of payment. Registration codes are 14 alpha/numeric characters (e.g., R91234567XXXSE). The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

See Registration topic

4.9 Welcome Wizard

Welcome Wizard

Upon first entering 8966 Pro 2017, the Welcome Wizard walks users through creating their first filer and activating optional security features.
5 Support

5.1 Technical Support & Maintenance

Technical Support

All 1099 Pro, Inc. software products includes context-sensitive help screens as the first means of supporting your use of this product. In addition, 1099 Pro, Inc. offers many technical support options including: online Help Tutorials and a Knowledge Base. These options are intended to provide customers with immediate solutions. If these sources do not contain the answers to your questions, contact technical support by phone or E-Mail. To help us better assist you, please provide the following information:

- Company name or Customer ID (CID) number
- Please be at the computer you are experiencing the problem with
- A list of what steps were taken prior to the problem
- Any error messages that you have encountered.

Technical Support Options

Help Tutorials and Knowledge Base

http://www.1099 Pro.com

Phone (888) 776-1099 (toll-free) or (818) 876-0200
E-mail support@1099 Pro.com

Service Bureau

Phone - (866) 444-3559
E-Mail - sb@1099 Pro.com

Normal Hours

Monday to Friday: 5AM to 5PM PST
Saturday: Closed
Sunday: Closed

Tax Season Hours (January)

Monday to Friday: 5AM to 5PM PST
Saturday: 8AM to Noon PST
Sunday: 8AM to Noon PST

Direct Links

Tutorials: http://www.1099pro.com/videos.asp
Software download location: http://host.1099 Pro.com

IRS Telephone Assistance: Information Reporting Customer Service Site

If you have questions about reporting on Forms 1096, 1098,1099, 5498, W-2, W-2G, and W-3, you can call a toll-free number, 1-866-455-7438. You can still use the original telephone number, 304-263-8700 (not toll free). For TTY/TDD equipment, call 304-267-3367 (not toll free). The call site can also be reached by E-Mail at mccirp@irs.gov. The hours of operation for the call site are Monday through Friday from 8:30a.m. to 4:30 p.m., Eastern time. For other tax information related to business returns or accounts, call 1-800-829-4933.
Complimentary technical support is limited to questions regarding 1099 Pro, Inc.'s software products. We are NOT authorized to provide accounting, tax or legal advice. Please direct such questions to your accountant or attorney. Calls may be limited during peak tax season.

5.2 **Online Help Options**

### Online Help Options

#### Built-In Help Options

**Context-Sensitive Help**
Use the <F1> key at any screen to access context-sensitive help screens.

**Search for Topics**
On the **menu bar** select Help > Search the Help File and at the "Index" tab type the first few letters of the word you're looking for. For example, type "pen" to display the Penalties help topic.

**Print Topics**
- Click the "Print" button, or
- Use "CTRL + P" to display the Print dialog box.

#### Online Help Tutorials


Additional tutorials are available on our YouTube channel including:
- How to Import Using Standard Excel Import Maps (6 minutes)
- How To Print and Mail via the Service Bureau (8 minutes)
- Filing Electronically via the Service Bureau (7 minutes)
- Creating Corrections (7 minutes)
- and many more!

#### Online Knowledge Base

5.3 **Single-User Installation**

### Single-User Installation

To download any 1099 Pro, Inc. software product please visit: [http://host.1099pro.com](http://host.1099pro.com). All software installations are two-step; requiring both the Full Install and the most recent Update.

- See **Multi-User/Network Installations**

**To Install Single-User** or **Demo**
1. Insert the CD-ROM into your computer's CD-ROM drive.
2. On your Windows desktop click the "Start" button and select "Run".
3. In the Open field, type x:\setup.exe, where x is the name of the CD-ROM drive and setup.exe is the
4. Click "OK" to start the setup program.
5. Follow the instructions provided by the setup program. If 8966 Pro prior year data is detected on your system the Roll Forward Utility activates.

**Virus Checkers**

Disable virus checkers (e.g., Norton, McAfee, ViruScan, Sophos, etc.) PRIOR to installation to avoid potential corruption. Random errors in 8966 Pro are typically due to the installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

### 5.4 Multi-User Installations

**Multi-User Installations**

All 1099 Pro, Inc. software products are available in single, multi-user or unlimited-user licenses. The algorithm of your registration code indicates the edition, user license and number of transactions purchased.

**Upgrade From Single-User/DEMO to Multi-User Version**

1. Close all applications including 8966 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "8966 Pro" for the year you are upgrading and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Uninstall the program, but KEEP data files and backups" and then click the "Next" button to start the uninstall program.
6. 1099 Pro prompts through the remainder of the uninstall routine.
7. Once the process is completed remove the "Admin" in the installation folder for the software year just uninstalled.
8. Proceed to the appropriate multi-user installation instructions below.

8966 Pro is network neutral; either a peer or server install is acceptable. The only requirement is that one machine be designated as server and all others as workstations.

**Network Installation**

1. Determine a network drive and folder to install 8966 Pro software. All workstations must have rights to this folder. The software can use a UNC or a mapped network drive.
2. Install software on the server where the data will be stored. Enter your multi-user Registration code as prompted. Select Web Update Workstation as the Install Type. Allow the program files to reside on the local drive.
3. Upon successfully installing software to the network, click on the "8966 Pro icon" on your desktop. The Welcome Wizard prompts through setting up the software. By default, Audit Trails and Security are enabled*. Complete the Welcome Wizard and then re-enter the software. Administrators use "Administrator" and "NEW" to logon for the first time with enabled security. Administrator must create users and assign rights prior to installing software to workstations.
Workstation Installations

1. Complete network installation prior to installing workstation(s).

2. Install 8966 Pro at the workstation. Enter your multi-user Registration code as prompted. Select Workstation Installation as the Install Type. Browse for the network drive and folder (e.g., X:\1099 Pro \Pro66T17 where "X" is the mapped network drive). Allow the program files to reside on the local drive (e.g., C:\1099 Pro\Pro66T17).

3. If the Administrator enabled security, the workstation is deemed a "user". Upon first entering 8966 Pro at the workstation, a User ID (as assigned by the Administrator) is required. For the Password enter "NEW". The User is then required to create their own unique password.

Multi-User Installation with Remote Data/Program Location

1. **Install Server** - Installing software a code ending with ME or MP will trigger a Multi-user installation. ALWAYS install the "Server" first noting that this PC will be the only PC where software updates can be applied. Subsequent installations are "Workstations".

2. **Remote Data/Program Location** - When installing the 'Server', you are presented with an option to have your data and program DLL's reside on another PC, Novell drive or Network Attached Storage.
   - Check the box "Allow Remote Server Installation" to start the Remote Data/Program Location.
   - Click on the "Browse" button and select the destination directory. Note that the value under "Select Destination Directory" must end with a pathname of \Pro99T17 (or similar depending if you are installing 1099, W-2 or 1042-S Pro). Note that you may select a mapped network drive or you may use UNC such as \amd800\C in this case.
   - Next you will be prompted if you wish to roll forward data such as Filers, Security Settings, ... from a prior year. Once you have finished installation you can open the software, click on "Help" and "About" and then click on the graphic icon for the software and you can see the data paths involved. Note that none of the data or program files are kept on the "Server", they are kept at the Remote Server/Data Location.

3. **Install Workstations** - Perform subsequent workstation installations as needed. Be sure that each workstation has read/write/delete rights to the Remote Data/Program Location. Note: each Workstation must communicate with the Remote Server/Data Location via UNC or a mapped letter drive. Workstations do not have to communicate with the "1st Multi-user Installation = 'Server' shown above.

4. **Web Updates** - When it is time to perform a Web Update you will have to perform it from the "Server" that you just installed. Web Updates are performed at the "Server" and in this case performing the update at the "Server" will result in the program files and the data files being updated on the "Remote Server" (based on the .ini file on the "Server"). Note that workstations will communicate with the Remote Server/Data Location only and not with the 'Server' where the software was originally installed from or the Web Update was run from.

*We recommend enabling Security. If security is disabled ANY USER on ANY WORKSTATION can access 8966 Pro and view/modify Administrator settings and all data. This includes the potential for ANYONE to create himself as Administrator and lock you out of 8966 Pro!*
**Note:** 8966 Pro uses a local .INI file to store the data path of your remote data. Verify the following: If the 8966 Pro install was done under a different account with a drive letter mapping then that same path will need to be mapped with the same drive letter. For example: If the Administrator of the computer has the remote drive as L: and the user has the mapped drive as a K: then the user will not be able to access the data.

See Multi-User Considerations

### 5.4.1 Multi-User Considerations

#### Multi-User Considerations

When running 8966 Pro software's multi-user versions, some tasks require exclusive control of certain files. These tasks are detailed below.

**Record Locking**

The multi-user version of 8966 Pro software utilizes record locking when two or more users concurrently open the same record. This allows users to simultaneously view the same record but prevents them from overriding each other's changes. For example, Users A and B open the same record. User A changes an amount and saves the record. User B then changes an amount and attempts to save the record. User B receives a "Record Was Not Updated" warning and the record is automatically updated with User A's changes. User B may then select a field to restore and use the <F4> key to re-populate what they had originally entered.

**Import Locking**

During the final step of the Import Wizard, Post Import Session, the software attempts to gain control of all records. If the software is unable to gain control of a record (because someone else has the record open) it will notify the user and offer to post the files the slow, non-locking way or allow them to cancel.

**To Unlock Records**

1. From the menu bar go File > Security and Administration.
2. In the "Business Rules and Options" section, click on "Browse System Process Locks".
3. Highlight User and click "Delete/Remove the Selected Lock".

### 5.5 Uninstall Software

#### Uninstall Routines

The Select Uninstall Method screen offers two options for removing 8966 Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine.

**Uninstall Software (Custom)**

1. Close all applications including 8966 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "8966 Pro 2017" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Custom" and then click the "Next" button to start the
uninstall program.
6. Files are categorized for deletion. Users may "Select All" (recommended), "Select None" or use their mouse to select specific files. Categories include:
   - System Files
   - Directories
   - **INI Files**
   - INI Entries
   - Registration Database Keys
7. After selecting appropriate files click "Finish" to complete the uninstall.

**Uninstall Software (Automatic)**
The Automatic uninstall process retains your current data files under the main program directory in the folder named "Data", preserves the "Uploads" folder containing any uploads generated by the 1099 software for submission to the Service Bureau, and miscellaneous .DLL files are left in the Program root directory used by the software. In addition the .INI file is also preserved in the\Admin or \Windows directory.

1. Close all applications including 8966 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "8966 Pro" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Automatic" and then click the "Next" button to start the uninstall program.
6. 1099 Pro prompts you through the remainder of the uninstall routine.

**NOTE: Users who uninstall 8966 Pro and then reinstall it may get an "Invalid Record Declaration (47) Accessing TAXDATA.TPS [or FILERS.TPS]. Press OK to end this application" warning. This error occurs because some files were not deleted during the automatic uninstall. Users must perform a custom uninstall of 8966 Pro (and select all files for deletion) and then reinstall the software.**

## 5.6 Data Files

### Data Files

8966 Pro data files are suffixed with ".TPS" and are logically named. For example, "filers.tps" contains filer data and "states.tps" contains state data. These files are located in the Data folder and in a typical installation may be found at C:\1099 Pro\Pro66T17\Data.

### INI File

The INI file contains information specific to your installation such as data paths and version. For example:

NetPath=C:\1099 Pro\Pro99T17
LocalPath=C:\1099 Pro\Pro99T17
InstallVersion=2015.08.16
CurrentVersion=2015.16.05

In a standard installation the "Pro99T17.INI" file is located at C:\1099 Pro\Pro66T17\Admin.

The .INI file may or may not be deleted during a custom uninstall. This file can be manually deleted to
totally remove software from your system or to perform a clean re-installation. This file can remain if a user wants to reinstall the software but retain their settings.

5.6.1 Backup Data

Backup Data

8966 Pro backups can automatically copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. It is smart to backup your data on a regular basis. If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense!

- See Restore Data (via a backup file)

To Modify Backup
1. At the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their software Administrator.
2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.
3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
   - Uncheck the box to disable backup prompts (not recommended).

To Backup Data
Access the Backup Wizard as prompted automatically by 8966 Pro (see Modify Backup above). The Backup Wizard application, Backup17.exe, can also be accessed directly through File Explorer. In a standard installation it is located at C:\1099 Pro\Pro66T17\Data Backups. All users must exit the software prior to running the backup.

1. At the Backup Wizard screen click "Next" to proceed.
2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file and use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name. Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. **Backup twice to the same file name and the existing backup file will be overwritten!**
3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.
4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at www.winzip.com.
5.6.2 Restore Data

**Restore Data**

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. **Restoring a data file means losing ALL changes made since the last backup.** See [Backup Wizard](#).

- No backup file? If you used the Service Bureau to process your forms, we may be able to recover your data files for a fee. Contact the [Service Bureau](#) for more information.

**To Restore Data**

1. Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the [1099 Pro Wiki](#). Download the appropriate Tax Year and Version. Consult Technical Support with questions.

2. Locate your .ZIP backup file (e.g., "1099 Pro Backup 9-AUG-2017 9-38AM.ZIP") which in a standard installation is located in the Data Backups folder (i.e., C:\1099 Pro\Pro66T17\Data Backups).

3. Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file—.TPS (data) files—to your Data folder (i.e., C:\1099 Pro\Pro66T17\Data).
   - Learn more about [WinZip](#).

4. Open your software and run a [Form Counts by Filer](#) report to verify accuracy of restored data.

5. After successfully restoring your data, update your software to its most recent version.

5.6.3 Roll Forward Data

**Roll Forward Data**

8966 Pro software allows users to roll forward 2016 Filer and/or Recipient information (including name, TIN and address) and optionally Transmitter and Security settings and customized Import Maps. Rolled forward Recipient data is available at the [Recipient Master List](#) screen for viewing or changes; Filer data is likewise available at the [Filer Master List](#) screen.

**How to Select Filers/Recipients AFTER Roll Forward**

- **Select Filers:** Use the "Select Another Filer" button, located at the top of the [task panel](#), to switch between Filers.

- **Select Recipients:** At any tax form data entry screen, users can place their cursor in the Recipient TIN field and right-click their mouse or use the <F2> key to select a Recipient and auto-populate the tax form with the Recipient's name, TIN and address.

**IMPORTANT:** To roll forward data does NOT mean to copy 2016 tax form specific information such as dollar amounts into the new 2017 installation. For example, a 2016 Form 8966 is only available in 8966 Pro 2016. The exception is Corporate Suite — a multi-year software product.

**How To Roll Forward Data**

Users can roll forward their prior year data during the Installation Wizard (Image 1) or from the Windows
Start Menu > 8966 Pro > Roll 2016 Data to 2017 Software. The roll forward utility is unavailable if any Filer and/or Recipient data has been added into the 2017 software; perform the roll forward PRIOR to entering or importing any data into the software. To perform a roll forward AFTER adding data, users must uninstall the 2017 software and then perform a fresh installation.

(Image 1 - Roll Forward data option available through initial Installation Wizard.)

See File Not Found: Information Request Error

5.7 Video Display Issues

Video Display Issues

If the data on the form appears distorted or out of alignment please follow the directions below to correct your resolution and font settings.
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Display Settings.
2. At the Customize Your Display screen verify the size of text is set at 100% (not larger). Then click "Advanced Display Settings" and verify Resolution is set at 800 x 600 (or higher). Click "Apply" and "Keep Changes". You may need to restart for these settings to take effect.

Windows 98/NT/2000
Adjusting your resolution and DPI settings.
1. From your desktop click Start > Settings > Control Panel. Double-click the Display icon and click the Settings tab. Verify your screen area is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. From the Settings tab click Advanced, and verify font size is set at small fonts. You may need to restart for these settings to take effect.

Windows XP
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Properties > Settings. Verify Screen Resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. From the Settings tab click Advanced > General and verify the DPI setting is 96 DPI. You may need to restart for these settings to take effect.

Windows Vista
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Personalize > Display Settings. Verify Resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. On the Personalization screen click Adjust font size (DPI). Verify your setting is Default scale (96 DPI) – fit more information. Click "Apply" then "OK". You may need to restart for these settings to take effect.

Windows 7/8
Adjusting your resolution and DPI settings.
1. On your Windows desktop right-click your mouse and select Personalize > Display. Click Adjust resolution, verify your display resolution is set at 800 x 600 (or higher). Click "Apply" then "OK".
2. On the Display screen click Set custom text size (DPI). Verify scale is set to 100% (96 pixels per inch). Click OK. You may need to restart for these settings to take effect.

6 Browse Filers

Browse Filers

Use the Filer Master List screen to view/sort filers and Add, Change or Delete filers. To quickly jump between existing filers use the Select Filer button.

Filer Highlights
- 8966 Pro accepts multiple filers with one TIN. This is useful for companies that issue forms from multiple departments or for batch processors.
- 8966 Pro allows US, Canadian and foreign filers.

☐ See Filer Record Details for a thorough explanation on each filer specific field.

Views and Queries
- Current Sort/View Order - Users may sort filers by Filer Name, TIN or PCode.
- Current Query/Filter - By default all filers are displayed. Users can display a subset of the filers by clicking on the "Current Query" drop menu or create their own custom query, e.g. "Address Type Code = Other Foreign", etc.

Add a Filer
8966 Pro allows unlimited filers. See Adding a Filer

Change a Filer
Changes made to a filer affect only records with a Pending status. To switch between existing filers use the Select Filer button. See Changing a Filer

Delete a Filer
A filer can only be deleted if it is NOT associated with any recipient records. See Deleting a Filer

Run Filer Report
The Filer/Employer/Payer Listing provides detailed information on filers including Name, TIN, Contact Information, State ID Numbers and a history of any address changes. See Running Filer Reports

Select a Filer
Use the Select Filer screen to select a filer. See Selecting a Filer
Tag Filers
8966 Pro allows users to manually tag (select) filers for inclusion in a print session.
See Tagging Filers

6.1 Add a Filer

Add a Filer/Reporting FI

8966 Pro allows unlimited Filers.

*Please visit https://www.1099pro.com/videos.asp and view the "How to Add a Filer" video for a brief tutorial on the Filer process.

Add a Filer
1. From the menu bar select File > Filers (Withholding Agents).
2. At the Filers (Withholding Agent) Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields and click "OK" to save the filer.

See Filer Record Details for a thorough explanation on each entry field.

To Create a NIL Filer
8966 Pro only allows a NIL Filer to create a NIL Report.

1. On the Reporting F1 task panel select "My Filers List".
2. At the Filer Master List screen add a new filer or edit an existing filer.
   o The "Filer Is Used ONLY for NIL Reporting" checkbox must be marked. This checkbox is not available if editing a filer with existing data.
   o A Payer Code (PCODE) is required, but the Filer/Agent EIN is not.
3. Click "Save".

6.2 Change a Filer

Change a Filer

Changes made to a filer only apply to records with a Pending status. To switch between existing filers use the Select Another Filer button.

To Change a Filer
1. From the menu bar click File > (Withholding Agents)*.
2. At the Filer (Withholding Agent) Master List screen click "Change".
3. At the Changing a Filer Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new filer information. Click "Yes" to update filer or "Cancel" to abort changes and exit the screen.

See Filer Record Details for a thorough explanation of each entry field.
6.3 Sponsored Entity / Intermediary

Sponsored Entity / Intermediary

8966 Pro users can review or add Sponsored Entity or Intermediary List information via the Reporting FI task panel > "Intermediary/Sponsored Entity" link. Please review the IRS 2017 Instructions for Form 8966 for specific definitions of Intermediaries and Sponsored Entities.

Modify Indicators on Existing Data
Users can edit Sponsored Entity / Intermediary information on existing Forms 8966. First add the Sponsored Entity or Intermediary as outlined above. Then at the Work With My Tax Forms screen open the appropriate record and use the "Spon ENT Type" drop menu to select "No Spon ENT Type", "Intermediary" or "Sponsored Entity". Tab to the TIN field and right-click your mouse to display available Sponsored Entities or Intermediaries to auto-populate the form.

Another option is to re-import your data by creating a new map with the "Spon ENT Type" field added to your data file as outlined below.

Import File Conventions
Mark the "Spon ENT Type" column in the 8966 sample import file as follows:
- 1 / I / i = Intermediary
- 2 / S / s = Sponsored Entity

6.4 Contact Persons

Contact Information

At the Filer Record screen add or edit a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records. At least one contact is required. The contact phone number prints on all copies and 1096/W-3/1042-T Transmittals. The exception is 8966 Pro wherein the Contact Phone Number does NOT print on the Form 8966. The Transmitter/Submitter contact name is included in electronic files.

To Add/Edit Contacts:
1. On the menu bar select File > Filers List.
2. At the Filer Master List screen highlight a filer and click the "Change" button.
3. At the Filer Record screen (General tab) use the "Add", "Change" or "Delete" buttons as appropriate.
   - Dept. Code - The filer's internal reference such as AP, Sales, HR, LA Office, NY Office, etc. A maximum of 15 characters is allowed.
   - Default - Only one contact may be selected as default.
4. Use the "Save" button to save changes or "Cancel" to abort changes and exit.

6.5 Delete a Filer

Delete a Filer
A filer can only be deleted if it is NOT associated with any recipient records.

**To Delete a Filer**
1. From the menu bar click File > (Withholding Agents)“.
2. At the Filer (Withholding Agent) Master List screen highlight the filer and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the filer or "No" to cancel.

### 6.6 Filer Record Details

**Filer Record Details**

#### General Tab

**Filer/Withholding Agent’s Identification Numbers**
- Filers should enter a valid EIN if available (leave blank if necessary).
- Filers must have a GIIN or FIN. A GIIN is a 19-character identification number in the XXXXX.XXXXX.XXX.X format. Use the <F2> key in this field to view the Foreign Financial Institution (FFI) List of GIINs. Filers without a GIIN see FATCA Identification Number. See GIIN Composition.
- Filer Category - Use the <F2> key to view and select the appropriate filer category code.
- “Filer is used ONLY for NIL reporting” checkbox applies to Direct Reporting Non-Financial Foreign Entities (NFFEs) and Sponsoring Entities’ reporting on behalf of a Sponsored Direct Reporting NFFEs who are required to submit Nil reports. **Only NIL Filers can create a NIL Report.** This checkbox is not available if editing a filer with existing data.

**Payer Code—Required**
For the user’s internal reference only, a Payer Code (or PCode) is an alphanumeric shorthand used to identify a Payer/Filer in the system. Users may set up several Filers with the same TIN in the system and the Payer Code is an easy way to identify the unique business. For example, use a Payer Code of ‘BOD’ if reporting for the Board of Directors. Typically security and/or the return address is different for each Payer Code. Additionally, in an import file with recipient/tax form data for more than one Payer/Filer, Payer codes can be used to define which Payer/Filer the recipient/tax form data should be posted to.

Payer Codes must be unique. If an already in use Payer Code is entered, the system prompts to create a new one for the user.

**Country**
Defaults to USA. Selecting Canada or a foreign country automatically reformats the address fields.

**Filer Name**
Prints on all tax records.

**Address**
Prints on all tax records.

**Contact Information (Required)**
Use the "Add" button to add a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records (use the Dept. field at the Adding a Form Record screen). At least one contact is required. The phone number prints on all copies and IRS/SSA paper Transmittals; the exception being 8966 Pro wherein the Contact Information does NOT print on Form 8966. The Transmitter/Submitter contact name is included in electronic files.
Fax
This field is optional.

E-mail
This field is optional.

Notes
Enter notes specific to a Filer/Pcode for reference purposes.

Prior Address Tab
This tab displays only if a filer's address has been modified. Preserves prior filer address information for reference purposes. This information cannot be change.

6.7 Filer Reports

Filers List Report

The Filer/Employer/Payer Listing provides detailed Filer specific information including Name, TIN, Contact Information, State ID Numbers and a history of any address changes. All filers are automatically included in the report.

- See Summary of Forms Issued by Filer report for a detail of forms issued by filer including Form Counts, Recipient Name / TIN / Address and each record's respective status.

To Run Filers List Report
1. From the menu bar select File > Filers (Withholding Agents).
2. At the Filer/Employer/Payer Master List screen click "Run Filer Report".
3. The Administrator prompts to "Print One Filer Per Page" and preview the report. Select as appropriate.

6.8 Select Another Filer

Select Another Filer

Use the "Select Another Filer" button, located at the top left of the task panel, to select a filer.

To Select Filers
1. On the task panel click the "Select Another Filer" button.
2. At the Browse the Filers File screen highlight the filer to use and click "Select".
Note: The Current Filer is displayed at the top of the Select Filer box.

To Add/Edit Filers
- On the task panel click the "Manage" button to access the Filer Master List screen or see Browse Filers.

6.9 Tag Filers

Tag Filers

8966 Pro allows users to manually tag (or select) filers for inclusion in a print session.

To Tag Records
1. On the Printing & Mailing task panel click "Print/Mail Forms Myself". Use the Current Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "All Pending Forms for Selected Filers" option.
3. Click the "Begin a New Print Process" button.
4. At the Browse the Filers File screen click the "Tag" button to select filers. A red check mark appears beside each tagged filer. (See Tag Key Shortcuts below.)
   - To sort filers prior to tagging, use the View drop menu.
5. After tagging all filers, click "Proceed" to initiate the Print Wizard.

Tag Key Shortcuts
- **Tag**: Use this button (or ALT + T) to tag individual filers.
- **Tag All**: Use this button (or ALT + A) to tag all filers.
- **Untag**: Use this button (or ALT + U) to untag an individual filer.
- **Untag All**: Use this button to untag all filers.
- **Flip**: Use this button (or ALT + F) to reverse the tag status of an individual filer.
- **Flip All**: Use this button (or ALT + L) to reverse the tag status of all filers. For example, if there are three filers and only one filer is tagged, the Flip All button will tag the two previously untagged filers and untag the original filer.
- **Prev Tag**: Use this button (or ALT + P) to scroll backwards through tagged filers.
- **Next Tag**: Use this button (or ALT + N) to scroll forwards through tagged filers.

7 Browse Recipients

Browse Recipients

Use the Recipient Master List screen to add, change or delete recipients. To access these recipients at any data entry form, use the <F2> key or right-click your mouse in the recipient ID Number field.

See Recipient Record Details

Add
Unlimited recipients can be added; however, a maximum of 5,000 recipient transactions (or records) are allowed in a standard software installation. Additional transactions can be purchased via Bump Codes.
See Add Recipients

Change
Changes made to a recipient only impact records with a Pending status. When making manual changes to the filer and/or recipient master list, those changes cascade or update throughout all tax forms with a status of Pending. Cascading updates help ensure that the entire filer and recipient information—regardless of the tax form—synchronizes quickly and uniformly. These changes are NOT tracked through the Record History screen; only direct changes to a tax form are tracked under record history.
See Change a Recipient

Delete
A recipient cannot be deleted if any tax forms are associated with it.
See Delete Recipients

Run Forms Issued Report
The Forms Issued for Recipient report details all forms issued to each recipient. Includes filer, recipient address, and form status.
See Running Forms Issued Reports

Group Actions
Group Actions allow users to tag/select a number of items and then perform a single action on them. In all instances the user is prompted to confirm their choice before the action is taken.
See Group Actions

Multiple Recipients - One TIN
Occasionally a filer may issue multiple forms to the same recipient or issue forms to two individuals sharing one SSN or EIN. For example, Jane Doe DBA Jane's Courier Service and Jane Doe both use an SSN of 123-45-6789. However, Jane Doe DBA and Jane Doe have different addresses. To enter both recipients follow this procedure:
See Multiple Recipients - One TIN

Run Recipient Report
The Recipient Listing includes the Name, TIN, and Address of all recipients in the database. For more detailed recipient information, including Account Numbers and status of any forms, use the Control Totals report.
See Recipient Listing Report

Select a Recipient
All recipient records are stored in a master database that is accessible at any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. At the Select a Recipient screen, highlight a recipient and click "Select" or double-click the recipient.
See Selecting Recipients

Tagging Recipients
Users can manually tag (select) records for inclusion in a print session.
See Tagging Recipients
7.1 Recipient Record Details

Recipient Record Details

General Tab
SSN/EIN - The placement of the dash in the TIN field is critical. The entry of an SSN or EIN determines the formatting of the Name and Company fields. For Form 8966 if the TIN is unknown, leave this field blank.

First Name (SSN) - Enter the recipient's First Name.

Last Name (SSN) - Enter the recipient's Last Name.

Company (EIN) - Enter the recipient's Company.

Name Line 2 - Enter a second name or DBA, as appropriate.

Address Type - Defaults to USA. Selecting Canada or Other reformats the address fields. See Canadian Postal Code Rules.

Address - Enter the recipient's Address.

E-mail - This field is optional but is useful for e-mailing encrypted tax forms to recipients upon request.

Accounts/Name 2 Tab
Name Line 2 - This field is for reference only and reflects entries made at the data entry screen.

Account Numbers - Enter as many account numbers as necessary. Access this information at the Account Number field at any data entry screen via the <F2> key.

7.2 Add Recipients

Add Recipients

8966 Pro allows unlimited recipients. In a standard software installation up to 5,000 recipient transactions (tax records) are allowed; bump codes may be purchased at any time.

☐ 8966 Pro users may manually add individual recipient records; Corporate Suite Edition users may import recipient records. Most often users import data - including tax form and recipient information - thereby eliminating the need to manually add recipients, aside from the occasional record issued at the last minute. See Import Overview for more information.

Manually Add Individual Recipients
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen click "Add".
3. At the Adding a Recipient Record screen complete all fields. Use the <F1> key at any time to access field specific information.
4. After completing all fields click "OK" to save the recipient.
   - Access the Recipient Master List at the Adding a Tax Form screen by placing your cursor in the "Account Holder/Payee TIN" field and right-clicking your mouse OR via the <F2> key.

Import Recipients
Corporate Suite Edition allows users to import recipient records. Please see Import Wizard Step 1 - Import Data, Filers or Recipients.

7.3 Select Recipients

Select a Recipient by TIN or Last Name
All recipient records are stored in a master database that is accessible at any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. At the Select a Recipient screen, highlight a recipient and click "Select" or double-click the recipient. All Recipient associated information (TIN, Name, Address) automatically populates the form.

To Filter Recipients
1. Place your cursor in the Search/Filter box.
2. Select the View by TIN (SSN/EIN) or View by Last Name tab.
3. Enter your search criteria and hit TAB on your keyboard. For example, to view only recipients with last names starting with the letter "B", type "B" and TAB.
4. To remove the filter click the "Show All (remove filter)" button.

7.3.1 Tag Recipients

Tag Recipients
8966 Pro allows users to manually tag (select) records for inclusion in a print session.

Tag Records
1. At the Printing & Mailing task panel click "Print/Mail Forms Myself". Use the Current Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "Manually select forms..." option.
3. Click the "Begin a New Print Process" button.
4. At the Selecting Form Records screen click the "Tag" button to select records. A red check mark appears beside each tagged record. (See Tag Key Shortcuts below.)
   o To sort records prior to tagging, use the View or Query drop menus.
5. After tagging all records, click "Proceed to Next Step" to initiate the Print Wizard.

Tag Key Shortcuts
- Tag: Use this button (or ALT + T) to tag individual records.
- Tag All: Use this button (or ALT + A) to tag all records.
- Untag: Use this button (or ALT + U) to untag an individual record.
- Untag All: Use this button to untag all records.
7.4 Change a Recipient

Changes made to a recipient only affect associated records with a Pending status.

To Change a Recipient
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen highlight the recipient and click "Change".
3. At the Changing a Recipient Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new recipient information. Records with a printed, filed or Filed 1096 status are not updated.

7.5 Delete Recipients

A recipient cannot be deleted if any records are associated with it; users must first delete all records (or tax forms) associated with the recipient. Users are strongly encouraged to backup data prior to deleting recipients.

To Delete INDIVIDUAL Recipients
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen highlight the recipient and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the recipient or "No" to cancel.

To Delete Recipients With No Forms
1. From the menu bar select File > Recipients List.
2. At the Recipient Master list screen click "Delete All With No Forms".
3. The Administrator warns this action cannot be reversed. Click "Yes" to continue with deletion or "No" to cancel and exit this screen.

7.6 Forms Issued Report

Forms Issued for Recipients

The Forms Issued for Recipients report details all forms issued to each recipient including Form Type, Form Status, Form Filer (by TIN), Form Account Number, Date Created and Date Last Updated.

To Run Report
1. From the menu bar click "File" and "Recipients List".
2. At the Recipient Master List screen click the "Run Forms Issued Rpt" button.
3. The Administrator prompts, "Limit the report to just the selected recipient?"
   - Select "Yes" to run a report for ONLY the recipient selected (or highlighted) at the Recipient
     Master List screen.
   - Select "No" to run a report for ALL recipients in the database.
4. Click "Yes" to preview the report.

7.7 Recipient Listing Report

Recipient Listing Report

The Recipient Listing includes the Name, TIN, and Address of all recipients in the 8966 Pro database. For more detailed recipient information, including Account Numbers and status of any forms, use the Control Totals report.

To Run Report
1. At the menu bar select Reports > Recipients List, or alternately, at the Recipient Master List screen click the "Run Recipient Report" button.
2. At the Recipient Master List screen the Admin prompts to preview report, click "Yes".

7.8 Group Actions

Group Actions

The "Group Actions" button is located at the bottom of the Work With My Tax Forms screen and provides direct access to the following options:

QUICK-PRINT Pending Tax Forms
Users can tag any number of tax forms with a Pending status and print them via the Quick-Print option. To print IRS Copy A forms and update the status of the forms from Pending to Printing, use the Print Tax Forms Wizard. Quick-Printing does not allow for the updating of a record's print status.

QUICK-REPRINT Printed or Filed Tax Forms
Users can tag records in a group—regardless of print status—via the Reprint tab. To print any individual record use the Quick-Print option located at the Work With My Tax Forms screen.

ADD New Forms for Selected Recipients
Users can tag any number of recipients, and then loop through the list creating new forms for them. The program auto-populates the recipient information on each new form, only the specific box information for the form must be entered. For additional flexibility, users may add the forms by the following sort orders: Name, TIN, State or ZIP.

DELETE Pending Tax Forms
Users can tag any number of Pending tax forms and delete them with one operation. All notes associated with the form(s) are also deleted.

RESET Printed Tax Forms Back To Pending
Users can tag any number of forms with a Printed status and reset their status to Pending to make
forms available for edits or deletions. The selected forms can belong to any print session.

**VOID Printed Tax Forms**
Users can tag any number of forms with a *Printed* status and change their status to *Void* to prevent them from being filed. The selected forms can belong to any print session.

**UN-VOID Tax Forms**
Users can tag any number of forms with a *Void* status, and reset their status *Pending* to make forms available for edits or deletions.

### 7.9 Multiple Recipients - One TIN

#### Multiple Recipients - One TIN

A Filer can issue multiple forms to the same recipient or issue forms to two individuals sharing one SSN or EIN. For example, *Jane Doe DBA Jane's Courier Service* and *Jane Doe* both use an SSN of 123-45-6789. However, Jane Doe DBA and Jane Doe have different addresses. To enter both recipients follow this procedure:

1. Enter Jane Doe as normal at any Adding a New Record screen. This will be the "master" recipient information for Jane Doe. Click "Save" to save Jane Doe's record.
2. At the next Adding a New Record screen, enter the shared TIN in the Recipient TIN field. Jane Doe's name and address automatically fill the screen.
3. Use SHIFT + TAB to move backwards through the fields and overwrite the name and/or address fields with Jane Doe DBA's information. Click "Save" to save changes.
4. The Administrator indicates a possible recipient information mismatch. Click "No" to not update Jane Doe DBA with the "master" record. Also uncheck the "Update All Other Pending Forms" checkbox.

At the Recipient Master List screen only the "master" record, Jane Doe, is listed. However, the recipient record does list the DBA under the Accounts/Name2 tab.

### 8 Corrections

#### About Corrections - An Overview

**When do I need to create a correction?**
If a return is filed with the IRS/SSA and an error is discovered it must be corrected as soon as possible. Some corrections require one return, others require two. 8966 Pro software intuitively creates the appropriate corrected return(s) based on the type of correction created. Additionally, users must provide corrected returns to recipients as soon as possible. Filers may be subject to penalties for failure to file correct information returns or furnish a correct payee statement.

To begin the process of making a correction(s), see [Correct a Record](#).

**Do I need to file corrections with the IRS?**
Filers only need to file a correction with the IRS/SSA if incorrect data was sent to the IRS. For example, if recipient copies were mailed in January and errors were changed prior to sending data to the IRS/SSA, then no correction is necessary.
Do I need to issue corrections to my Recipients?
The IRS requires filers to issue a "correct payee statement" to their recipients.

- If forms were sent with incorrect data to recipients, but not to the IRS, consider sending recipients a revised statement from 8966 Pro reflecting the accurate data. These forms will have a "Pending" or "Printed" status in the software. The corrected box is not marked; however, some filers manually check the box with a pen to aid the recipient in distinguishing the revised (good) form from the original issue form.
  o Filers may also force an "X" in the corrected box using the Advanced Print Options. Forcing an "X" does not qualify as a legitimate correction.

- If forms were sent with incorrect data to recipients AND filed with the IRS a formal correction is required and corrected copies must be sent to the recipient and filed with the IRS. After generating the corrections these forms have a "Corr/Pend" status and the corrected box on the recipient copy is automatically marked with an "X" when printed. See Correct a Record topic.

For More Information ...
Tax year 2017 form specific IRS/SSA instructions are available within 8966 Pro and are accessible via the Help & Extras task panel by selecting "IRS Pubs & Links”. Double-click on any form or instruction to open, view or print it.

About Corrections Screen
The About Corrections screen lists all form types containing corrected records.

To View About Corrections Screen
On the Help & Extras task panel select the Correcting Filed Forms link. A red check mark appears beside any form type containing corrected records.
  o Corporate Suite Users: On the Filing & Corrections task panel select the Correcting Filed Forms link. Any form type for the selected tax year containing corrected records is listed.

### 8.1 Correction of a Correction (CS Version only)

Creating a Correction of a Correction

The features contained within this section are available exclusively to users of the Corporate Suite edition.

This simple tutorial guides users through the process of creating a correction of a correction. A corrected form must be filed with the IRS/SSA prior to correcting a correction; if the corrected form has not yet been filed it is only necessary to make changes and save the form. It may be necessary to file a Federal or State correction depending on what is done within the correction.

☐ Effective As Of TY 2016: For 1099 Informational Returns de minimis corrections do not need to be printed or filed UNLESS the recipient specifically requests it. Filers are no longer required to create corrections if the amount difference is $100 or less and $25 or less for any tax withheld box. See the IRS General Instructions for Certain Information Returns for specific details.

To Correct a Corrected Form
1. On the Forms & Printing task panel select the "Browse, Enter & Edit" link. Verify the appropriate Tax Year and Form Type are selected.

2. At the Browse, Enter & Edit screen highlight the recipient record to perform the correction of a correction on and click the "Change" button.

3. At the Protected Form Update Options screen click the "Initiate a NEW Correction Process" button and "Yes" to continue.
   ○ Note: If more than one correction form was created for this record's previous correction (for example, there were both a State and a dollar amount change, thus generating two associated records; zero/pending and correction/pending), 1099 Pro automatically bases the initial values for this NEW correction on the most recently filed correction.

   **Example of Form before Second Correction**

   ![Example of Form before Second Correction]

   4. At the Adding a Correction screen modify the information for the correction. Any modified fields display in blue and the Correction Type box specifies the type of correction.

   **Example of Modifying a Corrected Form**
5. After making all changes click the "Save Form" button.

6. Return to the Protected Form Update Options screen where all corrections associated with this record are detailed. Click the "Close" button to exit this screen. Remember to provide a corrected form to the recipient and file with the appropriate Federal or State agency.

Example of the screen showing the Associated Corrected and Corrections Forms

8.2 Corrected Options

Corrected Options

The Corrected Options screen is a useful tool for viewing corrected and associated forms; as well as for printing corrected and original forms.

Considerations:
- All forms, both corrected and non-corrected, are available at the "Work with My Tax Forms" screen.
- A corrected form may not necessarily appear next to its original form. Forms may have different TINs or names and be sorted accordingly.
Some types of corrections generate two forms, while others generate only one.
All corrections may be submitted on paper UNLESS there are 250+ corrections per filer, per form type (in which case they must be filed electronically). This is true even if your original forms were filed electronically.
Audit trails do not track changes for corrected forms.
8966 Pro does NOT process corrections of already corrected forms*. Prepare such corrections manually.

* Corporate Suite software prepares corrections of already corrected forms.

8.3 Create Corrections

8966 Corrections - An Overview

8966 Pro handles three types of corrections including:
• Amended - Process filed forms that were subsequently amended.
• Voided – Send voided forms that you individually marked as void.
• Corrected – Corrected Data is used for records being re-transmitted after the IRS has notified the sender of a problem with the file or underlying data. Only select Corrected Data if responding to an IRS
request to correct the data (do not use for Decryption, XML or other file-level errors).

☐ Effective TY 2016 corrections require reference to a unique RFID.

**To Change Data On a Previously Filed Form:**
1. At the Work With My Tax Forms screen double-click on the appropriate recipient to access the Protected Form Update Options screen.
2. Click the “Correct/Amend/Void” button.
3. The Changing a Form 8966 Correction screen displays. Change record as necessary:
   - If this record should never have been sent in, click the VOID box and save the form. Then go to Create XML and generate a VOIDED XML file.
   - To change the values on a record, click the AMENDED box. Make changes and save the form. Then go to Create XML and generate an AMENDED XML file.
   - To re-transmit a file to the IRS because the IRS told you to, click on the CORRECTED box. Make changes and save the form. Then go to Create XML and generate a CORRECTED XML file.
4. Use the IDES Packager and transmit your corrected XML file(s) to IDES.

### 8.4 Delete Corrected Forms

#### Delete Corrected Forms

Only corrected forms with a **Pending** print status are available for deletion. If a corrected form with a pending print status is associated with a corrected form with any other print status, deletion is not possible. You must first reset all associated forms to pending.

**To Delete Corrections**
1. At the Work with My Tax Forms screen highlight any corrected record (Corr/Pending). Click the “Delete” button.
2. At the Associated Corrected and Corrections Forms screen highlight the record and click the “Delete” button.
3. The Administrator prompts to confirm deletion. Click “Yes” to continue or “Cancel” to abort.

The deleted form immediately exits the Corrected Options screen and reverts to the Work with My Tax Forms screen with its pre-corrected print status.

### 8.5 Protected Forms

#### Form Status Overview

Records with a Printed, Filed (1096/W-3/1042-T), Filed Mag, SB Filing, Corr/SB Filing or Void status are "protected" from changes or edits. Use the Protected Form Update Options screen to access these records. Available update options vary according to the record's status.

**Protected Form Update Options screen**

Use this screen to access protected records for viewing, reprints or generating corrections.
1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link.
2. Highlight any record with any status except Pending.
3. Click the "Change" button to display the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>These forms are ready to be printed and/or filed. Users may view, change or delete the form. Print the form and/or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).</td>
</tr>
<tr>
<td>Printed</td>
<td>These forms have been printed and are ready to be filed. Users may view the form, reset the form to pending print status, void the form, reprint the form or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Records that were imported with a printed status cannot be void, reset or delete. The entire import session must be reset.</td>
</tr>
<tr>
<td>Voided</td>
<td>These forms have been voided. Users may view the form, unvoid the form or reprint the form</td>
</tr>
<tr>
<td>Deleted</td>
<td>These forms have been deleted and may not be undeleted. Users may view the form.</td>
</tr>
<tr>
<td>Filed</td>
<td>Users may view the form, reprint the form or create corrections. <em><strong>This status is not applicable to 8966 Pro users.</strong></em></td>
</tr>
<tr>
<td>Filed Mag</td>
<td>These forms have been printed and filed electronically (magnetic media). Users may view the form, reprint the form or create corrections.</td>
</tr>
<tr>
<td>SB Filing</td>
<td>These forms have been submitted to the Service Bureau for electronic filing. Users may view the form, reprint the form or create corrections.</td>
</tr>
<tr>
<td>SB Print+Mail</td>
<td>These forms have been submitted to the Service Bureau for printing and mailing. Users may view the form, file the form (to paper* on IRS/SSA Copy A, electronically or via the Service Bureau), reprint the form or reset to pending.</td>
</tr>
<tr>
<td>Corr/Pending</td>
<td>These forms have been corrected and are ready to be printed and/or filed. Users may view the original or corrected form, reprint the original form. Print and/or file the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Change the corrected form or delete the correction.</td>
</tr>
<tr>
<td>Corr/Printed</td>
<td>These forms have been corrected and are ready to be filed. Users may view the original or corrected form, reprint the original or corrected form. File the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Reset the corrected form to pending status.</td>
</tr>
</tbody>
</table>
Corr/SB Filing  These forms have been corrected and submitted to the Service Bureau for electronic filing. Users may view the original or corrected form, reprint the original or corrected form.

Corr/Mag  These forms have been corrected and filed electronically (magnetic media). Users may view the original or corrected form, reprint the original or corrected form.

* Filers must file electronically if they have 250 or more forms of any one form type or risk IRS penalties.

Create Corrections
Refer to About Corrections and Create Corrections - A Tutorial

8.6 Reprint Corrections

Reprint Corrections

To Reprint Corrections
1. At the Work with My Tax Forms screen highlight any corrected record without a Pending print status. Click the "Change" button.
2. At the Corrected Options screen click the "Reprint Correction Form" button.
3. The Administrator prompts to reprint ALL associated corrections or just the selected form.
4. At the Print Options screen select the paper type; preprinted laser, blank stock.
   • If selecting preprinted laser adjust margin alignment as necessary.
5. Select the copies to print.
6. Select the sort order to print forms (this field is ghosted if only one record is selected for print):
   • By Last Name/Company Name (default)
   • By TIN
   • By Zip Code (use to presort mailings for the post office)
   • By State Abbreviation
7. Enter an optional message to print in the upper right corner of the form(s).
8. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

8.7 Reprint Originals

Reprint Originals

Use to reprint the original form prior to any corrections.

To Reprint Originals
1. At the Work with My Tax Forms screen highlight any corrected record. Click the "Change" button.
2. At the Corrected Options screen click the "Reprint Original Form" button.
3. At the Print Options screen select the paper type; preprinted laser, blank stock
   • If selecting preprinted laser forms you should adjust the margin alignment as necessary.
4. Select the copies to print.
5. The "Select the Sort Order to Print Forms" field is ghosted because only one record is selected for print.
6. Enter an optional message to print in the upper right corner of the form(s).
7. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

9 Account Generation Wizard

Account Generation Wizard

The IRS has indicated they will not reject files if they do not have account numbers but by having account numbers the IRS will be able to process any corrections that they encounter.

Why would I need to generate Account Numbers?
IRS Publication 1220 states that the IRS now requires account numbers: "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ..."

The Generate Account Number wizard creates unique Account Numbers for tax forms that have not been filed to satisfy the requirement. Users can also individually specify the Filers and/or form types to process.

- Only forms with a status of Printed or Pending are updated.
- Any form with existing Account information is NEVER overwritten, regardless of status.
- Users can manually replace generated account numbers at any time before filing with the IRS/SSA.
- The Account Wizard algorithm is the first two letters of the Recipient's last name, the IRS form code and a number unique to that form. For example, one might look like this SM-M-0001234.

See Generating Account Numbers

9.1 How To Generate Account Numbers

Generate Account Numbers

To Generate Account Numbers*:
1. At the menu bar select Utilities > Generate Account Numbers.
2. At the Account Number Generation Wizard click "Next" through the screens.
3. Confirm the settings on the Account Number Generation summary screen.
4. Click "Finish" to begin generating Account Numbers. Existing account numbers are NEVER overwritten.

* The Generate Account Number Wizard is also available within the Print Wizard, Upload File Wizard and Electronic File Wizard.

See Account Generation Wizard

10 Security and Administration

Global Administrative Options
Access the Global Administrative Options screen via the menu bar > File > Security and Administration.

**Security**
Through the use of settings and rights administrators can restrict users and thereby protect sensitive company data.

**Add/Update Individual Users**
Administrators can use the Add/Update Individual Users screen to create users and assign them to specific tasks.
See [Adding and Updating Users](#).

**Access Groups and User Profiles**
Create new Access Groups and User Profiles based on the user's custom settings. Your groups will be available when adding or changing a user and are included in all security reports.
See [Security - Access Groups](#) and [Security - User Profiles](#).

**Passwords**
Passwords can help protect sensitive company data.
See [Passwords](#) for more information

**Security Access Logs**
The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all logon attempts.
See [Security Access Logs](#).

**Security Reports**
1099 Pro offers numerous reports to track users and access groups. These security reports are available only to administrators or users with administrative rights.
See [Security Reports](#).

**Turn On/Off Security**
1099 Pro offers two levels of security; on and off. If security is enabled, access to 1099 Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This provides a twofold method of protecting sensitive company data.
See [How to Enable or Disable Security](#).

**Tax Form Audit Trail and Action Logging Options**

**View Audit Trail Records**
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).
See [Master Audit Trail Browser](#).

**Purging Audit Trail Logs**
The Audit Trail Record Log is invaluable for tracking tax forms changes. If the log becomes so large that the performance of 1099 Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.
See [Purging Audit Trail Logs](#) for more information.
Combining Tax Forms (Corporate Suite Only)

Aggregation / Rollup Options
The 1099 Pro Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.
See Using Aggregation for more information.

Program Options

Preference, Update and Program options
Configure many of the software general settings such as date range warning, update checking and backup reminders.
See Preferences for more information.

Tax Form Validation for Import and Entry
Adjust settings to configure the warning and error messages displayed when importing or manually entering forms.
See Custom Tax Form Validation Rules for more information.

Reporting Thresholds (Corporate Suite Only)

Manage State CFS Limits and Settings
The State CFS Limits and Settings Manager is a 1099 Pro Corporate Suite/ASP feature that allows users to manage reporting thresholds for state and federal returns.
See State CFS Limits and Thresholds

User Fields and E-mail (Corporate Suite Only)

Optional Form 1099-MISC Amount Box
This feature allows for a custom MISC amount box and/or custom Oil & Gas fields on Form 1099-MISC.
See MISC Optional Fields for more information.

Lookup and Code Translations
This section allows users to manage custom codes and texts for tax forms.
See Manage Custom Codes and Texts for more information.

Scheduler Utility Email Settings
This section allows users to manage the e-mail address, recipients, and messages sent by the Scheduler Utility
See Scheduler for more information.
10.1 Security Overview

10.1.1 System Security Settings/Password Requirements: Step 1

Setting Password Requirements

Step 1: Set Security Preferences/Password requirements

The Security Preferences/Passwords requirements section allow Administrators to configure details regarding user passwords including: password length, lockout settings, expiration and password format. Corporate Suite additionally allows Administrators to set the login type such as tying Corporate Suite security into Windows Active Directory security.

1. To configure password and login requirements click the "Set Password Requirements" / "Set Security Preferences" (Corporate Suite) button.

2. At the Modify System Security Settings window, configure the following settings:
   a. **Login Type**: (Corporate Suite Only)
      - Default: Requires the user to enter the username and password assigned to during user creation (Step 4).
      - AutoFill: Pre-fills the login dialogue with the Windows User Name. When creating users you must use the same login name they use for Windows for this to be useful.
      - Active Directory: Removes login prompts instead using the Windows Domain/Username/Login that the user logged into their computer with. The username in our software must match the username they log into Windows with.
   b. **Minimum Password Length**: Defines the minimum character length the password can be; range is from 5-15 characters
   c. **Lock a User ID after this many invalid login attempts**: Sets the maximum number of times a user can fail to log in before needing to have their account unlocked by an administrator.
   d. **Days before a password expires**: Sets the length of time a user’s password is valid before they must choose a new one.
   e. **Days to warn a user before their password expires**: Defines when the software will begin notifying when the user’s password is going to expire.
   f. **Times before a password can be used again**: Defines how many different passwords must be used before a user can use the same password again.
   g. **Ignore case when validating Passwords [e’ = ’E]**: Determines whether or not the case matters when a user is entering their password.
   h. **Require at least One (1) Uppercase Character**: Determines whether or not there must be at least one uppercase character in a User’s password.
   i. **Require at least One (1) Lowercase Character**: Determines whether or not there must be at least one lowercase character in a User’s password.
   j. **Require at least One (1) Numeric Character**: Determines whether or not there must be at least one numeric character in a User’s password.
   k. **Require Special Characters in Password**: Determines whether or not special characters (i.e., !, @, #, $, %, ^, etc.) are required in a User’s password. Admin must specify which special characters are allowed before enabling this option (see "l" below).
   l. **Special Characters (Up to 15)**: Define special characters which may be used during password creation.
10.1.2 Security - Access Groups: Step 2

Security - Access Groups

Step 2: Creating and Managing Access Groups

Access Groups allow an Administrator to define the Program Areas and Form types that a User will have access to, as well as their level of access. Users only have the rights specifically assigned to them; any rights not assigned are denied by default. The rights available within 1099 Pro are View/Access area, Create, Modify, Delete, Report, Correct, Print, and Reset/Void where applicable.

1. At the menu bar click File > Security & Administration > Security Groups.

2. At the Security Options screen click the "Create and Manage Access Groups" button to access the Access Groups screen.

3. Click “Add” to open the Update Access Groups screen and create a new access group.
   - Users may also select “Change” or “Delete” to modify any access groups you have already created or to view the contents of a built-in Access Group.
   - IMPORTANT: 1099 Pro includes multiple built-in access groups (indicated by a TEAL color) that cannot be modified or deleted.

4. Assign or Modify Access Rights at the Update Access Groups screen by entering a Group Name and then “Tag” (or select) items in the Access Form or Program Area to configure. After tagging an item click the “Modify Highlighted Records” button.

5. The Modify Access Rights window opens and the Administrator may assign specific rights to a form or program area by clicking the check box to the left of the form to modify. If the right is ghosted or grayed out then that right is unavailable for that particular area. You may also “Select All Rights” or “Clear All Rights”.

6. Click “Save” when done to return to the Update Access Groups screen. Administrators may add Notes for the Access Group if desired. When done modifying Access rights click “Save Changes to Group” to exit and save changes.

7. At this point the Admin may "Add", "Change" or "Delete" other Access Groups as necessary; excluding 1099 Pro’s built-in access groups. When finished click “Close” to return to the Security Options screen.
   - IMPORTANT: If a Program Area or Form type is "Tagged" (or selected) and no rights are assigned to it, you have created a “View only” access rule. This will allow assigned users to enter an area or form but they will NOT be able to enter or save any changes.

10.1.3 Security - Manage Profiles: Step 3

Security - Manage Profiles

Step 3: Create and Manage User Profiles

User Profiles allow Admin to apply Access Groups to specific Filers/Departments. When assigning a user to this profile (Step 4), the User only has the specific rights granted by that Access Group to the specified Filers. 1099 Pro’s built-in User Profiles are applied to ALL filers. NOTE: In order to access the 1099 Pro system, a User must have rights to AT LEAST one Filer, in other words, they must be assigned to at least one User Profile.
The below diagram illustrates the components comprising a **User Profile**. In Step 4 the users are assigned to the profiles.

**Diag 1:**
User profile composed of multiple filers (companies/departments) and 1 access group.

**Diag 2:**
User profile composed of 1 filer and multiple access groups.

1. To create or manage a User Profile click "Create and Manage User Profiles for Filers and Access Groups" from within the Security Options window. 1099 Pro includes built-in User Profiles. Built-in groups are colored in teal and cannot be modified or edited. By default, **all built-in User Profiles have access to ALL current and Future Filers**.

2. Click "Add" to create a new user profile or select "Change" to modify any existing User Profiles. The "Quick Assign" button walks users through these steps in a wizard. Use the "Clone Profile" button to clone a previously created profile and then edit the Filers and Access Groups assigned to it.

3. After clicking "Add", "Change" or "Clone Profile" the Update User Profile screen opens. At this screen assign Access groups to Filers.
   - **Create or update a user profile:**
     a. Create a name for the User Profile.
     b. Tag (or select) the Filers to allow access to.
     c. Highlight the Filer to configure and click the "Assign Access Groups" button to attach Access Groups that were previously created to the profiles.
     d. At the Tag Access Group screen select the previously created profiles (Step 2).
     e. After selecting profiles click "Save" to exit. **Repeat Steps C, D and E for each Filer in this profile.**
4. Upon exiting the Update User Profile screen return to the User Profiles screen where Admin can continue to add, change or delete profiles. After updating profiles click "Close" to return to the Security Options window.

10.1.4 Security - Add/Update Individual Users: Step 4

Security - Add/Update Individual Users

Step 4: Add/Update Individual Users
Generally there is one User for each physical user of the software. This section assists in the creating, updating, and deleting of Users. Remember, built-in accounts cannot be modified or deleted.

1. To configure Users, click on "Add/Update Individual Users" at the Security Options screen.

2. The Users screen displays all current users in the software. Use the "Add User" button to add a new user and the "Change" button to modify an existing user or view the profiles they are associated with. The "Delete" button removes users from the system.

3. Click the “Add User” button to open the Adding a User window where Admin creates the login information required for the new User to access the software (or Change User in the case of clicking the "Change" button).
   a. **User Login Settings:**
      i. **User ID:** Enter a User ID for software login. Corporate Suite users using the Active Directory Login Type must use the same username that the user logs into their network with.
      ii. **Password:** By default, all new users are assigned NEW as their password—this cannot be changed at this screen. To set the user requirements for password see Set Security Preferences.
      iii. **Lock Status:** Indicates if a user account is locked due to login failures. Click "Change" to lock or unlock an account. The Admin can reset the password as necessary.
      iv. **Pre-W2K Domain (Corporate Suite only):** This is only used when Active Directory Login type is selected by clicking "Set Security Preferences" on the “Security Options” screen
   b. **User Name:** User's full name; this information does not impact login credentials.
   c. **Phone:** User contact phone number.
   d. **Other Info:** Add other information such as user's department, e-mail address, location, etc.
   e. **User Profile Membership:** This field displays all of the User Profiles that the user is currently associated with. See Step 5: Add Users to a Profile

10.1.5 Security - Add Users to a Profile: Step 5

Security - Add Users to a Profile

Step 5: Add Users to Profiles:
This last step in configuring security will guide you through the process of assigning a user to a profile created during Step 3.

To Add User to a User Profile
1. Click on the "Add/Remove Users from Profiles" button located on the Security Options window.
2. At the Security – Assign Users screen (Available User Profiles screen in Corporate Suite) assign newly created users to a profile.
3. Select the profile you wish to add users to by clicking the “Available User Profiles” dropdown.
4. Tag the users that you wish to have applied to the selected profile. **Click “Save” prior to adding users to another profile.**
5. To tag a user highlight the user and click “Tag” button or click in the column to the left of their UserID.

**Select which tax years users have access to under the profile.** *(Corporate Suite Only)*
1. Click “Save”/ “Save my Changes to this Profile/Year”
2. Repeat the steps above to add users to additional profiles.

### 10.1.6 Turn On/Off Security

#### Turn On/Off Security

**Section 1: Accessing Security**
2. At the Security Options screen the Security status is displayed as ON or OFF.
3. If security is OFF (or not enabled) click the “Activate Security” button to enable it.
4. The user is prompted to restart the program.

### 10.1.7 Passwords

#### Passwords

Passwords help protect sensitive data.

- See **Setting Password Requirements**

**First Time Logon**
If security is enabled during the **Welcome Wizard**, the Administrator must create a new password the first time they logon to 1099 Pro.

1. In the User ID field enter **Administrator**; in the Password field enter **NEW**.
2. Click "OK".
3. The Logon screen requires you to enter a new password.
   - Passwords must be at least 6 characters.
   - Passwords are case sensitive.
   - Password cannot be "NEW"
4. After successfully creating a password, Administrators are encouraged to create **Users**.

**I Lost My Password!**
If a User forgets their password the Administrator may reset it.

1. At the **menu bar** select File > Security & Administration.
2. At the Administration screen click “Security Groups” and "Add/Update individual Users”.
3. At the Browse & Update the List of Users screen select the User whose password needs to be reset and click "Change".
4. At the Changing a User screen click the "Reset" button. The password is automatically reset to "NEW". The next time the User logs into 1099 Pro they are required to change the password.

☐ If the Administrator forgets their password they must contact Technical Support. The purchaser of 1099 Pro must send a request on company letterhead stating that the Administrator password is lost and an unlock code is required. Upon receipt of this request, Technical Support will provide an unlock code good for that day only.

10.1.8 Security Reports

Security Reports

1099 Pro offers numerous reports to track Users, User Profiles, and Access Groups. These security reports are available only to administrators or users with administrative rights.

To generate security reports

1. At the menu bar select File > Security and Administration.

2. At the Administration screen click the "View/Print Security Reports" button. Available reports include:
   - Print Users by Name: Lists all users sorted by User ID.
   - Users and Attached Profiles: Lists all access users and all of the User Profiles they are associated with.
   - Profiles and Associated Access Groups: Lists User Profiles and the Access Groups, Filers and Departments they are associated with.
   - Access Group Detail: Lists Access Groups and all of the permissions assigned to them.
   - Detailed Security Report: Summarizes the User Profiles and Access Groups selected Users are assigned to.
   - Security Log: Generates a report based on the security audit trail.

3. All reports offer a print preview option.

10.1.9 Security Access Log

Security Access Log

The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all log-on attempts.

Browse & Manage the Security Access Log

1099 Pro includes predefined queries for sorting access log records including:
- All Records: Default selection that displays all records.
- Access for One Date: Select this query and then enter the date for which you want to show logs.
- Access for One User: Select this query and then click "Select User to Show" to pick a user, or click "Show Records with No Users" for any records with an unknown user.
Export Log-on Records to an Excel spreadsheet:
The Security Access Log tracks all attempts to open 1099 Pro. This log can be exported for review in an Excel document:

1. At the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. Click on "Export to XML" located near the bottom left.
4. Select your destination folder and click "OK"

Purge Log-on Records
The Security Access Log tracks all attempts to open 1099 Pro. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. When purging records ONLY successful log-on's are deleted. To purge records:

1. At the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. At the Browse & Manage the Security Access Log screen click the "Purge Log-on Records" button.
4. The Purge Audit History screen allows the user to indicate the date PRIOR to which log-on records are purged. Modify this date as necessary.
5. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.
   - All purge attempts are permanently recorded in the log.

10.2 Data Maintenance
10.2.1 Backup Data

Backup Data

8966 Pro backups can automatically copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. It is smart to backup your data on a regular basis. If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense!

See Restore Data (via a backup file)

To Modify Backup
1. At the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their software Administrator.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.

3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
Uncheck the box to disable backup prompts (not recommended).

To Backup Data
Access the Backup Wizard as prompted automatically by 8966 Pro (see Modify Backup above). The Backup Wizard application, **Backup17.exe**, can also be accessed directly through File Explorer. In a standard installation it is located at C:\1099 Pro\Pro66T17\Data Backups. **All users must exit the software prior to running the backup.**

1. At the Backup Wizard screen click "Next" to proceed.

2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file or use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name. Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. **Backup twice to the same file name and the existing backup file will be overwritten!**

3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.

4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at [www.winzip.com](http://www.winzip.com).

10.2.2 Restore Data

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. **Restoring a data file means losing ALL changes made since the last backup.** See **Backup Wizard**.

No backup file? If you used the Service Bureau to process your forms, we may be able to recover your data files for a fee. Contact the **Service Bureau** for more information.

To Restore Data

1. Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the [1099 Pro Wiki](http://www.1099pro.com). Download the appropriate Tax Year and Version. Consult Technical Support with questions.

2. Locate your .ZIP backup file (e.g., "1099 Pro Backup 9-AUG-2017 9-38AM.ZIP") which in a standard installation is located in the Data Backups folder (i.e., C:\1099 Pro\Pro66T17\Data Backups).

3. Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file—.TPS (data) files—to your Data folder (i.e., C:\1099 Pro\Pro66T17\Data).
   - Learn more about **WinZip**.

4. Open your software and run a **Form Counts by Filer** report to verify accuracy of restored data.
5. After successfully restoring your data, update your software to its most recent version.

10.3 Rules and Options

10.3.1 1099 Module Preferences

1099 Module Preferences

The features contained within this section are available exclusively to users of the Corporate Suite edition.

☐ 8966 Pro users see Preferences.

Corporate Suite preference items allow the customization of the software. Any user with access to Security and Administration may modify preferences. Changes made at the 1099 Module Preferences screen are universal to the program; not specific to the user. Administrators may opt to restrict user access to this area by setting permissions within Access Groups.

1099 Module Preferences Tabs

- **Global**: Includes options to capitalize recipient names and/or addresses, backup data, set date ranges, current tax year form options, deleted tax form options and other special features.
- **Local**: Includes recipient city options and local options specific to each user workstation.
- **Updates**: Includes settings for software updates.
- **Limits**: Includes accounting date cutoff, open window cutoff date and earliest tax year to select in software.
- **Update Options**: Includes ASP only settings, Form 1099-LTC Box 5 options, processing restrictions and Transmitter/Submitter information protection.
- **Rcp Options**: Includes options to select recipients, force recipients as 'new', bypass recipient compare and cascade processes and error level checking.

10.3.1.1 Global

See Global Administrative Options

10.3.1.2 Local

Local Tab

Recipient Address ZIP Code/City Options

- **Convert City to UPPER case during manual entry ZIP lookups**: Selecting this check box causes the program to automatically convert the City to all uppercase characters when using the software's built-in zip code to city matching utility.

- **Always convert Recipient City to UPPER case during printing**: Selecting this checkbox causes the City name to always print in all uppercase characters, regardless of what is displayed at the Work With My Tax Forms screen.

Local Options

- Automatically reselect the last Filer at program start: (Default On) Turning on this option will automatically start the user viewing the filer information that they were viewing when they exited the
software.

1. Show a reminder when using 'Add Recipient": Turning on this option will enable a warning that states:

"Tip: In order to reduce typing and save time, recipients are normally added to 1099 Pro as part of the process of creating their 1099 forms. You do NOT need to add a recipient here before creating a tax form for them. Do you still want to add a new recipient/employee right now?"

2. Whenever you add a recipient in the "Recipient" section. Note: You will also be given the option to disable this message, at the time this message is displayed.

3. Show a reminder that First Name is discarded for EIN/Company: Note: These options can be set/changed by the user on each workstation. Your choices here will provide the default.

10.3.1.3 Limits

Limits Tab

This area will allow you to set the accounting day limit entries on records, so if you enter a specific date in these areas, users will receive a warning that they cannot save the record because it goes beyond that date.

There are two different areas where dates may be entered, the Transaction/Accounting Date Cutoff, and the Open Window Cutoff Date (WEB/ASP data entry only) which is extremely useful because representatives that are only allowed to interface with the program using the internet browser, can have different limits for record creation, allowing for a method of administration. Note: If the "Accounting Date Cutoff Date" or "Open Window Cutoff Date" are left blank, the accounting date will not be enforced, and no warning will be issued, regardless of the accounting date entered at the time of the records entry.

10.3.1.4 Update Options

Update Options

Change Recipient Address on Filed Forms (ASP Only)

- **Create correction**: Choosing this option will allow users to allow representatives using the ASP interface to adjust the address on accounts after the form has been saved, and then filed.
- **Update Address for Filed Forms without creating correction**: Choosing this option will allow representatives using the ASP interface to alter a records recipient information, that has been filed, without creating a correction.

Refile Forms already filed to a State:

- **Forms can not be re-filed to a state**: When a eFile has been generated for the State, it will not be sent to the State via the CFS (Combined Federal & State filing program) if that option is selected in the Federal eFile creation.
- **Enable option to file form already filed to a State**: If a record has been submitted using the State Subset eFile creation utility it will not then be submitted to the State again if the CFS (Combined Federal & State filing program) is checked during the Federal eFile file creation process.
Change of Status from Quick Print (ASP Only)
- Disallow status changes from Quick Print: Regardless of what copies are printed using the quick print tool, the status of the form will not change.
- Allow Quick Print status changes, option will not be checked:
- Allow Quick Print status changes, option will be checked:

Restrict Creation of Filed Wrong Form Corrections:
- No Restrictions: Anyone who has access to create corrections will have the ability to choose the filed wrong form option when a record will have its information manipulated.
- Restrict for ASP only: Representatives that use the ASP interface will not be able to choose the option "Filed Wrong Form" when manipulating a filed Record.
- Restrict for ASP and CS: Users in general will not have the option to choose the "Filed Wrong Form" option when choosing to alter a filed form.
- Restrict Form 1099-LTC Box 5: This area will give you the option of what information is displayed when a 1099-LTC is printed out. Note: Box 5 indicates a Chronically Ill or Terminally Ill status.
- Use Box 5 information for printing/filing: Information entered in box 5 of the 1099-LTC will be printed for all copies and included in electronic filing.
- Suppress Box 5 for printing and filing: This option suppresses printing or reporting via electronic filing information entered in box 5 of the 1099-LTC

Options for allowing "Processing Restrictions" to be used with Tax Forms. 
Note: These restrictive actions are allowed by default. Enabling them to disallow use.
- Restrict "Do Not Print" option: Checking this box will disable a representatives ability to check the "Do not print" box in the ASP interface and Corporate Suite software.
- Restrict "Do Not File" option: Checking this box will disable a representatives ability to check the "Do Not File" box in the ASP interface and Corporate Suite software.
- Restrict "Do Not Merge" option: Checking this box will disable a representatives ability to check the "Do Not Merge" box in the ASP interface and Corporate Suite software.
- Restrict "User Hold" option: Checking this box will disable a representatives ability to click the "Hold" button on a form in the ASP interface and Corporate Suite software.

Specify the max number of records that will be return by Search engine in ASP: In this area you can determine how man records will be returned when a search is initiated using the "Form lookup" utility within the ASP interface, limiting this number can significantly reduce the amount of time that is used to search the database when a search criteria that is vague is used. Note: If no number is set, it will default to returning 100 records.

10.3.1.5 RCP Options

RCP (Recipient) Options

The features contained within this section are available exclusively to users of the Corporate Suite edition.

This area will allow you what rules apply to recipient information as it is entered into the system.
manually, or if it is imported into the software via the import utility.

**Recipient Select options:**
The following list applies only if you have an existing list of recipients within the software.

- **Select from Recipient list:** (Default) Choosing this option will allow people who are manually entering a record to pull information from the recipient list into the form.

- **Select Recipients from forms (ASP Only):** Choosing this option will only allow people using the ASP interface to pull information from the recipients list when manually entering a record.

- **Select Recipients from Forms (Corporate Suite and ASP only):** Choosing this option will not allow people using the Corporate Suite software, or ASP interface to pull information from the already existing recipients database.

**Force Recipients as New**

- **Do not force Recipients as new:** Choosing this option will cause the software to ask the user who is entering recipient information if they would like to update users and forms already in the recipient database. *The above option applies on both manual entry and import.*

- **All Recipients on import or manual entry are forces as new/unique:** Choosing this option will create a new entry in the recipient database for every recipients information entered into the software. *The above option applies on both manual entry and import.*

- **Disable Recipient List:** Choosing this option will disable the storing of recipients information altogether, and information will not be available to users manually entering forms, or importing them into the software.

*The following applies to the 1099 Pro Corporate Suite/ASP interface only.*

If you have the recipients list disabled during an import, the records that were imported will not be combined with future transactional imports. This is because there is no record kept of the transaction being linked to a specific recipient when the “Recipient list” has been disabled.)

**Bypass Recipient Compare process**

- **Compare Tax Form date to Recipient record on entry and offer updates:** When importing or manually entering recipient information, the software will prompt if this is newer information than the information currently stored in the recipient database.

- **Bypass Recipient Compare process for ASP only:** When manually entering recipient information into the Corporate Suite software, the software will prompt if this is newer information than the information currently stored in the recipient database.

- **Bypass Recipient Compare process for ASP and CS:** You will not be prompted when entering recipient information if this is newer information than the information stored in the recipient database in either the Corporate Suite software or the ASP interface.

**Bypass Recipient cascade process**
Recipient Cascade process depends on Recipient Compare settings. If Bypass Recipient Compare is turned on then no cascades can take place regardless of the setting for Bypass Recipient Cascade.

- **Allow cascade**: (Default) This option will allow changed in recipient information to take place across multiple filer, and different take forms, so that if there are multiple form types for one filer, you will not have to adjust them all. This does not effect forms that have a status other than "Pending".

- **Restrict to current Filer only**: This option will allow changes in a recipients information to adjust multiple form types at the same time, but will not allow adjustments across multiple Filers.

- **Disable Cascade**: This will disable the ability for adjusted recipient information to be spread across multiple form types, and filers, all together.

**Error Level if missing Address Line 1 and 2**

- **No Error**: (Default) Turning on this option will disable the warning message if there is a missing Address line 1 or 2 for recipient information entered manually or via import.

- **Warning**: Turning on this option will give a warning message with a status of "Warning" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The error message of warning will not prevent the tax form from being save, or from being brought into the software without prompt.

- **Error**: Turning on this option will give a warning message with the status of "Error" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The error status of "Error" is more severe than the status of warning, but is still capable of being brought into the software.

- **Reject**: Turning on this option will give a warning message with the status of "Reject" when entering recipient information that is missing a Address line 1 or 2 for recipient information either manually or via import. The warning status of "Reject" is the most severe message, and records with the status of reject will not be allowed to be saved in the system.

**Error Level if for SWT (State Withholding Tax) for non-taxing states**

This is the error warning that a user will see if they enter information for State Withholding Tax for a non-taxing state, this will be via the Corporate Suite software or the ASP interface, weather entered manually or imported into the software.

- **No Error**: (Default) Choosing this option will not attribute an error message to forms that are entered with State Withholding Tax on non-taxing States.

- **Warning**: Choosing this option will attribute an error message of "Warning" to forms that are entered with State Withholding Tax on non-taxing States. The error message of warning will not prevent the tax form from being save, or from being brought into the software without prompt.

- **Error**: Choosing this option will attribute an error message of "Error" to forms that are entered with State Withholding Tax on non-taxing States. The warning status of "Error" is more severe than the status of warning, but is still capable of being brought into the software.

- **Reject**: Choosing this option will attribute an error message of "Reject" to forms that are entered with
State Withholding Tax on non-taxing States. The warning status of "Reject" is the most severe message, and records with the status of reject will not be allowed to be saved in the system.

10.3.2 Preferences

Preferences

Preference items allow the customization of 8966 Pro software. Any user with access to Security and Administration may modify preferences. Changes made at the Preferences screen are universal to the program; not specific to the user. In multi-user environments, Administrators may opt to restrict user access to this area by setting permissions within Access Groups.

To Modify Preferences

1. At the menu bar select File > Security and Administration.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.
   - Corporate Suite Users: At the Global Administrative Options screen click the "Rules & Options" button and under Business Rules and Options click the form specific "Preferences / Options" button.

3. At the Preferences screen, tabs include; General, General (More) and Checking for Updates. Many items are checked "on" by default with the intention to help safeguard user data. Functions may be set "off" or "on" at the user's discretion by inserting or removing a check in the corresponding box.
   - Corporate Suite Users: Preferences screen tabs include; Global, Local, Updates Checking, Limits, Update Options and Recipient Option. The below listed Preference Options are included in Corporate Suite and many more as well. For information on these options please consult your Corporate Suite Account Manager.

4. Changes take place after clicking "OK" and then exiting and re-opening the software.

Preferences Options

Overall Options

Auto capitalize names, addresses and localities during manual entry.

Backing Up Data Files

Remind me to backup every X days. Users are strongly encouraged to backup data on a regular basis. To backup once per day enter "1", every two days enter "2", etc. Set to zero to backup every time the program is exited.

Global Date Range Checking*

Warn if dates entered on forms are outside of this range. Set dates are within the respective tax year. Dates may be modified by clicking the ellipses buttons.

- Date is before 1/01/2017 (default entry)
- Date is after 12/31/2017 (default entry)
* This feature is not available in 1042-S Pro.

Options for Manually DELETED Tax Forms

- Allow previously deleted tax forms to be visible at the Work With My Tax Form screen.
- Allow users to undelete previously deleted tax forms. *Available in Corporate Suite only.*

**Other Global Options**
- Suppress/turn off the Report Wizard ‘Custom Reports’ option on Browses.
- Suppress/hide all TINCheck functions and capabilities.

**Recipient Address ZIP Code/City Options**
- Convert City to UPPER case during manual entry ZIP lookups
- Always convert Recipient City to UPPER case during printing

**Other Options**
- Automatically reselect the last Filer at program start
- Show a reminder when using "Add Recipient"

**Task Menu Display**
- Suppress the "Control Total Reports" option
- Suppress the "Recipients List" option

**Checking for Updates**
- Ask for confirmation every time before checking for updates. Only uncheck this box if your Internet connection is always on. When an update is available, users are always prompted prior to download/installation, regardless of the status of this box.
- How often should program check for updates:
  - Automatic Adjustment (recommended) - The program will check for updates occasionally during summer, more frequently as tax season approaches and every day at the height of tax season.
  - Specified Interval (1 - 45 days) Throughout the Year - Checks will occur at the interval specified here.
  - Manual Checking Only
  - See [Software Updates](#)

### 10.3.3 Custom Tax Form Validation Rules

**Custom Tax Form Validation Rules**

1099 Pro E/SQL software allows you to create and manage tax form validation rules. These rules are used for detecting errors and/or warnings on tax forms. Items such as invalid TINs, invalid zip codes, and the rules that govern how boxes should be filled out. The software does come with a basic set of rules built-in, but this new feature will allow you to create your own validation rules at any time.

1. To view, change or delete tax for validation rules, click on "File" from the top menu and then select "Security and Administration".
2. At the Global Administrative Options window, click on the "Business Rules" button on the left pane.
3. Now click on the "Tax Form Validation for Import and Entry" button.
4. The Manage business Rules/Validation screen summarizes the rules for a particular form and indicates if the rule is active, where the rule is active and the severity.

5. The "DT.Imp/Web" column determines where the validation rule is applied. "DT" applies the rules to a manual data entry, "Imp" to imports and "Web" refers to users on the web/internet module. There are also three levels of error message severity. "W" is a warning, which is a non fatal problem with your form. "E" is an error which may be a fatal problem with the form and "R" is a reject which will not allow the form to be saved or imported at all. You can also define "OK" which will allow the form to be saved without warning or you can use the "Default" option, which will use the systems default rules to evaluate the form.

6. To deactivate a rule that you may want to reactivate later or customize a rule, see Business Rules/
10.4 Reporting Thresholds

10.4.1 State Reporting Thresholds

Reporting Thresholds and Options

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Corporate Suite includes the ability to manage the built-in state reporting limits/thresholds that are applied when generating a State Subset eFile. Thresholds are used to determine which amounts should or should not be reported. Typically these thresholds are set by each individual state and may vary.

See State Reporting Thresholds & Rules

Configuring Reporting Thresholds

To configure State Reporting Thresholds please use the following steps:

1. From the menu bar select File > Security and Administration.
2. At the Global Administrative Options window click the "Reporting Thresholds" button.
3. From the Reporting Thresholds and Options window, click on the Manage State CFS Limits and Settings button.

4. At the View/Manage CFS Filing Thresholds window a list of all the current state thresholds for all states is displayed. Available options include:
   - **Select State**: Select All States or an individual state to view associated thresholds.
   - **Select Year**: Select All Tax Years or a specific year to view associated thresholds.
   - **Select Form**: Select All Form Types or an individual form to view associated thresholds.
Customizing a Standard Rule
To customize a built-in state threshold rule follow these steps:
1. Select the threshold rule to customize from the View/Manage CFS Filing Thresholds window by highlighting it. Click the "Customize Rule" button.
2. At the Record Will Be Added window options include:
   • Active: When this box is checked, the rule is enabled (active), when it is unchecked the rule will be disabled.
   • Form Type: The Form Type the rule is associated with.
   • Rule Year: The Tax Year to which the rule applies.
   • Rule Type: Defines the kind of rule that is being edited (i.e., Standard, Standard (Custom) etc.).
   • State: The state that the rule is associated with.
   • State Rule: This box contains the actual rules used when the thresholds are evaluated.
3. If customizing a built-in rule the Form Type, Rule Year, Rule Type and State boxes are grayed out; users can only make the rule "Active" or "Inactive" and/or customize the "State Rule" field.

Editing the "State Rule" box
There are two ways to edit the contents of the "State Rule" box.
1. Manual Keying in of rules: Users familiar with the names of the fields and mathematical symbols used to evaluate the rules can modify any existing rules or enter new rules at anytime.
2. Right Clicking in the "State Rule" box: Users new to customizing threshold rules should use this method.
Upon right-clicking in the “State Rule” box a menu appears with two options:

- Select Form Fields: Click on this option to choose which amount field(s) to evaluate (e.g., Box Amount 1, Box Amount 2, etc.)

- Select Operator: Click on this option for a list of all available operators that can be used to evaluate your rules.
10.4.2 State Reporting - Manage State CFS Limits and Settings (CS Only)

State Reporting - Manage State CFS Limits and Settings (CS Only)

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See Security & Administration, Reporting Thresholds, Manage State CFS Limits & Settings, 1099-R, state of AL to follow this example.

- If your Filer has the CFS checkbox checked then your form will be filed in CFS if all the following requirements are met:
  - The state participates in the CFS Program,
  - The form type is included in the CFS Program
  - The records meets the State Thresholds (discussed below)
  - There is not a CFS Exception rule that excludes the related records from being included in the CFS file.

State Threshold Rule Types:

- Standard Rules - Records meeting the criteria in these rules will be filed with the state - either directly or via the CFS program.
- Standard (Custom) - These rules override Standard Rules and can be created/edited by the user. Both Standard & Standard (Custom) rules can be active and the Standard (Custom) rule will trump the standard.

○ Select an operator by highlighting it and clicking the "Select High-Lighted Value" button.
- CFS Exceptions - Records meeting the criteria in these rules will be excluded from the CFS program filing even though the state & form type participate in the CFS program. This is done to accommodate state reporting thresholds for instances when states require direct filing.

NOTE: Users can inactivate rules they do not want.

See Reporting Thresholds

10.5 SUTA Information (CS Version only)

10.5.1 Browse Region Code/SUTA State Table

Browse Region Code/SUTA State Table

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Use Region Codes to link a business entity with a specific SUTA (State Unemployment Tax Act) state. In an import, Region Codes may be used to assign a recipient to a particular state for SUTA purposes when they differ from their residence or tax state. Region Codes must be unique.

Browse Region Code/SUTA State Table
1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click the Rules & Options button.
3. Under Form Specific Rules and Settings click the "W-2 Region Code & SUTA State Table" button.
4. At the Browse the Region Code/SUTA State Table screen use the "Add" or "Change" button to access the Region Code Update & Maintenance screen.
   - See Region Code Update & Maintenance screen
5. Region Codes are accessible on Form W-2 in the Region Code field via the <F2> key or by double-clicking your mouse.

See Adjust SUTA and Secondary State Limits for information on editing state specific values and secondary calculations.

10.5.2 Edit Region Code/SUTA State - CS

Region Code Update & Maintenance

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See Adjust SUTA and Secondary State Limits

Region Update & Maintenance
Region/Area codes are identifiers used to link a business entity with a specific State Unemployment Tax (SUTA) state. Region Codes are accessible on Form W-2 in the Region Code field via the <F2> key or by double-clicking your mouse.
To Edit Region Codes
1. From the Browse the Region Code/SUTA State Table screen use the "Add" or "Change" button to access the Region Code Update & Maintenance screen.
2. At the Region Code Update & Maintenance screen enter a unique Region Code to link a business entity with a SUTA state.
3. Enter the business entity’s Name and Address information.
4. Click "OK" to save entry. Changes made at this screen flow through to associated Form W-2 records with a Pending print status.

10.6 Create and Manage Custom Codes (CS Version only)

Create and Manage Custom Codes

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

All tax forms now contain a 'Custom Code 1' and 'Custom Code 2'. These fields can be imported and exporting containing a code of up to 5 characters. When printing certain PS/ACL layouts this code translates to a string of up to 120 characters for recipient/combined printouts only. The message that is printed can be assigned a custom font and size.

10.6.1 Update or Change Custom Code

Update or Change Custom Code

This screen is used to modify custom codes that are when printing certain PS/ACL layouts this code translates to a string of up to 120 characters for recipient/combined printouts only. The message that is printed can be assigned a custom font and size.
10.7 Installing

Install Software

To download any 1099 Pro software product please visit: http://host.1099pro.com. All software installations are two-step, requiring both the Full Install and the Update.

☐ See Multi-User/Network Installations

To Install Single-User* or Demo
1. Insert the CD-ROM into your computer's CD-ROM drive.
2. On your Windows desktop click the “Start” button and select “Run”.
3. In the Open field, type x:\setup.exe, where x is the name of the CD-ROM drive and setup.exe is the name of the 1099 Pro executable.
4. Click “OK” to start the setup program.
5. Follow the instructions provided by the setup program. If 1099 Pro prior year data is detected on your system the Roll Forward Utility activates.
Virus Checkers
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in 1099 Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.

10.8 Logging in as a Different User

Logging in as a Different User

If logged in with a user account in 1099 Pro, you may log off your existing user and log in as a different user without fully closing the software. Follow the steps below to log in as a different user. IMPORTANT!
You must first close all screens in 1099 Pro using the close button at the bottom right. "Logon as Different User" will only appear once you close all top level screens and you can see the following window in your 1099 Pro software.

Steps to change your current logon account.
1. Click on “File” on the toolbar at the top in 1099 Pro.
2. Select “Logon as Different User”
3. When you are prompted with the 1099 Pro logon screen, type in your User ID and then your password.
4. Click "OK".

Finally verify your login has changed by checking the user currently logged in in the bottom right corner.
10.9 Optional Field Filters

**Optional Field Filters**

*The following features are available exclusively to users of the Corporate Suite edition of our software.*

**Optional Fields**
- Optional Grouping/Filtering Fields
- Source
- Batch ID
- Category
- Alternate Acct/Info - Specific to 1099-INT

**Codes & Flags**
- Special Print Codes
- Select for Print/Export
- Custom Codes
- Processing Restrictions

**Print/Export Checkbox**
The print/export checkbox is an additional filter when exporting or creating custom queries. This checkbox allows users to tag (or select) individual records for a future print/export process without having to print each record individually. This allows companies the ability to consolidate print runs, standardize print processes, and to automate print processes through integration with the 1099 Pro Scheduler. See Print/Export Checkbox.

10.10 1099-MISC Optional Fields

**MISC Optional Fields**

Form 1099-MISC provides optional fields for custom recipient reporting.

- See data entry specific [Optional Field Filters](#) (as highlighted in green in the below image).

**Optional Text Line 1/Line 2 Fields**
These fields allow users to enter a maximum of 30 alpha-numeric characters per line. This data prints on Combined Recipient copies only; it is not provided to the IRS. Users may import data to these fields or directly enter it at the 1099-MISC data entry screen. This field is available to users of both 1099 Pro and Corporate Suite software.
The following options are available exclusively to users of the Corporate Suite edition.

Optional Amount Box
1. On the Corporate Suite menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click the "User Fields and Email" button.
3. Under Optional Fields, select the "Allow use of 1099-MISC extra amount box" checkbox.
4. Enter a title for the box and click the "Apply Now" button to save changes and close the screen.
   - The amount box and custom title display on the 1099-MISC data entry screen to the right of the Account Number field (see example, "MISC Optional Box" in below image).
   - The optional amount box and title print only on the Combined Recipient Copies; this information is not reported to the IRS.
5. Users may need to exit and re-enter CS for changes to take effect at the 1099-MISC data entry screen.

Oil & Gas Amount Fields
1. On the Corporate Suite menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click the "User Fields and Email" button.
3. Under Optional Fields, click the "Manage 1099-MISC Oil & Gas Fields" button.
4. At the Update Custom Fields screen users may select the "Activate Optional Oil & Gas Amount" checkbox for a maximum of three fields.
   - Enter a Custom Name to display on reports (required).
   - Use the Update Form Prompt field to enter an optional field description to display at the 1099-MISC data entry screen (see example, "OIL & GAS 1" in below image).
   - The oil & gas amount boxes and titles print only on the Combined Recipient Copies; this information is not reported to the IRS.
5. Click the "Save" button to save changes and close the screen.
6. Users may need to close and restart CS for changes to take effect at the 1099-MISC data entry screen.
10.11 Set Aggregation Rules (CS Version only)

Setting Aggregation Rules

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

See Aggregation

Aggregation allows users to group similar records of the same PCode (PTIN) and Form Type together into one record.

To Turn On Aggregation
1. On the menu bar select File > Security & Administration.
2. At the Global Administrative Options screen select the "Combining Tax Form" button.
3. At the Aggregation/Roll-Up Options screen select the "Turn ON Aggregation" button.

To Turn Off Aggregation
1. To remove existing aggregation from a tax form uncheck the Enable Aggregation box.
2. When finished, click "Save/Apply Changes" to save your changes.
   - All forms currently aggregated will be de-aggregated and listed as individual tax forms again.
   - Users may not turn off aggregation if any forms associated with the process have a protected status (e.g., Filed, etc.)
Select the tax form to aggregate on.
1. Select the tax form to enable Global Aggregation for and click the "Set/Change Matching Criteria button". First time users must set aggregation rules which determine current rules for combining tax forms in a particular order. Tax forms which match all of the selected criteria for the Filer will be combined into a single aggregate form.

Set Aggregation Rules
1. The list of available fields are TIN, Account Number, Tax State, Category, Form Source & Department.
2. From the list of Available Fields for Aggregation window on the left, click to highlight the field, then drag the field over to the left side window entitled, "Selected Fields for Aggregation".
3. To adjust the order of the fields, use the up and down arrow keys. When finished, click "OK" and "Save" to apply your changes.
4. The software aggregates the forms according to these rules.

Exceptions for Individual Filers
Aggregation can also be set for filers individually as an exception.
1. Click "Add" to add an aggregation exception for a filer. Select the filer from the list and then click "Select".
2. The list of available fields are TIN, Account Number, Tax State, Category, Form Source & Department.
3. From the list of "Available Fields for Aggregation" window on the left, click to highlight the field, then drag the field over to the left side window entitled, "Selected Fields for Aggregation".
4. To adjust the order of the fields, use the up and down arrow keys. When finished, click "OK" and "Save" to apply your changes.
5. The software aggregates (by/on) the chosen fields for this filer for the specified form type.

10.12 Un-Installing

Uninstall Routines

The Select Uninstall Method screen offers two options for removing 8966 Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine.

Uninstall Software (Custom)
1. Close all applications including 8966 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "8966 Pro 2017" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Custom" and then click the "Next" button to start the uninstall program.
6. Files are categorized for deletion. Users may "Select All" (recommended), "Select None" or use their mouse to select specific files. Categories include:
   - System Files
   - Directories
7. After selecting appropriate files click "Finish" to complete the uninstall.

Uninstall Software (Automatic)
The Automatic uninstall process retains your current data files under the main program directory in the folder named "Data", preserves the "Uploads" folder containing any uploads generated by the 1099 software for submission to the Service Bureau, and miscellaneous .DLL files are left in the Program root directory used by the software. In addition the .INI file is also preserved in the\Admin or \Windows directory.

1. Close all applications including 8966 Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "8966 Pro" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Automatic" and then click the "Next" button to start the uninstall program.
6. 1099 Pro prompts you through the remainder of the uninstall routine.

NOTE: Users who uninstall 8966 Pro and then reinstall it may get an "Invalid Record Declaration (47) Accessing TAXDATA.TPS [or FILERS.TPS]. Press OK to end this application" warning. This error occurs because some files were not deleted during the automatic uninstall. Users must perform a custom uninstall of 8966 Pro (and select all files for deletion) and then reinstall the software.

11 Audit Trails

Audit Trails Overview

Audit Trails DO NOT track the history of manual and cascading changes to a tax form including old and new values, date changed and the user responsible for changes. NOTE: If Audit Trail Records don't reflect a known change; Audit Trails are (or were) disabled.

Master Audit Trail Browser
The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the Record History screen allows the viewing of individual tax forms only).
See Master Audit Trail Browser.

About Record History
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected.
See Record History for more information

Purging Audit Trail Logs
The Audit Trail Record Log is invaluable should you need to track tax forms changes. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system. See Purging Audit Trail Logs for more information.

Enabling/Disabling Audit Trails
Disable Audit Trails only if speed/performance is critical to the user. By disabling this feature tax form changes are not tracked AND the Record History screen is automatically disabled. See Enabling/Disabling Audit Trails

11.1 Audit Trails Activity Report

Audit Trails Activity Report

This tutorial will guide you through the process of printing a report of all audit trail activity related to one or more areas in your 1099 Pro software.

1. The Audit Trail Activity Report is available by launching the software.
2. Click on “File” from the main menu.
3. Click on “Security and Administration”.
4. Click on the “Audit Trails & Logging” button.
5. Click the “View/Print Audit Changes Report” button.
6. Select the options you would like to have included in your Audit Trail Activity Report and then click the “OK” button.
7. You will now be brought to a screen that will ask, “Do you wish to PREVIEW this Report?”
   a. Click the “Yes” button to access the preview options
   b. Click the “No” button to send the Audit Trail Activity Report to the printer without previewing.
   c. Click the “Cancel” button to continue without generating the Audit Trail Activity Report.

Note: Once the report prints out, use the following legend to determine what changes have been made to the records and filers on the report.

Definitions of the items on the “Audit Trail Activity Report” are as follows:

T = TIN (Tax ID Number)
N = Recipient Name
R = Recipient Name
A = Account (#)

Old values are on the left
New values are on the right

Subtype: Audit report tool doesn't know what was done with the record.
TransType: Audit report tool doesn't know what was changed on any transactions.
11.2 Deleted Record Detail

**Deleted Record Detail**

From the Master Audit Trail Browser, click the "Deleted Record Details" button to display the contents of a deleted tax record. *NOTE: The Master Audit Trail Browser will not reflect records that were deleted while Audit Trails were disabled.*

See [Master Audit Trail Browser](#)

11.3 Master Audit Trail Browser

**Master Audit Trail Browser**

The Master Audit Trail Browser is available only to administrators or users with administrative access rights. Use it to view all manual and cascading changes to all tax forms (the [Record History](#) screen allows the viewing of individual tax forms only).

**To View Records**

1. On the [menu bar](#) select File > Security and Administration.
2. At the Administration screen click "Audit Trails & Logging", "View Audit Trail Records".
3. At the Master Audit Trail Browser screen refer to the Date, Time, User ID, Field Name, Old Value and New Value columns for invaluable information.

11.4 Purge

**Purge Audit Trail Log Records**

The Audit Trail Record Log is an invaluable tool for tracking tax forms changes. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.

**To purge audit trail log**

1. On the [menu bar](#) select File > Security and Administration.
2. At the Administration screen click "Purge Audit Trail Records".
3. At the Purge Tax Data Audit Trail Record screen all records prior to the selected date are deleted. Modify this date as necessary.
4. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort.

11.5 Record History

**Record History**

The Record History screen displays audit trail information for the selected tax form and is available to all [Access Groups](#). A limited version of the [Master Audit Trail Browser](#), this screen tracks all manual changes made directly to a record. Cascading updates are not reflected. *NOTE: If Record History does not reflect a known change to a tax form, Audit Trails are, or were, disabled.*
11.6 Turn Audit Trails On/Off

To turn audit trails On/Off
1. On the menu bar click "File" and "Security and Administration".
2. The Administration screen indicates if Audit Trails are on or off.
   - Click "Activate Audit Trails" to turn on functionality.
   - Click "Turn OFF Audit Trails" to turn off functionality.

To view record history
At the "Work with My Tax Forms" screen highlight a record and click "Change".
   - Records with a pending print status display the Changing a Record screen. Click the "Audit Trail" button located in the upper right corner of the screen.
   - Records with any other print status display the Protected Form Update screen. Click the "Field Update History" button.

11.7 Audit Trail Report Filters

Audit Trail Report Filters

1. In this section you may print or view a report showing an audit trail using that are narrowed down by filters.
2. To begin this process click on the "File" button on the menu bar.
3. Then Click on the "Security and Administration" button, this will bring you to the "Global Administrative Options" window.
4. From here, click on the "Audit Trails and Logging" button, here you will be taken to the "Tax Form Audit Trail and Action Logging Options" window.
5. From here click on the "View/Print Audit Changes Report" button, you will be given the "Specify Audit Trail Report Filters" screen. From here you can choose what options to use to filter down what information will go into the Audit Trail report.
   - **Limit Report to changes for one Form Type**
   - **All Forms**: Choosing this option will list all available form types on your report.
   - **One Form Type (select from list)**: This option will let you choose which forms will be used in the report from a list. You will be asked to TAG each form type you would like listed.
   - **Limit Report to changes for one PCode**
   - **All Filers**: Choosing this option will show all available PCodes on the report
   - **One Filer (Select from list)**: Choosing this option will allow you select which PCodes will be included on your report.
   - **Limit Report to changes from one User ID**
   - **All Users**: Choosing this option will show all available UserID's on your report.
- **One User - enter User ID**: Choosing this option will allow you to choose which UserID will be used to filter down your report. *(P3)*

- **Limit report to a Date Range**
  - **None - all dates will be shown**: 
    - **Today**: Choosing this option will show all changes made today.
    - **Last 7 days**: Choosing this option will show all changes made within the last 7 days.
    - **Last 14 days**: Choosing this option will show all changes made within the last 14 days.
    - **Last 30 days**: Choosing this option will show all changes made within the last 30 days.
  - **Specify Other Range**: Choosing this option will allow you to choose the date range that will be used to display your Audit Trail Report. *(P4)*

**Deleted Record Options**
- **All activity**: choosing this option will show you all deleted option.
- **Skip deleted**: If you choose this option deleted records will not be displayed on your report.
- **Only deleted**: Choosing this option will display only deleted records on your report.

6. Once you are done choosing the options you prefer, click on the "OK" button.
7. Now you will be given the option PREVIEW your report before it is printed. Click "Yes" if you would like to view the report before it actually prints out. Click "NO" to have the report begin printing or click "Cancel" to change your options before you begin printing your report.
12 Browse Records

Work With My Tax Forms

To access the Work with My Tax Forms screen go to the Preparing My Forms task panel and select the "Work With My Tax Forms" link.

The Work With My Tax Forms screen allows users to view all forms which may be sorted in a designated order. From this screen users can Add, Change, Delete, Print, Total as well as perform Group Actions with their forms.

- **Current Sort/View Order** - Users may sort forms by Last Name/Company, TIN, Account or by creating a custom view. See Current Sort/View Order for further details. There are two ways to search for a form; one from the keyboard depending on your sort order and one by using your mouse.

- **Current Query/Filter** - By default all forms for the form type selected are displayed. Users can display a subset of the current form type by clicking on the "Current Query" drop down and use an alternate ready-made query, e.g. "Filed Corrections Only" or create their own custom query, e.g. "Tax State = CA, Corrected Forms Only", etc. Note that the "Status" of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported - one with a Pending status and the other a Printed status - you could limit the forms displayed by their respective status.

**Add a Record**
8966 Pro allows records to be added (either manually or via import) up to the user's current transaction limit. Transactions can range from 5,000 in a standard purchase up to an unlimited number of transactions.
See Adding a Record and Registration & Upgrades for more information.

**Change a Record**
Only records with a **Pending** status are available for modification.
Note: Cascading updates are changes made to a filer and/or recipient's information globally throughout all tax forms.
See Cascading Changes and Changing Records for more information.

**Delete a Record**
Only records with a **Pending** status are available for deletion. Delete records individually at this screen or in batch via Group Actions.
See Deleting Records and Group Actions for more information.

**Print/View Report**
This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).
See Print/View Reports
Group Actions Button
Group Actions allow users to tag (or select) a number of items and then perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of pending forms allows you to manually select any number of pending forms for removal. All associated notes for the forms are likewise deleted.
See Group Actions for more information.

Browse by Form Button
The new "Browse by Form" button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as if you were using the standard browse. For example, if you are viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when you switch to Browse by Form mode.
See Browsing by Form for further instructions.

Quick-Print Form Button
To quickly print any tax form, regardless of print status, highlight the form and click on "Quick-Print Form".
See Quick-Print for further instructions.

Email Tax Form Button
Use to e-mail tax forms to recipients. Requires a default mailing client for your computer.
See E-Mail Tax Forms for further instructions.

12.1 Browse IRS Instructions

Browse IRS Instructions

The following instructions are available within your local 8966 Pro installation via the task panel under Help & Extras > IRS Pubs & Links OR may be viewed online (with an active Internet connection) by selecting the appropriate link. Corporate Suite Users: At the menu bar select Forms > IRS/SSA PDF Instructions and Blank Forms.

8966 Instructions
Instructions for Form 8966
And many others

Miscellaneous Instructions*
Publication 3609 - Filing Information Returns Electronically
Form 4419 Application for Filing Information Returns Electronically/Magnetically
Form 592-B Resident and Nonresident Withholding Tax Statement
Form 8809 Request for Extension of Time to File Information Returns
Form SS-4 Application for Employer Identification Number
Form W-7 Application for IRS Individual Taxpayer Identification Number
Form W-8 Instructions for the Requester of Forms W-8BEN, W-8ECI, W-8EXP & W-8IMY
Form W-9 Request for Taxpayer Identification Number and Certification
Form W-9s Request for Student's or Borrower's Taxpayer Identification No. Certification
Puerto Rico Forms Informative Returns Electronic Filing Instructions (rev. 1/2016)

* Availability of forms and instructions is specific to software version installed.

**IRS Telephone Assistance: Information Reporting Customer Service Site**
For questions about reporting on Forms 1096, 1098, 1099, 5498, W-2, W-2G, and W-3 call toll-free (866) 455-7438 or (304) 263-8700 or E-mail mccirp@irs.gov. For TTY/TDD equipment, call 304-267-3367 (not toll free).

The hours of operation for the call site are Monday through Friday from 8:30 a.m. to 4:30 p.m., Eastern time.

**Other tax-related matters**
For other tax information related to business returns or accounts, call (800) 829-4933.

*Note: Users with an active internet connection can access many other files directly from the IRS/SSA websites. For details see Print Blank Forms & Instructions.*

### 12.2 Entry Forms

**Entry Forms**

Entry forms are used to add, edit or view tax form information for a recipient. Recipients or payees are defined as the individual or entity receiving the informational return. All 1099 Pro software products allow up to 5,000 recipient records (or "transactions") in a standard installation; additional transactions may be purchased.

**Browsing & Working with Entry Forms**

- **Navigating / Filling In Forms**
- **About Updates & Corrections**
- **Saving & Canceling Changes**
- **About Protected Forms**
- **View List of Changes to a Form**
- **Group Actions**
- **Using Lookups**

**Navigating Fields / Filling In Boxes**

Use the TAB key to move through fields on the tax form. To move backwards through fields use the SHIFT and TAB keys concurrently. To select/unselect a check box use the space bar and then TAB to the next field.

**Updates and Corrections**

Make necessary changes, additions or deletions to the form and click the "Save" button to exit and return to the Enter, Update & View screen. Any changed values or amounts turn blue to distinguish between original and corrected information.

- **TINs** - To change an SSN to an EIN or vice versa delete the entire number and then re-enter with appropriately placed hyphens.
If generating a correction, the IRS stipulates that the account number on the corrected form remain exactly as it was on the original form.

**Saving and Canceling**

Any changes made to a tax form may be saved immediately by clicking the "Save" button or abandoned via the "Cancel" button.

**What Is a Protected Form?**

A form with any status other than **Pending** is protected or locked to prevent any mismatch of data from the original record that has been mailed to a recipient and/or submitted to the IRS. This includes records with a status of Printed, Filed, SB Print+Mail, SB Filing, Filed 1096, etc. It is also possible that these forms were imported in a status other than pending in which case they would also be considered protected until they are Reset (VOIDED). Forms with a pending status may be changed or deleted.

**Use Lookups to Fill In Information**

8966 Pro allows users to select existing recipients from the Recipients Master List to add to or update a form. All recipient records are stored in a master database that is accessible on any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and hit the <F2> key or right-click your mouse. The Select a Recipient screen appears with ALL recipients for ALL filers available for selection. Lookups are also available via the <F2> key in the Account Number, State ID Number and various Income Code fields.

**Adding a group of forms**

Group Actions let you tag/select any number of recipients, and then loop through the list creating new forms for them. The program will automatically fill in the recipient information on each new form, so all you have to do is fill in the specific box information for the form. For additional flexibility, you are also given the option to add the forms in any of four sort orders: by name, by TIN, by State or by ZIP. The Group Actions button can be found on the main Enter, Update & View screen at the bottom of the screen.

1. Click the "Group Actions" button
2. Select the Add tab, then click the "proceed with this action" button.
3. On the next screen, begin by selecting (tagging) all of the recipients you want to add to blank forms.
4. Next Select the "Sort" order in how these form will be placed.
5. Finish by filling out all information for each form and clicking "save".

**Viewing the list of prior changes to a form**

1099 lets you view a list of prior changes to a form. Records with a pending status display the Changing a Record screen. In the upper right corner of the form is an audit trails button. Click the "audit trails button". This screen tracks all manual changes made directly to a record.

**TIN Validation**

This feature checks your recipients information against the lists below.
(Note: Please note that it is required that you have an account at TINCheck.com prior to using this feature.)

- **TIN Validation:** This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs).
- **(DMF) Death Master File:** The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud.
- **(SDN/OFAC) Specially Designated Nationals (SDN/PLC) Office of Foreign Assets Control (OFAC):** Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties.

### 12.2.1 1099 Aggregation Feature (CS Version only)

#### Tax Form Aggregation

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The Tax Form Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.

For example, John Smith owns an automobile detail business and frequently comes by the movie studio to wax and wash the studio automobiles. You, the Filer, issuing the 1099-MISC form, pay John frequently on a bi-weekly basis. Instead of printing and issuing multiple 1099 forms for John you prefer to provide him with a single, combined form at year's end. This feature allows you, the Filer, to view/print the aggregated box amount totals in the tax form which is a reflection of all tax form dollar amounts for this recipient under this master tax form only.

#### How Aggregation Works

Users first set aggregation rules for the specific tax form type. Then when performing a transactional import data is automatically aggregated - based on the user's specified rules (e.g. by TIN, Name, etc.) - during each successive import. Users may view an individual record's aggregated amounts at the Changing a Form Record screen via the "Transactions" button.

The initial tax form may be manually entered and subsequent associated transactional imports are aggregated to it. However, future manually entered tax forms for the same recipient and form type are not aggregated as they are not linked to the original master tax form. **Tax forms must be imported via a Transactional Import for aggregation to occur.**

- See [Setting Aggregation Rules](#)
- See [Transactional Imports](#)
- See [Name/Address Reconcile by TIN Tool](#)

### 12.2.1.1 Viewing Transactions (CS Version only)

#### Viewing Transactions
The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

To show the Aggregated Dollar Amounts list:
1. First, open a tax form a for recipient that contains more than one dollar amount for 1 tax form type.
2. Click the "Transactions" button on the right side of the tax form.
3. Click the "View" button to see a detail of the transaction.

12.2.1.1.1 Updating Transactions (CS Version only)

**Updating Transactions** *(This feature is only available in the Corporate Suite version of the 1099 Pro Software)*

This screen will allow you to edit transaction's that were previously entered. **Currently disabled!**
12.3 Browsing by Form

Browsing By Form

The Work With My Tax Forms screen now offer the ability to browse all tax forms (of the same form type, same filer) using the update form. This allows the user to quickly move from form-to-form and view data.

To Browse By Form
1. On the Preparing My Forms task panel click the "Work With My Tax Forms" link.
2. Select the type of tax form to browse.
3. At the Enter, Update and View screen select the individual form to start browsing at.
4. Click the "Browse By Form" button located at the bottom center of the screen.
   o Use the PageUp ("pgup") and PageDown ("pgdn") keys to move forwards/backwards through the forms.
   o If a form has a protected status (Printed, SB Filed, MagMedia, etc.) users may only VIEW the form.
   o Forms with a Pending status are available for EDITS. To continue browsing forms after making changes to a Pending form, simply press the PageUp/PageDown keys to continue.
5. To exit the Browse By Form feature use the Escape ("esc") key on your keyboard or click the "Cancel" button on the tax form.

NOTE: When using Browse by Form, the current View and Query settings remain in effect, just as when using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when switching to Browse by Form mode.

12.3.1 State Status

State Status Legend

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.

Note if the state is known then the status below will be preceded by the state abbreviation. For example, CA Orig/Pending

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orig/Pending</td>
<td>Record is to be filed as State Original</td>
</tr>
<tr>
<td>Orig/Filed</td>
<td>Record was filed with State as Original</td>
</tr>
<tr>
<td>Orig/Filed CFS</td>
<td>Record was filed CFS as Original</td>
</tr>
<tr>
<td>Orig/Filed ST corr/Filed</td>
<td>Record is filed with State as Original and all State Correction(s) that exist for the record filed with the State(s)</td>
</tr>
<tr>
<td>Orig/Superceded</td>
<td>Record was IRS filed but not filed with the state. Then a correction was created which will be an Original to the state.</td>
</tr>
<tr>
<td>Orig/Pending but Superceded</td>
<td>Record was IRS filed but not filed with the state. Then a correction was filed with the IRS. And then a correction of a correction was created which will be an Original to the state.</td>
</tr>
<tr>
<td>Orig/Filed but Superceded</td>
<td>Record was IRS filed but not filed with the state. Then a correction was filed with the IRS &amp; with the state. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Orig/n/a</td>
<td>Original State records for one of the non taxing states</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Corr Active</td>
<td>Record was filed with State and at least one state correction for the records is pending</td>
</tr>
<tr>
<td>Corr/Pending</td>
<td>Record is to be filed as State Correction</td>
</tr>
<tr>
<td>Corr/Filed</td>
<td>Record is filed with State as Correction</td>
</tr>
<tr>
<td>Corr/Superceded</td>
<td>Record is created as state Correction but superceded by creating of new correction</td>
</tr>
<tr>
<td>Corr/Pending but Superceded</td>
<td>Record was IRS &amp; state filed. Then a correction was filed with the IRS. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Corr/Filed but Superceded</td>
<td>Record was IRS &amp; state filed. Then a correction was filed with the IRS and with the state. And then a correction of a correction was created which will be an Correction to the state.</td>
</tr>
<tr>
<td>Corr/n/a</td>
<td>Correction State records for one of the non taxing stated</td>
</tr>
<tr>
<td>n/a</td>
<td>No state information on the record</td>
</tr>
</tbody>
</table>

## 12.4 Void Records

### Void Records

Records are *Voided*, instead of deleted, to retain data for possible future reference. Only records with a *Printed* status can be voided.

**To Void a Record**

1. At the "Work with My Tax Forms" screen highlight a record and click "Change" to access the Protected Form Update Options screen.
2. Click the "Void the Form" button.
3. 1099 Pro prompts, "Are you sure you want to do this?" Click "Yes" to void the record.

### Un-Void a Record

A voided record may be un-voided (or reset) to a *Pending* status.

**To Un-Void a Record**

1. At the "Work with My Tax Forms" screen highlight a record and click "Change" to access the Protected Form Update Options screen.
2. Click the "Un-Void the Form" button.
3. 1099 Pro prompts, "Are you sure you want to do this?" Click "Yes" to un-void the record. The record automatically reverts to Pending status.

## 12.5 Browse Notes/Attachments

### Browse Notes

All tax forms, recipient forms and filer forms now have an icon/button to the left of the SAVE button that lets you create and update notes for that item.

When you are on a data entry form, the Notes button will change colors to help you know if there are
existing notes or not.
- If the button background is BLUE, no notes have been entered for the item yet, or any existing notes have been deleted.
- If the button background is RED, there are currently notes for the item.

Each note can contain up to 512 characters, and you can have as many notes as you want for each item. Every time a note is created or updated, the note will show the date and time of the action and either the User ID of the person who made the change (if you have Security turned on) or the network name/ID of the machine where the change was made.

Depending on the type of note, you may be able to view and update them from multiple places within the program.

**Global Notes**
These are visible everywhere within the program, and can be viewed and updated from every Notes browse. You can also enter Global Notes directly from the main File menu, using the ‘Global Notes’ option.

**Filer Notes**
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Recipient, you can also view/update all Global notes.

**Recipient Notes**
Recipient notes are associated with the individual recipient, and can be viewed and/or updated from both the recipient update form and from every tax form associated with that recipient. When entering notes for a Recipient, you can also view/update all Global notes.

**Tax Form Notes**
This type of note is attached to one specific tax form for one recipient. When entering notes for a tax form, you can also view/update the notes for the recipient of the form, as well as view/update all Global notes.

**Attachments**
*(Corporate Suite/ASP Version Only)*
You may attach documents to Filer/Form/Recipient Notes. You will be able to View/Download these documents from the program.

### 12.5.1 Update Notes

**Update Notes**

This screen will allow you to add or modify note.
Please see Browse Notes/Attachments for all available note types.
12.6 GIIN Validation

GIIN Validation

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI's jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI's FATCA Registration is submitted and approved.

The Internal Revenue Service (IRS) Automatically validates a Global Intermediary Identification Number (GIIN) against the most up to date IRS information. A GIIN is a 19 digit identification number that is instrumental in the United States' new FATCA legislation. Any Foreign Financial Institution (FFI) will undoubtedly need to validate all GIIN information before reporting the upcoming FATCA Form 8966.

Below is some information on GIIN formatting.

Format: X0000X.XXXXX.XX.XXX

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

- Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI's online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI's FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN.

- The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

- The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

- The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

12.7 GIIN Composition

GIIN Composition

- Enter a filer's GIIN at the Add a Filer screen.
- See FATCA Identification Number.
GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI's jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI's FATCA Registration is submitted and approved.

Format: XXXXXX.XXXXX.XX.XXX

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI's online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI's FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN.

The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution's country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

Global Intermediary Identification Number (GIIN) Composition Format:

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>No. of char</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXXXXXX</td>
<td>6</td>
<td>1-6</td>
<td>Alphanumeric upper case only</td>
</tr>
<tr>
<td>FATCA ID (first six characters)</td>
<td></td>
<td></td>
<td>For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID, for members; this is just the first six characters. (First 6 characters of any Financial Institution’s FATCA ID are randomly...</td>
</tr>
<tr>
<td>Character Representation</td>
<td>No. of char</td>
<td>Position</td>
<td>Description / Rules</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td><strong>Separator 1</strong></td>
<td>1</td>
<td>7</td>
<td>Period = .</td>
</tr>
<tr>
<td>Xxxxx</td>
<td>5</td>
<td>8-12</td>
<td>Alphanumeric upper case only Lead = 00000 Sponsoring Entity = 00000 Single = 99999 Member = Same as the last 5 characters of the Member’s FATCA ID (sequential, starting from 00001 and going to 99998, then A0000 – ZZZZZ; will never use the letter “O”)</td>
</tr>
<tr>
<td><strong>Separator 2</strong></td>
<td>1</td>
<td>13</td>
<td>Period = .</td>
</tr>
<tr>
<td>xx</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only Based on Financial Institution or Branch category LE = Lead SL = Single ME = Member BR = Branch (the first thirteen characters of a branch’s GIIN will match the first thirteen characters of the GIIN of the Financial Institution with which the branch is associated) SP = Sponsoring Entity</td>
</tr>
<tr>
<td><strong>Separator 3</strong></td>
<td>1</td>
<td>16</td>
<td>Period = .</td>
</tr>
<tr>
<td>xxx</td>
<td>3</td>
<td>17-19</td>
<td>Numeric ISO 3166-1 numeric standard country code of the Financial Institution or branch NOTE: Use 999 for country code “Other”</td>
</tr>
</tbody>
</table>

### 12.8 Capitalization

**Capitalization**

1099 Pro capitalizes the first letter of names, addresses and non-ID boxes (Form W-2G only) during manual data entry. This is a default Preference setting that may be modified.

Please note:
Account number and free form text fields have no special formatting.

State abbreviations are forced uppercase.

12.9 Cascading Changes

Cascading Changes

What are Cascading changes?
When making manual changes to the Filer and Recipient Master Lists in 8966 Pro, those changes are then cascaded or (updated) throughout all tax forms with a Pending status. Cascading updates help ensure that ALL filer and recipient information, regardless of the tax form, is quickly and uniformly synchronized.

When does the cascading of those changes take place?
After making changes to a filer or recipient, click the "Save" button. The Administrator prompts to "Update all Pending forms with the new information?" Click "Yes" to update all pending forms associated with the recipient or filer, or "No" to update only the selected recipient or filer.

To update filer information for tax forms with statuses other than Pending (i.e., Printed, Filed, Uploaded,...etc.), the user must manually reset the form's status back to Pending. The cascading changes automatically and immediately take effect.

I made prior changes to a tax form and now I am being prompted with a window "Recipient Record may need updating" or "Possible Recipient Information Mismatch." What do I do now?
8966 Pro prompts the user to update or synchronize changes if it sees that the existing recipient information does not correspond with the master recipient database. It will continue to do this for all consecutive tax forms that require updating. Click "Yes" to apply the changes or "No" to not make any changes. The same applies to changes made to filer and contact information, as well as manual changes made directly to the Recipient Master list.

12.10 Add a Record

Add a Record

A standard installation of 8966 Pro allows up to 5,000 records (or tax forms); bump codes may be purchased at any time. Please visit https://www.1099pro.com/videos.asp and select the "How to Add a Form" video for a brief tutorial on the process.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link. Use the Current Form drop menu to select the form type to process.
   - Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link. Use the Current Form drop menu to select the form type to process and Tax Year drop menu to select the year.
2. At the Work with My Tax Forms screen click "Add" to access the Adding a Form Record screen.
3. After completing all fields click "Save". The record is saved and a blank screen is presented for your next record. Click "Cancel" to exit the Adding a Form Record screen.
12.11 Change a Record

Change a Record

Only records with a Pending status are available for modification.

To Change a Record
1. At the Preparing My Tax Forms task panel click the "Work With My Tax Forms" link.
   o Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Update" link.
2. At the Enter, Update and View screen highlight the appropriate record and click "Change" (or double-click) to access the Changing a Form screen.
3. Make necessary changes and click "Save".

12.12 Delete a Record

Delete a Record

Only records with a pending print status can be deleted. Deleted tax records may be viewed at the Work With My Tax Form screen (see View Deleted Records below). Corporate Suite users only may un-delete previously deleted tax records.

To Delete a Record
1. At the "Work with My Tax Forms” screen highlight the record and click “Delete”.
   o Corporate Suite Users: At the Browse, Enter and Edit screen highlight the record and click "Delete".
2. The Administrator prompts to confirm the deletion. Click "Yes" to delete the record or "No" to cancel.

To View Deleted Records
Deleted tax records are available for audit trail purposes and may be viewed or reprinted. By default, the recipient copies of any deleted tax records that are reprinted have the phrase, ”* * * DELETED FORM * * * * " imprinted in the upper right corner of the document. Do NOT file deleted tax records with the IRS/SSA or state.

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click "Program Options" and "Preference, Update and Program Options" buttons.
3. At the Preferences screen, General tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
   o Corporate Suite Users: At the Preferences screen, Global tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
4. Click "OK" to save changes.
5. Return to the Work With My Tax Forms screen to view deleted tax records.
   o Corporate Suite Users: Return to the Browse, Enter and Edit screen to view deleted tax records.

To Un-Delete Tax Records
This feature is only available in Corporate Suite.

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen click "Rules & Options" and the appropriate form type "Preference/Options" button.
3. At the Preferences screen, Global tab, under Options for Manually DELETED Tax Forms select the "Allow Users to Un-Delete Previously Deleted Tax Forms" checkbox. The "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox must also be selected.
4. Click "OK" to save changes.
5. Return to the Browse, Enter and Edit screen to view deleted tax records.
6. Highlight the record to un-delete and click the "Delete" button.
7. At the Protected Form Update Options screen click the "Un-Delete the Form" button.
8. The Administrator prompts "Are You Sure You Want To Do This?" Click "Yes" to un-delete the record or "No" to cancel.
9. The record is immediately un-deleted and reverts to Pending status at the Browse, Enter and Edit screen.
   o Use the Record History screen to view an audit trail of all changes to the selected record including Box Amount Changes, Views and Deleted and Un-Deleted statuses.

12.13 Form Status Overview

Form Status Overview

Records with a Printed, Filed (1096/W-3/1042-T), Filed Mag, SB Filing, Corr/SB Filing or Void status are "protected" from changes or edits. Use the Protected Form Update Options screen to access these records. Available update options vary according to the record's status.

Protected Form Update Options screen
Use this screen to access protected records for viewing, reprints or generating corrections.

1. At the Preparing My Forms task panel click the "Work With My Tax Forms" link.
   o Corporate Suite Users: At the Forms & Printing task panel click the "Browse, Enter & Edit" link.
2. Highlight any record with any status except Pending.
3. Click the "Change" button to display the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>These forms are ready to be printed and/or filed. Users may view, change or delete the form. Print the form and/or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).</td>
</tr>
<tr>
<td>Printed</td>
<td>These forms have been printed and are ready to be filed. Users may view the form, reset the form to pending print status, void the form, reprint the form or file the form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau). Records that were imported with a printed status cannot be void, reset or delete. The entire import session must be reset.</td>
</tr>
</tbody>
</table>
Voided  These forms have been voided.  
Users may view the form, unvoid the form or reprint the form

Deleted  These forms have been deleted and may not be undeleted.  
Users may view the form.

Filed  Users may view the form, reprint the form or create corrections.  
***This status is not applicable to 8966 Pro users.***

Filed Mag  These forms have been printed and filed electronically (magnetic media).  
Users may view the form, reprint the form or create corrections.

SB Filing  These forms have been submitted to the Service Bureau for electronic filing.  
Users may view the form, reprint the form or create corrections.

SB Print+Mail  These forms have been submitted to the Service Bureau for printing and mailing.  
Users may view the form, file the form (to paper* on IRS/SSA Copy A, electronically or via the Service Bureau), reprint the form or reset to pending.

Corr/Pending  These forms have been corrected and are ready to be printed and/or filed.  
Users may view the original or corrected form, reprint the original form.  Print and/or file the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).  Change the corrected form or delete the correction.

Corr/Printed  These forms have been corrected and are ready to be filed.  
Users may view the original or corrected form, reprint the original form.  File the corrected form (to paper* on IRS/SSA Copy A, electronically or through the Service Bureau).  Reset the corrected form to pending status.

Corr/SB Filing  These forms have been corrected and submitted to the Service Bureau for electronic filing.  
Users may view the original or corrected form, reprint the original or corrected form.

Corr/Mag  These forms have been corrected and filed electronically (magnetic media).  
Users may view the original or corrected form, reprint the original or corrected form.

* Filers must file electronically if they have 250 or more forms of any one form type or risk IRS penalties.

Create Corrections  
Refer to About Corrections and Create Corrections - A Tutorial

12.14 Department

Department
The “Select Department” feature allows users to quickly change the department phone number associated with the current filer contact. Click on the down arrow in the tax form to display the list of contacts. Choose the contact by highlighting it and then click on “Select”. Return to the tax form and the current contact phone number and department ID are listed. The name of the department does not print out.

Contacts can be added by clicking on "File" from the main menu and then selecting Filers list, Change Filer, Add as described in Filer Record Details.

12.15 Options for Tax Form Data Entry

Options for Tax Form Data Entry

1099 Pro contains a list of data entry options accessible at the Tax Form screen. Inactive buttons in this list indicate the tax form is non-editable and therefore not available for use. The image below displays how the button title changes after information has been entered.

- **Audit Trails** - This screen displays record history information for the selected tax form

- **Notes** - Allows users to View, Add, Update and Delete Notes for this tax form. After entering in Notes the button changes to "Has Notes" with BOLD text to indicate that notes now exist for this form. For more help on Notes, See Browse Notes.

- **Preferences** - Access the “Data Entry Preferences for Form” screen where you can change the position of the First Name and Last Name/Company orientation in how it is displayed on the tax form.

- **Tax State** - Tax State is used for State filing only. It is normally the same as the state withholding (if any) or address state unless there is an explicit need to override it.

- **Withholding State** - When a tax form or electronic file is generated within 1099 Pro the "Withholding State" is determined to be the state with dollar amounts withheld. For example, Form 1099-R Box 12 "State Tax Withheld" or Form 1099-MISC).

- **Tax State with no amounts withheld** - If there are no amounts withheld users can still designate a “Tax State” if the work or event took place in a specific state via the Tax State override button. Click the “State” button to set a "Tax State".
• **Residence State** - If there is no “Tax State” then the default state is the recipient’s “State of Residence”.

• **IRS Instructions** - Access the 2017 General Instructions and the specific “Current Tax Form” instructions.

• **Form Help** - Provides help for the current tax form.

### 12.16 Print/View Reports

#### Print/View Reports

**How to Print/View Reports**

1. At the “Work with My Tax Forms” screen click the “Print/View Report” button.

2. The Administrator prompts to use the current query if one is selected at the Work With My Tax Forms screen. If a query is not selected, the Administrator asks “Which Forms To Include?” Options include:
   - (1) All - Generates a standard Control Totals report
   - (2) Query - Allows the user to select a previously saved query or create a new query
   - (3) Selected - Generates a report for the highlighted record at the Work With My Tax Forms screen
   - Cancel - Cancel and exit the report

See Control Totals Report

### 12.17 Search

#### Search

Use the Search field to quickly locate a recipient or filer.

**To Search (AKA Incremental Index)**

1. Set the [Current View](#) to the correct sort order criteria (i.e. By TIN)
2. At the Browse the Recipients, Browse the Filers or Browse Forms screen of the software, place your cursor in the Search field.
3. Enter the first few characters of your search criteria and hit the TAB key.
   - The browse screen highlights the record matching your entry. If multiple records match your entry the screen highlights the first match. Use the ARROW keys to scroll through the matches.
   - The Search results are governed according to the column sort order. (i.e. If searching by Last Name/Company, and you search the last name of Charlie Tuna in ascending order by typing in the letters “T” then “U”... in the search field then hit the TAB key, the search results listed are displayed with Charlie Tuna's last name.) If searching by Recipient TIN and you're sort order is set in ascending order then your search results are going to be listed in numeric order from beginning to end for this column only. This same method and result applies to all respective columns.

**Note:** For a quick form lookup without using you mouse, type the 1st numbers of the TIN (when your sort order is by TIN) and you will drop down to that particular record, if your sort order is by another field (Last
Name or Account ...) then type the first few characters you of the field to drop down to that record. To use the "Search ..." box you must click in the box, type your characters and hit the Tab key.

12.18 Select a Form

Select a Form

Use the Select a Form Type screen to select the form type you want to process.

To Search for Forms
1. Place your cursor in the search field.
2. Enter the first few letters of the form type, for example "1099-M", and click TAB. The first record matching your entry is highlighted.

12.19 Select Form Type

Select Form Type

If a record was originally issued on an incorrect form type, select the correct form type. The user is presented with a new form that displays the original recipient TIN and address but no individual box amounts or values.

12.20 Tagging Records

Tagging Records

1099 Pro allows users to manually tag (or select) records for inclusion in a print session.

To Tag Records
1. On the Forms & Printing task panel select the "Print Tax Forms" link. Use the Selected Form drop menu to select the form type to process.
2. At the Printing Tax Forms screen choose the "Manually select forms..." option.
3. Click the "Begin Print Process" button.
4. At the Selecting Form Records screen click the "Tag" button to select records. A red check mark appears beside each tagged record. (See Tag Key Shortcuts below.)
   • To sort records prior to tagging, use the View or Query drop menus.
5. After tagging all records, click "Proceed to Next Step" to initiate the Print Wizard.

Tag Key Shortcuts
- Tag: Use this button (or ALT + T) to tag individual records.
- Tag All: Use this button (or ALT + A) to tag all records.
- Untag: Use this button (or ALT + U) to untag an individual record.
- Untag All: Use this button to untag all records.
12.21 **Zip Code Lookup**

**Zip Code Lookup**

1099 Pro allows you to quickly find or verify zip codes, cities, and states within the USA.

The Zip Code Lookup feature:
- Includes every 5 digit ZIP code in the USA.
- Includes FPO (Fleet Post Office) and APO (Army Post Office) ZIP codes.
- Allows you to search by city, state, or ZIP code.
- Contains current ZIP code data.

Zip Codes can be looked up from either the City field (shows all matching cities) or the zip field (more precise, shows matching zips.) If you type a partial city or zip and then invoke the pop up, the list will start at the closest approximation. This database includes all zip codes and cities accepted by the United States Postal Service. The USPS currently recognizes all United States ZIP codes by either their preferred or alternate city names.

**USPS Codes:**
- **P** = Preferred City Name (Example: Philadelphia, 19101)
- **A** = Alternate (Example: Phila, 19101)

**Tip**
You can right click on the City or Zip Code fields to pull up the list of cities in the U.S. You may also type in the name of the City or Zip code in the search field. As you type, the software will narrow down the closest match based on your entry. A third tab, By State, allows you to type in the abbreviation of the state to match the zip code your are searching for.
12.22 IRS Codes

IRS Codes

Please review the IRS Instructions for the form to find a current listing of codes.

These instructions are available via the menu bar and selecting “Forms” and "IRS/SSA Instructions & Blank Forms".

13 Current Sort/View

Current Sort/View

Record Sorting:
1099 Pro offers built-in views that are tied directly to the Search field. To search for records by TIN the view must be set to "By TIN". Likewise, to search for records by name the view must be set to "By Last Name/Company" or "By Filer Name" as appropriate. Failure to properly set the view will result in a failed search attempt.

Views are available at select browse screens.

13.1 Current Sort/View

Custom View
Custom Sorting of Records & Column Display

Sophisticated users can select Custom View from the Current View drop menu and design their own views.

To Define a Custom View
1. At the "Enter, Update and View" Screen", where you can browse your form, click the drop down arrow in the field located in the upper right labeled "Current Sort/View."
2. Select Custom View from the list. (The software displays the Define View Format Layout Screen.)
3. This screen allows you to select the available fields from the left column and organize them in the "show these fields in this order" column on the right.
4. You may move the position of these items in the order in which they will appear by highlighting them on by one and clicking the up or down arrow to adjust it's position accordingly.
5. To save these changes click, "Apply" or Click "Next" to define a sort order for the custom view. The software displays the "Select a sort order for the view" screen. At this point you may:
   - Use the default sort order (Which tells 1099 Pro to accept the current sort order)
   - Select a predefined sort order (fastest) which tells the software to use the built in predefined list (Example: Filer ID, Last Name/Company, First Names or by Filer ID, Recipient TIN, then Last Name/Company.)
   - Define your own custom sort order (slowest) Allows you to indicate what custom sort order the software should follow based on your custom field selections.

13.2 Custom Sort Order

Custom Sort Order

Define Custom Sort Order
Users may define a custom sort order to view recipient records in addition to the default sort options of by Recipient TIN or by Recipient Last/Company Name.

1. At the Work With My Tax Forms screen, click the “Current Sort/View” drop menu and select “Custom View”.
2. At the Define View Format window use the "Next" button to move to the Select a Sort Order for the View window.
3. Select the "Define Your Own Custom Sort Order" radio button to access the Sort Designer window.
4. Make your selections to arrange records by up to four fields, in ascending or descending order. For example: Sort View by "Account", Then By "State", Then By "City".
5. Click "OK" to save changes and close window.
6. Click "Apply" at the Select a Sort Order for the View window. This window closes and changes take effect immediately at the Work With My Tax Forms screen.
7. To cancel the custom view use the Current/Sort View drop window to select the default view.

13.3 Dynamic Queries (CS Version Only)

Dynamic Queries

The features contained within this section are available exclusively to users of the Corporate Suite edition of our software.
Basic Use

- All 'AskFor...' tokens are composed of a single word with no spaces or other punctuation. Tokens are not case sensitive, but users are strongly encouraged to enter them using the capitalization as shown in this document as it makes the queries easier to read and understand.
- Manual Query: Click on the ‘Manual’ button and use the “AskFor...” string where desired. Examples:
  - RcpTIN = AskForText
  - DateLastEdit > AskForDate
  - DateCreated BETWEEN AskForDateRange
  - TIP: Date and Time ranges must be entered manually as shown above.

- At the Query Wizard Value Entry screen the 'Expression' radio button must be selected, or else the 'AskFor...' token is treated as if it is the actual value to use. Thus, the query returns neither a result nor triggers an invalid query response/error from the database. If the ‘Expression’ option is disabled, the query must be manually created.

Query Wizard
Value Entry
Enter a value to complete your expression.

- Constant Value
- Another Field
- Expression

Box 1 Income Code Is Greater Than:
AskForNumber

Once the query is created and saved it prompts the user, each time, for the value to use (substitute) where the ‘AskFor...’ expression was in the query. To resubmit the query with a different value, click on the ‘Redo’ button under the ”Current Query:” prompt to enter a new value (or set of values). Users can likewise press “F5” on their keyboard to redo a query. This simplifies the process of creating a query with new values to browse, update or report.

Removing a Query
To view all records again, users can select ‘All records’ on the query list or click on the ‘Undo’ button to the left of the ‘Redo’ button.

Restrictions
Users can have multiple unique 'AskFor...' expressions in the same query, but not the same one multiple times. For example:

This expression is allowed.
DatePrinted = AskForDate AND RcpLName = AskForText

This expression is not allowed.
RcpLName = AskForText AND RcpFName = AskForText
1099 Pro, Inc. plans to lift these restrictions at a future date.

**WORKAROUND:** For text and numbers users can use the from/through variants of the same type as additional tokens. For example:

\[\text{RcpLName} = \text{AskForText} \text{ OR RcpLName} = \text{AskForFromTest} \text{ OR RcpLName} = \text{AskForThruText}\]

**TIP:** Each ‘AskFor…’ token creates its own pop-up window, so multiple tokens can result in a succession of pop-ups before the query is completed and applied.

**Available "AskFor…" Tokens**

<table>
<thead>
<tr>
<th>Token Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AskForText</td>
<td>Requests any type of text/string value. For example, anything dealing with names, addresses, TIN, account numbers or alphanumeric codes. Basically, anything that is not explicitly a number or date. Prompt is &quot;Text to use&quot;.</td>
</tr>
<tr>
<td>AskForFromText</td>
<td>Same as &quot;AskForText&quot; except the prompt is &quot;1st/From value&quot;.</td>
</tr>
<tr>
<td>AskForThruText</td>
<td>Same as &quot;AskForText&quot; except the prompt is &quot;2nd/Thru value&quot;.</td>
</tr>
<tr>
<td>AskForDate</td>
<td>Requests a single date, with the pop-up calendar option. Defaults to current date and preset options are available.</td>
</tr>
<tr>
<td>AskForFromDate</td>
<td>Same as &quot;AskForDate&quot; except the prompt is &quot;1st/From date&quot;</td>
</tr>
<tr>
<td>AskForThruDate</td>
<td>Same as &quot;AskForDate&quot; except the prompt is &quot;2nd/Thru date&quot;</td>
</tr>
<tr>
<td>AskForDateRange</td>
<td>Pops up the full date range query window, with calendars and quick-select options for all common ranges (this year, this month, a particular month, a quarter, etc.) or select any random range.</td>
</tr>
<tr>
<td>AskForNumber</td>
<td>Requests a single number and provides for decimals. Prompt is &quot;Number/Amount&quot;.</td>
</tr>
<tr>
<td>AskForLowNumber</td>
<td>Same as &quot;AskForNumber&quot; except the prompt is &quot;1st/Low number&quot;.</td>
</tr>
<tr>
<td>AskForHighNumber</td>
<td>Same as &quot;AskForNumber&quot; except the prompt is &quot;2nd/High number&quot;. These two tokens can be combined to create a numeric range.</td>
</tr>
<tr>
<td>AskForTimeRange</td>
<td>Asks for starting and ending times within a single day. Offers a number of quick-select options including 'Last 30 minutes', 'Midnight to 6AM', 'Before Noon', etc.</td>
</tr>
</tbody>
</table>

1099 Pro is continuing to enhance the token process and add more tokens to make it more intuitive. Check the online help or ask 1099 Pro for an updated list when program updates are issued.

### 14 Error & Validation Checking

**Error & Validation Checking**

8966 Pro performs various validation checks on your data. This helps users find and fix potential tax form errors ([see Disclaimer](#)) prior to submission to recipients or the IRS. Error and validation checks occur whether data is manually entered or imported. It also occurs when printing a form, or when generating electronic or service bureau files. If a problem is found, the software flags the record with a Warning, Error or Reject Error. Users are encouraged - but not required - to fix warnings and errors prior to
submitting their records to recipients or the IRS.

- Users can instantly scan all records in the software for errors and warnings via the menu bar > Utilities > Check/Update Error Status For All Forms.
- See Filing Problems

Warnings & Errors Defined
Whether importing or manually entering data, 8966 Pro indicates if any records have errors or warnings associated with them, or if they were rejected.

- **Warnings** are intended to flag a possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA.
- **Errors** are serious flaws in the data that would most likely result in the record being rejected by the IRS/SSA.
- **Reject Errors** occur when the user has not entered correct data, resulting in an automatic rejection.

Find Problem Records
8966 Pro offers several methods to locate records containing warnings and/or errors including:
- **Form Counts Report** - View a concise listing of all filers and form types including number of warnings and/or errors per form type.
- **Control Totals Report** - View errors and/or warnings in detail by Recipient. Users must select the “Extended Version - Errors and Warnings Messages” to access this information.
- **Review Import Records** - Prior to posting import data into the software, users can edit or delete individual records, or abandon an entire import session, during the Import Wizard—Step 2: Validate Data.
- **Error Queries** - Sort records with errors and/or warnings at the Work With My Tax Forms screen. See Error Queries below.

Error Queries
At the Enter, Update and View screen display records with errors and warnings or errors only.

To Run Error Queries
1. On the Preparing My Forms task panel select “Work With My Tax Forms”.
   - Corporate Suite Users: On the Forms & Printing task panel select “Browse, Enter & Edit” to access the Add, Update and View screen.

2. At the Enter, Update and View screen use the Current Query drop menu to select “Errors and Warnings Only” or “Errors Only”.

3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no records for the selected filer and form type with errors or warnings.
   - Any record containing an error or warning may be fixed provided it has a pending status.
   - After fixing a problem record it will disappear from this list. After fixing all problem records reset the Current Query to “All Records”.

Disclaimer
1099 Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly
reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

Feedback
Users who encounter a situation that should possibly generate an Error or Warning in the software are encouraged to discuss the situation with 1099 Pro, Inc. at compliance@1099pro.com. Please indicate the form type, data set and IRS regulations in your correspondence.

14.1 Warnings and Errors Scan Screen

Errors & Warnings Scan

Users may scan their records for errors and warnings prior to generating an electronic file or Service Bureau upload file. If errors or warnings are found in electronic files, users may choose whether or not to process those records. For uploads, all records are processed regardless of any errors or warnings; the scan is simply a final informational check.

Processing Records with Errors/Warnings
Errors and Warnings typically indicate missing or incorrect information. Missing TINs (SSN or EIN), and State Fields are typical warnings. An incorrect Zip Code, for example, would generate an error. Typically the IRS accepts uploads with errors and warnings but a high percentage of missing TIN’s or other errors or warnings may cause the IRS to reject your file and/or result in penalties.

Users are encouraged to make every effort to fix missing or invalid data but if unable to do so; file the records anyway. A good way to identify errors and warnings is to run a Control Totals Report, Extended Version. See Finding & Fixing Records with Problems.

☐ Try to fix Errors and Warnings before filing with the IRS. Consider filing Form 8809 for a 30-day filing extension in order to submit more accurate data.

14.2 Filing Problems

Filing Problems

Users may scan their records for errors and warnings prior to generating an electronic file or Service Bureau upload file. If errors or warnings are found in electronic files, users may choose whether or not to process those records. For uploads, all records are processed irregardless of any errors or warnings; the scan is just a last chance informational check.

Processing Records with Errors/Warnings
Errors and Warnings typically indicate missing or incorrect information. Missing TINs - SSNs or EINs - and State Fields typically generate a warning. An incorrect Zip Code, for example, would generate an error. Typically the IRS accepts uploads with errors and warnings but a high percentage of missing TIN’s or other errors or warnings can cause the IRS to reject your file and/or result in penalties.

Users are encouraged to make every effort to fix missing or invalid data but if they are unable to do so, file the records anyway. A good way to identify errors and warnings by recipient is to run a Control Totals Report with “Extended Version - Errors and Warnings Messages” selected. Try to fix any errors
or warnings prior to filing with the IRS. Consider filing Form 8809 for a 30 day filing extension in order to submit more accurate data.

- See Error & Validation Checking

### 14.3 Penalties

#### Penalties

**Penalties Increased Effective 2017**

The following penalties generally apply to the person or entity required to file information returns. The penalties apply to both paper and electronic filers. Reference the IRS's 2017 General Instructions for Certain Information Returns, page 18.

- See Deadlines

**Failure To File Correct Information Returns by the Due Date (Section 6721)**

If you fail to file a correct information return by the due date and you cannot show reasonable cause, you may be subject to a penalty. The penalty applies if you fail to file timely, you fail to include all information required to be shown on a return, or you include incorrect information on a return. The penalty also applies if you file on paper when you were required to file electronically, you report an incorrect TIN or fail to report a TIN, or you fail to file paper forms that are machine readable. The amount of the penalty is based on when you file the correct information return. The penalty is as follows.

- $50 per information return if you correctly file within 30 days (by March 30 if the due date is February 28); maximum penalty $536,000 per year ($187,500 for small businesses, defined below).

- $100 per information return if you correctly file more than 30 days after the due date but by August 1; maximum penalty $1,609,000 per year ($536,000 for small businesses).

- $260 per information return if you file after August 1 or you do not file required information returns; maximum penalty $3,218,500 per year ($1,072,500 for small businesses).

If you do not file corrections and you do not meet any of the exceptions to the penalty described later, the penalty is $260 per information return. Please see the IRS Help for Taxpayers site for information and advice on late filings and penalties.

**Form 8966 Specific Requirements**

An entity that is a financial institution is required to file Form 8966 electronically, irrespective of the number of Forms 8966 filed. All other entities that file 250 or more Forms 8966 for the calendar year are required to electronically file Form 8966.

If you are required to file electronically but fail to do so, and you do not have an approved waiver on record, penalties under sections 6721 through 6724 may apply.

For up to date information regarding FATCA related penalties please visit: irs.gov/fatca
15 Exports

Export Overview

8966 Pro features a powerful and intuitive Export Wizard for the exporting of tax form data in a Mapped ASCII (Fixed/Delimited/Excel) format, IRS* (Pub 1220 Format), and Moore Wallace 1099 Print Export.

* IRS format exports are only available in 1099 Pro Enterprise and Corporate Suite edition.

15.1 Export ASCII Wizard

Export Wizard

The 8966 Pro Export Wizard simplifies the process of exporting tax form data to an ASCII file; accessible in spreadsheet applications such as Excel or Access. If using Notepad to view files, data will appear out of alignment as the export files are Tab delimited. All export files are "Map by Name" compatible and can be imported directly into another Filer.

See Import Wizard
See IRS Bulk TIN Export Wizard

To Export Data:
1. At the menu bar select Utilities > Export Tax Forms to ASCII File(s).

2. At the 8966 Pro Export Wizard click "Next" to proceed. Use the "Back" button at any time to go back a step.

3. At the "Select the type of data and format to use" screen use the drop menu to select the appropriate form type and click "Next".
   ○ To customize the delimiters and data exported use an export map, accessed via the "Add or Update Export Map" button. See Export Mapping Wizard for important field descriptions.

4. Choose a method for selecting eligible tax forms. Options include:
   ○ Export tax forms for ALL Filers: This option automatically selects every eligible form for all filers.
   ○ Export tax forms for up to 25 selected filers: This option prompts to manually select (tag) the filers to include in the export file. All form types for the selected filers are processed.
   ○ Split export records into separate files for each filer?: Mark the check box to export filers’ records into individual files. Leave the check box unmarked for a single, larger file containing data for all filers and form types.

5. Select the destination folder and click "Next" to continue.

6. Review settings and click "Finish" to create your export file.
15.2 Export Map Wizard

Export Map Wizard

8966 Pro allows users to customize the delimiters and data exported by generating unique export maps. Export maps are form specific and are saved as .TPS files.

- See Import Map Reports
- To export data files into an ASCII format see Export Wizard.

To Create Export Maps
1. The Excel Import Map Wizard is accessed via the menu bar select > Utilities > Export Tax Forms to ASCII Files.
   - This process is also available in the Import Wizard at the Select the Type of Data and Format screen via the "Add/Update Form Import Maps" button.

2. Review onscreen information and click "Next" to continue to the Select the Type of Data and Format screen. Then click the "Add or Update Export Maps" button.

3. At the Manage Export Maps screen highlight the map to edit and click the "Change" button. Default/built-in maps are not available for edits; however, they can be duplicated via the "Copy" button and the copied version can be edited. To add a new map click the "Add" button.
   - Export maps are defined by their Map Type, File Format (Delimited or Fixed), Status (Default or OK) and Description. The Description column gives details about the currently selected export map and the Notes windows provides additional details.

4. In the Export Map Wizard review onscreen information and click "Next" to continue.

5. At the Define File Format for Exported Information screen select the type of information to export:
   - Tax Form: One form type can be exported per map.
   - Recipients
   - Filers

6. Select the File Format, End of Record character, Field Delimiter and other options. Click "Next" to continue setting default field processing options—reference the below chart for useful information. Click on a checkbox or "radio button" to set options On or Off.

7. Select specific fields to include in the export process by double-clicking an available field from the left to automatically move it to the right. Alternately select a field and click the "Add Field" button. Repeat until all of the necessary fields have been added.
   - If the wrong field is accidentally assigned, highlight the incorrect field and click the "Remove" button.
   - Use the Up / Down arrows to change the order of a specific field in the list.
   - Customize the parameters of a mapped Field Header by double-clicking it.

8. At the Specify a Name and Usage Notes screen enter a brief title for the export map. Use the Map Usage Notes field to enter specific notes for future reference.

9. At the Set Options screen verify the default destination folder for the export file and change as necessary.
10. At the Ready to Generate Export File screen review settings and click "Finish" to generate export map. Return to the Manage Form Export Maps screen and close it. Now return to the Select the Type of Data and Format screen within the Export Wizard and select your newly created export map. Click "Continue" and complete the export process with the newly created export parameters.

<table>
<thead>
<tr>
<th>Category</th>
<th>Options Available</th>
<th>Additional Information and Details Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters</td>
<td>1. Convert to all UPPER case</td>
<td>Character values include Names, Address Fields, Descriptions...etc</td>
</tr>
<tr>
<td>Amounts</td>
<td>1. Include Commas</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>2. Include Dollar Signs</td>
<td></td>
</tr>
<tr>
<td>Check Boxes</td>
<td>1. Blank for unchecked - &quot;X&quot; for checked</td>
<td>Check boxes are logical values: Yes/ No, True/False, On/Off</td>
</tr>
<tr>
<td></td>
<td>2. Use Y/N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Use T/F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Use 0/1</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>1. mm/dd/yy</td>
<td>Dates can be from a tax form box or for example when a form was created</td>
</tr>
<tr>
<td></td>
<td>2. mm/dd/yyyy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. yymmdd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. yyyyymmdd</td>
<td></td>
</tr>
<tr>
<td>Numeric</td>
<td>1. Round to the nearest whole number</td>
<td>Numeric values are numbers that are NOT dollar amounts like percentages or total shares.</td>
</tr>
<tr>
<td>EIN / SSN</td>
<td>1. Formatted (TIN type not required)</td>
<td>EIN/SSN values are Tax ID numbers (TINs).</td>
</tr>
<tr>
<td></td>
<td>2. Unformatted (Must include the TIN type)</td>
<td>required</td>
</tr>
<tr>
<td>Text (Multi-line)</td>
<td>1. Convert to all UPPER case</td>
<td>Text values are multi-line box values such as a transaction description.</td>
</tr>
<tr>
<td></td>
<td>2. Don't convert CR/LF, export as is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Convert CR/LF to a single space</td>
<td></td>
</tr>
</tbody>
</table>

15.3 Bulk TIN Matching

**IRS Bulk TIN Matching Overview**

The features contained within this section are available exclusively to users of 1099 Pro Professional, Enterprise and Corporate Suite editions.

Name/TIN mismatches on 1099 Informational Returns can generate penalties of up to $260/record, up to a maximum **penalty** of $3,193,000 per company! The IRS offers an interactive TIN Matching and Bulk TIN Matching Program for Forms* 1099-B, DIV, INT, K, MISC, OID and PATR. **Or consider using 1099 Pro's Bulk TIN Matching Service;** no IRS registration is required, it’s easy to create an upload file.
within our software and results are available within one business day. Cost is $135 for a single upload file of up to 100,000 records.

See 1099 Pro'sBulk TIN Matching Service

Steps To Participate In IRS TIN Matching Program:
1. Register for the IRS TIN Matching System; allow at least 4-6 weeks.
2. Perform a 1099 Pro Web Update to acquire the latest updates for your 2017 software.

IRS TIN Matching Program Registration
2. Click on the "Register" button. Registrants will be asked to provide personal data including their Adjusted Gross Income (AGI) from their most recent individual income tax return.
3. After completing the online registration,SAVE YOUR USERNAME AND PASSWORD for future reference. It takes approximately 10 business days to receive your IRS confirmation code by mail.
4. After receiving the confirmation code, return to the Registration Services page and select the "Confirm Registration" link.
5. Once your registration is officially confirmed, complete the application for the TIN Matching Programs.

Notes On System Use
- Registered users may verify Names and TIN's interactively. Manually enter up to 25 Name and TINs at one time. Registered users may also submit a .TXT file as generated by the IRS Bulk TIN Export Wizard.
- IRS responses are sent to a "secure object repository" and an E-Mail notification is sent to the registered user indicating a response is waiting. Users have 30 days to access and download the results file. Once accessed, the results are retained for 3 days before being purged. The same information sent in the .txt file is returned with one additional field containing the results indicator.
- BE SURE NOT TO SUBMIT THE SAME DATA WITHIN A 24 HOUR PERIOD OR THE SYSTEM WILL SUSPEND YOUR ACCOUNT FOR 96 HOURS!
- 1099 Pro, Inc. suggests verifying Name/TIN combinations prior to January.

How To Respond To System Results
1. Review your IRS Bulk TIN Results.
2. Verify your data against the original W-9 form on file for the Recipient.
3. Use the 1099 Pro software to issue and track additional W-9s, 1st B Notices or 2nd B Notices as applicable.
4. Lastly, mail corrected returns to recipients and file IRS corrections as necessary.

Protection From IRS Penalties
- **Due Diligence:** Using either 1099 Pro'sBulk TIN Matching Service or the IRS TIN Matching System allows users to verify the accuracy of TIN and Name information prior to submitting information to the IRS.
- IRS Code 6724 provides any penalties under Section 6721 may be waived if the Filer shows the failure to provide a correct TIN on an information return is due to Reasonable Cause and not Willful Neglect.
- Filers may prove Due Diligence and receive a waiver from proposed penalties if they prove the TIN and Name combination they submitted matched IRS records. Providing a copy of the "Print Screen" of your IRS System Responses will be considered proof of Due Diligence.

*Note: As of this writing, the IRS does not allow other form types to participate in this program under
penalty of perjury and possible imprisonment.

15.3.1 IRS Incorrect TIN Flowchart

Flowchart for Incorrect Name/TIN

- If the Name/TIN & the tax number match your records?
  - Yes
  - No action required.
  - No

- Is the mismatch due to IRS processing? (IRS approved a prior submitted TIN info (bulk TIN matching)?
  - Yes
  - No

- Is the info the same as what you have on file?
  - Yes
  - Did the payee return a certified W-9 within 30 business days?
    - Yes
    - Update your records.
    - No
      - Did the payee return a SSA 7023 or a SSA 7010 within 30 business days?
        - Yes
        - Begin backup withholding within 30 business days.
        - No
          - The 1099 software would show that the payer has not returned the forms so the former recipient status would remain open with a pending 2nd B-notice status. Payer continues backup withholding.

- If the info is different?
  - Mismatch due to error in your submission
    - Yes
    - Correct your records if necessary
    - No

- Send the first B-notice with Form W-6 to the payee.

- Has the second notification within a three year period been sent?
  - Yes
  - The payer only has to send two notices within a three year period. Beyond the two notices the payer has provided due diligence and does not need to take any further action in acquiring the TIN of the payee.
  - No

- The 1099 software could ask the user if they would like to issue a W-6 B-notice after the first TIN matching returns incorrect TIN information.

- Has the second notification within a three year period been sent?
  - Yes
  - The payer only has to send two notices within a three year period. Beyond the two notices the payer has provided due diligence and does not need to take any further action in acquiring the TIN of the payee.
  - No

- Keep the W-9 form. Stop backup withholding if it already begun Close out b-notice.

- Stop backup withholding if it already begun Close out b-notice.

- The software keeps track of all w-9s and B-notice when information is rolled over into a new 1099 software.

- The payer would update the payer’s profile with the correct information and close out the pending 2nd B-notice status. Payer would stop backup withholding.
15.3.2 IRS Missing TIN Flowchart

IRS Missing TIN Flowchart

The features contained within this section are available exclusively to users of the Enterprise and Corporate Suite editions.

Registered users of the IRS TIN Matching System can quickly generate .TXT files suitable for submission to their program.
To Create Export File

1. On the menu bar select Utilities > Export for IRS Bulk TIN Matching.

2. At the Bulk TIN Matching Export Wizard review important onscreen information. Click "Next" to proceed. Use the "Back" button at any time to go back a step.

3. Choose a method for selecting eligible records. **IMPORTANT:** The IRS does not allow submission of the form types displayed in red. Only check these form types if you have verified with the IRS or appropriate counsel that it is legal to submit recipients receiving these form types
   - **Selected Form Types for ALL Filers:** This default option prompts to select (tag) the form types to include in this upload file. All filers will be processed.
   - **Selected Form Types for Selected Filers:** This option prompts to select (tag) the filer and the form types to include in this upload file.

4. Set options for your export.
   - **Specify where export files should be created:** The default location is C:\1099 Pro\Pro66T17 Exports.
   - **Force TIN Type as Unknown for all records:** Select this check box to remove the SSN or EIN identifying hyphens. Users will be unable to import results back into the software if this box is checked.
   - **Split export records into separate files for each filer?** Check this box to split filer records into separate export files; otherwise all Filers and form types are combined in a single large file.

5. At the Ready to Generate Bulk TIN Matching Export File screen review settings and click "Finish" when satisfied. The system will process your file and the Administrator indicates when file is “Done”.
   - In the \Exports directory two files are created; your primary Bulk TIN export file with a date and time stamp in the file name AND a secondary file with the word “DUPLICATE” appended to the file name. When submitting your export file to the IRS **send the primary file, not the duplicate file.** The duplicate file is for your records - the IRS will penalize any uploads containing duplicate records.

6. Go to the IRS E-Services website to login and post the .TXT export file.

15.3.4 Bulk TIN Results

**Bulk TIN Results**

Users receiving Bulk TIN results (after submitting a Service Bureau Bulk TIN Upload or via the IRS Bulk TIN Matching Program) are provided coded responses for all invalid Name/TIN combinations.

**Bulk TIN Results**

Bulk TIN results contain the following coded information from the IRS:

<table>
<thead>
<tr>
<th>Code</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Name/TIN combination matches IRS records.</td>
</tr>
<tr>
<td>1</td>
<td>Missing TIN or TIN not 9 digit number.</td>
</tr>
<tr>
<td>2</td>
<td>TIN not currently issued.</td>
</tr>
<tr>
<td>3</td>
<td>Name/TIN combination does NOT match IRS records</td>
</tr>
</tbody>
</table>
4* Invalid request (i.e., contains alphas, special characters)
5 Duplicate request.
6 (matched on SSN), when the TIN type is (3), unknown, and a Matching TIN and name control is found only on the NAP DM1 database.
7 (matched on EIN), when the TIN type is (3), unknown, and a matching TIN and name control is found only on the EIN/NC database.
8 (matched on EIN and SSN), when the TIN type is (3), unknown, and matching TIN and name control is found only on both the EIN/NC and NAP DM1 databases.

Sample Bulk TIN Results
The following sample lines indicate the TIN provided by Matthew Mulberry is 2 - Not Currently Issued and the Name/TIN provided by Acme Incorporated is 0 - Matches IRS records.

1;183421111;Matthew Mulberry;89765;2
2;562611111;Acme Incorporated;89765;0

Invalid TIN Matching Requests
Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. For example, the following line from a Bulk TIN Matching file is missing the Name field:

2;562611111;;8976

The above line would generate a "4" in the results data file, indicating an Invalid Request, as follows:

2;562611111;;89765;4

* Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. If TIN Type is unknown, you may check the "Force TIN Type As Unknown" box during the Wizard and the IRS will check the TIN against both the SSN and EIN master files. However, you will be unable to import returned results for matching purposes if this option is chosen.

For More Information:
Direct questions regarding specific tax regulations or regulatory services to IRSCompliance.org at:
Phone: 877 TAX-REGS (877) 829-7342
Email: compliance@IRSCompliance.org

16 Filing via IDES
16.1 IDES Packager

IDES Packager

8966 Pro includes an IDES Packager to quickly package data or decrypt an IDES notification package. IDES Packager 2016 requires Windows 7, 8 or higher with MS .NET Framework 4.0.

• To package data allows a user to take a plain text 8966 XML file and compile it into an IDES
compatible data archive. This utility will sign, compress and encrypt data and save it to the chosen output directory.

- To **unpackage** data allows a user to **decrypt** their IDES notification package for review.

  See IDES Overview

**Digital Certificates**

The IDES Packager *requires* a Digital Certificate and a Key for all files going to the IRS. However, some users *only* generate XML files as their country might not require IDES encryption; thus no certificate is necessary (see Cayman Islands and Other Countries, below).

A digital certificate binds digital information to physical identities and provides non-repudiation and data integrity. Before beginning the IDES enrollment process, each entity should obtain one valid digital certificate issued by an approved certificate authority (CA). IDES stores your public key and related digital certificate. IDES only recognizes and accepts digital certificates issued by IRS approved certificate authorities.


**Key**

Most digital certificates include an embedded key. Some digital certificates include a separate key that must be placed in the same folder as the certificate and share the same naming convention, e.g., XYZ123.certificate and XYZ123.key.

**To Package XML File**

Users must create an XML file *prior* to this step, see 8966 XML File Wizard.

1. On the **Create XML** task panel select "IDES Packager".
2. At the top of the IDES Packager screen select the "Package/Encrypt" radio button.
3. **Step 1**: Browse for the 8966 XML File. In a default installation the file is located at C:\1099 Pro \Pro66T16\MagFiles.
4. **Step 2**: Browse for your Digital Certificate or private key, regardless of which is selected the other is chosen as well, provided the associated file has the same naming convention and is located in the same folder. For example, selecting XYZ123.crt prompts the software to look for XYZ123.key. Enter the digital certificate passphrase if required.
5. **Step 3**: Select a recipient certificate. A recipient certificate is provided from the host tax country authority; e.g., the Philippines receives their recipient certificate from the Philippines government tax authority.
6. **Step 4**: Select an output directory (optional).
7. **Step 5**: Click the "Create" button to create the package. The digital certificate is verified. If a passphrase is required it is validated.
8. This process combines your XML and certificate information into a .ZIP file which is then signed by the key. Upload this file to the IDES site at https://www.ides-support.com/

**To Unpackage/Decrypt XML File**

1. On the **Create XML** task panel select "IDES Packager".
2. At the top of the IDES Packager screen select the "Unpackage/Decrypt" radio button.
3. **Step 1:** Browse for the IDES notification package.
4. **Step 2:** Browse for your Digital Certificate. Enter your digital certificate passphrase if required.
5. **Step 3:** Select a certificate for the sender of the IDES notification package.
6. **Step 4:** Select an output directory (optional).
7. **Step 5:** Click the "Extract" button to unpackage and decrypt the archive. The digital certificate is **verified**. If a passphrase is required it is validated.

**Cayman Islands and Other Countries**
This software officially supports Model 2 IGA (IRS) filings which require IDES encryption. Model 1 IGA countries, such as the Cayman Islands, should contact their host country tax authority (e.g., the Cayman Islands government) for specifications since they are submitting files to them and not the IRS. *Not all countries require IDES encryption.* See Cayman Islands AEOI Portal.

### 16.2 IDES Overview

**IDES Overview**

- See IDES Packager

**International Data Exchange Service (IDES) Overview**
All FATCA electronic filings are processed through the Production IDES Gateway: [https://www.idesgateway.com/](https://www.idesgateway.com/). To get started please visit the IRS for an overview on how to enroll and obtain a User ID/Password to begin transmissions at [https://www.irs.gov/businesses/corporations/international-data-exchange-service](https://www.irs.gov/businesses/corporations/international-data-exchange-service).

The FATCA reporting specification for e-filing and communication with the IDES Gateway is in XML format. Moving forward as the form changes and compliance changes, the XML also is updated. For the latest specifications and compliance, please visit their website at [https://www.irs.gov/businesses/corporations/fatca-xml-schemas-and-business-rules-for-form-8966](https://www.irs.gov/businesses/corporations/fatca-xml-schemas-and-business-rules-for-form-8966).

**IDES Testing**
Users can optionally create test XML e-files within 8966 Pro. Please note that any production files submitted to the test environment are not processed. Do not submit production files to the test environment or test files to the production environment. Please visit the IRS website for the next IDES testing window: [https://www.irs.gov/businesses/corporations/ides-testing-schedule](https://www.irs.gov/businesses/corporations/ides-testing-schedule).

**IDES Help and FAQs**
The IRS posts common responses to frequently asked questions regarding FATCA compliance and e-filing issues at [https://www.irs.gov/businesses/corporations/fatca-ides-technical-faqs](https://www.irs.gov/businesses/corporations/fatca-ides-technical-faqs). For questions not addressed in this help file or in the IDES FAQ, contact the IDES Help Desk via email at support@ides.desk-mail.com.
16.3 NIL Report

NIL Reports

Who Must File NIL Reports? What Is The Submission Procedure?
Only Direct Reporting Non-Financial Foreign Entities (NFFEs) are required to submit nil reports. For all other entities, submission of nil reports is not mandatory and submission of these reports is optional. While nil reporting might not be required by the IRS, it might be required by the local jurisdiction. Please check with your local tax administration. Nil reports that are submitted must provide Reporting FI information. The report contains Reporting Group, but it does not contain any account reports or pooled reports. Reporting group can be empty or can contain Sponsor or Intermediary information.


UK financial institutions (FIs) that have no US-reportable accounts will not be required to submit annual 'nil returns' in order to ensure compliance with new rules designed to prevent tax evasion by US citizens, HM Revenue and Customs (HMRC) has confirmed. The change comes after the US Internal Revenue Service (IRS) updated its own Foreign Accounts Tax Compliance Act (FATCA) information to clarify that it itself does not require nil returns but that they might be required by the FI's local tax authority.


To Generate NIL Report
Prior to generating a NIL Report please view https://www.1099pro.com/videos.asp “How to Create a NIL Report with 8966 Professional”. 8966 Pro only allows a NIL Filer to create a NIL Report; please see To Create a NIL Filer below.

1. On the Create XML task panel select "XML V2.0 File".
2. At the Filing Tax Forms via eFiling screen click the "Create a NIL Report" button.
3. In the NIL Report Wizard review important onscreen information. Click "Next" to continue or "Back" at any time to go back a step.
4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Tag Filers to include in the report. Click "Next".
6. Select the Type of File to create. Click "Next".
7. Review the default destination folder for the NIL report; in a standard installation this is C:\1099 Pro \Pro66T16\MagFiles. Click "Next" to continue.
8. Review Contact and Company information and update as necessary. The default Reporting Period for the NIL Report is year-end, i.e., 12/31/XXXX, but may be edited as needed. Click "Next".
9. Review onscreen settings then click "Finish" to generate the report.

To Create a NIL Filer
8966 Pro only allows a NIL Filer to create a NIL Report.

1. On the Reporting F1 task panel select "My Filers List".
2. At the Filer Master List screen add a new filer or edit an existing filer.
   o The "Filer Is Used ONLY for NIL Reporting" checkbox must be marked. This checkbox is not available if editing a filer with existing data.
A Payer Code (PCODE) is required, but the Filer/Agent EIN is not.

3. Click "Save".

17 Form Status Overview

Form Status Overview

Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.

Use the Import Session Report to review the status of records in an import session.

17.1 Printed

Printed

All records are assigned a print status that determines their position in the filing cycle. A record with a Printed status is available for inclusion in a , electronic filing or Service Bureau upload. To edit a Printed record, first reset its print status to Pending.

See Print Status

17.1.1 Electronic Sessions Summary Report

eFile Log Summary Report

The features contained within this section are available exclusively to users 1099 Pro Professional, Enterprise and Corporate Suite.

The Electronic File Log Summary report provides in-depth comparative information on selected Filers, Pcodes, Form Types, or Session IDs.

See eFile Session Summary Report

to Generate Report
1. On the menu bar select Reports > eFile Sessions/Logs Summary Report.

2. At the eFile Log Report Wizard review the overview and click "Next" to proceed.

3. At the Limit Log Records for this eFile Log Report screen select a report option. Choices include:
   o One or more Filers (by PCode) - Filter the report for only selected PCodes. A PCode or Payer Code is an alphanumeric shorthand used to identify a Payer/Filer in the system. See Filer Record Details for further information.
   o One or more Filers (by EIN) - Filter the report for only selected EIN(s).
   o One or more Form Types - Filter the report for only selected form type(s).
4. At the same screen, users may opt to select the "Group and Generate Additional Subtotals by EIN" checkbox. This feature is useful for tallying up recipient information by filer. After making appropriate choices click "Next" to continue.

5. At the next screen users must tag (or select) the appropriate PCode(s), Filer(s), Form Type(s) or Session ID(s) as indicated in Step 3, then click "Next" to continue.

6. At the Select the Date Range screen the current tax year is set as the default; for example, 1/01/2017 to 12/31/2017 for 1099 Pro 2017. To modify the Log Summary Report setting click the "Date Range To Use" button to customize the date range value by Day/Month/Year or alternately by quarter or tax year. Click "OK" to save changes and then "Next" to continue.

7. At the Ready To Generate eFile Log Report screen review settings and click "Finish" to generate report, use the "Back" button to go back and make changes if necessary. After clicking the "Finish" button the Administrator automatically prompts to preview the report.

17.1.2 Print Sessions

Print Sessions

A print session is any batch of records with a Printed or Filed print status.

See Print Status topic.

17.1.3 Printed Status

Printed Status - Shortcut

8966 Pro assigns a print status to all records. To determine a record's status go to the "Work with My Tax Forms" screen and refer to the Status column.

See Print Status Overview

Shortcut

8966 Pro includes a shortcut to assign "pending" records a "printed" status without actually printing the records (also referred to as a false print session).

To update records to a printed status

1. Follow the Print Wizard instructions through steps 1-7.

2. At step 8 select Preprinted forms as your paper type and do NOT select any copies to print.

3. Use the "Next" button to continue through the Print Wizard.

4. At the Print Summary screen, the Print Wizard warns that no copies have been selected to print. Click "OK" to proceed and click the "Print" button.

5. At the Are these forms ready to send to the IRS? screen select "I have printed and verified my red Copy A forms...". These records are assigned a printed status.
17.2 Print Status Overview

Print Status Overview

A print status is assigned to all records which determines its eligibility to participate in various processes. To determine a record's status go to the Work with My Tax Forms screen and refer to the Status column. Alternately, use the Form Counts Report to see all forms, sorted by filer, and their respective statuses.

Pending
All records begin with a Pending status. Only PENDING records may be modified.

Printed
Records receive a Printed status after selecting "I have printed and verified my red Copy A forms..." at the last step of the Print Wizard. These records are available for inclusion in a 1096 transmittal, Service Bureau Electronic Upload or IRS Magnetic Media file. To modify a Printed record first reset its print status to Pending.
- To reset the status for an individual record go to the Work With My Tax Forms screen, highlight the record, and click the "Change" button. At the Protected Form Update Options screen select "Reset to Pending".
- To reset the status for a print session, at the menu bar go to Reports > Tax Form Print Sessions > highlight the print session and click the "Reset (VOID) Session" button.

SB Print+Mail
Records receive SB Print+Mail status if included in a Service Bureau Printing and Mailing upload. These records are available for generating a 1096 transmittal, Service Bureau Electronic Upload or IRS Magnetic Media file. To modify a record with this status reset it to Pending status.
- To reset the status for an individual record go to the Work With My Tax Forms screen, highlight the record, and click the "Change" button. At the Protected Form Update Options screen select "Reset to Pending".
- To reset the status for a print session at the menu bar go to Reports > Service Bureau Upload Sessions > highlight the print session and click the "Reset (VOID) Session" button.

SB Filing
Records receive SB Filing status if included in a Service Bureau Electronic Upload file. To modify a record with this status reset the entire upload session to their original pre-upload status. Do NOT reset the upload session if you have already submitted the file to the 1099 Pro Service Bureau for processing (contact the Service Bureau for assistance).
- To reset the status at the menu bar go to IRS > File Electronically via 1099 Pro Service Bureau > highlight the upload session and click the "Reset (Void) Upload" button.

Filed Mag
Records receive Filed Mag status after inclusion in a magnetic media or electronic file.
- To reset the status go to menu bar go to IRS > Create IRS Electronic Files > highlight the magnetic media session and click the "Reset (Void) Session" button.

Filed 1096
Records receive Filed 1096 status after inclusion in a 1096 Transmittal.
- To reset the status at the menu bar go to Reports > Form 1096 Filing Session > highlight the print session and click the "Reset (Void) 1096" button.

Corr
Records receive Corr (corrected) status after processing a correction. Corrected records are further identified by their position in the print cycle. For example, Corr/Pending, Corr/Printed, Corr/1096, Corr/Mag, etc.

- To reset a corrected record with a pending status (Corr/Pending) go to the Work With My Tax Forms screen, double-click the record and click "Delete" at the Corrected Options screen. The record reverts to its pre-correction status. IMPORTANT: If there are any other corrected records associated with the record, they too must have a Pending print status prior to attempting the reset.
- To reset a corrected record with any other status, first reset it to Corr/Pending. The process for resetting a printed correction or filed correction is identical to the various procedures described above. Once the record has a Corr/Pending status delete it as normal.

**Deleted**
Records with a Pending status may be deleted. Deleted records are only visible at the Work With My Tax Forms screen if that setting has been enabled at the Preferences screen. Deleted records may be un-deleted in Corporate Suite only. See Delete a Record.

**Void/Unvoid**
Records are Voided, instead of deleted, to retain data for possible future reference. Only records with a Printed status can be voided. See Void Records.

* (Asterisk)
An asterisk indicates the record has errors and/or warnings associated with it.

**Shortcut**
8966 Pro includes a shortcut to assign "pending" records a "printed" status without actually printing the records (also referred to as a false print session).

**To update records to a printed status**
1. Follow the Print Wizard instructions through steps 1-7.
2. At step 8 select Preprinted forms as your paper type and do NOT select any copies to print.
3. Use the "Next" button to continue through the Print Wizard.
4. At the Print Summary screen, the Print Wizard warns that no copies have been selected to print. Click "OK" to proceed and click the "Print" button.
5. At the Are these forms ready to send to the IRS? screen select "I have printed and verified my red Copy A forms...". These records are assigned a printed status.

**17.3 Forms Status Values**

**Form Status Values**

Database values are useful for generating Custom Queries in 8966 Pro or in an SQL database.

In the Query Wizard select **Form Status Code** = Optional, form statuses to return, accepts an array of integers. The default returns all printed status forms. If an original 1099 form has a correction, only the latest correction is returned. This includes both parts of a 2-part correction, the zero correction and the new part. The original or new corrected values can be requested and both parts are returned. Corrected
W-2’s return the latest correction (W-2C) plus any superseded corrections and the original.

<table>
<thead>
<tr>
<th>ORIGINAL RECORDS</th>
<th>CORRECTION ZERO FORM (2-PART)</th>
<th>Correction (1-Part) / New Form (2-Part)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: Original Pending</td>
<td>10: Corrected Pending</td>
<td>20: Correction Pending</td>
</tr>
<tr>
<td>1: Original Printed</td>
<td>11: Corrected Printed</td>
<td>21: Correction Printed</td>
</tr>
<tr>
<td>2: Original Printed and Voided</td>
<td>12: Corrected Printed and Voided</td>
<td>22: Correction Printed and Voided</td>
</tr>
<tr>
<td>3: Original Printed and Filed Paper</td>
<td>13: Corrected Printed and Filed Paper</td>
<td>23: Correction Printed and Filed</td>
</tr>
<tr>
<td>4: Original Printed and e-Filed</td>
<td>14: Corrected Printed and e-Filed</td>
<td>24: Correction Printed and e-Filed</td>
</tr>
<tr>
<td>5: Original SB Printed</td>
<td>15: Corrected SB Printed</td>
<td>25: Correction SB Printed</td>
</tr>
<tr>
<td>6: Original Not Printed and e-Filed</td>
<td>16: Corrected Not Printed and e-Filed</td>
<td>26: Correction Not Printed and e-Filed</td>
</tr>
<tr>
<td>7: Original Not Printed and SB e-Filed</td>
<td>17: Corrected Not Printed and SB e-Filed</td>
<td>27: Correction Not Printed and SB e-Filed</td>
</tr>
<tr>
<td>8: Original SB Printed and SB e-Filed</td>
<td>18: Corrected SB Printed and SB e-Filed</td>
<td>28: Correction SB Printed and SB e-Filed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SPECIAL STATUS CODES</th>
<th></th>
</tr>
</thead>
</table>

**Error Status Values**

In the Query Wizard select **Error Status** = Optional.

0: No Errors
1: Warnings
2: Errors
3: Warnings + Errors
4: Fatal / Major Errors

## 18 Imports Overview

### Import Overview

8966 Pro features a powerful, intuitive Import Wizard to simplify the process of importing your data. Generally, users who can access their data in Excel (or a similar product) can import it! Importing delimited data is easiest, however users may also import Fixed Length files such as those created for the IRS. The Microsoft applications Excel, Access and SQL allow data to be saved in a .TXT format (see Converting Excel Formats); whereas older applications allow data to be saved in a .CSV (comma separated values) format.

**All 8966 Pro software installations include sample import files.** Users who review the sample import files and include our Header Records have great success with their imports! See Sample Import Files and Import File Conventions.

**Error and Validation Checking** is automatically performed on all imports; thereby allowing users the opportunity to find and fix any problem records before importing into the software.

- See Reset (Void) Import Session
Import Wizard Steps

Step 1: Importing Data - Begin the import process.

Step 2: Validating Data - Test data for errors and warnings.

Step 3: Post Results - Post imported data for access at the Work With My Tax Forms screen.

18.1 Import Data

Import Data

8966 Pro features a user-friendly Import Wizard to simplify the import routine. Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into 8966 Pro, thus relieving the burden of manually entering the information onto the tax form.

- Import Maps for a Delimited or Excel File Type
- Corporate Suite Users: Import Maps for Fixed Length Files

Please review Import File Conventions.

18.1.1 * SAMPLE IMPORT FILES *

Sample Import Files

All 8966 Pro software installations include sample import files (also referred to as XLS Data Shells). Users are strongly encouraged to review the sample import files included in our software and available, in a standard installation, at C:\1099 Pro\Pro66T17\Import\Sample_XLS Files. Users who review the sample import files and include our Header Records have great success with their imports!

Please review Import File Conventions.

For customers not interested in using our Header Records or for information on importing Delimited File Types, see Import Maps for a Delimited File Type, or Excel.

Instructions for an Easy Import

Users who review our sample import files PRIOR to creating theirs and include our exact Header Records (the respective field names) have great success with their imports. Follow these steps:

1. Access the Import folder, which in a standard installation is located at C:\1099 Pro\Pro66T17\Import.

2. In the Import folder, double-click on the Sample XLS Files folder to view all available sample import files. Select and open the appropriate sample file, for example, "8966 Pooled_Sample Import.xls", "8966 Not Pooled_Sample Import.xls" or "8966 NIL Reporting.xls".

3. Review the sample data and notice the formatting of the TINs, First and Last Names, Foreign Addresses, etc. Review Import File Conventions completely before proceeding. All Excel files contain a second worksheet with form specific guidance on the various fields and data requirements.
4. Copy the Header Records (the first row of data containing the respective field names) onto a new Excel sheet. Then copy your relevant data into the appropriate fields.
   - Do not place a blank row between the Header Records and the start of your data.
   - Do not edit the Header Record descriptions.
   - It is acceptable to delete columns, however doing so will trigger a warning during the import process.

5. Save this excel sheet as a **Text (Tab Delimited).TXT** file to maintain formatting. This file is ready to be imported into the software.

See **Import Wizard - Step 1: Importing Data**

### 18.1.2 Import Wizard

#### Import Wizard

8966 Pro simplifies the import process with our Import Wizard. The Import Wizard consists of three simple steps that may be done at once or at different times. Nothing is actually imported into the software until all three steps are completed.

- See **Create An Import File** - Please review PRIOR to using the Import Wizard.
- See **Import Session Summary Report**

#### Import Wizard Steps:

**Step 1: Importing Data** - Begin the import process.

**Step 2: Validating Data** - Allows the opportunity to test data for errors and warnings.

**Step 3: Post Results** - Post imported data for access at Work With My Tax Forms screen.

### 18.1.2.1 Manage Import Maps

#### Manage Import Maps

The Browse Screen for Import Map files lists the type of mapping and the file format used for each map. Additional details including Map Notes and Formatting Details are displayed in the Notes section.
To Add a New Map
1. Within the 8966 Pro Import Wizard click the "Add/Update Import Maps" button.
2. To add a new map click the "Add" button, select Delimited or Fixed Length as the map type, and follow the steps in the Import Map Wizard.

Change Existing Maps
Users can highlight an existing map on this screen and click "Change". Follow the steps on the screen and the wizard guides the user through the process of changing an existing map. Any changes made overwrite the current mappings.

To Delete Existing Map
1. Highlight the existing map to delete. The user is prompted to confirm their choice, click "OK".
2. An existing mapping cannot be deleted if it is tied to a current import/in-process import session. Any such imports must be completed or abandoned first and then the map can be deleted. Once deleted a map cannot be recovered.

View/Print Map Reports

18.1.2.1.1 Delimited or Excel Import Map Wizard

Delimited or Excel Import Map

The 8966 Pro Import Wizard simplifies the process of creating Import Maps so users can import their data into the 8966 Pro software. The first step in creating an Import Map is to specify how the records to import will be selected and where the records will be inserted into the tax form. Import files can be imported in a variety of formats, including delimited .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length, and Excel (XLS or XLSX). Follow the steps below to create and/or define an Import map.

☐ Remember, your 8966 Pro installation includes sample import files for automatic map-by-name imports!
Define Import Map Type
The Excel Import Wizard can be accessed during the Import Wizard process at the Select the Type of Data and Format Screen.

1. At the Select the Type of Data Format screen click the "Add/Update Form Import Maps" button.

2. At the Manage Form Import Maps screen click the "Add" (or "Change") button to access the Import Map Wizard. The Administrator prompts, "Which Type of Import Would You Like To Create?": select "Delimited" or "Excel".
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

3. At the Manage Form Import Wizard review onscreen information and click "Next" to proceed.

4. At the Define Overall Specifications for the Import File screen, the Mapping Form is determined by the type of tax form previously selected in the Import Wizard at the Select the Type of Data and Format to Use screen. To change the form type users must exit this wizard and return to the Import Wizard.

5. Check the "Has a Header Row" check box if appropriate. The header row in the spreadsheet has unique descriptive field names instead of user data.

6. At the Select the Sample Form File To Use screen browse for your file and click "Next" to proceed. A sample of the user's data file will display in the below box.

7. At the Map the Import Fields/Columns to Your Form screen, users can:
   - **Map by Name** - use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.
   - **Drag & Drop Fields** - manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. To cancel a match, drag from right to left or double-click on it.
   - **Assign Value** - assign a fixed value to the selected unmapped field. For example, for the Rcp TIN Type field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an identical recipient TIN type.

8. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
   - Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount. For example, "10000" = "100.00" in implied decimals. The use of the implied decimal format in delimited file formats is rare.
   - Define date field indicators.

9. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
   - **Matching Recipients with a TIN**
     - TIN plus Account Number
     - TIN plus Last Name (use only if account numbers are unavailable or inconsistent)
   - **Matching Recipients When TIN is Missing/Blank**
10. At the Specify a Name and Usage Notes for the Import Map screen enter a title of description for this map. Users can also add usage notes for further clarification. Click "Next" to continue.

11. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
   - Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
   - Users may optionally specify a default file name for the files that will be imported using this map.

12. CORPORATE SUITE ONLY: Processing Options for Tax Form Imports
   - Select the type of data processing to be applied when your import is performed and click "Next" to continue.
     - Standard: All forms are added as individual records regardless of whether other forms may exist in the system for the same recipient.
     - Transactional: If existing forms are found for a recipient that match the form matching rules configured at the time of import, the new information will update the existing record and be added as a transaction for that record. Non-matching forms are added as new.
     - Year To Date: Transactions are added to existing tax forms to reflect the new Year to Date (YTD) amounts and information. Existing forms that are not included in the YTD import will be flagged as zero-drop candidates if the zero-drop option is enabled.
     - Replacement: This feature is currently unavailable.

13. Lastly, review settings on the summary screen and if satisfied, click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to
create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

18.1.2.1.1 Map by Name Method

Map by Name Method

The Map by Name method is ideal for those import files incorporating 8966 Pro's unique import file Header Records and automatically maps all fields with matching names. Users are strongly encouraged to incorporate these Header Records from our sample import files. See Delimited or Excel Import Map.

Import files containing 8966 Pro Header Records automatically map during the import process. Some users may prefer to manually map by name and can reference the below instructions.

To Perform a Manual Map By Name
At the Map the Import Fields/Columns screen of the Import Wizard, use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.

When Mapping Street Addresses:
- Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
- Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.
- Drag all other fields as normal.

18.1.2.1.2 Drag & Drop Method

Drag & Drop Method

The Drag & Drop method is ideal for those import files containing unique header records or no header records. Users are strongly encouraged to incorporate Header Records from our sample import files. See Delimited or Excel Import Map.

At the Map the Import Fields/Columns screen of the Import Wizard, click on any field from the left column (Input Field Name) and drag it across to the corresponding field in the right column (Mapped Field Destination). Repeat process until all needed fields are assigned. If the wrong field is accidentally assigned, double-click the mapped field and the information is removed.

When Mapping Street Addresses:
- Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
- Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates
Address Lines 1 & 2 have merged for a successful mapping.

- Drag all other fields as normal.

18.1.2.1.2 Export Map Wizard

Export Map Wizard

8966 Pro allows users to customize the delimiters and data exported by generating unique export maps. Export maps are form specific and are saved as .TPS files.

☑ See Import Map Reports
☑ To export data files into an ASCII format see Export Wizard.

To Create Export Maps
1. The Excel Import Map Wizard is accessed via the menu bar select > Utilities > Export Tax Forms to ASCII Files.
   - This process is also available in the Import Wizard at the Select the Type of Data and Format screen via the "Add/Update Form Import Maps" button.

2. Review onscreen information and click "Next" to continue to the Select the Type of Data and Format screen. Then click the "Add or Update Export Maps" button.

3. At the Manage Export Maps screen highlight the map to edit and click the "Change" button. Default/built-in maps are not available for edits; however, they can be duplicated via the "Copy" button and the copied version can be edited. To add a new map click the "Add" button.
   - Export maps are defined by their Map Type, File Format (Delimited or Fixed), Status (Default or OK) and Description. The Description column gives details about the currently selected export map and the Notes windows provides additional details.

4. In the Export Map Wizard review onscreen information and click "Next" to continue.

5. At the Define File Format for Exported Information screen select the type of information to export:
   - Tax Form: One form type can be exported per map.
   - Recipients
   - Filers

6. Select the File Format, End of Record character, Field Delimiter and other options. Click "Next" to continue setting default field processing options—reference the below chart for useful information. Click on a checkbox or "radio button" to set options On or Off.

7. Select specific fields to include in the export process by double-clicking an available field from the left to automatically move it to the right. Alternately select a field and click the "Add Field" button. Repeat until all of the necessary fields have been added.
   - If the wrong field is accidentally assigned, highlight the incorrect field and click the "Remove" button.
   - Use the Up / Down arrows to change the order of a specific field in the list.
   - Customize the parameters of a mapped Field Header by double-clicking it.

8. At the Specify a Name and Usage Notes screen enter a brief title for the export map. Use the Map Usage Notes field to enter specific notes for future reference.
9. At the Set Options screen verify the default destination folder for the export file and change as necessary.

10. At the Ready to Generate Export File screen review settings and click "Finish" to generate export map. Return to the Manage Form Export Maps screen and close it. Now return to the Select the Type of Data and Format screen within the Export Wizard and select your newly created export map. Click "Continue" and complete the export process with the newly created export parameters.

<table>
<thead>
<tr>
<th>Category</th>
<th>Options Available</th>
<th>Additional Information and Details Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters</td>
<td>1. Convert to all UPPER case</td>
<td>Character values include Names, Address Fields, Descriptions...etc</td>
</tr>
<tr>
<td></td>
<td>2. Include Dollar Signs</td>
<td>None</td>
</tr>
<tr>
<td>Amounts</td>
<td>1. Include Commas</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Include Dollar Signs</td>
<td></td>
</tr>
<tr>
<td>Check Boxes</td>
<td>1. Blank for unchecked - &quot;X&quot; for checked</td>
<td>Check boxes are logical values: Yes/ No, True/False, On/Off</td>
</tr>
<tr>
<td></td>
<td>2. Use Y/N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Use T/F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Use 0/1</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>1. mm/dd/yy</td>
<td>Dates can be from a tax form box or for example when a form was created</td>
</tr>
<tr>
<td></td>
<td>2. mm/dd/yyyy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. yymmd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. yyyyymmdd</td>
<td></td>
</tr>
<tr>
<td>Numeric</td>
<td>1. Round to the nearest whole number</td>
<td>Numeric values are numbers that are NOT dollar amounts like percentages or total shares.</td>
</tr>
<tr>
<td>EIN / SSN</td>
<td>1. Formatted (TIN type not required)</td>
<td>EIN/SSN values are Tax ID numbers (TINs).</td>
</tr>
<tr>
<td></td>
<td>2. Unformatted (Must include the TIN type)</td>
<td></td>
</tr>
<tr>
<td>Text (Multi-line)</td>
<td>1. Convert to all UPPER case</td>
<td>Text values are multi-line box values such as a transaction description.</td>
</tr>
<tr>
<td></td>
<td>2. Don't convert CR/LF, export as is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Convert CR/LF to a single space</td>
<td></td>
</tr>
</tbody>
</table>

18.1.2.2 Custom Record Filter

Custom Record Filter

The features contained within this section are available exclusively to users of the Corporate Suite edition.

From the define import maps wizards, users can enter a value to filter records if an import file contains multiple form types. Any form that does not have the matching value entered on this window is skipped/
ignored.

For example, an import file might have record types ‘9I’ for 1099-INT and ‘9M’ for 1099-MISC records. Adding the "Filter: RecType" field to a map triggers filtering. Entering ‘9M’ in the window will cause the map to ignore the ‘9I’ records, etc. If the filter trigger field is added, a filter value must be added in order to save the map.

18.1.2.3 Customize a Fixed Field

Customize a Fixed Field

The features contained within this section are available exclusively to users of the Corporate Suite edition.

During the Import of Fixed Length files, users have the option to customize the field size of a mapped field.

To Customize a Field during Fixed Width Import
1. Select specific fields to be included in the import process and add them to your layout. Do this by clicking and highlighting a field from the available fields on the left and then click the "Add this field" button to carry the "Database Field" from the left column over to the "Field Value" screen on the right.

2. In the Field/Header list to the right, double-click on the field name until you see the "Customize a
mapped field" screen. The following chart explains the title of the field and its contents.

<table>
<thead>
<tr>
<th>Customize a Mapped Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Number: 13</td>
</tr>
<tr>
<td>Position From: 222 Through: 244</td>
</tr>
<tr>
<td>Field Size: 20</td>
</tr>
<tr>
<td>Mapped To: Rep Account</td>
</tr>
<tr>
<td>Field Value: Recipient account number</td>
</tr>
<tr>
<td>Process: (none)</td>
</tr>
</tbody>
</table>

**Field Number:** Field or Record Number (Equivalent to a column in an Excel spreadsheet).

**Position From - Through:** Location of the field value expressed in numeric positions from the first location to the last location.

**Field Size:** Total Number of characters form the first position to the last position of the field value.

**Mapped To:** Tax Form field that the Field Value is mapped or linked to.

**Field Value:** Title of the specific field.

**Process:** Allows users to enable specialized processing rules for the imported field.
- **If the field is empty, fill it with this:** Specify what should be entered into a field that is empty.
- **Removing leading/trailing characters:** Trim both leading or trailing characters from the imported field by a specified amount.
- **Changing the case of the imported value:** Force all characters to be either all upper or lower case for the imported field.
- **Adding fixed characters to the imported value:** Add characters to both the beginning or end of an imported field.
18.1.2.4 Modifying an Existing Import Map

Modify an Existing Import Map

Adding a header after import map creation for a custom import map with headers

1. Click on “Import New Tax Forms” from the left hand navigation menu.
2. Click on “Begin a new XXXX Import Process”.
3. Click “Next”.
4. Click on “Add/Update XXXX Import Maps”.
5. Select the import map that you would like to add the new header to.
6. Click on “Change”.
7. Click “Next”.
8. Click “Next”.
9. Click “Add”.
10. You will see two fields, one labeled “Mapped to Field” and one labeled “Field Name/Column”.

11. Enter the name of the header into “Field Name/Column”.

12. Drag the new header (Input Field Name/Column) to the “Mapped Import Field/Column Value” corresponding to the “Map to Field/Destination”. See the Map by Name section for more detail.
13. Once you are done, click "Next".
14. Please review all subsequent screens and click "Next" if they meet with your approval.
15. Click on "Finish".

Your import map will now be modified and the next time that you use this import map to bring in tax forms, it will also bring in the information located underneath the newly designated header.

Adding an import field after import map creation for a custom import map without headers.
(Fixed Position)
1. Click on “Import New Tax Forms” from the left hand navigation menu.
2. Click on "Begin a new XXXX Import Process".
3. Click "Next".
4. Click on “Add/Update XXX Import Maps”.
5. Select the import map that you would like to add the new import field to.
6. Click on "Change".
7. Click "Next".
8. Click "Next".
9. Select the Database(Form) Field on the left hand side that you wish to add. (Highlighted in yellow below)

10. Click “Add this Field” to move the Database Field over to your import map.
11. Use the Up and Down Arrows to move the Database(Form) field to match the column in your import file. Note: The column on the import map must match the column's location on the spreadsheet. In

12. Click on "Finish".

Your import map will now be modified and the next time that you use this import map to bring in tax forms, it will also bring in the information located underneath the newly designated header.
12. When you are done making changes/adding columns, click "Next".
13. Please review all subsequent screens and click "Next" if they meet with your approval.
14. You will see your new entry in the "Drag (map) Fields from here...", on the left side under the "Col" entry will be the column where the import map will be looking for the information to import on your spreadsheet.
15. It is very important that the column number that is listed in there matches the column number over from the left on your spreadsheet. For example, if it indicated that it will be the 6th column over on your new import map area, it must be the 6th column over on your spreadsheet.
16. Please review the information located in the right window that contains the "Map to Field/Destination", "Mapped Import Field/Column/Value" and "Col" columns.
17. If your information is correct, click on "Next".
18. Please review all subsequent screens and click "Next" if they meet with your approval.
19. Click on "Finish".

18.1.3 Step 1: Import Data, Filers or Recipients

Step 1: Import Data, Filers or Recipients

Importing of Recipients is available exclusively to users of the Corporate Suite edition.

Welcome to the first step of the Import Wizard. Users can import Data, Filers Only or Recipients Only (Corporate Suite feature) into the program; thereby eliminating the need to manually enter data and thus saving valuable time!

Prior to starting an import please consider:

- All programs include sample import files. In a standard installation they are located at C:1099 Pro \Pro66T17\ Import. Users are strongly encouraged to review the sample files and incorporate the Header Records to ensure a smooth import.
- If your data file includes leading zeros in TINs or ZIP codes save the file in Text (Tab Delimited) (.txt) format in Excel to preserve formatting.
- For detailed information on import file conventions please reference the online 1099 Pro WIKI.

Import Wizard—Step 1: Importing Data

Please visit https://www.1099pro.com/videos.asp and click the "Importing Using Standard Maps" video to watch a brief tutorial of the import process.

1. On the Preparing My Forms task panel click the "Import New Tax Forms" link.
Corporate Suite Users: At the menu bar select Utilities > Run the Import Wizard. User is prompted to select the type of form to import.

2. At the Start a New Import Process screen click the “Import Records From Excel or a Delimited Text File” button.
   Corporate Suite Users: At the Begin a New Import Session screen click the "Begin a New TY Import Process" button.

3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time to go back a step.
   Corporate Suite Users: Select the form series to import. For filer or recipient imports, make any selection.

4. Select the Type of Data and Format and then click "Next" to proceed. If working in a multi-user or network environment see Troubleshooting Import Issues below.

5. Select the type of tax form or "FILERS" for a filer only import, "RECIPIENTS" for a recipient only import (available in Corporate Suite Edition only).
   Indicate the Import File Format: Excel or Delimited
   If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See Manage Import Maps and the Delimited Import Map Wizard.
   Corporate Suite Users Only: If importing filers or recipients, select "FILERS" or "RECIPIENTS".

6. The Tax Forms Revisions Notice appears for any form type with new tax year changes. Checking the "I understand and agree" box cancels the reminder for future imports to this form type. Click "Next" to continue.

7. At the Select the File To Import screen browse for your file and click "Next" to continue.
   The selected file should appear in the display box; although the data may appear slightly askew.
   Data may NOT appear if 1) there is a blank row at the top of the import file, or 2) there is a blank row between the Header Row and the start of their data. Users should cancel the import and modify their import file accordingly.
   If data is based on a 8966 Pro sample import file and any columns or fields were manually deleted, users may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

8. Select the Filer for the Import. By default the forms import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

9. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapping. Use the "View Next" button to sort through actual records and see live data. Should your data contain any strange characters; see Import File Conventions. Users can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next' to continue.

10. Specify Import Status and click "Next" to continue. See Import Statuses.
    Pending - This default status allows users to edit, print and print records. Most users select Pending status.
    Filed - To indicate forms have been filed on paper with the IRS/SSA, e.g., Copy A and associated 1096 / W-3 / 1042 transmittal.
    Uploaded - To indicate forms have been sent to the 1099 Pro Service Bureau.
    E-Filed - To indicate forms have been printed and filed with the IRS/SSA.
11. At the Confirm, Text and/or Begin Import Process screen users can test their import file for potential errors or warnings. If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. Users may NOT edit errors and save changes at this screen. Click "Finish" if satisfied with the import file and are ready to proceed to Import Wizard - Step 2: Validating Data.

12. The Administrator prompts, "What do you want to do?"
   - 1 - Report: Select to review any warnings or errors in your import data and generate a report or correct them
   - interactively.
   - 2 - Continue: Select to proceed directly to Import Wizard—Step 2: Validating Data.
   - 3 - STOP: Select to return to the Import Wizard at a later time.

Troubleshooting Import Issues
When importing a Microsoft Excel text file users may encounter a problem when assigning fields at the Specify Form Field Mapping screen. If the software generates "0" records on the left side in the Available Input Fields column, this is due to the import file being "locked" in memory by Microsoft Excel—or similar application—across a network LAN or WAN. The user must force Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

If working locally on an individual computer (not on a network): First, close all instances of Microsoft Excel used to generate your text file for import. Rename the import file. Begin a new import process, starting with Step 1 above.

If working on a network with your import file residing on another computer (such as a workstation or server): Close all instances of Microsoft Excel used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. Rename the import file. Begin a new import process starting with Step 1 above. Verify with your Administrator you have the proper rights to carry out this task.

18.1.3.1 Import Status Options

Import Status Options

Users must select a print status for data imported via the Import Wizard. The imported records are termed a 'session'. Records in an import session with a Pending status are available for edits, printing, etc. Records in an import session with any other status can only be voided (deleted). Use the Import Session Report to review the status of records in an import session.

Pending Status
Forms in this import session can be changed, printed, reset or filed in any manner.

Filed = Filed Status
Forms in this import session have been printed and filed with the IRS/SSA on paper via 1096/W-3/1042 transmittal.

Uploaded = SB Filing Status
Forms in this import session have been uploaded to the Service Bureau for processing.
E-Filed = Filed Mag Status
Forms in this import session have been printed and electronically filed with the IRS/SSA.

18.1.3.2 Import Session Status

Import Session Status

All import sessions have a status to indicate its position in the import process (reference the Status column at the Completed and In-Process Import Sessions screen).

- **Loaded** The import file has been loaded, but not fully imported into the software. To complete the import process highlight the session and click the "Continue with Session" button.

- **Updated** This import file has been imported and at least one of the records has been opened and saved (edits to the form). Re-applying validation, etc., will also trigger this status.

- **Partial** Some records in the import file have been Imported and some are still in a Loaded status.

- **Imp/Disc** Some records in the import file have been Imported, others were deleted during the Post

- **Abandoned** All records for the log were abandoned, none imported.

- **Reset/Void** A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Printed or Filed) are NOT removed.

Users must select a print status for data imported via the Import Wizard. The imported records are termed a 'session'. Records in an import session with a Pending status are available for edits, printing, etc. Records in an import session with any other status can only be voided (deleted). Use the Import Session Report to review the status of records in an import session.

Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session. Use the Import Session Report to review the status of records in an import session.

Import Session Status Overview

- **Loaded**: Step 1 of the Nothing has been done to the entire import other than the initial load.
- **In Process**: Something has happened to logs (edit, posted, abandon, etc.), but there are still more records left.
- **Completed**: All logs either posted, abandoned or reset. Nothing left to do.
- **Discarded**: All logs abandoned or reset.
- **All Reset**: All logs were posted, then reset.

**Individual Logs (one per Filer) can have the following values:**

- **Loaded**: Nothing has been done to the records other than the initial load.
**Updated**: At least one of the records in import hold has been opened and saved, e.g., changes were possibly made. Re-applying validation, etc., will also trigger this status.

**Partial**: Some records were posted, some are still left.

**Imported**: All records were posted, processing completed.

**Imp/Disc**: Some records were posted, the rest were abandoned, so processing still completed.

**Abandoned**: All records for the log were abandoned, none imported.

**Reset/Void**: A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Printed or Filed) are NOT removed.

### 18.1.4 Step 2: Validate Data

**Step 2: Validate Data**

Welcome to Step 2 of the Import Wizard. At this screen users validate and check their data for any potential errors.

**Import Wizard — Step 2: Validating Data**

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and click the "Importing Using Standard Maps" video to watch a brief tutorial of the import process.

1. Click the "Test My Import for Problems" button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/ Fix selected record" to view data, however changes are not saved in test mode. This is an excellent opportunity to verify your data and go back and make any necessary changes to mappings, delimiters, etc. Click "Close" to exit this screen.

2. Decide how to proceed with the import:
   - If records need to be corrected or deleted click "Finish" and then "Report" to run a summary report detailing any errors or warnings. This report is not available once the import session is posted. Then proceed to the Edit, Post or Abandon Imported Records screen.
   - If NO records need to be corrected or deleted AND you want to proceed directly to the final step of the import routine, click "Finish" and then "Continue". At the Edit, Post or Abandon Imported Records screen click "Post Session". You immediately enter the Post Import Records wizard.
   - If NO records need to be corrected or deleted BUT you don't want to proceed to the final step of the import routine at this time, click "Finish" and then "Stop". Remember to return at some point to modify, delete or post this import session!

3. A standard installation of 8966 Pro allows up to 5,000 transactions. If the combined total of existing records in the database and imported records exceeds 5,000, the import may abort.
   - To handle more than 5,000 transactions contact Sales at (888) 776-1099.

Proceed to **Import Wizard—Step 3: Posting Results**.
18.1.4.1 Review Import Records

Review Import Records

The Edit, Post or Abandon Import Records screen allows users the opportunity to review individual import records PRIOR to posting them to the database. Users can change/edit or delete individual records OR abandon an entire import session. Users also have the opportunity to edit eligible import records post import via the Work With My Tax Forms screen.

See Errors and Warnings

To Review Import Records

1. Click the “Continue with Session” button at the Completed and In-Process Import Session window for any import session with a Loaded or Updated status, OR at the conclusion of the Import Wizard—Step 2: Validate Data, select “2 - Continue” as prompted by the Administrator.
   o During the Import Wizard—Step 1: Importing Data, users can click the “Test My Import File for Problems” button. This opens the Review Import Records screen in TEST mode strictly for the purpose of verifying field mappings. Changes made at this screen in TEST mode are not saved.

2. The Edit, Post or Abandon Import Records screen displays all import records contained in an import session.

<table>
<thead>
<tr>
<th>Primary Identifier</th>
<th>TIN. If TIN is not present then Last Name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Identifier</td>
<td>Last Name. If Last Name is not present OR used as Primary Identifier then the field is blank.</td>
</tr>
<tr>
<td>Status/Validation</td>
<td>OK = Record complies with business rule validations (no obvious problems). Errors = Record is imported BUT contains serious data flaws that may result in the record being rejected by the IRS/SSA. Err+Warn = Record is imported BUT contains possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA. <em>Reject</em> = Record is not imported unless corrected. Triggered by Missing Last/Company Name or non-allowed negative amounts. <strong>EDIT</strong> = Record is flagged in TEST mode; changes to record are not saved in TEST mode.</td>
</tr>
<tr>
<td>Error Messages (blank means no errors)</td>
<td></td>
</tr>
</tbody>
</table>

3. Double-click on any record to access the Update Records window.

<table>
<thead>
<tr>
<th>Data Field</th>
<th>The tax form specific fields; whether populated or not.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Value</td>
<td>Precise data values from the import file. For example, a raw value of &quot;750&quot; for a dollar amount box.</td>
</tr>
<tr>
<td>Import Value</td>
<td>Software imported data values. For example, an imported value of &quot;750.00&quot; for a dollar amount box—notice the dollar amount is auto-formatted during the import process.</td>
</tr>
<tr>
<td>Field Errors or Warnings</td>
<td>Lists any Reject errors including Missing Last/Company Name or non-allowed negative amounts. If the incorrect or missing data is corrected, the associated warning disappears after clicking the &quot;Save&quot; button.</td>
</tr>
</tbody>
</table>
4. Make edits in the corresponding Raw Value fields (double-click to open field) and then "Save" (see Image 1) to return to the main Edit, Post or Abandon Import Records screen. Notice that after data is corrected at the Update Records window, the Status/Validation and Error Messages columns automatically update to reflect changes.

![Image 1](image.png)

5. Users can continue to 1) "Change/Fix" selected records and/or 2) "Delete/Remove" selected records and then "Post the Session" to complete the import and bring eligible* records into 8966 Pro (see Import Wizard—Step 3: Posting Results). Alternately users can opt to "Abandon This Session" and discard all records in the import, regardless of their Status/Validation.

- Records imported and posted with errors have asterisks (*) prefixed to their status at the Work With My Tax Forms screen. For example, *Pending or *Filed.

18.1.5 Step 3: Final Import / Post Results

Step 3: Final Import / Post Results

Welcome to the final step the Import Wizard. At this screen users post their data into the software.

- Users importing very large import files should consider optimizing the post process.

Import Wizard - Step 3: Post Results

Posting Import Session

1. Open the Post Import Wizard via:
   - Continuing directly from the Import Wizard—Step 2: Validate Data and selecting "Post This Session", OR
   - At the Preparing My Forms task panel select the "Import New Tax Forms" link. At the Completed and In-Process Import Session screen select any import session with a Loaded or Partial status and click "Continue with Session" and then "Post This Session".

2. At the Post Import Wizard click "Next" to continue. At any time click "Back" to go back a step.
3. If any records in the session contain errors or warnings you must decide how to handle them. Options include:
   o **Do not post records with errors:** (Recommended!) Records without errors are posted and problem records are placed on "hold" so you can fix them at a later time.
   o **Post records with Warnings/Errors:** Post all records now. You'll need to review individual records and manually update these fields at a later time.

4. Specify how to deal with existing recipients in the 8966 Pro system. Options include:
   o Match forms with existing Recipients, but do not update addresses
   o Ignore existing TINs, add every Recipient as new
   o Update the incoming tax form with my current Recipient information
   o Update my Recipient information with new information from the tax forms (default selection)

5. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the Work With My Tax Forms screen.
   o See Import Session Summary Report
   o See Print Wizard

18.1.6 Reset (Void) Import Session

Reset/Void Import Session

What Happens When an Import Session Is Reset
When an import session is reset (voided), all tax forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as Pending and then some are updated to Printed or Filed Mag status, only the Pending records are deleted.

If this was a partial import and records have a Loaded status, users must use the “Continue with Session” button and then “Abandon the Session” to remove the session.

What Does NOT Happen When an Import Session Is Reset
Recipient records added or changed during the import session are NOT deleted or rolled back. To remove those recipient records refer to the Recipient Master List screen.

Reset/Void Import Session
Once an import session is reset/void it cannot be reversed.

1. On the Preparing My Forms task panel select the "Import New Tax Forms" link.
   o Corporate Suite Users: On the General Options task panel select the "Import Forms" link and select the appropriate form type to delete.

2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   o The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".
18.1.7 Country Codes Table

Country Codes Table

When adding or changing information in a tax form users have the option of setting the address type for the recipient address.

Address Type Options:
- USA
- Canada
- Other

If “Other” is selected the Select Country Code screen appears. The list of country codes are consistent with the list of codes on the IRS website at https://www.irs.gov/tax-professionals/e-file-providers-partners/foreign-country-code-listing-for-modernized-e-file. Select the appropriate code from the list then click the “select” button or click “cancel” to go back to the tax form screen.

18.1.8 Country Alias

Country Alias / Validation Options

8966 Pro supports custom country name and validation options during the import process. This is useful in situations where the code used for a particular country does not match the one used by the IRS. For example, if using "JPN" to denote Japan, an error would occur as the IRS country code for Japan is "JP". To correct this error, 8966 Pro allows users to create an alias for any country in the IRS database.

Using the above example:

1. On the initial import attempt, 8966 Pro generates an "Invalid Country" warning.
2. By double-clicking on the record it is determined that the country code "JPN" is invalid.

3. To correct this use the "County Alias/Validation Options". Click on the "Update Country Alias File" button to add "JPN" as an alias country code for Japan.

4. The Browse Country Alias/Translations screen lists any existing country alias. To create a new alias, click "Add".

5. At the Adding a Country Alias Record screen, in the top box enter the alias (or incoming value) and in the bottom box enter the name of the country or click on the ellipsis button for a complete list of IRS country names and codes. After entering both the alias and corresponding IRS country code, click "OK" to continue.

6. After configuring the alias, click the "Close" button on the Browse Country Alias/Translation window to return to the import wizard.

7. Click on the "Reapply Alias/Validation" button and 8966 Pro applies the new country code alias to your import data.
9. After clicking on the "Reapply Alias/Validation" button, the Administrator prompts how to apply your alias/translations. The alias can be applied to ALL records or only problem records.

![Administrator]

How would you like to apply the update?
- Only records with problems
  [faster but not as thorough]
- All records regardless of status
  [checks every record for problems]

10. Once the aliases/validations are applied, 8966 Pro can properly translate "JPN" to Japan or "JP" and the "Invalid Country" warning is removed.

### 18.1.9 Transactional Imports (CS Version Only)

#### Transactional Imports

The features contained within this section are available exclusively to users of the Corporate Suite edition.

A transactional import is an import which will allows users to aggregate (combine) data for a given recipient. Aggregation is the process where a recipient with multiple forms of the same type can have the total(s) of certain tax form fields added together to create one overall form which will continually display the total of the specified tax form fields. This is useful in situations when users need to combine, print and report on a single form the totaled amounts from multiple forms for a given recipient.

An important aspect of aggregation to understand is the criteria in which data is aggregated by. Transactional imports are unique in that they require two steps. The first step involves creating a recipient to import data into and the second step is the actual importing of data to be associated with the previously created recipient record.

**Recipient data can be added in 1 of 2 ways:**
- Manually add a recipient record: Enter the Master Employees List under the menu option General Options and manually create a new recipient record by pressing the Add button.
- Import recipient data: Enter the Import module by clicking on the "Utilities" tab on the main menu and then clicking on the "Run Import Wizard" option. Create a new map for importing recipient data and then use the map to import your recipient data.

**Once you have created your recipient data, you can proceed to import the transactional data:**
- Create a new map for your transactional data using the Import Wizard.
- Make sure that the correct TIN, Account Numbers and other associated data match the recipient information that you would like to import this data for.
- Import your transactional data using the map you created.
Important notes: Please see the following links to learn more about creating and using Delimited Import Maps and Fixed Width Import Maps. If you attempt to import transactional data without having added an associated recipient, the software will save the transactional data import until the recipient is added and the import can be posted. If you have the recipients list disabled during an import, the records that were imported will not be combined with future transactional imports. This is because there is no record kept of transaction being linked to a specific recipient when the recipient list has been disabled. To view a list of the current optional transactional items (criteria) to be used during aggregation, view transactional items. For help combining transactions with other versions of our program please see the Roll Up procedure.

18.1.10 Transactional Items (CS Version Only)

Transactional Items

The features contained within this section are available exclusively to users of the Corporate Suite edition.

Configurable Criteria

Form combining can be configured to use any single or combination of the following criteria to aggregate forms by:
- TIN
- Control Number
- Account
- Box 15 State
- Tax State
- Distribution Code
- Form Category
- Form Source
- Department
- Box 13 Retirement
- Box 13 Statutory
- Box 13 Sick Pay

To Set Criteria

1. At the menu bar click File > Security & Administration > Combining Tax Forms.

2. The Aggregation/Roll-Up Options screen indicates if aggregation is On or Off and for which forms, if any, are enabled for this functionality.

3. Select a tab for any enabled form to view Exceptions by Filer.

4. Click "Add" to add a new filer or highlight an existing filer with exceptions and click "Change".

5. The Form Aggregation Options screen displays two columns; the left column (Available Keys) contains a list of available matching criteria and the right column (Selected Keys) represents the items selected for matching.
   o Drag items from the left column to the right column to select aggregation fields.
   o Use the Up / Down buttons to change the order by which the criteria are matched. The order reads from top to bottom, with the top coming first.
   o See Setting Aggregation Rules
6. Once finished, click “Save/Apply Rule NOW” to save settings or “Cancel” to abort changes.

7. The software immediately aggregates (combines) forms based on the user selected fields.

**18.1.11 States Code Table**

**States Code Table**

When adding or changing information on a tax form, the Employees’ master list, or Employers’ master list, users have the option of selecting the State code via a list of state names and abbreviations. Users can right-click on an existing State field in a tax form or an entry screen and select from the list of states. The list that appears on the screen is determined by the Address Type you have selected. For Example: Choose an address type of USA and a list of states will appear. Select Canada to display a list of provinces. Other allows the user to select a country from the **Country Codes Table**.
18.2 Import File Conventions

Import File Conventions

For a smooth import please thoroughly review these conventions PRIOR to creating your import file. We highly encourage our users to review the sample import files that are included in our software and available, in a standard installation, at C:\1099 Pro\Pro66T17\Import\Sample_XLS Files. Users who review the sample import files and include our Header Records have great success with their imports!

☐ For additional form specific import file conventions please refer to the 1099 Pro Wiki site.

The order of data fields is not important and it is acceptable to have extra fields that won't be included in your import file (e.g., phone number, date of birth, etc.).

Fields in RED are required.

<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rcp TIN</td>
<td>Enter dashes in TINs to differentiate SSNs and EINS. Leave blank if TIN is missing or unknown.</td>
<td>11</td>
</tr>
<tr>
<td>Rcp TIN Type</td>
<td>This is a 8966 Pro internal code used to format TINs entered in the RCP TIN field without dashes. Definitions include: EIN=1, SSN=2, Unknown type=0 or blank</td>
<td>1</td>
</tr>
<tr>
<td>Rcp TIN Code</td>
<td>Required for Form 1042-S only. This is an IRS required code to differentiate TIN types. Definitions include: 0=No TIN Required, 1=SSN/ITIN, 2=Standard EIN, 3=QI/WP/WT-EIN,</td>
<td>1</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Rows</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Last Name / Company</td>
<td>Enter Company if Recipient TIN is an EIN. Enter Last Name if Recipient TIN is an SSN.</td>
<td>40</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter First Name only if Recipient TIN is an SSN. If Recipient TIN is an EIN, leave this field blank.</td>
<td>40</td>
</tr>
<tr>
<td>Name Line 2</td>
<td>Name line 2.</td>
<td>40</td>
</tr>
<tr>
<td>Address Type</td>
<td>Leave blank for US addresses. Enter &quot;C&quot; for Canada or &quot;O&quot; (not zero) for Other foreign countries. See Country Codes Table for more information. Please see Address Type Error below.</td>
<td>1</td>
</tr>
<tr>
<td>Address Deliv / Street</td>
<td>Recipient address line 1</td>
<td>40</td>
</tr>
<tr>
<td>Address Apt / Suite</td>
<td>Recipient address line 2</td>
<td>40</td>
</tr>
<tr>
<td>City</td>
<td>US/Canada enter City. Foreign addresses ONLY enter City, Country and Postal Codes.</td>
<td>40</td>
</tr>
<tr>
<td>State</td>
<td>US State or Canadian Province.</td>
<td>2</td>
</tr>
<tr>
<td>ZIP</td>
<td>US/Canada enter postal codes. For Canada the required format is letter-number-letter, a space, then number-letter-number. For example, &quot;C3H 4W9&quot; is a valid Canadian postal code. Foreign addresses enter postal codes in City field.</td>
<td>4</td>
</tr>
<tr>
<td>Country</td>
<td>Enter if Address Type is “O”. Please see Country Field below.</td>
<td>25</td>
</tr>
<tr>
<td>Rcp Account</td>
<td>Recipient Account Number. The Generate Account Wizard can auto populate field if required.</td>
<td>20</td>
</tr>
<tr>
<td>Rcp Email</td>
<td>Useful if you want the ability to e-mail forms (individually) to your recipients. See E-Mail Tax Forms.</td>
<td>2</td>
</tr>
</tbody>
</table>

**Additional Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkboxes</td>
<td>Use X / Y / T / 1 to mark a checkbox. Leave field blank or use N / F / 0 (zero) to NOT mark checkbox. Values are not case sensitive.</td>
<td>1</td>
</tr>
<tr>
<td>Dates</td>
<td>Use MM/DD/YYYY format only. Unacceptable formats include Jan 3, 2017 and January 3,2017.</td>
<td>1</td>
</tr>
<tr>
<td>Dollar Amounts</td>
<td>Do not use commas or dollar signs, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250.</td>
<td>1</td>
</tr>
</tbody>
</table>

**COUNTRY FIELD** - The following formats are acceptable to enter in this field:

- **A Country Name**: This is matched against the country file, and if a match is found, it assigns the proper country code to the form. (e.g., Japan)
- **An Alias for a Country Name**: If a match is found for an alias, it is converted to the proper country name. For example, setup "FR" as an alias for France. See Country Alias.
A Country Code: and optionally, one of the internal country key values for cases where there are multiple names associated with one code (e.g., 'UK' can be 'United Kingdom', 'England', 'Scotland', 'Wales', etc.). The format is a two character country code, a slash and then the country key (if any). The country file is arranged so that if there is no key being imported, it will use the most inclusive/generic country name. Examples: 'UK' translates to 'United Kingdom', as would 'UK/0' or 'UK/1' 'UK/2' = 'Great Britain' 'UK/3' = 'Northern Ireland' ... and so on. The country name may also be spelled out however the spelling must match what is displayed in the list of acceptable country names in the 1042-S Instructions listed on the IRS's website. For more information, refer to the Instructions for 1042-S from the IRS Website at http://www.irs.gov. The last few pages of the 1042-S form instructions have both the country name & country codes in the section entitled "Country Codes"

ADDRESS TYPE ERROR - Users may receive an error during import if there is a discrepancy between the Address Type and Country fields; for example, if an Address Type of "C" for Canada is entered with a Country Code of "JA" for Japan. Users should abandon their import and edit their data file to reflect the proper Address Type for the Country to resolve the error. There is also the option to manually correct the error upon importing and posting your data at the Enter, Update & View screen.

18.3 Import History

View History

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The Import Summary/History screen allows users to view a summary of the selected import session including the form type, import map, tax year, date and time of import, total number of records imported as well as the number of errors and warnings associated with the import session.

To View History

1. On the General Options task panel select "Import Forms".
2. At the Completed and In-Process Import Sessions screen highlight an import session to view its' history.
3. Click the "History" button.
Converting Excel Formats

Excel Spreadsheet Files
When saving data in Excel, use the 'Save As' method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select [TAB], [CR LF] and Double Quotes as your delimiters in the Import Wizard. .TAB files will not display at the "Open" screen in Excel unless "All Files (*.*)" is selected at the "Files of Type" field.

Comma Quote Delimited Files
In a database program such as Microsoft Access save your file in .CSV (Comma Separated Values) format. To import .CSV files select Double Quotes and Comma as your delimiters in the Import Wizard or the import will fail. Examples of acceptable .CSV file formats (note formatting of dollar amounts):

"Charlie","Tuna","100.00","555-55-5555","1525 Bruin Ave","Westwood","CA","90024"
"Charlie","Tuna",100.00,"555-55-5555","1525 Bruin Ave","Westwood","CA","90024"

Other Spreadsheet Files
In your program determine if files can be saved in .TXT (text) format. If difficulty is encountered, columns may be inserted between the existing columns and a "|" (pipe) may be entered as a delimiter. To import .TXT files select Pipe as your delimiter in the Import Wizard.
No Obvious Way to Create an Import File
If nothing else works, try printing your data to a file. A generic text driver that only prints text characters may be required. Import that file into a spreadsheet, parse the various columns and then import into 1099 Pro.

18.5 Delimiters

Delimiters

A Delimiter is defined as a character used to indicate the beginning and end of a data string. Delimiters can be commas, periods, tabs, spaces or quotes. Users must specify the delimiter for their import file. Upon correctly setting delimiters, each field of your header record should appear on a different line at the Import Data Delimiter screen. If your data displays in one long row or contains strange characters the wrong delimiter was used. Select the appropriate delimiter to correct this problem.

File Format Choices
- **Standard Tab Delimited**: Works with all .TAB sample import files and standard .TAB files.
- **Standard Comma Delimited (CSV)**: Works with comma separated value (CSV) files.
- **Pipe**: Works with pipe delimited "|" values.

18.6 Import Session Report

Import Session Summary Report

The Import Session Summary details all records in the selected import session.

To Generate Report
1. At the Preparing My Forms task panel select the "Import New Tax Forms" link.
2. At the Completed and In-Process Import Sessions screen highlight an import session and click the "Amount/Totals Report" button.
   - The "Amount/Totals Report" button is ghosted for any session with a status of Abandoned or Reset/Void.
3. The Report Options screen prompts to:
   - Select the Printer - consider printing to PDF to save paper
   - Select the Sort Order - by Last Name/First Name or by TIN
   - Preview before printing
   - Print Summary totals only
4. Click "OK" to generate the report or "Cancel" to exit the report.

See Reset/Void Import Session

18.7 Reset/Void Import Session

Reset/Void Import Session

What Happens When an Import Session Is Reset
When an import session is reset (voided), all tax forms associated with the import session are
deleted UNLESS their status has been changed since the original import. For example, if records are imported as *Pending* and then some are updated to *Printed* or *Filed Mag* status, only the *Pending* records are deleted.

If this was a partial import and records have a Loaded status, users must use the “Continue with Session” button and then “Abandon the Session” to remove the session.

**What Does NOT Happen When an Import Session Is Reset**
Recipient records added or changed during the import session are NOT deleted or rolled back. To remove those recipient records refer to the Recipient Master List screen.

**Reset/Void Import Session**
Once an import session is reset/void it cannot be reversed.

1. On the Preparing My Forms task panel select the “Import New Tax Forms” link.
   - **Corporate Suite Users:** On the General Options task panel select the “Import Forms” link and select the appropriate form type to delete.

2. At the Completed and In-Process Import Session screen highlight any session with a status of “Imported” or “Partial” and click the “Reset (Void) Session” button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to “Reset/Void”.

**18.8 Reject Imports**

**Reject Imports**

Records that contain certain errors are automatically rejected for import. Reject errors include:
- Missing Last Name and TIN
- Field contains non-allowed negative amounts

If the correct information is available, users should exit the Import Post Wizard and fix the record at the Edit, Post or Abandon Records screen. If the correct information is not available, users may proceed with the import. The rejected record is held at the Completed & In-Process Import Sessions screen and may be fixed at a later time.

For more information on Warnings, Errors and Reject Errors see [Error & Validation Checking](#).

**18.9 QuickBooks Import Wizard**

**QuickBooks™ Import Wizard**

1099 Pro allows users to import Form 1099-MISC data directly from QuickBooks.

Please note:
- Any QuickBooks version from 2008 onward is supported for the US, Canada, Australia and United
Kingdom.

- The QuickBooks Online Edition is NOT currently supported.
- 1099 Pro ONLY imports 1099-MISC data; no other form types may be imported via this wizard.
- See QuickBooks Troubleshooting below.

**QuickBooks Import**

1. On the **Preparing My Forms** task panel click the "Import New Tax Forms" link.

2. At the Start a New Import Session screen click the "Import records directly from QuickBooks" button.

3. At the QuickBooks Import Wizard screen review important information and click the "Next" button to start the process.
   - QuickBooks must be properly installed, configured, open and running on this computer. Users must have Administrative credentials for QuickBooks.
   - The company you want to import data from must already be open in QuickBooks.
   - If there is a discrepancy between the QuickBooks Recipient information and existing Recipient information, the existing record will be updated or overwritten to reflect the imported QuickBooks data.

4. At the Connect to QuickBooks screen click the "Connect to QuickBooks" button.

5. Switch to the QuickBooks software.

6. Select the following options when prompted:
   - "Yes, whenever this QuickBooks company file is open."
   - "Allow this application to access personal data such as Social Security Numbers and customer credit card information."

7. Choose an account with Administrator privileges.

8. After selecting the previous options, switch back to the 1099 Pro software and click the "Next" button.

9. Click on “Continue…”.

10. Click on “Done”. 1099 Pro will open and inform you if the connection was successful. Click on “OK” and then "Next”.

11. Click on “Select Filer” and choose the Filer where the 1099-MISC information from QuickBooks will be imported.

12. Verify the Filer you want is selected and click “Select” and then "Next”.

13. Click “Load QuickBooks Data Now”. Users receive a message indicating that “QuickBooks data successfully loaded”. Click “OK” and then "Next”.

14. Users are presented with a preview of all the information that will be imported from QuickBooks into the 1099 Pro software. Options Include:
   - **Skip forms with errors?**: Select this option to skip any records with errors (Note: There is an errors column noting imported records with errors).
**Imports Overview**

- **Skip forms with Warnings?**: Select this option to skip any records with errors (Note: There is a warnings column noting imported records with warnings).
- **Combine forms by TaxID**: Select this option to combine multiple tax forms with the same TaxID into one form.
- **Use Company Name?**: Select this option to import the companies’ vendor name when creating the form. If this is not selected, the vendor’s first name and last name will be used.

15. If information is acceptable click “Finish”.

16. Users can view a report of the imported forms by clicking on “Report” or click “Exit” from the administration warning screen.

17. After reviewing all imported information to go to the Work with my Tax Forms screen to view imported records.

---

**QuickBooks Troubleshooting**

Users who receive an error stating that the 1099 Pro software could not establish a connection to QuickBooks should follow the below process:

1. Click on the start button.
2. Right click on “Computer”.
3. Click on “Manage”.
4. Expand “Services and Applications”.
5. Click on “Services”.
6. Scroll down to QuickbooksDB21 and right-click on it.
7. Click “Properties”.
8. On the start up type drop down change it to “Automatic” and click ok.
9. Try connecting via the 1099 Pro software again.

---

**18.10 Microsoft Access 2007 Rollup Procedure**

**Microsoft Access Rollup Procedure for Microsoft Office 2007**

This procedure assists users with the process of aggregating information for multiple tax forms located on one spreadsheet and combining them onto one sheet. This process is useful when exporting information from multiple databases and several of them contain information for the same recipient. 1099 Pro, Inc. does not supply customers with Microsoft Office 2007 or Microsoft Access 2007. Users must have their tax form information in an Excel spreadsheet prior to beginning this tutorial.

- Corporate Suite includes built-in Tax Form Aggregation.

**To Aggregate Data**


2. Click on “Blank Database” and name the file. If necessary select an alternate location to save your database file.

3. In Access select the “External Data” tab and choose “Excel”.

4. Click on “Browse” to locate the Excel file to import. Verify the option “Import the source data into a
new table in the current database” is selected.

5. The user is presented with a screen displaying all data contained on the spreadsheet divided by columns. Users are STRONGLY encouraged to use Header Records for the columns in their Excel files. To do so, select the option “First Row Contains Column Headings”. Verify data and click the “Next” button to proceed.

6. As the user clicks “Next” through the Import Spreadsheet Wizard, they are prompted to choose which field will be used as a primary key; we recommend letting Access choose the primary key. Click “Next” to continue.

7. The user is prompted to name the table and click “Finish”.

8. Lastly, the user can save the import steps used to create this table. Mark the “Save Import Steps” checkbox, name the file file and click “Save Import”.

9. The user returns to the Access main screen. Select the "Table" and locate the newly created table in the left-hand pane. Double click the table to display its contents.

10. With the table open, right-click on the table name in the left-hand pane to display a drop down menu and select “Design View”.

11. The table displays three columns: Field Name, Data Type and Description. It is important to verify that the data is imported as the correct data type. All boxes to be aggregated must have “Number” as their Data Type; otherwise, errors will occur during aggregation.
   - Field Name contains Header Records.
   - Data Type indicates how Access stores the data. The Number field type stores only numerical data. The Text field type can store text or numerical characters.
   - Description (optional) is useful for internal notes and will not affect data in any way.
12. Click the “Create” tab and then the “Query Design” icon.

13. The Show Table window lists the newly created table. Highlight the table and click “Add” and then “Close” the window.

14. Drag and drop the Header Records from the query window into the “Field” columns on the bottom of the screen. Drag and drop each Header Record that should appear in the export.

15. Next, for every box area to be aggregated right-click your mouse and select the “Totals” area underneath the desired box and select “Sum”.

16. For all areas that should have their information combined, leave the “Totals” area at “Group by”. This will combine their fields, and this is what should be used for things like TIN, Address types, etc.

17. Once you are done, click on the “Run” icon.

18. If everything was entered correctly, you will be presented with a combination of all your matching forms as well as the totals for all the boxes where the prior information matched identically. If “Sum” was chosen for an area that could not be “Summed” (I.E. Form Category), you will receive the following error message:

19. Once that is done, you will be presented with a new object that contains all the information that you chose to aggregate.

20. You can now click on the “External Data” tab, and over the “Export” area, click on “Text File”.

21. It is not recommended that you select any of the options on this page. You will be given further options once you have clicked “OK”.

22. You will now see all your information in the “Sample Export Format” window. In addition to this, you will be given the option to save your text file as a “Delimited” or “Fixed Width”. It is recommended that
you choose “Delimited” file. Click “Next” to continue.

23. You will now be given the choice of what delimiter will be used. It is recommended that you use the “Tab” delimiter. Also select “Include Field Names on First Row” and change the “Text Quantifier” to “None”, and click “Next” to continue.

24. You will now be given the chance to name your file; it is suggested that you name the file that will easily identify it, and click “Finish”. If you plan on creating many of these types of files, it is recommended that you select the option to “Save Export Steps” and choose a name that will easily identify the delimited text file creation process.

19 Printing Overview

Printing Overview

Print Tax Forms The Print Wizard simplifies the printing routine. Users can opt to print to blank stock (i.e., the tax form and data print directly to blank paper) or preprinted laser forms. See Print Tax Forms Wizard

Quick-Print Quickly print an individual tax form using the Quick-Print feature at the Work With My Tax Forms screen. See Quick-Print

Print Status All records at the Work With My Tax Forms screen are assigned a print status that determine their eligibility for various processes—refer to the “Status” column. See Print Status

Margin Alignments Alignment adjustments can be made when printing to blank stock (plain copy paper). At the “Ready to Print” summary screen choosing Blank Stock as your paper type and then select Advanced Print Options.

Pre-Printed Forms Address Alignment The Print Wizard allows users to print a test alignment—and adjust margins accordingly—prior to printing forms. A test alignment to a blank sheet of paper is a smart way to minimize form waste. See Troubleshooting Margin Alignments

PCL Printing High-speed PCL printing is designed for printing thousands of forms. Contact Technical Support for details.

Reprint Records It is easy to reprint an individual record from a print session. See Quick-Print

Reprint Print Sessions It is easy to reprint an entire print session. See Reprinting Print Sessions

Reset Print Sessions Only print sessions with a Printed status can be reset. Resetting a session automatically resets ALL records to Pending status. To reset an individual record see Print Status. See Reset Print Sessions
This installation includes many useful IRS/SSA forms and instructions. Additionally, users with an active Internet connection can access current versions of these and other files directly from the IRS/SSA websites. See Printing Blank Forms

1099 Pro software prints to most Windows compatible printers, subject to the printer's margin limitations. Printers with a bottom margin greater than 1/3-inch may be unable to print data at the bottom of the page or may require printing two forms to a page. Check your printer's manual and/or Maximum Printable Area for your BubbleJet, Deskjet, Inkjet or Laserjet for exact printer specifications. See Trouble-Shooting Printer Issues

Use Form Session Limits for additional filtering options when printing forms. See Form Limits

Creating PDF files is fast and easy! 1099 Pro software allows users to e-mail or electronically transfer PDF files via the Internet. To protect sensitive data users may optionally password protect PDF files and save them to a location on their hard drive or network. See Initial PDF Options

Advanced Print Option allow users to shift the position of the Filer and Recipient Addresses either vertically or horizontally on a printed recipient copy and also force an "X" into the "Corrected" and VOID boxes on the form. These options are only available on Recipient copies (not Federal, Local, State or Filer copies). See Advanced Print Options

19.1 Advanced Print Options

Advanced Print Options allow users additional print functionality when printing recipient copies. Choices made at this screen are unique to the individual print run and must be reset for subsequent print runs.

Options Include:
- A brief, standardized message to be printed on all forms in this print run. Select from the available list or enter your own message of up to 30 characters.
- Force an "X" in the Corrected* box.
- Force an "X" in the Void* box (the Void box is available only on select forms).
- Print "0.00" instead of blanks for all zero amounts.
- TIN Masking On/Off
- Address/Envelope Offsets - Use to shift the position of the Filer and/or Recipient addresses up or down and left or right. Address adjustments are measured in hundredths of an inch from the DEFAULT placement. For example, a change of ".25" will shift address down or to the right 1/4-inch. Likewise, a change of ".-25" will shift address up or to the left 1/4-inch. As adjustments are made, the adjustment title turns RED if the value entered is too large. When finished click "OK" to save changes and return to the Print Wizard.

* Forcing an "X" in the Corrected or Void box does NOT constitute a valid correction or void a form. These boxes may only be checked on Recipient copies, not Federal, Local/State or Filer copies.
Related topics:
An Overview of Print Status
Print Wizard
Forcing An "X"
Using the Print Message Option

19.1.1 Inserting a Custom Print Message

Inserting a Custom Print Message

Why a Custom Message?
This is an optional feature allowing filers to provide a brief, custom message to recipients such as "Revised & Re-Issued" or "Corrected and Re-Issued" on the form. This provides additional information to the recipient as to what was done, for example a correction to an SSN or confirmation of an address change.

To Enter Custom Message / Force an "X"
1. "The Special Options for this run only" tab allows users to specify an optional message to be printed on all Recipient copies for the print run. For convenience, 8966 Pro provides the following built-in messages:
   - * Re-issued Form *
   - * Revised and Re-Issued *
   - * Corrected and Re-issued *
   - * Replacement Copy *
   - * Duplicate copy per request *
2. Users can also force an "X" to be printed in the corrected box for the form(s) by placing a check mark in this option. For the few recipient copies that have a VOID box on them (most forms don't), users can force an "X" to be printed in that box. Forcing an "X" in the either of these boxes does not create a valid correction.

19.1.2 Forcing an X

About Forcing an "X"

Why Force an 'X' in the Corrected Box?
Many users regard these revised, re-issued forms as a correction, and want to have the Corrected box checked to indicate to the Recipient that the new form has updated information on it. The Advanced Options allows users to force an "X" and thus help avoid confusion for the recipient. What's important to understand is that the IRS does NOT consider this a valid correction. Since the information has not yet been filed with the IRS/SSA, they neither know nor care how many versions of a form have been issued and/or reissued before they get the final information.

Regarding formal IRS corrections (i.e., a correction to information AFTER it has been submitted to the IRS), the IRS has very strict rules about which forms should have the Corrected and/or Void boxes checked. That's why the Advanced Options are only available for forms that go to the Recipient—send the IRS an original form with the Corrected box checked and it will probably be rejected.
To Enter Custom Message / Force an "X"
1. "The Special Options for this run only" tab allows users to specify an optional message to be printed on all Recipient copies for the print run. The following built-in messages are provided:
   - * Re-issued Form *
   - * Revised and Re-Issued *
   - * Corrected and Re-issued *
   - * Replacement Copy *
   - * Duplicate Copy per Request *
2. Users can also force an "X" to be printed in the corrected box for the form(s) by placing a check mark in this option. For the few recipient copies that have a VOID box on them (most forms don't), users can force an "X" to be printed in that box. Forcing an "X" in the either of these boxes does not create a valid correction nor void a form and is purely visual. These special options apply to the current print run only. For each subsequent print run these options must be set again.

See Advanced Print Options

19.2 Form Limits Overview

Form Selection Limits Overview

Form Selection Limits provide an extra filtering option when printing forms. For example, users may print a large batch of "Pending" forms and wish to further filter the forms to a specific geographic area.

To Use Form Selection Limits
1. On the Printing & Mailing task panel click the "Print/Mail Forms Myself" link.
2. At the Begin Printing IRS Approved Tax Forms Forms screen select as appropriate:
   - ALL Pending forms for the CURRENT filer
   - All Pending forms for ALL filers
   - Manually select forms for the CURRENT filer
   - ALL Pending forms for SELECTED filers
3. After making above selection check the "Show me the optional extra filters for limiting the number of records that will be selected" box and click the "Begin a New Print Process" button.
4. At the Form Selection Limits screen select:
   - General Filters including Address Type, States/Provinces and Zip Code ranges.
   - Amount Thresholds - check the box to skip any form(s) without dollar amounts.
   - Overall Maximum Record Limit - indicate the maximum number of records for this process.
5. Review settings and when satisfied, click the "Apply Filters" button to begin the Print Wizard.

19.3 PDF File Generation Overview

PDF File Generation Overview

What Is a PDF File?
PDF stands for Portable Document Format and is a distribution format developed by the Adobe Corporation to allow electronic information to be transferred between various types of computers. The software which allows this transfer is called Acrobat. In order to view and print a PDF file users must download and install a copy of the Adobe Acrobat Reader, available at Adobe. This utility may be
installed as either:
- A browser plug-in wherein PDF documents can be viewed directly in the browser window.
- A stand-alone program wherein PDF files can be downloaded and viewed separately.

**Why Generate a PDF Files?**
PDF files are a fast and easy method to e-mail or electronically transfer data via the Internet. Adobe Acrobat Reader is the preferred method of generating PDF files as it allows users to password protect PDF files and save them locally or on a network.

**PDF Security - Is It Safe to Email PDFs?**
8966 Pro offers the ability to both encrypt and password protect PDFs for security according to the Acrobat 5.0 standard. Encryption is commonly used to prevent unauthorized viewing, printing, editing, copying text from the document and doing annotations. Users can then control how they are used. The "Standard Security" encryption feature of the PDF Library has been enhanced to provide 128-bit encryption support.

[Click here to see the options available for PDF printing](#)

### 19.3.1 Initial PDF Options

#### PDF Print Options

Generating PDF documents enables your organization to optimize the delivery of professional-looking, compliant documents. This feature allows users to print reports or tax forms to an encrypted PDF file which can be password protected.

- To password protect *individual* tax forms for recipients see E-Mail Tax Forms.

**Generate Protected PDF Forms &/or Reports:**
Use the following procedure to print any document in 8966 Pro to an encrypted and/or password protected PDF file. Your system must have an available Adobe PDF printer.

1. At any print screen, use the "Change Selected Printer" button to access the Select Printer screen.
   - Alternately, at any Report Preview screen click the "Print to PDF Format" icon (see Image 1 below) to access the Select Printer screen. Additional features at this screen include the "Search" icon (blue binoculars) to search for characters on any of the pages in the document and the "Toggle Stay After Printing" icon (black pushpin) to keep the tax form or report preview on the screen.

   ![Image 1](#)

2. Select Adobe PDF as the printer and click the "Properties" button.
3. At the Adobe PDF Document Properties screen change the Adobe PDF Security drop menu setting to "Reconfirm Security for Each Job" and click the "Edit" button.
4. At the Adobe PDF - Security screen select "Encrypt All Document Contents" and select the "Require a Password to Open the Document" checkbox. Enter a password in "Document Open Password" field.
   - Additionally, users may select to restrict the editing and printing of the document.
5. Click "OK" to save settings. The system prompts to confirm password. Please make a note of
password; this is your internal password and 1099 Pro technical support cannot retrieve it for you.

6. For all future print runs with Adobe PDF as the selected printer, 8966 Pro automatically encrypts the
document and users may opt to check/uncheck the password protection as necessary.

19.4 Printing Blank Forms Overview

Printing Blank Forms Overview

Your 8966 Pro installation includes many useful IRS/SSA forms and instructions. Additionally, users
with an active internet connection can access current versions of these and other files directly from the
IRS/SSA websites. All documents are in PDF format and require Acrobat Reader to be viewed or printed.

See View & Print IRS Tax Forms & Instructions

19.4.1 Print IRS Form & Instructions

Print IRS Forms and Instructions

To View Local Files
1. On the Help & Extras task panel select "IRS Pubs & Links".
   o Corporate Suite Users: On the menu bar select Forms > IRS/SSA PDF Instructions and Blank
     Forms.
2. At the View or Print Blank Forms and Instructions screen set the Current View to "Local files
   installed on my machine".
3. Highlight a PDF document and click "View the Selected Form". The selected file opens
   automatically in Acrobat Reader.

To View Files on Internet
1. User must have an active Internet connection.
2. Follow the appropriate links provided at the Browse IRS Tax Forms help topic.

IMPORTANT: Copy A Forms and 1096 / W-3 Transmittals
The IRS requires most Copy A* forms and all 1096 and W-3 Transmittal sheets to be preprinted with a
special red ink that is invisible to their scanners. Do NOT send a black and white printout of any of
these forms as they will be rejected.

* Copy A for Forms W-2 and 1042-S can be printed directly to blank paper - the preprinted red ink form is not
required for these forms.

19.5 Email: Email Tax Forms

E-Mail Tax Forms

8966 Pro software allows users to email a password protected, PDF version of a "Combined for
Recipient" or "Pressure Seal/Alternate Combined Layout" version of the tax form.
1099 Pro software uses the default mailing client for your computer. Users without a default mailing client setup will be unable to send encrypted PDF documents to recipients through the 1099 Pro software. See No E-Mail Client Detected.

E-Mail Tax Forms
Tax forms are e-mailed individually to recipients.

1. At the Preparing My Forms task panel click the “Work With My Tax Forms” link.

2. At the Work With My Tax Forms screen highlight the recipient to e-mail a tax form to and click the “Email Tax Form” button.

3. At the E-Mail an Encrypted Tax Form screen complete all fields.
   - **Step 1: Set the E-Mail Address** - This field is auto-populated if the recipient's e-mail address was included in your import file (using the Rcp Email column header). Otherwise the field is blank and the e-mail address must be manually entered.
   - **Step 2: Encryption and Password Settings**
     - Encryption is by default set at AES 128-bit; a more secure setting requiring Adobe Acrobat 7 or higher. The encryption is how complex a file is transformed using an algorithm (called a cipher) to make it unreadable to anyone except those possessing special knowledge, usually referred to as a key. The higher the level of encryption used, the more difficult it will be for the wrong person to open should they attain the document. However, high levels of encryption also require more sophisticated software to open. Choosing too high a level of encryption may prevent your recipient from being able to open the document.
     - The default password is based on the first five digits of the recipient's TIN, a hyphen and the first five digits of their ZIP code. For example, 12322-99999. The recipient must enter this password before the tax form can be viewed. The following is automatically included in the body of the recipient's e-mail, "The password is the first 5 digits of your Taxpayer Identification Number (SSN or EIN), followed by a dash, followed by the first 5 digits of your mailing address zip code." Users may alternately enter a password of their own choosing.
   - **Step 3: Choose PDF Format**
     - Standard Combined (default)
     - Select a PS/ACL Layout - allows for the selection of an Alternate Combined Layout or Pressure Seal formats.
   - **Step 4: Advanced Print Options**
     - Force an X in the "Corrected" checkbox.
     - Force an X in the "Void" box (not available on all forms).
     - Print 0.00 instead of blanks for all zero amount fields.
     - Mask TINs
     - Enter optional message to print on all forms in this print run.

4. Extra Options (for advanced users only)
   - **Print Driver:** Use to select a different printer/driver.
   - **File Folder:** By default the encrypted PDF is placed in a PDF directory in the installation folder for the software. To choose an alternate location use this button.
   - **Preview PDF:** Check to preview the encrypted PDF before it is sent. The user password is required.

5. **Create PDF and email message:** Click button to generate the encrypted PDF and attach it to an email using your default email client.
19.6 Email: No Email Client

**Email: No E-Mail Client Detected**

Those users without a default email client setup, e.g., Microsoft Outlook, Mozilla Thunderbird, Gmail, will receive the below notice indicating where the PDF file will be saved, the email address it was going to, the subject line for the aforementioned email and the text.

![Image of email notification](image)

19.7 Assigning a Printed Status

**Assigning a Printed Status**

Select this option after printing and approving all copies of these records (including Copy A). These records are assigned a *printed* status and are now ready to generate a 1096/W-3 transmittal or electronic file.
19.8 Field Sizes

Field Sizes

Listed below are the maximum number of characters that will print in the respective field. In some fields, 8966 Pro may allow the entry of more characters than will actually print. The maximum printable characters is assumed numeric unless otherwise stated. Some field sizes are dependent on the selected address type; USA, Canada or Other (foreign, not Canada).

For form specific data fields please see Import Field Definitions and Data Types.

Filer Data
Location Code/Establishment No. = 4
Filer Name = 36
Filer Name 2 = 36
Address 1 = 36
Address 2 = 36
City = 21
State = 2
ZIP = 9
Department = 6
Contact Name = 24
Phone Number = 10
Extension = 5
RTN = 9
Fax Number = 10
E-Mail = 40

Recipient Data
If using an SSN:
First Name = 40
Last Name = 40
Name Line 2 = 40

If using an EIN:
Company = 40
Name Line 2 = 40

State ID Numbers
State Abbreviation = 2
State ID Number = 14
Recipient Data

If using an SSN:
First Name = 40*
Last Name = 40*
Name Line 2 = 40*

If using an EIN:
First name = 40
Company = 40
Name Line 2 = 40

**USA Address Type**
Address = 40
Address 2 = 40
City = 21
State = 2
ZIP = 9

**Canadian Address Type**
Address = 40
Address 2 = 40
City = 21**
Province = 2
Postal = 6 (plus 1 space)

**Other Address Type**
Delivery/St. = 40
Other/loc. = 40
City/Postal = 40
E-Mail = 40
Account Number = 20

**Optional Grouping Fields for Querying**
Form Source = 12
Category = 6

*Note: The First & Last Name fields print a combined maximum of 37 characters (plus one space) UNLESS the Last Name field contains 24 or more characters AND the First Name field contains 14 or more characters; then the First Name field prints only 1 character regardless of actual characters in that field. If there are 20 or more characters in the City field, "Canada" is automatically truncated to "Cana".*

19.9 Margin Alignments

**Margin Alignments**

**Alignment Adjustments when printing to Blank Stock**
Alignment adjustments can be made when printing to blank stock. After choosing blank stock you can
select Advanced Print Options at the “Ready to Print” summary screen.

Pre-Printed Forms Address Alignment
The Print Wizard offers the opportunity to print a test alignment, and adjust margins accordingly, prior to 
printing your forms. A test alignment to a blank sheet of paper is a smart way to minimize form waste. 
Test alignments print the characters "X" and "9" instead of your actual data. Your data will print 
(assuming the software is registered) at the last step of the Print Wizard.

To Test Alignment
Initiate the Print Wizard; it automatically prompts to print a test alignment prior to printing your forms*.

- When selecting preprinted laser as the paper type, the user is prompted to test alignment after selecting the copies to print. For the first test print do not modify the default Top and Left margin settings. Print the test to blank paper and then hold it and a preprinted form to the light to determine if data fits into the appropriate boxes. If data does not align refer to “Alignment Adjustments” below.

Alignment Adjustments
Alignment adjustments are measured in hundredths of an inch from the default margin. For example, 
"0.25" would effect an adjustment of ¼-inch. Once a margin is adjusted, it becomes a default setting for that form type until the margin is adjusted again.

Top Margin
Positive numbers (e.g., "0.25") move the data lower on the page. Negative numbers (e.g., "-0.25") raise the data higher on the page.

Left Margin
Positive numbers (e.g., "0.25") move the data to the right. Negative numbers (e.g., "-0.25") move the data to the left.

Review Margin Limitations

19.10 PCL Printing

PCL Printing

Please contact Technical Support for more information about this feature.

High-speed PCL printing is designed for printing thousands of forms. In order to provide an efficient and 
effective way to control printer features across many different printing devices, HP created PCL. PCL was 
originally conceived and devised for HP's dot matrix and Inkjet printers. The first printer in HP's LaserJet 
series, the HP LaserJet was released in 1984 with the PCL 3 version of the language.

PCL commands are compact escape sequence codes that are embedded in the print job before being 
sent to the printer. Issuance of the sequence was relatively easy from any high level language or form 
assembler. HP PCL formatters and fonts were designed to quickly translate application output into high-
quality, device-specific, raster print images. The PCL printer language is common to virtually all HP
printers, but not universal and not always backward compatible. This conceptual thinking enabled HP to
minimize printer support problems and protect HP printer investment in applications and printer driver
software. It is why the HP laser printers quickly became the industry standard.

The PCL printer language is successful because the following points remain consistent across
all levels:
1. All HP LaserJet series printers implement PCL printer language features consistently.
2. HP printers implement the PCL feature in very cost-effective formatters.
3. HP printers have the ability to ignore most unsupported commands without causing the printer or
issuing device to crash.

There are six major levels of PCL. The creation of these levels was driven by the combination of printer
technology developments, changing user needs and application software improvements. The first
versions of PCL (PCL 1 and 2) were used in HP impact and Inkjet printers in the early 1980s. The major
phases of the PCL printer language are as follows:

PCL 1 This version is supported by all HP LaserJet series printers (except the HP LaserJet 3100 and
3150 series products). It provided very basic printing and spacing functionality, but was limited to only
text printing and ASCII characters. PCL 1 is the foundational base set of functions provided for simple,
single-user workstation output. It was created in the late 1970s and introduced in the late 70s and early
80s.

PCL 2 As was PCL 1, this version is supported by all HP LaserJet series printers (except the HP
LaserJet 3100 and 3150 series products). Hence it covered all PCL functionality and provided Electronic
Data Processing/Transaction functionality. Functions were added for general purpose, multi-user system
printing, but still in ASCII printing only. It was introduced in the early part of 1982.

PCL 3 This was the first of the intelligent series of efforts by HP to incorporate graphics, crude as they
were back then. It was the embedded code for the original HP LaserJet series printer, and the HP
LaserJet Plus series printer. This version provided the commands and features required for simple high
quality word processing and data printing. Allowed for the use of a limited number of bitmapped fonts and
graphics. It quickly rose to the position of industry standard and PCL 3 was widely imitated by other
printer manufacturers, commonly referred to as "LaserJet Plus Emulation" when used by other
companies. It came out in 1984.

PCL 4 This industry standard release was the embedded code for the HP LaserJet Series II, commonly
referred to as the workhorse laser, the HP LaserJet IID, HP LaserJet IIP, and HP LaserJet IIP Plus. It had
a host of new page printing capabilities, including support for macros, larger bitmapped fonts and
graphics. Introduced in 1985, it was the most radical of version improvements and would be more than
sufficient for users for several years.

PCL 5 As the foundation of the HP LaserJet III, HP LaserJet IIIID, HP LaserJet IIP, and HP LaserJet IISISI,
PCL 5 provided ultimate office publishing functionality. It was released to allow compatibility for industry
acceptance for font scaling, outline fonts and HP-GL/2 (vector) graphics. PCL 5 was designed for more
complex desktop publishing, graphic design, and presentation applications. Introduced in mid-1990 with
the HP LaserJet III, this is the most widely used version of PCL compatibility in use by customers.

PCL 5E (Enhanced) Though it was labeled an enhancement to PCL 5, it was the internal code released
HP LaserJet 8000 series, HP LaserJet 9000 series printers. It had major improvements and changes
including bidirectional communication between the printer and the PC. It featured a wider selection of fonts for use primarily with the Microsoft Windows environment and applications.


**PCL 6** This version offered significant changes in the backward compatibility issue for HP. PCL6 is very different from PCL5 and previous PCL versions. One significant difference is the manner in which the commands are sent to the printer. The target was performance and reliability; the jury is still out on the question of better. Prior to PCL 6, each new version of the language included commands not found in older versions as well as the older PCL commands. As a result, printers with more recent versions of PCL are backwards compatible with software that supports older versions of the language. PCL 6 was released with the HP LaserJet 4000 series, HP LaserJet 4100 series, HP LaserJet 2100 series, HP LaserJet 2200 series, HP LaserJet 1200, HP LaserJet 3200, HP LaserJet 3300, HP LaserJet 4200 series, HP LaserJet 4300 series, HP LaserJet 5000 series, HP LaserJet 5100 series, HP LaserJet 8000 series and HP LaserJet 9000 series printers. PCL 6 features new modular architecture that can be easily modified for future HP printers. The efforts for faster, post printing return to application have made somewhat of a problem with older operating systems. Other performance efforts are faster printing of complex graphics, more efficient data streams for reduced network traffic, better WYSIWYG printing, improved print quality, truer document fidelity, and complete backward compatibility. The compatibility issues have caused many users to select PCL 5 as the language version.

The PCL printer commands activate the printer features. By design, HP provided four general types of HP printer language commands. Control codes, PCL commands, HP-GL/2 commands and PJL commands. A control code is a character that initiates a printer function (for example, Carriage Return (CR), Line Feed (LF), Form Feed (FF), etc.).

PCL commands provide access to the printer's PCL control structure. The PCL structure controls all of the printer's features except those used for vector graphics, which are controlled by the HP-GL/2 commands. PCL commands (other than single-character control codes) are also referred to as "escape sequences." That design provided very easy use from high level programming languages and in reality, made the PCL the industry standard. The terms are used interchangeably. Once a PCL command sets a feature of the printer that feature remains set until that PCL command is repeated with a new value, or the printer is reset to default. In other words you turn on the feature and then turn it off.

**HP-GL/2** (vector graphic) commands are two letter codes that represent the function of the command (such as IN for initialize). After the two-letter mnemonic, there may be one or more parameters that identify details of how to process the command.

HP made great efforts to yield an ease on selecting feature and capabilities in the PCL designs and procedures. That ease rewarded HP with the popularity that is second to none in the industry for laser printers. They have been active in creating other printer languages and utilities as well, such as PJL, a JCL type language and utility.

### 19.11 Print Session Report

**Print Session Report**
The Print Session report summarizes all records in a selected print session. Details include recipient name, TIN, address, account number, individual box amounts and the record's print status.

**To Generate Report**
1. On the **Printing & Mailing** task panel select "Print/Mail Forms Myself". Use the Current Form drop down menu to change the form type to process as needed.
2. At the Completed Print Session List highlight a print session and click the "View/Print Session Report" button. Click "Yes" to preview the report.

### 19.12 Printing Tax Forms Wizard

#### Print Wizard

**Print Tax Forms Wizard**

The Print Wizard simplifies the process of printing tax forms. Any form with a **Pending** print status (or **Corr/Pending** for corrected forms) is available for selection in this wizard. Forms with any other print status may be printed individually via Quick-Print or in batch via Group Actions.

- See [Printing and Mailing via the Service Bureau](#)

#### Print Forms Via Print Wizard

1. At the **Printing & Mailing** task panel click the "Print/Mail Forms Myself" link.
   - **Corporate Suite Users:** At the **Forms & Printing** task panel click the "Print Tax Forms" link. Use the Tax Year and Current Form drop menus to select the appropriate year and form.

2. At the Print Forms for Recipients and the IRS screen refer to the Begin Printing IRS Approved Tax Forms section. Choose the method for selecting the pending forms to print.
   - All Pending forms for the CURRENT filer (default)
   - All Pending forms for ALL Filers
   - ALL Pending forms for SELECTED Filers
   - Manually select forms for the CURRENT filer

3. **Set Form Selection Limits:** Check the "Show Me the Optional Extra Filters" box to limit the number of records that will be selected. Records may be filtered by Address Type for specific print runs.

4. **Corrections:** Check the "Process and Print Corrected Forms Instead of Originals" box. This box is only available if there are corrected forms for the currently selected form type. See [About Corrections](#).

5. Click the "Begin a New Print Process" button to access the Print Wizard.
   - **Corporate Suite Users:** Click the "Begin Print Process" button to access the Print Wizard or the "Custom Print Process" button to generate customized print statements.

6. **Confirm Processing:** This screen is triggered only if any records in the print run have errors or warnings. **Filing records with missing or invalid data may result in the record being rejected by the IRS.** If your data contains no errors or warnings this screen will not appear. Users may choose to:
   - Yes - Print the Forms Anyway
   - No - Skip These Forms For Now
7. The Print Wizard displays the number of recipients selected for printing. To verify recipients, amounts, or other information users are encouraged to first run a Control Totals report. To proceed with the Print Wizard click "Next". Use the "Back" button at any time to go back a step.

8. Select Printer and Paper Type and then click "Next" to continue.

9. Review the selected printer and change if necessary.
   - Choose your paper type:
     - Preprinted laser forms: Including IRS red Copy A forms
     - Blank stock forms: Select to use the Combined Print option (at the next screen) which prints all recipient copies and instructions directly to blank paper.
     - Pressure Seal/Alternate Combined Layouts: Some form types offer unique print layouts. For example, 1042-S has an alternate layout to allow additional characters in the recipient name fields.

10. Select copies to print. Multiple copies may be selected; user is prompted to load preprinted forms into the printer as required.
    - Review how to Safeguard TINs.

11. Verify Print Alignment (preprinted forms only): Users are highly encouraged to print a test alignment to BLANK paper prior to inserting preprinted forms to minimize waste. After printing a test alignment page to blank paper, hold it up to the light behind the preprinted form. Adjust margins as necessary. When satisfied, click "Next" to continue.
    - Adjustments: Are measured in hundredths of an inch, e.g. "0.25" will shift the margin 1/4-inch.
      - Top Margin: Positive numbers move the data down, negative numbers move data up.
      - Left Margin: Positive numbers move the data right, negative numbers move data left.

12. Select a sort order to print forms:
    - By Last Name/Company Name (default)
    - By TIN
    - By Zip Code (use to pre-sort mailings for the post office)
    - By State Abbreviation
    - By Account Number, then Last Name
    - Additionally, check the "Within Each Selected Copy, Keep All Forms For Each Filer Grouped" box as appropriate.


14. Indicate preview preference:
    - Ask me before processing each copy (default)
    - Yes, preview each selected copy type without asking me
    - No, send the forms directly to the printer without previewing them

15. Review print summary and advanced print options. When ready to proceed click "Print". The Print Wizard pauses before printing each copy and prompts the user to load the appropriate form into the printer.
    - FALSE PRINT: To change a record's print status from Pending to Printed WITHOUT printing any forms do NOT select any copies to print. The Administrator prompts to press the "Print" button.

16. Indicate if forms are ready to send to the IRS/SSA:
o **NO - I haven't printed my finalized or red Copy A yet.** These forms continue to have a *Pending* status and are available for further edits at the Work With My Tax Forms screen.

o **YES - I have verified and/or printed my finalized Copies or red Copy A forms.** These forms are assigned a *Printed* status and are no longer available for edits. These forms are ready to transmit to the IRS via electronic filing or on a 1096 transmittal.

17. Click "Finish" to exit the Print Wizard.

### 19.13 Puerto Rico Compliant Tax Forms (CS Version Only)

**Puerto Rico Compliant Tax Forms**

The features contained within this section are available exclusively to users of the Corporate Suite edition.

1099 Pro Corporate Suite (CS) software supports enhanced Puerto Rico form printing from both the desktop and ASP web interface.

This section of the help file will assist you with printing tax forms that are acceptable in Puerto Rico. This feature is accessible in either the “Quick-Print” or “Print tax forms” sections of the software. Additionally, Puerto Rico compliant tax forms can also be printed from our ASP interface, specifically via the quick print function in the software. Please see the section of the help file entitled, “For Puerto Rico Printing via the ASP web interface”, for more information.

The following information is for Corporate Suite only. Please see below for instructions on printing Puerto Rico forms.

These steps are to be used when you are asked to select what type of paper to use in either the "Quick Print" or "Print tax forms screen". To Print 1099-R's on approved Puerto Rico forms in the CS software:

1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to “Select the type of paper you want to print on”.
2. Click on "Puerto Rico 480.7C”.
3. Click the "Select" button.
4. Click the "Print Now" button.

Since there are multiple pages required for a Puerto Rico 1099-R compatible printout (6 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 1099-Int’s on approved Puerto Rico forms:

1. Select “Pressure Seal/ACL” when asked to “Select the type of paper you want to print on”.
2. Click “Puerto Rico 480.7A No PR Tax W/H” to print 1099-Int Puerto Rico forms without Tax withheld for Puerto Rico, or Select “Puerto Rico 480.7A PR Tax W/H” to print 1099-Int Puerto Rico forms with Tax withheld for Puerto Rico.
3. Click the "Print Now" button.

Since there are multiple pages required for a Puerto Rico printout (4 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 1099-MISC's on approved Puerto Rico forms:

1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to “Select the type of paper you want to print on”.
   - Select “Puerto Rico 480.6A Corp/Partners” to print 1099-Misc Copy A Puerto Rico forms for Corporations or Partnerships.
   - Select “Puerto Rico 480.6B Corp/Partners” to print 1099-Misc Copy B Puerto Rico forms for Corporations or Partnerships.
   - Select “Puerto Rico 480.6A Individuals” to print 1099-Misc Copy A Puerto Rico forms for Individuals.
   - Select “Puerto Rico 480.6B Individuals” to print 1099-Misc Copy B Puerto Rico forms for Individuals.
2. Click "Select".
3. When you are done selecting the type of form you want to print, click "Print Now".

Note: Since there are multiple pages required for a Puerto Rico printout (4 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can create a template for the address information to be displayed properly with other envelopes.
To Print 5498’s on approved Puerto Rico forms:

1. From either the "Quick Print" screen or the "Print Tax Forms" screen, select “Pressure Seal/ACL” when asked to “Select the type of paper you want to print on”.
2. Click "Puerto Rico 480.7”.
3. Click "Print Now”.

Since there are multiple pages required for a Puerto Rico printout (6 pages per recipient), it is recommended that you put the printer in duplex mode before printing. Currently address information is spaced to fit into an 8888-1 envelope. If needed 1099 Pro can setup a template for the address information to be displayed properly with other envelopes.
For Puerto Rico Printing via the ASP web interface.
The 1099-R, 1099-Misc, 1099-INT or 5498 Puerto Rico tax form can be printed using the "Quick Print" option in the ASP interface.
1. Click on the record that needs to be printed.
2. Click on the "Quick Print" button on the bottom left corner of your screen.
3. Make sure the box to the left of the "Use Puerto Rico 480.x format instead of US format" is checked.

The filing state on the record being printed must be Puerto Rico otherwise the following option will not appear:
- Click the printed form type that you would like and click "Print Now" button to begin the print process.

19.14 Quick-Print Individual Record

Quick-Print

8966 Pro makes it easy to quickly print an individual form using the Quick-Print feature. Please visit https://www.1099pro.com/videos.asp and watch the "Using Quick-Print" video for a brief tutorial on this process.

To reprint a group of forms, regardless of print status, please see Group Actions.
To reprint an entire print session, as opposed to an individual form, see Reprint Print Session.

To Quick-Print a Form
1. At the **Preparing My Forms** task panel select the "Work With My Tax Forms" link. Use the Current Form drop menu to select the form type to print.
   - **Corporate Suite Users:** At the **Forms & Printing** task panel select the Browse, Enter & Edit link. Use the Current Form drop menu to select the form type and Current Year to select the tax year.

2. Highlight an existing record and click the "Quick-Print Form" button to access the Print Options screen.

3. Select the printer to use.

4. Select the type of paper:
   - **Preprinted forms** - including IRS/SSA red copy A. Adjust margin alignment as necessary.
   - **Blank stock** - print the form and data directly to blank paper.
   - **Pressure Seal/Alternate Combined Layout (ACL)**

5. Select the copies to print. Available options are determined by type of paper selected in previous step.
   - Combined Recipient Copies is a smart choice to print all required recipient copies and instructions on a single page. Must select Blank Stock as paper type in previous step.

6. Indicate your preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them

7. Select the sort order to print forms (this field is ghosted if the print session contains only one record):
   - By Last Name/Company Name (default)
   - By TIN/Name/Account
   - By Zip Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account/Name

8. Advanced Options are only available for Recipient copies. Settings apply to all forms in this print run only. Options include:
   - Include a brief, standardized message on all forms
   - Force an "X" in the Corrected box on all forms. **IMPORTANT:** Forcing an "X" does not create a valid correction.
   - Force an "X" in the Void box. Most forms do NOT have a Void box. **IMPORTANT:** Forcing an "X" does not void a form.
   - Force "0.00" instead of blanks for all zero amounts
   - Modify **TIN Masking** settings

9. Click the "Print Now" button to print or "Cancel" to exit the screen.

## 19.15 Reprint Print Sessions

**Reprint Print Sessions**
8966 Pro makes it easy to reprint a print session.

**To Reprint a Print Session**

1. On the **Printing & Mailing task panel** select the "Print/Mail Forms Myself" link. Use the Current Form drop menu to select the form type to process.
2. At the Completed Print Sessions screen highlight a print session and click the "Reprint Session" button.
3. At the Print Options screen select the paper type: **Preprinted forms**, or **Blank stock**
   o If selecting pre-printed forms, adjust **margin alignment** as necessary.
4. Indicate your preview preference:
   o Ask me before processing each copy (default)
   o Yes, preview each selected copy type without asking me
   o No, send the forms directly to the printer without previewing them
5. Select the sort order to print forms (this field is unavailable if the print session contains only one record):
   o By Last Name/Company Name (default)
   o By TIN
   o By Zip Code (use to pre-sort mailings for the post office)
   o By State Abbreviation
6. Enter a brief, optional message to print in the upper right corner of the form(s).
7. When satisfied with all entries click the "Print Now" button. Click "Close" to exit this screen.

To reprint an individual record, as opposed to an entire print session, see **Quick-Print**.

### 19.16 Reset Print Session

**Reset Print Session to Pending**

Only **print sessions** with a printed* status may be reset. Resetting a session will reset ALL records in that session to pending status. This is usually for making a revision to a tax form. For Example: an incorrect address, a dollar amount, or a TIN number...etc. To reset an individual record see **Print Status**.

**To Reset Session**

1. On the **Printing & Mailing task panel** select the "Print/Mail Forms Myself" link. Use the Current Form drop menu to select the form type to process.
2. At the Completed Print Session List highlight a print session and click the "Reset (VOID) Session" button.
3. The software prompts, "Are you sure you want to reset these records to pending status?" Click "Yes" to proceed or "No" to cancel.

* After a print session is filed, users must **first** void any associated transmittal (i.e., 1096, W-3 or 1042-T) and then the print session is available for reset.

### 19.17 Troubleshoot Printer Issues

**Troubleshoot Printer Issues**

**Margin Limitations**
8966 Pro prints to most Windows compatible printers, subject to the printer's margin limitations. If your bottom margin is greater than 1/3-inch you may not be able to print data at the bottom of the page or you may have to print 2 forms to a page. Check your printer's manual and/or Maximum Printable Area for your BubbleJet, Deskjet, Inkjet or Laserjet if you have questions.

- Preprinted forms accepting up to a 1/2-inch bottom margin: 1099-MISC, 1099-R
- Preprinted forms requiring 1/3-inch or less bottom margin: 1098, 1098-T, 1099-DIV, 1099-INT, 1099-PATR, 1099-S, 5498, 1099-B (Needs 1/36-inch additional room at the bottom margin.)

Data Truncation
8966 Pro recommends a 1/5-inch (0.20) bottom margin when printing to blank paper. Data truncation occurs if bottom margin is greater than 1/3-inch. Suggested work around is to print 2 forms to a page instead of 3 forms per page.

Postscript Drivers
8966 Pro prints to almost all printers. When opting to print to blank paper, the forms and/or fonts may print too large or otherwise print strangely. This is typically due to printing with a postscript driver. To resolve this situation try printing to a PCL 5, PCL 6, EMF or any other non-postscript driver.

Help File Print Problems
Some print drivers may have difficulty printing hot spot or jump items. For example, instead of printing a dotted or solid line underneath the hot spot/jump item, only a blank line prints. To resolve this issue install an HP 4L print driver and set it as the default printer.

Default Printer
8966 Pro may default to a specific printer. Always review the selected printer while choosing your paper type in the Print Wizard. To switch printers use the "Select a Different Printer or Port" button to access the "Print Setup" screen.

Random Errors
Occasionally a virus checker (e.g., Norton, McAfee) can corrupt the 1099 Pro installation and cause random, inexplicable errors. If this occurs, backup your data files, perform a custom uninstall and then reinstall the software with the virus checker disabled.

12 CPI (characters per inch)
8966 Pro prints at 12 CPI to allow the maximum number of characters per field (e.g., 36 characters in a name field). Accordingly, your printer must be set at 12 CPI. To set your printer either:

- Adjust the front panel of the printer manually by setting the CPI to 12 and selecting a font like Courier. Do not select a proportional font or the IRS may fine you $50 for each form!, or
- On your Windows desktop click "Start", "Settings", "Printers" and highlight the printer. Right click your mouse, select "Properties" and click the "Device Options" tab if available (may not be available). You must know what control code(s) will set your printer to 12 CPI. For example, in the case of many Epson printers hit the <ESC> key, type an uppercase M, and <ESC>M then displays in the box. This may differ for your printer.

Generic Print Driver
If 8966 Pro indicates your driver is obsolete then consider installing an additional print driver.

Go to the Windows Machine connected to the printer. Click "Start", "Settings", "Printers" and "Add Printer". In the left window select "Generic" and then "Next". Keep your existing driver, select LPT1 (if appropriate) and name the printer "Generic12CPI". Indicate this is NOT the default printer and if prompted, provide the computer with your Windows CD. After installing this new print driver verify paper size is 8½-inch x 11-inch and dip switches are off.
If you are on a Windows Network you must install this "Generic12CPI" driver on the computer connected to the printer and allow sharing. To allow sharing click "Start", "Settings", "Printers", right click on "Generic12CPI" and select "Sharing".

19.18 View Selected Records

View the Records Selected for this Process

This screen previews the records selected for this print process. This information is also available via log reports.

20 Queries

Queries

8966 Pro offers predefined queries to filter your data. The Current Query drop menu is available at the Work with My Tax Forms, Filer Master List and Recipient Master List screens.

- See Custom Query (Corporate Suite Users only)

Pre-defined Queries include:
- Corrections (Filed)
- Corrections (Not Filed)
- Errors and Warnings
- Filed Original Forms
- Forms with Notes
- Pending Original Forms
- Printed Original Forms
- Voided Original Forms

Recipient
- Has notes
- Only SSN
- Only EIN
- TIN nonstandard
- Foreign, Canada, US for various addresses
- Open W-9s
- Any W-9s

Filer:
- Has notes
- SSN
- EIN
- Combined Fed/State filing program
20.1 Custom Query using Manual Override

Custom Query using Manual Override

Sophisticated users can use the manual override feature in the Query Wizard to create custom queries via the Expression Builder which allows additional Date and Function Categories.

1. At the Query Wizard Field Selection screen, click the "Manual" button in the lower left of the window.

2. In the Query Wizard Manual Override screen, users may either choose from pre-selected fields from the Field List drop menu or click the ellipses [...] button to its immediate right.

3. At the Expression Builder screen options include:
   - **Data and function categories**: Select the category of the function to be applied in this column.
   - **Data and function names**: Contains a list of logical expressions to be applied to the query. A logical expression consists of a field, operator and value.
   - **Validate**: This button will compile and determine if the current expression has been constructed properly.
   - **Clear**: Removes the contents of the current expression from the expression builder main screen.
   - **Insert**: Inserts the currently highlighted "Data and function name" into the Expression Builder Window.
   - **OK**: Executes the "Validate" feature to check the validity of the expression and saves your expression.
   - **Cancel**: Closes the expression builder and returns you to the Query Wizard "Field Selection screen

4. After saving your custom expression it is available for selection at all Current Query drop menus.
20.2 Custom Query Wizard

Custom Query Wizard

The Query Wizard allows custom access to data via an intuitive wizard driven interface. All users can quickly create and save customized queries and then re-use those queries.

1. Access the Current Query drop menu at the Work With My Tax Forms screen. At the Current Query drop menu select "Custom Query".

2. In the Query Wizard select a field to evaluate, e.g., "Box 1 Amount" or "Recipient State or Province", and click "Next".
   - See Form Status Values for specific information on the "Form Status", "Voided", "Correction Type" and "Error Status" fields.

3. At the Operation Selection screen, select the operator, e.g., "Is Equal To" or "Is Between", and click "Next".

4. At the Value Entry screen determine the value to be used to complete the expression. For example, "Recipient State or Province Is Equal to CA" where "CA" is the value. Optionally, users may process the query using "Compare Using Case Sensitive Matching" by placing a check in the box. Click "Next" to continue.

5. Click "Finish" to save your changes and run the query.
   - At the finish screen users may add any additional selection criteria as needed.
   - Use the "Change" button to change your current query or use the "Delete" button to delete the current query and start again.
   - After clicking "Finish" the user is prompted to save the query. Click "Yes" to save and enter a query name or click "No" to bypass saving a query name and display the results of the current query.

20.3 Form Status Values: Database Queries

Form Status Values

Database values are useful for generating Custom Queries in 8966 Pro or in an SQL database.

In the Query Wizard select Form Status Code = Optional, form statuses to return, accepts an array of integers. The default returns all printed status forms. If an original 1099 form has a correction, only the latest correction is returned. This includes both parts of a 2-part correction, the zero correction and the new part. The original or new corrected values can be requested and both parts are returned. Corrected W-2's return the latest correction (W-2C) plus any superseded corrections and the original.

<table>
<thead>
<tr>
<th>ORIGINAL RECORDS</th>
<th>CORRECTION ZERO FORM (2-PART)</th>
<th>Correction (1-Part) / New Form (2-Part)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: Original Pending</td>
<td>10: Corrected Pending</td>
<td>20: Correction Pending</td>
</tr>
<tr>
<td>1: Original Printed</td>
<td>11: Corrected Printed</td>
<td>21: Correction Printed</td>
</tr>
<tr>
<td>2: Original Printed and Voided</td>
<td>12: Corrected Printed and Voided</td>
<td>22: Correction Printed and Voided</td>
</tr>
<tr>
<td>3: Original Printed andFiled Paper</td>
<td>13: Corrected Printed and Filed Paper</td>
<td>23: Correction Printed and Filed Paper</td>
</tr>
<tr>
<td>4: Original Printed and e-filed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5: Original SB Printed  
6: Original Not Printed and e-Filed  
7: Original Not Printed and SB e-Filed  
8: Original SB Printed and SB e-Filed  
14: Corrected Printed and e-Filed  
15: Corrected SB Printed  
16: Corrected Not Printed and e-Filed  
17: Corrected Not Printed and SB e-Filed  
18: Corrected SB Printed and SB e-Filed  
24: Correction Printed and e-Filed  
25: Correction SB Printed  
26: Correction Not Printed and e-Filed  
27: Correction Not Printed and SB e-Filed  
28: Correction SB Printed and SB e-Filed 


Error Status Values
In the Query Wizard select Error Status = Optional.

0: No Errors  
1: Warnings  
2: Errors  
3: Warnings + Errors  
4: Fatal / Major Errors

20.4 Select a User

Select a User

The Select a User screen displays all users. Use to select an individual user for querying or reporting purposes.

21 Reports

Reports

8966 Pro offers numerous reports including:

- Control Totals
- Form Counts
- Forms Issued by Filers
- Recipients Listing
- Filers Listing
- Import Session Summary
- Import Map Reports
- and many others!

21.1 Form Control Totals

Form Control Totals
The Control Totals report is an invaluable tool for reviewing recipient records and pinpointing recipient errors and warnings. Information contained in this report includes:

- Form type
- Filer's Name and TIN
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

To Run Control Totals Report
1. Select the appropriate form type and filer.
2. On the menu bar select Reports > Control Totals for Current Filer & Form Type.
3. At the View/Print Control Totals Report screen select a printer. Consider printing to PDF to save paper.
4. Report Filter and Form Selection Options - Choose a method for selecting records:
   - All Pending Originals for this filer
   - All Original Forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)
3. Error and Warning Messages - Choose how to print warnings and/or errors. This option is only available if Extended Version is selected under Report Format Options, below.
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors
4. Report Record Ordering Options - Choose how to sort the records:
   - By Last Name
   - By TIN
   - By Account Number, then Last Name
5. Report Format Options - Choose a report format:
   - Summary Version (amounts only, no address, text or error/warning detail)
   - Extended Version (all form details including address and errors/warnings)
6. Additional options include:
   - Add custom notes for this report run
   - Print totals only (suppress individual form details)
   - Print Preview
7. To generate report click "Print Now".
8. At the preview screen go to the last page to view box-by-box totals.
21.1.1 Troubleshooting Control Totals

Troubleshooting Control Totals

On occasion users may experience difficulty generating a Control Totals report due to setting incorrect parameters. To resolve this issue users should:

- Verify the correct form type, for example, 1099-MISC or 1099-INT, is selected from the Current Form drop menu.
- Verify the form selection method, e.g., "All Original Forms For This Filer" [Print Only Forms With Errors or Warnings] or "All Corrections for Filer" is accurate.

If no information matches the set parameters the Control Totals Report will not generate.

21.2 CA-592 Quarterly eFile Wizard (CS Edition)

CA-592 Quarterly eFile Wizard

The features contained within this section are available exclusively to users of the Corporate Suite edition.

- See Form CA-592 Overview
- See State Quarterly eFile Wizard

1. Verify the correct Tax Year is selected (use the “Tax Year” drop menu to change as necessary).

2. On the Filing & Corrections task panel select "Electronic Filing" and choose the "1099/1099/5498" radio button as the form type.

3. At the Begin a New IRS eFile Generation Session screen click the "Quarterly State Reporting" button and select "CA-592 Quarterly File".

4. At the CA-592 State Quarterly Filing Wizard carefully review information specific to filing CA-592 per Pub. 1023 paying special attention to the handling of Standard vs. Transactional Filers. Click "Next" to proceed; use the "Back" button at any time.

5. At the Do You Have the Latest Version of 1099 Pro? screen it is recommended, although not required, to check for updates. Click "Next" to continue.

6. At the Choose How Forms Will Be Selected For the CA-592 State Quarterly Filing screen choose a method for selecting eligible records. Voided records are not included in quarterly electronic files.
   - ALL CA-592 Forms for ALL Filers - This option selects every eligible tax form for every Filer.
   - ALL CA-592 Forms for Selected Filers - This option allows users to manually select the Filers to process.

7. At the Specify the File Type, Transmission Medium and Quarter To Process screen indicate files to include.
   - Type of Quarterly File(s) Being Created:
     - Original (default) - 1099 Pro creates 592 electronic files for Original records only. NOTE: The Franchise Tax Board has specific requirements for filing Amended records via paper only; review
the Instructions for Form 592.

- **Select the Quarter to Process:** See Filing Deadlines below
  - Quarter 1 – Jan. 1 to Mar. 31
  - Quarter 2 – Apr. 1 to May 31
  - Quarter 3 – Jun. 1 to Aug. 31
  - Quarter 4 – Sep. 1 to Dec. 31 (Standard - non-transactional - records are considered Quarter 4)

- **Select the Form Type to Process:**
  - Only Filed/Uploaded forms - This option generates a report showing completed reports, ensuring work is not duplicated.
  - Only Pending/Printed forms- This option generates a report for all records that are not yet filed with the IRS.
  - All forms - This option generates a report for all records, regardless of print status.

8. At the Select Destination Folder for your CA-592 State Quarterly Filing screen review the default file location. Users are encouraged to save files to a LOCAL drive and then move them as necessary. All files are automatically named by individual Filer and per SWIFT specifications. The naming convention is preset for the State abbreviation, filing quarter and year, TIN, today's date and time (hour-minute-second) and Filer Name; for example, `CA Q4TAX 2016 555335555 10-21-16 8-37-11AM2 CA-592 Test Filer 2CS`

- **Archive a Copy of this File (recommended):** Creates an original copy of this file as a BLOB retrievable should your original file become corrupted or lost.

- **Create a State Withholding Summary Report**
  - Detail Report: Includes Recipient Names and TINs with totals, by Filer.
  - Summary Report: Includes totals only, by Filer.

9. At the Ready to Generate CA-592 State Quarterly eFile(s) screen review settings and if satisfied click the “Finish” button to initiate the electronic file creation and report (if selected in Step 6). Use the “Back” button if necessary to make any changes.

- The file is saved to the default file location unless a different location was selected.
- If a State Withholding Summary Report was selected it automatically displays in PDF format.

**SWIFT System Code H Error**

**IMPORTANT - Part III Type of Income Subject to Withholding**

During 1099 Pro, Inc.’s testing via Swift1023xValidator.exe, the Code H “Allocations to Foreign (non-US) Nonresident Partners/Members” fails validation although it is a choice on Form 592-B. Accordingly, 1099 Pro Corporate Suite changes code H to code I resulting in “Independent Contractor” in your CA file(s).

**SWIFT System**

SWIFT (Secure Web Internet File Transfer) is the Franchise Tax Board's method for securely transmitting files to and from FTB via the Internet. To use the SWIFT System transmitters must have FTB issued SWIFT login credentials; contact your FTB representative to request this information or refer to the State of California Franchise Tax Board website at https://www.ftb.ca.gov/

1099 Pro's CA-592 Quarterly E-File Wizard creates files in the required CSV format. Post files on the SWIFT login site at [https://swift.ftb.ca.gov/](https://swift.ftb.ca.gov/).

**592 Filing Deadlines**

Filing deadlines are subject to change. 1099 Pro, Inc. strongly encourages users to verify all filing
deadlines and addresses and assumes no liability for inaccuracies or changes contained herein.

Quarter 1 = April 15  
Quarter 2 = June 15  
Quarter 3 = September 15  
Quarter 4 = January 15

If the due date is on a weekend or holiday, the deadline is extended to the next business day.

21.3 Form Counts

Form Counts by Filer

The Form Counts by Filer reports generates a listing of all forms sorted by filer, detailed by print status. The last page of the report tallies forms with errors and/or warnings and indicates if original or corrected. This report is very useful for tracking the status of your forms and determining if records contain any errors or warnings.

To Run Form Counts by Filer
1. On the menu bar select Reports > Form Counts by Filer/Status (all Filers/all Form types).
2. Click "Yes" to preview the report.

21.4 Forms Issued By Filer

Forms Issued by Filer

The Summary of Forms Issued by Filer provides detailed recipient information for all forms issued by the selected filer(s).

To Run Report
1. On the menu bar select Reports > All Forms issued by Selected Filer.
2. Click "Yes" to preview the report.
3. At the Browse the Filers File screen click the "Tag" button to select filers. A red checkmark appears beside each tagged filer. To sort filers prior to tagging, use the View drop menu.
   ○ Review Tag Key Shortcuts
4. After tagging appropriate filers click "Proceed" to run the summary.

21.5 Import Map Reports

Import Map Reports

The Import Map report is an invaluable tool for reviewing import maps. Information contained in this report includes:

- Form type
- Creation Date and Time of the Import Map
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
• Creation Date and Time of the Report including the Network Station ID
• Field Name, Field Type and Field Description...

To Run Report
1. On the menu bar select Utilities > Run the Import Wizard OR on the Preparing My Forms task panel select "Import New Tax Forms".
2. Select the "Import Records from Excel or a Delimited Text File" button to initiate the Import Wizard.
3. At the Select the Type of Data screen in the Wizard, click the "Add/Update (form type) Import Maps" button.
4. Highlight the appropriate import map and click the "View/Print Map" button
5. The user is prompted to preview the report.

21.6 Corrections/Late Add Report

Corrections/Late Add Report

The features contained within this section are available exclusively to users of the Corporate Suite edition.

The Corrections/Late Add utility allows users to export an Excel report detailing any Corrections and/or Late Add records that need to be filed or have been filed since a specified date.

To Generate Corrections/Late Add Report
1. On the menu bar select Reports > 1098/1099/5498/W-2G Reports > Corrections/Late Add to access the 1099 Pro Corrections/Late Add Report Wizard.

2. In the Wizard review important onscreen information. Click "Next" to proceed, use the "Back" button at any time.

3. At the Select Form Status screen indicate:
   - Type of Export/Report to Create -
     • Federal Report
     • State Report
   - Set the Cutoff Date and Level of Detail -
     • Cutoff Date: Defaults to current day. The Cutoff Date affects the type of forms included in the report.
     • Export Summary Records. The Federal Summary Report includes the Filer's EIN, and box totals. The State Summary Report includes the Filer's EIN, and box totals by State. Both reports list total forms and box-by-box grand totals.
     • Export Details Records. The Federal/IRS Detail Report includes the Filer's TIN, Recipient's TIN, Account Number and individual box amounts. The State Detail Report includes the Filer's TIN, Recipient's TIN, Account Number, State and individual box amounts. Both reports list total forms and box-by-box grand totals.
   - Select the Type of Forms to Include in the Report -
     • Only Filed/Uploaded forms (Filed at the Federal/State level). Only corrections and late adds filed ON OR AFTER the Cutoff date will be included in the output.
     • Only Pending/Printed forms (Not Filed at the Federal/State level). This option would be used to process records that have not been filed and were created on or BEFORE the Cutoff date.

4. At the Select the Filers & Forms Types screen choose a method for selecting eligible records. Options include:
5. Select Destination Folder:
   - Specify the Export File Destination Folder. Mark the checkbox to overwrite the Destination File Name (not recommended).
   - Location Where Export File Will Be Created. The default location is C:\1099_Pro\Pro99CS Exports; users may change the destination folder at their discretion.

6. Confirm settings and when satisfied click "Finish" to start the Export process. The Administrator indicates when process is complete.

7. Open the Excel file to view report(s). Each form type's report is located on a separate worksheet, accessed by the sheet tabs at the bottom of the document window.

21.7 Daily Totals Report by UserID

Daily Totals Report by UserID

The Daily Totals Report by UserID displays the total changes made via manual entry by UserID. The user must specify the date, Filer(s) and form(s) to include in this report. This report is useful for verifying changes made to records by an individual user.

22 Service Bureau Overview

Service Bureau Overview

Why should I use the Service Bureau?
NO customer has EVER incurred an IRS penalty due to an error on the part of 1099 Pro for information filed late or in an incorrect format to the IRS/SSA! The 1099 Pro Service Bureau is proud to offer a wide variety of services to registered users of 1099 Pro, all performed in our secure SSAE 16 SOC I TYPE II environment. We provide Printing and Mailing, Electronic Delivery, Web Presentment, Bulk TIN Matching, and IRS Filing services to thousands of our users. Additionally, all domestic Service Bureau Print/Mail jobs include IMB tracing. IMB (Intelligent Mail Barcode) tracing reports the last time each document was scanned by the post office.

Our customers utilize the Service Bureau to save money, minimize administrative headaches, safeguard their sensitive data, and benefit from our extensive experience. Whether you have a large or small job, consider the cost savings and the value of a “job done right” during your busiest months of the year.

What forms does the Service Bureau process?
The 1099 Pro Service Bureau can print, mail and/or file the following forms* for a fee:
- Informational Returns including 1098, 1099-INT, 1099-MISC, 3921, 5498, W-2G and many more!
- 1095-B / 1095-C Affordable Care Act (ACA) Compliance (Corporate Suite)
- W-2 Wage and Tax Statements
- 1042-S Foreign Person's U.S. Source Income Subject to Withholding
The Service Bureau does not print, mail or eFile Form 8966 Foreign Account Tax Compliance Act (FATCA) at this time.

* Users must purchase the associated software product to use the Service Bureau.

We’ve made the process simple:
1. Purchase the appropriate 1099 Pro software package for the type of form you wish to file.
2. Call or E-Mail our Service Bureau to schedule an appointment date. We must have your data by the agreed upon appointment date to ensure that it is posted online, mailed or filed by the IRS deadline.
3. Enter your data into the software via the Import Wizard or manual entry.
4. Use the Service Bureau Wizard to quickly and easily create, approve and transfer your upload file.

Customers are encouraged to schedule their upload appointments starting in December! Rates and availability are not guaranteed until your appointment is booked.

Contact the SSAE 16 SOC I TYPE II Service Bureau
Contact the 1099 Pro Service Bureau team to book your printing, mailing and/or electronic filing appointment and for all Service Bureau related inquiries.

- Phone: (866) 444-3559 (toll-free) or (818) 876-0200
- E-Mail: sb@1099 Pro.com
- Internet: http://www.1099 Pro.com

Instant price estimates are available online at http://www.1099 Pro.com/servPricing.asp

22.1 Service Bureau Packages

1099 Pro Service Bureau Packages

This feature is not available to 8966 Pro users.

Standard Service Bureau Options
Contact the 1099 Pro SSAE 16 SOC I TYPE II Service Bureau – (866) 444-3559, direct (818) 876-0200, or via email sb@1099pro.com.

- Print and Mail Only: The 1099 Pro Service Bureau (SSAE 16 SOC I TYPE II certified) will print and mail recipient copies by the IRS due date (pricing includes first-class US postage).
- Electronic Filing Only: The 1099 Pro Service Bureau will file your data electronically with the IRS on your behalf.
- The Complete Package: The 1099 Pro Service Bureau will print and mail recipient copies and file your data electronically with the IRS (pricing includes first-class US postage).
- Service Bureau Support for the IRS Bulk TIN Matching Program: The SSAE 16 SOC I TYPE II Service Bureau as an authorized agent can submit TIN/Name combinations to the IRS on behalf of our users and results are available to our customers within 24 hours! We encourage our customers to use this service to correct serious errors like invalid TIN numbers that would likely result in a 972CG, CP2100 or CP2100A notice from the IRS and possible penalties of $100.00 per mismatch. Call to schedule a Bulk TIN appointment today – (866) 444-3559.
• **TRA97 Compliance (Educational Institutions) Form 1098-T:** This option is unique to form 1098-T and designed for colleges/universities. The SSAE 16 SOC I TYPE II 1099 Pro Service Bureau prepares and mails the form 1098-T tuition statements and also files the forms electronically with the IRS. Call for a quote (866) 444-3559.

### Add-On Services
Additional fees apply for the following services and are subject to the availability of the 1099 Pro Support and Programming team. Contact the Service Bureau for more information toll free (866) 444-3559 or email sb@1099pro.com.

- Custom WMF Files: Our team will design a detailed custom layout for your specific printing needs including logo and/or statement design.
- Custom Programming
- Custom Reports
- File Translation/Data Manipulation
- Data Entry
- Remote Hosting via the Internet
- Full Service Provider
- Corporate Suite Installation and Support
- Corrections: Upload your corrections to the 1099 Pro Service Bureau via a secure FTP site, to eliminate the tedious paper filing process. Electronic filing of corrections via the Service Bureau is a $45 flat fee.

### 22.2 Service Bureau Overview & Upload Process

#### Service Bureau Upload Sessions

*This feature is not available to 8966 Pro users.*

The Service Bureau Upload Sessions screen provides direct access to optional Service Bureau utilities including Printing & Mailing, Electronic Filing and Bulk TIN Matching. Additionally, users may view uploads, reset/void uploads, complete pending uploads and view reports.

- See [Service Bureau Overview](#)
- See [Service Bureau Wizard](#) and [Bulk TIN Matching](#)

#### To Access Service Bureau Upload Sessions

On the **Filing My Forms** task panel click the "Via the Service Bureau" link.

- Upload sessions are Filer specific. If you don't see an upload session, verify the correct filer is selected.
- One upload session may contain multiple logs.
- The "Upload Task Column" indicates the type of upload sent to the Service Bureau including; Bulk TIN, Print+Mail, Filing, etc.
- The "Status" column indicates if the upload has been "Completed", is "Pending" final upload or has been " VOIDED".

#### To Reset (Void) Session

Highlight the session to void. If there are multiple logs within the session, highlighting any one log will void the entire session. A void session may not be un-voided.
To Complete Pending Upload
Highlight the session to upload. If there are multiple logs within the session, highlighting any one log will upload the entire session. To complete a pending upload the user must certify their data (even if they've previously done so) via Step 2 – Submit Service Bureau Upload and then submit it at the same screen. After successfully uploading the file, the "Status" column indicates "Completed".

Upload Form Summary
This report generates a log specific detail of an upload file. The last page of this report includes Total Forms and Box-By-Box Totals.

To Run Report
1. Click the "View/Print Log Report" button.
2. User is prompted to select a printer; consider printing to PDF to save paper.
3. Select the Sort Order; by Last Name/First Name or By TIN
4. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors and Warnings only

Upload Session Summary
This report lists all Form Types, Counts and Filers included in an upload session and the date generated. Users may also reprint the associated Control Totals Report. If there are multiple logs within the session, then multiple Control Totals Reports are generated.

To Run Report
1. Click the "View/Print Session Summary" button.
2. User is prompted to check "Reprint Control Totals" as necessary. Click "OK" to continue.

22.2.1 Service Bureau Upload Wizard

Service Bureau Upload Wizard

This feature is not available to 8966 Pro users.

The 1099 Pro Service Bureau has streamlined the process of Service Bureau uploads into two simple steps:

- Step 1 – Create an Upload File

- Step 2 – Submit Service Bureau Upload

22.2.2 Step 1 - Creating an Upload File for Print/Mail or E-File

Step 1 - Create an Upload File

Creating an upload file is the first of two steps to submit your files to the 1099 Pro Service Bureau.
Prior to starting this process please consider:

- There are fees to use the Service Bureau (see the Service Bureau Price Estimator) and an appointment is required.
- If using the Service Bureau's Complete Package (Printing, Mailing and eFiling) you will transmit to us a Printing and Mailing upload in January AND an Electronic Filing upload in March. This allows users the opportunity to make any changes to their forms so only the most accurate data is filed with the IRS.
- A record's print status determines its eligibility to be included in an upload file. See Print Status Overview.
- All upload processes include the opportunity to run the Generate Accounts Wizard. Some form types require recipients to have unique account numbers; the wizard will not overwrite existing account numbers.
- Users are highly encouraged to run a software update prior to starting an upload.

☐ See Service Bureau Upload Sessions

Printing and Mailing

Please visit https://www.1099pro.com/videos.asp and watch the "How to Print and Mail Using the Service Bureau" video for a brief tutorial on printing and mailing using the Service Bureau.

1. To have the Service Bureau print and mail your forms go to the Printing & Mailing task panel and click the "Via the Service Bureau" link.
   - Corporate Suite Users: Go to the Service Bureau task panel and click the "Printing & Mailing" link. Select the type of tax form to process and click "OK".

2. At the Printing, Mailing, Filing and Bulk TIN Matching screen click the "Printing & Mailing or E-Delivery Upload" button. NOTE: Only records with a Pending print status (or Corr/Pending for corrected forms) are available for inclusion in this upload file.

3. At the Create Upload File Wizard screen click the "Begin" button to start the process. You also have the option to:
   - Check for software updates, and/or
   - "Start the Generate Accounts Wizard". Learn more about Account Numbers.

4. STEP 1: Select Filers - Specify which filers should be processed.
   - All of my Filers: This default selection includes ALL eligible records for ALL Filers in the software. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - Select (Tag) Filers: This allows you to manually tag (or select) each Filer for inclusion in the Service Bureau Upload.
   - Current: This uses only the currently selected Filer for uploading Filer information to the Service Bureau.

5. STEP 2: Form Types - Select which tax forms will be included:
   - All Form Types: This default selection includes all form types for the Filer(s) selected and includes all eligible records. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - Select (Tag) Form Types: This allows you to manually tag (or select) form types for inclusion in the Service Bureau Upload.
   - Current: This uses only the currently selected form type and its eligible records for inclusion in the
Service Bureau upload.

**Additional Options**
- **Upload/Print Original Forms**: Default selection to upload original issue forms.
- **Upload/Print Corrections**: Use to select corrected forms (with a Corr/Pending status) for upload to the Service Bureau.

6. **STEP 3: Upload Action** - Select what the Service Bureau will do with the forms. **IMPORTANT**: To take advantage of Web Presentment or Electronic Delivery the recipient's email address must be included in your original import file. Both Web Presentment and Electronic Delivery have a $150 setup fee.
   - **Print and Mail the forms**: This default option includes the printing and mailing of your selected forms.
   - **Print and Mail with Web**: This option includes both the printing and mailing of your selected forms AND forms are available on our ViewMyForms.com website for easy recipient download and printing. Recipients must register online to access this service.
   - **Electronic Delivery**: This option includes the electronic delivery (email) of encrypted tax forms to recipients.
   - **Web Presentment Only**: This option includes email notification to your recipients that tax forms are available on our ViewMyForms.com website for easy recipient download and printing. Recipients must register online to access this service.
   - **Additional Options (New)**
     - **I request Immediate Filing with the IRS**: This option is designed for entities that may be closing, submitting corrections or late uploads that require expediency. *Most users will upload a file for print/mail in January and submit a second, revised file in March for filing with the IRS.*

7. **STEP 4: Thresholds** - Filter tax forms based on dollar amounts.
   - Check the "Do not include forms with no dollar amounts" box as desired.

8. **STEP 5: Contact Information** - Who should be contacted if there are questions? Enter the individual the Service Bureau should contact if there are any issues with the information in your upload file. Click "Update Contact" to edit individual.

9. **STEP 6: Printer** - Several reports print at the end of the Service Bureau Upload Wizard from the selected printer.

10. **Extra Options**
    - **TIN Masking**: Choose an option to mask the recipient's SSN or EIN or leave with default Filer setting. Learn more about [TIN Masking](#).
    - **Extra Print Options**: Choose this for advanced printing options unique to this run only. Includes the option to force an “X” in the Corrected box and/or to include a brief standardized message on the tax form(s).
    - **Error Scan**: Use to check records for the chosen Filer(s) and Form type(s) for errors or warnings prior to their being uploaded to the Service Bureau. Review [Errors & Warnings](#) for information on reviewing and/or adjusting any such records.
    - **Folder**: The default location is C:\1099 Pro\Pro66T17\Uploads. Although not recommended, users may change the location where an upload file will be saved.

11. Click on "Create File" to proceed. Please be patient while the upload session is generated. Upon completion summary reports will print to the default printer.

12. Proceed to [Step 2 - Submit Service Bureau Upload](#).
**Electronic Filing**

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and watch the "Filing Electronically with the Service Bureau" video for a brief tutorial on the Service Bureau filing process.

1. To have the Service Bureau electronically file your forms go to the Filing My Forms task panel and click the "Via the Service Bureau" link.
   - **Corporate Suite Users:** Go to the Service Bureau task panel and click the "Filing with the IRS" link. Select the type of tax form to process and click "OK".

2. At the Printing, Mailing, Filing and Bulk TIN Matching screen click the "Filing With the IRS Upload" button. **NOTE:** Any record with a Pending, Printed and SB Print+Mail print status (or Corr/Pending and Corr/Printed for corrected forms) is available for inclusion in this upload file.
   - **Corporate Suite Users:** Click the "Create an IRS or AIR Upload" button and select "Filing with the IRS Upload" for all 1099 Informational Returns or "1095-B Filing With the IRS Upload" or "1095-C Filing With the IRS Upload" as appropriate.

3. At the Create Upload File Wizard screen click the "Begin" button to start the process. You also have the option to:
   - Check for software updates, and/or
   - "Start the Generate Accounts Wizard". Learn more about Account Numbers.

4. **STEP 1: Select Filers** - Specify which filers should be processed.
   - **All of my Filers:** This default selection includes ALL eligible records for ALL Filers in the software. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.
   - **Select (Tag) Filers:** This allows you to manually tag (or select) each Filer for inclusion in the Service Bureau Upload.
   - **Current:** This uses only the currently selected Filer for uploading Filer information to the Service Bureau.

5. **STEP 2: Form Types** - Select which tax forms will be included:
   - **All Form Types:** This default selection includes all form types for the Filer(s) selected and includes all eligible records. When uploading to the Service Bureau bundle all records into a single file to avoid additional charges.

   - **Original (first) upload for these forms:** This default option is for both original uploads and corrected uploads.
   - **Replacement:** Select this option only if notified by the IRS. *Replacement forms are different than corrected forms.*

7. **STEP 4: Contact Information** - Who should be contacted if there are questions? Enter the individual the Service Bureau should contact if there are any issues with the information in your upload file. Click "Update Contact" to edit individual.

8. **STEP 5: Printer** - Several reports print at the end of the Service Bureau Upload Wizard from the selected printer.

9. **Extra Options**
   - **Error Scan:** Use to check records for the chosen Filer(s) and Form type(s) for errors or warnings.
prior to their being uploaded to the Service Bureau. Review Errors & Warnings for information on reviewing and/or adjusting any such records.

- **Folder**: The default location is C:\1099 Pro\Pro66T17\Uploads. Although not recommended, users may change the location where an upload file will be saved.

10. Click on "Create File" to proceed. Please be patient while the upload session is generated. Upon completion summary reports will print to the default printer.

11. Proceed to **Step 2 - Submit Service Bureau Upload**

### 22.2.3 Step 2 - Submit Service Bureau Upload

**Step 2 - Submit Service Bureau Upload**

After successfully completing **Step 1 – Create an Upload File**, users must certify their data by carefully reviewing associated reports and then submit it to the Service Bureau. The Summary Report details the Form Types, Form Counts and Filers included in the upload and contains important information including the name and location of your upload file. There is a unique Control Totals Report for every Filer and Form Type with box-by-box dollar totals and form counts.

See Service Bureau Upload Sessions

**Certify Your Data**

The Certify Your Data screen displays automatically after creating an upload file. To continue the upload process, users must certify their data by carefully reviewing the Summary and Control Totals reports.

- If in agreement with the reports please proceed to the below steps.
- If **not** in agreement with the reports, click the “Cancel” button and use the “Reset/Void Upload” button at the Service Bureau Upload Sessions screen. All of the forms associated with the session will reset to their original, pre-upload status. Correct any problems discovered while reviewing the Control Totals Reports, then start anew at **Step 1 - Create an Upload File**.
- To continue this process at a later time, click the “Cancel” button and use the “Complete Pending Upload” button at the Service Bureau Upload Session screen to return when convenient.

1. **Step 1: Review Totals** – Click the View Control Totals Report button OR Save Control Totals Report button. View the reports (one per Filer and Form type) and verify that all Filer(s), Form(s) and dollar amounts are correct. See **Control Totals Report**.

2. **Step 2: Confirm Totals** – Confirm the Total Number of Forms. Enter the total number of forms in the “Acknowledge the total by re-entering it here” field.

3. **Step 3: Transfer Method** - Choose between:
   - Built-in HTTPS secure transfer - This default/preferred method works well for most of our users; however, those with firewalls or very large files may experience issues. *An internet connection is required for this method.
   - Built-in FTP using the Internet - This is an alternate method of uploading to the Service Bureau. The Wizard will automatically upload the file using standard File Transfer Protocol. *An internet connection is required for this method.
   - Manual Transfer - This option requires you to manually upload your file to our FTP site, e-mail it or send it to our Service Bureau via postal service. See Manual Transfer Options below.

4. **Step 4: Select Printer** - Control Totals Report prints to selected printer.
5. **Step 5: Digital Signature** - The individual responsible for this upload must type their name to certify they have examined the information returns and control totals in this transmission and to the best of their knowledge and belief, are true, correct and complete.

6. Click “**Upload My File**” to immediately transmit your file to the 1099 Pro Service Bureau. The software indicates if upload was successful and if so you will receive an e-mail confirmation from the Service Bureau, usually the same business day.

   - If upload was not successful, repeat the above procedure using the Built-in FTP or Manual Transfer option as appropriate.
   - There is no need to fax any documentation or call the Service Bureau; your file and approval is submitted electronically.
   - Expect your Bulk TIN Results within 1-2 business days. If you haven't received your emailed results by then please contact the Service Bureau. It is possible your results were blocked by your internal firewall or went to your SPAM folder.

**Manual Transfer Options**

Transmitting your upload file to the Service Bureau via built-in HTTPS or FTP is preferred. Those with firewalls, very large files or no internet connection may need to use the manual transfer option.

**Method A:** Transmit your file to our secure SSAE 16 SOC I Type II Service Bureau via FTP:

1. In your web browser go to https://uploads.1099pro.com/.
   - **Login ID:** 1099upload
   - **Password:** 2004

2. After Login, click the “Upload” link and browse for your upload file. Service Bureau Uploads are automatically pulled into our system from the FTP site. You will receive e-mail notification from the Service Bureau within 30 minutes of successfully posting your upload file.
   - There is no need to notify the Service Bureau that a file was posted.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method B:** Transmit your upload file via e-mail.

1. E-mail your upload file to uploads@1099pro.com. Do NOT change the name of the attached upload file—it contains identifying information. After emailing the file you will receive an automatic confirmation of receipt of your e-mail within 30 minutes.
   - There is no need to notify the Service Bureau that a file was e-mailed.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method C:** Transmit your file via postal service on a CD or flash drive. This method is not recommended as files may easily get damaged, delayed or lost in the mail. Please contact the Service Bureau at (866) 444-3559 for more information on proceeding with this method.

22.2.4 **Reset/Void Service Bureau Upload**

**Reset (Void) Service Bureau Upload**

Resetting an upload session voids (deletes) the entire upload session. All forms automatically revert to their pre-upload status.
To Reset Session
1. On the Service Bureau task panel select "Printing & Mailing".
2. At the Completed Service Bureau Upload Session List screen highlight an upload session and click the "Reset (Void) Session" button.
3. The Administrator prompts to confirm the void. Click "Yes" to continue or "No" to abort. Session status immediately updates to Voided.

22.3 Using Bulk TIN Matching

Bulk TIN Matching

Avoid $100+ record mismatch penalties! Utilize 1099 Pro's Bulk TIN Matching Service!

See the Bulk TIN Matching Wizard
See Bulk TIN Matching Results

Offer Details
- $135 for a single upload of up to 100,000 records
- E-mail the Service Bureau at sb@1099pro.com if the file is greater than 100,000 records
- Approximately 24 hour turn-around time
- Access to a FREE trial of our individual TIN Matching service (details below)

Bulk TIN checks are an essential compliance and risk mitigation service that identify TIN/Name mismatches prior to filing with the IRS. Penalties can be assessed at up to $260/record at the IRS’s discretion.

Additional Services - TINCheck.com

Another great option to validate your TIN/Name combinations via individual checks or bulk!

TINCheck.com is a straightforward, user-friendly resource; simply log in and instantly gain access to multiple verification sources in one place.

Extra Options:
- Complete list validation: OFAC, DMF, EPLS, LEIE, TIN/Name
- Integrate an API/web service into an existing AP system for seamless verification of new vendors.
- Prepaid plans or monthly subscription pricing plans based on volume.
- Bulk TIN Checks with complete list validations available.
- FREE trial account - Sign up online at TINCheck.com for 10 free TIN checks!

22.3.1 Bulk TIN Matching

Bulk TIN Matching Upload

The 1099 Pro Service Bureau has simplified the process of validating Name/TIN combinations in bulk to
help filers minimize penalties. Please review Bulk TIN Matching for pricing and other important information.

- Step 1 – Create Bulk TIN Upload File
- Step 2 – Approve Control Totals

22.3.2 Step 1 - Creating an Upload File for Bulk TIN Matching

Bulk TIN Matching Wizard

1099 Pro's Bulk TIN Matching is an essential compliance and risk mitigation service that identifies recipient Name and TIN mismatches prior to filing with the IRS. The Bulk TIN Matching Wizard allows users to run up to 100,000 Name/TIN combinations in a single upload file for only $135. Results are typically available the following business day.

Step 1 - Create an Upload File
To submit a Bulk TIN Upload first schedule a Service Bureau appointment unless you have already used the Service Bureau for the current tax season. Current Service Bureau customers are welcome to upload at any time.

To Create Upload File
1. On the Printing and Mailing task panel select the "Via the Service Bureau" link to access the Printing, Mailing, Filing and Bulk TIN Matching screen.
   - Corporate Suite Users: On the Service Bureau task panel select the "Bulk TIN Matching via SB" link.

2. Click the "Bulk TIN Matching Upload" button to access the Bulk TIN Matching Upload Wizard. Click "Next" to proceed. Use the "Back" button at any time to go back a step.

3. Review informational screens and click "Next" to continue.

4. Run Software Update as prompted. It is highly recommend to check for updates to this program before starting any printing or filing process. This ensures the most recent version of the software is running. See Web Updates for more information

5. Choose a method for selecting eligible records.
   - Selected Form Types for ALL Filers: This default option prompts to select (tag) the form types to include in this upload file. All filers will be processed.
   - Selected Form Types for Selected Filers: This option prompts to select (tag) the filer and the form types to include in this upload file.

6. Set options for your upload.
   - Force TIN Type as Unknown for all records: Selecting this check box removes the SSN or EIN identifying hyphens. You will not be able to import your results back into the software if this box is checked.
o Select the destination folder: The default location is `C:\1099 Pro\Pro66T17\Uploads`.

7. Enter your Contact Information and User Password:
   o This information is critical to how we will contact you with issues and where we will email the encrypted results.
   o The password is used to encrypt your Bulk TIN matching results; **retain the password to access your results**. Your password must be 8 to 30 characters in length.

8. Select the Printer for your Bulk TIN Matching summary and instructions and change as necessary.

9. At the Ready to Generate Bulk TIN Upload File screen review settings and click "Finish" when satisfied. The system will process your file and the Administrator indicates when file is "Done".

10. Continue to **Step 2 - Submit Service Bureau Upload**.

22.3.3 Step 2 - Submit Service Bureau Upload

**Step 2 - Submit Service Bureau Upload**

After successfully completing **Step 1 – Create an Upload File**, users must certify their data by carefully reviewing associated reports and then submit it to the Service Bureau. The **Summary Report** details the Form Types, Form Counts and Filers included in the upload and contains important information including the name and location of your upload file. There is a unique **Control Totals Report** for every Filer and Form Type with box-by-box dollar totals and form counts.

See Service Bureau Upload Sessions

**Certify Your Data**

The Certify Your Data screen displays automatically after creating an upload file. To continue the upload process, users must certify their data by carefully reviewing the Summary and Control Totals reports.

- If in agreement with the reports please proceed to the below steps.
- If **not** in agreement with the reports, click the “Cancel” button and use the “Reset/Void Upload” button at the Service Bureau Upload Sessions screen. All of the forms associated with the session will reset to their original, pre-upload status. Correct any problems discovered while reviewing the Control Totals Reports, then start anew at **Step 1 - Create an Upload File**.
- To continue this process at a later time, click the “Cancel” button and use the “Complete Pending Upload” button at the Service Bureau Upload Session screen to return when convenient.

1. **Step 1: Review Totals** – Click the View Control Totals Report button OR Save Control Totals Report button. View the reports (one per Filer and Form type) and verify that all Filer(s), Form(s) and dollar amounts are correct. See **Control Totals Report**.

2. **Step 2: Confirm Totals** – Confirm the Total Number of Forms. Enter the total number of forms in the “Acknowledge the total by re-entering it here” field.

3. **Step 3: Transfer Method** - Choose between:
   - Built-in HTTPS secure transfer - This default/preferred method works well for most of our users; however, those with firewalls or very large files may experience issues. *An internet connection is required for this method.*
Built-in FTP using the Internet - This is an alternate method of uploading to the Service Bureau. The Wizard will automatically upload the file using standard File Transfer Protocol. *An internet connection is required for this method.

Manual Transfer - This option requires you to manually upload your file to our FTP site, e-mail it or send it to our Service Bureau via postal service. See Manual Transfer Options below.

4. **Step 4: Select Printer** - Control Totals Report prints to selected printer.

5. **Step 5: Digital Signature** - The individual responsible for this upload must type their name to certify they have examined the information returns and control totals in this transmission and to the best of their knowledge and belief, are true, correct and complete.

6. Click “**Upload My File**” to immediately transmit your file to the 1099 Pro Service Bureau. The software indicates if upload was successful and if so you will receive an e-mail confirmation from the Service Bureau, usually the same business day.

   - If upload was not successful, repeat the above procedure using the Built-in FTP or Manual Transfer option as appropriate.
   - There is no need to fax any documentation or call the Service Bureau; your file and approval is submitted electronically.
   - Expect your Bulk TIN Results within 1-2 business days. If you haven’t received your emailed results by then please contact the Service Bureau. It is possible your results were blocked by your internal firewall or went to your SPAM folder.

**Manual Transfer Options**

Transmitting your upload file to the Service Bureau via built-in HTTPS or FTP is preferred. Those with firewalls, very large files or no internet connection may need to use the manual transfer option.

**Method A:** Transmit your file to our secure SSAE 16 SOC I Type II Service Bureau via FTP:

1. In your web browser go to [https://uploads.1099pro.com/](https://uploads.1099pro.com/).
   - **Login ID:** 1099upload
   - **Password:** 2004

2. After Login, click the “Upload” link and browse for your upload file. Service Bureau Uploads are automatically pulled into our system from the FTP site. You will receive e-mail notification from the Service Bureau within 30 minutes of successfully posting your upload file.
   - There is no need to notify the Service Bureau that a file was posted.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method B:** Transmit your upload file via e-mail.

1. E-mail your upload file to uploads@1099pro.com. Do NOT change the name of the attached upload file—it contains identifying information. After emailing the file you will receive an automatic confirmation of receipt of your e-mail within 30 minutes.
   - There is no need to notify the Service Bureau that a file was e-mailed.
   - Your digitally signed Control Totals Report is automatically bundled into your upload .ZIP file. There is no need to fax documentation to the Service Bureau.

**Method C:** Transmit your file via postal service on a CD or flash drive. This method is not recommended as files may easily get damaged, delayed or lost in the mail. Please contact the Service Bureau at (866) 444-3559 for more information on proceeding with this method.
### 22.3.4 Bulk TIN Matching Results

#### Bulk TIN Results

Users receiving Bulk TIN results (after submitting a Service Bureau Bulk TIN Upload or via the IRS Bulk TIN Matching Program) are provided coded responses for all invalid Name/TIN combinations.

#### Bulk TIN Results

Bulk TIN results contain the following coded information from the IRS:

<table>
<thead>
<tr>
<th>Code</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Name/TIN combination matches IRS records.</td>
</tr>
<tr>
<td>1</td>
<td>Missing TIN or TIN not 9 digit number.</td>
</tr>
<tr>
<td>2</td>
<td>TIN not currently issued.</td>
</tr>
<tr>
<td>3</td>
<td>Name/TIN combination does NOT match IRS records</td>
</tr>
<tr>
<td>4*</td>
<td>Invalid request (i.e., contains alphas, special characters)</td>
</tr>
<tr>
<td>5</td>
<td>Duplicate request.</td>
</tr>
<tr>
<td>6</td>
<td>(matched on SSN), when the TIN type is (3), unknown, and a Matching TIN and name control is found only on the NAP DM1 database.</td>
</tr>
<tr>
<td>7</td>
<td>(matched on EIN), when the TIN type is (3), unknown, and a matching TIN and name control is found only on the EIN/NC database.</td>
</tr>
<tr>
<td>8</td>
<td>(matched on EIN and SSN), when the TIN type is (3), unknown, and matching TIN and name control is found only on both the EIN/NC and NAP DM1 databases.</td>
</tr>
</tbody>
</table>

#### Sample Bulk TIN Results

The following sample lines indicate the TIN provided by Matthew Mulberry is 2 - Not Currently Issued and the Name/TIN provided by Acme Incorporated is 0 - Matches IRS records.

1;183421111;Matthew Mulberry;89765;2  
2;562611111;Acme Incorporated;89765;0

#### Invalid TIN Matching Requests

Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. For example, the following line from a Bulk TIN Matching file is missing the Name field:

2;562611111;;8976

The above line would generate a "4" in the results data file, indicating an Invalid Request, as follows:

2;562611111;;89765;4

* Any record submitted without the required fields (TIN Type, TIN, Name) automatically receives Indicator 4 - Invalid Request. If TIN Type is unknown, you may check the "Force TIN Type As Unknown" box during the Wizard and the IRS will check the TIN against both the SSN and EIN master files. However, you will be unable to import returned results for matching purposes if this option is chosen.

#### For More Information:

Direct questions regarding specific tax regulations or regulatory services to IRSCompliance.org at:
23 Tax Supplies

Tax Supplies

1099 Pro, Inc. sells all of the tax forms and supplies necessary for use with 1099 Pro* software at competitive rates.

- All forms and supplies offered by 1099 Pro, Inc. are IRS approved.
- All orders over $100 automatically receive a 10% discount.
- Order in advance; overnight shipping of forms can cost more than the actual forms!
- Returns are NOT accepted after November 30, 2017. Customer is responsible for all return shipping charges.

*All tax forms and supplies are subject to availability. Prices subject to change without notice.

Online Ordering
Customers may place orders online for laser forms and envelopes (current tax year only). In addition to placing orders, customers may view tax forms and a brief item description. Try it at www.1099pro.com; click on the "Products" button and the "Tax Forms" hyperlink.

Online Customer Account Access
Customers who've purchased items in the past year may go online to view prior orders and activation codes. Order tracking is also available to see if your order has shipped. Try it at www.1099pro.com; click on the "Login" button and follow the prompts.

Telephone Orders
Customers may place orders for all tax supplies (including laser for current and past tax years) by telephone with our Sales team at (888) 776-1099.

23.1 Blank Copier Paper

Blank Copier Paper

Blank Copier Paper: Print Copy B &/or C directly onto blank copier paper. Good in case of an emergency when Blank Laser paper is unavailable (might require special folding and/or cutting to fit in standard IRS approved envelopes). 1099 Pro, Inc. offers custom designed IRS regulation envelopes to fit copier paper.

Blank Laser Perf: Print Copy B &/or C directly onto blank laser perforated stock (1099 Pro prints the necessary graphics). Easier to fold than blank copy paper because of the perforations and since it is blank...it won't go out of date! Also prints instructions. When using blank stock you must select the copies to print. The Print Wizard features a Combined option that prints all required copies for the recipient on one sheet (e.g., 1099-MISC Combined includes copies B, 2 and instructions). You may instead select the individual copies for the recipient, but you will need to manually collate the copies.

*Please visit https://www.1099pro.com/videos.asp and select the "Quick Tips: Print to Blank Paper"
When printing instructions to blank paper you may:
- Print them as part of the normal print run with one copy per recipient. Remember to collate instructions with the recipient copies, OR
- Print them on one sheet now and photocopy it as many times as needed. Then use the reverse side of the photocopied sheets to print your forms. If selecting this option do NOT print any copies at this time, first prepare the instructions and then print the copies, OR
- Print “X” pages at this time.

The IRS requires you to send both tax forms and instructions to recipients.

23.2 Preprinted Paper

Preprinted Paper

Preprinted Laser Perf: When using preprinted laser forms the user selects the copies to print; for example, Copies A, B, C and/or the 1096/W-3 Transmittal. Preprinted forms are perforated, with each required copy preprinted with the necessary information in an IRS/SSA approved ink (Copy A in red drop-out ink, Copy B in black, etc.). The Print Wizard pauses before printing each copy to prompt the user to load the appropriate form into the printer.

☐ Preprinted forms save toner and time - order your tax forms today at (888) 776-1099.

24 Transmitter/Submitter Information

Transmitter/Submitter Information

Transmitter and Submitter requirements are specific to the type of form electronically filed.

☐ Please see Create Transmitter/Submitter

1099 Informational Returns / Forms 1042-S

A Transmitter Control Code number or (TCC) is required when filing electronically. A TCC is composed of five alpha-numeric characters. If filing electronically via the Service Bureau, a TCC is not required and this information need not be completed.

Request a TCC for IRS FIRE System

To obtain a TCC file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Print Form 4419 via the Help & Extras task panel > IRS Pubs & Links. For more information on TCC's, contact the IRS-MCC at (304) 263-8700. A single TCC may be used to file on behalf of multiple filers.
Forms 1095-B & 1095-C
The TCC for AIR is unique to filing ACA returns. The TCC issued for filing 1099 Informational Returns is suitable for the IRS FIRE System, not the AIR Site. See TCC for AIR for important information on registering to use IRS e-Services, applying for a Transmitter Control Code (TCC) and submitting Test Files.

Form 8966
Transmitter information is provided to the IRS for contact purposes. This basic information must be filled out prior to creating the XML file that is packaged and sent to the IRS.

8966 Pro requires transmitters to have either a GIIN or FIN to generate XML files; this information is contained in the <ftc:MessageSpec> element of your XML file.

FIN Numbers
Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI), third party preparers, or commercial software vendors are not required to have GIINs. These non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN to access IDES. The FIN is the 19-character identifier entered in the metadata and FATCA XML message header.

24.1 Create Transmitter/Submitter

Create Transmitter/Submitter

Transmitter and Submitter information is required when generating electronic files and is specific to the form type. Please see Transmitter/Submitter Information. Transmitter/Submitter information is not needed if filing via the Service Bureau.

1099 Informational Returns / Forms 1042-S

To Create a Transmitter
1. On the menu bar select File > Transmitter Information.
2. At the Update eFile Transmitter Information screen:
   o Enter the IRS assigned TCC. A TCC is composed of five alpha-numeric characters. The first two numbers are always 22. Alpha characters must be upper case.
   o Enter the IRS assigned TIN (dashes MUST be inserted!).
   o Enter the name of the company (or individual) owning the TCC.
   o Enter a contact name and phone number.
   o Enter the TCC owner’s address.
3. Click "Save" or "Cancel" to exit the screen.

The transmitter information is incorporated into the electronic file. The TCC displays on the "Computer Generated Substitute Form 4804/Form 4802" report which prints automatically after creating an Electronic File. If after creating electronic files it is discovered that the TCC was incorrectly entered, the Electronic File session must be voided. Changes made at the Update Electronic File Transmitter Information screen will NOT flow through to already created electronic files.
Forms W-2 / W-2c

To Create a Submitter
1. On the menu bar select File > Submitter Information
2. At the Update Electronic Filing Submitter screen:
   a. Enter the Submitter EIN
   b. Enter the SSA assigned PIN (per the SSA, the PIN may not exceed 8 characters)
   c. Enter Submitter Name and Address
   d. Enter Company Name and Address
   e. Enter Contact Information
   f. Enter Preferred Method of Problem Notification
   g. Enter Preparer Code
3. Click "Save" or "Cancel" to exit the screen.

The Submitter information is incorporated into the electronic file. If after creating electronic files you discover that your Submitter information was entered incorrectly, the Electronic File session must be voided. Changes made at the Update Electronic Filing Submitter screen will NOT flow through to already created electronic files.

Forms 8966

To Create a Transmitter
1. On the menu bar select File > Transmitter Information.
2. At the Update Electronic Filing Transmitter Information screen enter the Company specific information:
   a. Company Name
   b. Address Formatting:
      i. USA
      ii. CANADA
      iii. OTHER
   c. Company Address
   d. City, Locale, Postal, Country
   e. Contact Name
   f. Phone Number
   g. Company Email
3. Enter the FIN if a third party preparer.
   a. Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI), third party preparers, or commercial software vendors are not required to have GIINs. These non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN to access IDES. The FIN is the 19-character identifier entered in the metadata and FATCA XML message header.
4. Click "OK" to save changes or "Cancel" to abort.

25 Error Messages

Error Messages

Error messages appear as pop-ups within your software due to user error or a software bug. Many of these errors have simple solutions that can be easily applied by the user, the user's IT department or 1099 Pro's technical support team. Prior to applying any solution backup data to avoid any possible data loss.
Most error messages result from one or more of the following issues:
- Incorrectly mapped data file.
- Inadequate user rights to read/write/edit data file.
- Third party anti-virus software removing critical software files.
- Incomplete software updates.

**Authorization Code Error**
If an Authorization Code does not work it is almost always because an incorrect version of the software was installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation; likewise a W-2 Pro 2016 Authorization Code is incompatible with a W-2 Pro 2017 installation. Users should verify that the version installed matches the version purchased.

**Common Error Messages & Solutions**
- **Invalid Record Declaration Error 47**
- Unable to Open Required File (ProTips): 2 – File Not Found
- Unable to Open Required File (ProTips): 3 – Path Not Found
- Unable to Open SystemID: 2 – File Not Found
- Unable to Open SystemID: 3 – Path Not Found
- Unable to Open SystemID File 53 – Invalid Clarion File
- Clarion Trappable Runtime Errors
- EC002 – Unable to Open Files!
- Error Code #0008 – Can't Find Stub Loader
- Could Not Load DLL Library \USER32.DLL
- Single User Version Error
- File Not Found: Information Request

**Antivirus Exceptions**
1099 Pro software requires full rights to certain folders and subfolders plus a carve-out from any antivirus programs (e.g., Norton, McAfee, Sophos, Kaspersky, Webroot, etc.). This includes full rights and permissions to where the software is installed is required, which is typically C:|1099Pro and all subfolders. In the case that your data folder is on a network, users will also need full rights to the Data folder where the .TPS files reside.

Antivirus (AV) programs often prevent installations, software updates and corrupt.TPS data files. The following assumes that the software is installed in the default installation locations. Be sure to create exceptions which correspond to where the software is launched from and where your data (.TPS) files reside.

For detailed instructions on setting up a carve-out for 1099 Pro software products please refer to the 1099 Pro WIKI at [https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions](https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions).

**25.1 Invalid Record Declaration (47)**

File Access Error: Invalid Record Declaration (47)
Solution:
This error can occur when either system latency or anti-virus software interrupts the record-numbering process. Please contact 1099 Pro Technical Support to further assist in renumbering records.

25.2 Unable to Open Required File (ProTips): 2 – File Not Found

Unable to Open Required File (ProTips): 2 – File Not Found

Solution:
This error most often occurs if there was an error during installation or an error when mapping the file path to your data folder. First, verify the software is not running from a network location; the software must be run locally, or from a client installation linked to a hosted data file.

The software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

25.3 Unable to Open Required File (ProTips): 3 - Path Not Found

Unable to Open Required File (ProTips): 3 – Path Not Found
Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

25.4 Unable to Open SystemID: 2 - File Not Found

Unable to Open SystemID: 2 – File Not Found

Solution:
This error most often occurs if there was an error during installation, or if a third party virus protection software removed 1099 Pro program files. Verify the file "Systemid.TPS" exists; located in file path C:\1099 Pro\Pro99Txx\Resource. If this file has been removed, or was blocked from installation, you may need to backup your data, then uninstall and reinstall the software. Be sure to list 1099 Pro as trusted software in your anti-virus software to avoid having files removed.

If "Systemid.TPS" is present, it's possible that the file path to your data contains unacceptable characters. This can be changed by editing your .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Locate the file path associated with "SAV:GlobalDataPath".
- Make sure the data file path does not contain a backslash at the end of the path, or any periods if using a UNC. For example: \stationx.1099pro.com\c\xxxxx\.
- Save and run the software again.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Please contact 1099 Pro Technical Support to further assist in renumbering your records.
25.5 Unable to Open SystemID: 3 - Path Not Found

Unable to Open SystemID: 3 – Path Not Found

Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file called Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

25.6 Unable to Open SystemID: 5 - Access Denied

Unable to Open SystemID: 5 – Access Denied

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.

25.7 Unable to Open SystemID File: 53 - Invalid Clarion File

Unable to Open SystemID: 53 – Invalid Clarion File
Solution:
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to `C:\1099 Pro\Pro99Txx\Admin`.
- Open the file `Pro99Txx.INI`.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in `C:\1099 Pro\Pro99Txx\Data`. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

25.8 EC002 – Unable to Open Files!

EC002 – Unable to Open Files!

Solution:
This error most often occurs when attempting to restore data from the wrong year (e.g., data from 2016 into 1099 Pro for 2017). Users cannot restore data into a different year's software. This is a security measure to ensure that users do not accidentally file the wrong data.

Recipient and filer information may be rolled forward during or immediately after installing. For more information, see Roll Forward Data.

25.9 File Not Found - Information Request

File Not Found: Information Request
Solution:
This error may occur when performing a Roll Forward procedure if some of the user selected items such as "Prior Year Security Settings" or "Prior Year Import Maps" do not contain data. For example, in the 2016 software security was not used or custom import maps were not created.

The user should click "OK" and continue with the installation.

25.10 Could Not Load DLL Library \USER32.DLL

Could not load the DLL library C:\Windows\USER32.DLL. The specified module could not be found.

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.

25.11 Clarion Trappable Runtime Errors

Clarion Trappable Runtime Errors

The following errors can be trapped in code with the ERRORCODE and ERROR procedures. Each error has a code number (returned by the ERRORCODE procedure) and an associated text message (returned by the ERROR procedure) indicating what the problem is.

2 File Not Found
The requested file does not exist in the specified directory.
3  Path Not Found
The directory name specified as part of the path does not exist.

4  Too Many Open Files
The total number of file handles available has been used. Check the FILES= setting in the CONFIG.SYS file, or the user's or network's simultaneous open files setting in a network environment.

5  Access Denied
The file has already been opened by another user for exclusive access, has been left in a locked state, or you do not have network rights to open the file. This error can also occur when no disk space is available.

7  Memory Corrupted
Some unknown memory corruption has occurred.

8  Insufficient Memory
There is not enough unallocated memory left to perform the operation. Closing other applications may free up enough memory.

15 Invalid Drive
An attempt to read a non-existent disk drive has failed.

27 Invalid Table Declaration
An attempt to open a table that has an invalid table structure has failed. This is normally found when a Dynamic File has been created incorrectly. Also seen in IP Driver based applications.

30 Entry Not Found
A GET to QUEUE has failed. For GET(Q,key), the matching key value was not found, and for GET(Q,pointer), the pointer is out of range.

32 File Is Already Locked
An attempt to LOCK a file has failed because another user has already locked it.

33 Record Not Available
Usually an attempt to read past the end or beginning of file with NEXT or PREVIOUS. May also be posted by PUT or DELETE when no record was read before the attempted PUT or DELETE.
35 Record Not Found
For a GET(File,key), the matching key field value was not found.

36 Invalid Data File
Some unknown data file corruption has occurred, or the OWNER attribute does not match the password used to encrypt the file.

37 File Not Open
An attempt to perform some operation that requires the file be already open has failed because the file is not open.

38 Invalid Key File
Some unknown key file corruption has occurred.

40 Creates Duplicate Key
An attempt to ADD or PUT a record with key field values that duplicate another existing record in the file has been made to a file with a key that does not allow duplicate entries.

43 Record Is Already Held
An attempt to HOLD a record has failed because another user has already held it.

45 Invalid Filename
The filename does not meet the definition of a valid DOS filename.

46 Key File Must Be Rebuilt
Some unknown key corruption has occurred that requires the BUILD statement to re-build the key.

47 Invalid Record Declaration
The data file on disk does not match the file's declaration in the .EXE, usually because you have changed the file's definition in the Data Dictionary and have not yet converted the existing data file to the new format. See How do I handle an Error 47

48 Unable To Log Transaction
A transaction logout or pre-image file cannot be written to disk. This usually occurs because no disk space is available, or the user does not have the proper network rights.
52 File Already Open
An attempt to OPEN a file that has already been opened by this user.

54 No Create Attribute
An attempt to execute the CREATE procedure on a file whose declaration does not include the CREATE attribute.

55 File Must Be Shared
An attempt to open a file for exclusive access that must be shared. (Legacy error, no longer used)

56 LOGOUT Already Active
An attempt to issue a second LOGOUT statement while a transaction is already in progress.

57 Invalid Memo File
Some unknown memo file corruption has occurred. For Clarion data files, this could come from a corrupt .MEM file "signature" or pointers to the memo file in the data file that are "out of sync" (usually due to copying files from one location to another and copying the wrong .MEM file).

63 Exclusive Access Required
An attempt to perform a BUILD(file), BUILD(key), EMPTY(file) or PACK(file) was made when the file had not been opened with exclusive access.

64 Sharing Violation
An attempt to perform some action on a file which requires that the file be opened for shared access.

65 Unable To ROLLBACK Transaction
An attempt to ROLLBACK a transaction has failed for some unknown reason.

73 Memo File Missing
An attempt to OPEN a file that has been declared with a MEMO field and the file containing that memo data does not exist.

75 Invalid Field Type Descriptor
Either the type descriptor is corrupt, you have used a name that does not exist in GET(Q,name), or the file definition is not valid for the file driver. For example, trying to define a LONG field in an xBase file without a matching MEMO field.
76  Invalid Index String
The index string passed to BUILD(DynIndex,string) was invalid.

77  Unable To Access Index
An attempt to retrieve records using a dynamic index failed because the dynamic index could not be found.

78  Invalid Number Of Parameters
You did not pass the correct number of parameters to a procedure called in an EVALUATE statement. Note: As of Clarion Version 6.2 (9047), the SQL Drivers now add more information to the trace log file, explaining why the ERRORCODE 78 was generated.

79  Unsupported Data Type In File
The file driver has detected a field in the file declared with a data type that is not supported by the file system the driver is designed to access.

80  Unsupported File Driver Function
The file driver has detected a file access statement that is not supported. This is frequently an unsupported form (different parameters) of a statement that is supported.

81  Unknown Error Posted
The file driver has detected some error from the backend file system that it cannot get further information about.

88  Invalid Key Length
An attempt to CREATE a Clarion file driver KEY or INDEX with more than 245 characters. Other file drivers can also return this error when their file system key length limits are exceeded.

89  Record Changed By Another Station
The WATCH statement has detected a record on disk that does not match the original version of the record about to be updated in a network situation.

90  File Driver Error
The file driver has detected some other error reported by the file system. You can use the FILEERRORCODE and FILEERROR procedures to determine exactly what native error the file system is reporting.

91  No Logout Active
The COMMIT or ROLLBACK statement has been issued outside of a transaction frame (no LOGOUT statement has been executed).

92  BUILD in Progress
A BUILD statement has been issued and PROP:ProgressEvents has been set to generate events. The statement generating this error is not appropriate to execute during a BUILD process.

93  BUILD Cancelled
The user cancelled the BUILD. This error is set when EVENT:BuildDone is posted.

94  Record Limit Exceeded
The target file has exceeded the record limit. This value is file driver dependant, and can be returned during any attempt to modify a file where the record limit is exceeded.

97  Stream Error
Used during RTF processing.

100  Trigger Error
This error is set whenever a registered file callback method returns FALSE. See CALLBACK

1010  Illegal Expression
The EVALUATE procedure has detected an error in the syntax of the expression it is attempting to evaluate.

1011  Variable Not Found
The EVALUATE procedure has not found a variable used in the expression it is attempting to evaluate. You must first BIND all variables used in the expression for them to be visible to EVALUATE.

25.12 Single User Version Error

Single User Version Error

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the software is installed. Contact your IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for additional assistance.
26 Additional Services

26.1 TINCheck

TINCheck: TIN/Name Verification

The IRS penalty for TIN/Name mismatches can reach $530* per return with no maximum! The TINCheck service is an essential tool in identifying mismatch errors through an interactive and user-friendly website prior to filing information returns. Simply sign up and then log in with your username and password, and instantly gain access to multiple verification sources in one place. Users also have the option of integrating the API/web service into an existing accounts payable system; thus allowing your company to seamlessly verify information while entering new vendor information into your database.

* Reference IRS Publication 1586.

IRS TIN/NAME MATCHING (IRS TIN MATCHING) Internal Revenue Service (IRS)
Internal Revenue Service (IRS) This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs). The IRS can assess penalties of up to $1,500,000 ($500,000 for small business) for non-compliance. In the event of intentional disregard, there is no limit.

EIN/NAME LOOKUP SYSTEM (ELS) Internal Revenue Service (IRS) Issued EINs
Internal Revenue Service (IRS) issued EINs This lookup process will retrieve the company name that is associated with a given EIN number. This lookup is only for public knowledge company EIN numbers, it does not return individual names from Social Security Numbers (SSNs). This lookup is very useful for getting the correct company name that was identified as a mismatch by the IRS TIN Matching process.

SPECIALY DESIGNATED NATIONALS (SDN/PLC) Office of Foreign Assets Control (OFAC)
Office of Foreign Assets Control (OFAC) Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties. OFAC non-compliance carries civil penalties of up to $1,000,000 per violation plus criminal fines of up to $10,000,000 and imprisonment ranging from 10 to 30 years.

DEATH MASTER FILE (DMF) Social Security Administration (SSA)
Social Security Administration (SSA) The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud. IRS TIN/Name Matching does not discern whether or not a payee is deceased. For some payers, knowing whether they are paying a deceased individual is prudent. Checking payees against the Death Master File gives the payer community the ability identify and prevent fraud.

DENIED PERSONS LIST (DPL) Department of Commerce (DOC)
Department of Commerce (DOC) The DPL is a list created by the U.S. Department of Commerce of individuals and entities that have been denied export privileges. Any dealings with a party on this list that would violate the terms of its denial order is strictly prohibited. Violation can result in a civil penalty amounting to the greater of $250,000 or twice the value of the transaction for each violation. For criminal violations, violators may be fined up to $1,000,000 and/or face up to 20 years of imprisonment.

EXCLUDED PARTIES LIST SYSTEM (EPLS) General Services Administration (GSA)
General Services Administration (GSA) The Excluded Parties List System includes companies that have been debarred, suspended, excluded, or disqualified from receiving Federal contracts, subcontracts,
assistance, and benefits. Government agencies and contractors are required to check this list to validate vendors and/or payees are in good standing with the federal government.

**EXCLUDED INDIVIDUALS AND ENTITIES (LEIE)** *Office of Inspector General (OIG), Health & Human Services (HHS)*
Office of Inspector General (OIG), Health & Human Services (HHS) In the health care industry, anyone who hires an individual, entity, or contractor on the LEIE may be subject to civil monetary penalties (CMP) by the OIG ranging into the millions of dollars. To avoid CMP liability, health care entities need to routinely check the LEIE to ensure that new hires, current employees, or contractors are not on the excluded list.

**DESIGNATED FOREIGN TERRORIST ORGANIZATIONS (FTO)** *Department of State (DOS)*
Department of State (DOS) Foreign Terrorist Organizations (FTOs) are foreign organizations that are designated by the Secretary of State in accordance with section 219 of the Immigration and Nationality Act (INA).

**POLITICALLY EXPOSED PEOPLE (PEP)** *Central Intelligence Agency (CIA)*
Central Intelligence Agency (CIA) A quarterly updated list compiled by the CIA of Chiefs of State and Cabinet Members of Foreign Governments.

**FBI Wanted Lists (FBL)** *Federal Bureau of Investigation (FBI), Department of Justice (DOJ)*
Federal Bureau of Investigation (FBI), Department of Justice (DOJ) Criminal Enterprises, Cyber Crimes, White Collar Crimes, Violent Crimes, Crime Alerts, Crimes Against Children, Domestic Terrorism, Seeking Information, Seeking Terror Information, Top Ten Fugitives, Most Wanted Terrorists, etc.

**ADDRESS VALIDATION (AV)** *United States Postal Service (USPS)*
United States Postal Service (USPS) Automatically validate a address (if provided) using the USPS Address Validation and Normalization Database to insure the most accurate and up-to-date address information.

**ADDITIONAL VERIFICATIONS** State Banned Lists Including state and local banned patron lists for casinos and other various lists.

For more information contact the TINCheck Sales and Support team; Monday through Friday, 8am to 5pm PST.

**Contact Sales**
Email: sales@tincheck.com
Phone: 1-866-452-3467

**Contact Support**
Email: support@tincheck.com
Phone: 1-866-452-3467

### 26.1.1 Manage My TINCheck Account

**TINCheck: Managing your TINCheck account**

**Note:** Before you can begin to use the TINCheck service an account needs to be created.
To review different plans please visit: [https://www.tincheck.com/plans](https://www.tincheck.com/plans)
*Please visit https://www.1099pro.com/videos.asp and select the "How to Use Integrated TIN/Name validation" to watch a brief tutorial on the TINCheck integration process.

In order to enter your tincheck account information into the software so that you can utilize real time tin verification please complete the following steps.

Click on "File"
Click on "Security and administration"
Click on "Program Options"
Click on "Set TINCheck Account"
In the TINCheck User (login) ID field please enter your TINCheck user ID (Note: This is normally an email address)
In the TINCheck Password field please enter your TINCheck password.
After completing the preceding two steps it is recommended that you click the "Test my TINCheck connection now!" button to make sure that your account information has been entered correctly before proceeding.

Note: If in the future you would like to disable the software's ability to verify TINs then click the "Turn off (Disable) all TINCheck functionality) checkbox.
If you would like to enter any notations or descriptions regarding the TINCheck service please enter them in the Account description or Account notes fields; please note that neither of these areas will have any impact on the processing of TINs.
Once you are done click on "Save" or, if you would like to discard of the changes made to this screen click on "Cancel".
If you attempt to verify a TIN prior to entering a TINCheck account you'll see the below screen, click the "Configure TINCheck account" button to enter TINCheck account information, or click the "Sign up now!" button to open the www.TINCheck.com website in your default internet browser.
26.1.2 Manage My Results

TINCheck: Managing your results

In order to check the validity of a TIN that you're using on a tax record:
When editing an existing tax form or adding a new one click the "Tax Validation" button.
Click "Check TIN/Name"

Please note that when checking TIN's the TINCheck service also provides you with information on the following lists:

**IRS TIN/Name Matching (TIN Matching):** Internal Revenue Service; This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs). The IRS can assess penalties of up to $1,500,000 ($500,000 for small business) for non-compliance. In the event of intentional disregard, there is no limit.

**Specially Designated Nationals (OFAC/SDN/PLC):** Office of Foreign Assets Control, Department of Treasury; Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties. OFAC non-compliance carries civil penalties of up to $1,000,000 per violation plus criminal fines of up to $10,000,000 and imprisonment ranging from 10 to 30 years.

**Death Master File (DMF):** Social Security Administration; The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud. IRS TIN/Name Matching does not discern whether or not a payee is deceased. For some payers, knowing whether they are paying a deceased individual is prudent. Checking payees against the Death Master File gives the payer community the ability identify and prevent fraud.
26.1.3 History Requests

TINCheck: History of Requests

The TINCheck History screen allows users to view all instances of the TIN associated with the viewed record. In this way it also serves as an audit trail allowing users to see the information associated with that TIN at the time it was checked and who performed that check (assuming multiple login IDs have been configured for this functionality).

To print an audit trail report click the "Print/View" button.
26.1.4 **TINCheck Integration**

**TINCheck Integration**

There are two ways to provide user access to TINCheck’s integrated features. The Administrator can create a *built-in* access group with permissions and include the user in that group.

If the end user is part of a “built-in” access group, the Administrator can create. If the user is part of a custom access group, you can simply modify the user profile under the access group. Users belong to access group that are highlighted in green are using Built-in Groups. If using built-in groups, a new access group must be created to allow access to TINCheck.
Users already using custom access groups and profiles will need to update the access group to allow TINCheck integration. Highlight the group and click the Change button. Tag the Program Area named “Allow access to TINCheck” and the click the Modify button.
Click Select All Rights then Save.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Access Form or Program Area</th>
<th>Create</th>
<th>Modify</th>
<th>Delete</th>
<th>Repeat</th>
<th>Correct</th>
<th>Print</th>
<th>Reprint/Void</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Payee Verification</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Import/Browse B Notices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request First B Notice</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request Second B Notice</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 BEN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 ED</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 EXP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 INTY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request W3 Combined</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dlsy Group to A3P module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dlsy Group to CS module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Allow access to TINCheck
Select the types of rights that should be granted within this area.

- [ ] Create new items or initiate processes
- [ ] Modify existing items
- [ ] Delete existing items
- [ ] Run Reports on this area
- [ ] Correct or initiate Corrections related activities
- [ ] Print these tax forms or items
- [ ] Reset/ VOID these processes

Select All Rights
Click Save Changes to Group. For users using Built-In Groups, you will need to create an Access Group first and then update your User Profile(s). Click the Add button at the bottom.
**About Access Groups…**

Access groups determine which Forms or Program Areas a User can access, and what rights the user has accessing those forms or areas.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Notes for the Selected Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Areas</td>
<td>This group grants a user full access to all areas of the software including the ability</td>
</tr>
<tr>
<td>All Areas Except Security</td>
<td>to modify Security and Administration settings. Tax form access must be added separately</td>
</tr>
<tr>
<td>Custom MISC Only</td>
<td>using additional groups. E.g. Tax Forms [Full Rights].</td>
</tr>
<tr>
<td>Export Tax Form Data</td>
<td></td>
</tr>
<tr>
<td>File Tax Forms With IRS</td>
<td></td>
</tr>
<tr>
<td>Import Tax Form Data</td>
<td></td>
</tr>
<tr>
<td>Service Bureau Upload</td>
<td></td>
</tr>
<tr>
<td>Tax Forms (Edit/Pending)</td>
<td></td>
</tr>
<tr>
<td>Tax Forms (Full Rights)</td>
<td></td>
</tr>
<tr>
<td>Tax Forms (View Only)</td>
<td></td>
</tr>
<tr>
<td>W-9 Tracking</td>
<td></td>
</tr>
</tbody>
</table>

= Groups that are this color are Built-in Groups, and cannot be deleted or changed other than just adding or removing members.

Give your new access group a name and tag Allow access to TINCheck and click the Modify button.
Click Select All Rights then Save.
Click Save Changes to Group. Go to your User Profiles and update them to include the new access group we created for TINCheck access. Tag the access group and click Save Changes to Group.
26.1.5 Status Icons

TINCheck Status Icons

These status symbols can be found when adding/editing an individual record; you'll find them to the right of the TIN being checked.
Clicking on the symbol will give you more information about it and allow you to validate the TIN once more by clicking on the “Go to Validation” button.
26.2 Managed Services

Managed Services

The 1099 Pro Managed Services team, IRSCompliance, can maintain your payee and payment database in our secure SSAE 16 SOC I Type II environment, or on your secure servers. Managed Services can support current and prior years of tax data for forms 1098, 1099, 5498, W-2G, W-2, 1042-S, 3921, 3922, as well as Puerto Rico payment information. This service includes regulatory support, compliance training, and year-end recipient statements. Users can access the 1099 Pro Corporate Suite software to securely view and print their payee and payment information and perform data queries, either online or through a secure network.

With more than 25 years of experience, IRSCompliance members have real world experience in a variety of industries, and as a result, are experts in federal law, state tax, local tax, and payment types that are subject to reporting. IRSCompliance’s expertise and efficiency will improve your compliance and minimize financial risk to your company.

CUSTOM AND SCALABLE FEATURES
Federal & state filing for originals and corrections
Quarterly wage reporting
Independent Contractor Reporting
TIN Compliance Management: B-Notices, TIN matching, W-8 and W-9 processing
Balancing and reconciliation
Transaction detail history and audit trails
Penalty abatement
Form 1099-K processing and reporting

OPTIONAL SERVICES
Withholding & deposit services
Policy and procedure development
Regulatory publications, webinars, and events
Standard and custom printing services
Consulting, risk assessment services, and curing
Penalty appeals
Electronic filing services
Electronic payee statement presentment
Electronic solicitation and validation of W-8s & W-9s

1099 Sales and Technical Support
(888) 776-1099
sales@1099pro.com

26.3 Form CA-592 New

Form CA-592 Overview

The features contained within this section are available exclusively to users of the Corporate Suite edition.
**New for Tax Year 2016** - 1099 Pro prepares Form CA-592 Resident and Nonresident Withholding Statements for payees who received California source income but are not residents of California. Users may print year-end composite statements and generate electronic files either 1) quarterly if using transactional imports with an accounting date, or 2) fourth quarter only if doing a standard year-end (non-transactional) import.

There is no Service Bureau support for printing, mailing or filing Form CA-592.

- See [CA-592 Quarterly E-File Wizard](#)

## 27 Glossary

### Glossary

- **10 Day**  
  *Per IRS Pub. 1220, part C, section 7:*  
  "If the [electronic] file is good, it is released for mainline processing 10 calendar days from receipt. Contact [the IRS] at 304-263-8700 within this 10 day period if there is a reason the file should not be released for further processing. If the file is bad, normal replacement procedures are followed."

- **250 Rule**  
  The Rule-of-250 states that any filer submitting 250 or more forms of any one type must submit those forms electronically. Failure to do so may result in significant per form penalties.

  See Rule-of-250 for detailed information.

- **4419**  
  To obtain a TCC number, file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Form 4419 may be printed at the Print Blank Forms screen.

- **8809**  
  Purpose of form. Use this form to request an extension of time to file 1098 series, 1099 series, W-2 series, W-2G, 5498 series, 8027, 1099-INT/OID for REMIC and 1042-S forms.

- **"A" Record**  
  Identifies the person making payments
Access Groups
Access Groups determine which Filers and tax form types a user can access and which tasks they can perform upon those tax forms. By default, all users can access ALL forms and All Filers unless you create your own Access Groups. Built in Groups are groups that cannot be deleted or changed other than just adding or removing members.
Available built groups consist of "All Forms/All Filers". The key to restricting forms and Filers to a user is to minimize the number of Filers and/or forms you make available to them.

Account Generation Wizard
1099 Pro offers a feature that will generate account numbers for each form that does not have an account number. IRS Publication 1220, states on page 77 that the IRS requires account numbers "Enter any number assigned by the payer to payee that can be used by the IRS to distinguish between information returns. This number must be unique for each information return ..." The IRS has indicated that they will not reject files if they do not have account numbers but by having account numbers the IRS will be able to process any corrections that they encounter.

Activation Code
A registration code (aka activation code or product ID) is provided upon proof of payment. The algorithm of your registration code indicates the edition, user license and number of record transactions purchased.

Aggregation
The 1099 Aggregation Feature was designed to allow users to consolidate more than one tax form of the same type, for one recipient under a given filer.

For example, John Smith owns an automobile detail business and frequently comes by the movie studio to wax and wash the studios automobiles You, (the Filer) issuing the 1099-MISC form, pay John frequently on a bi-weekly basis so instead of printing and issuing multiple 1099 forms for John you only want to view/print it as one combined form. This feature will allow you to view the aggregated box amount totals highlighted in green in the tax form which is a reflection of all tax form dollar amounts for this recipient under this master tax form only.

Audit Trails
Audit Trails do NOT track the history of all manual and cascading changes to a Master Recipient & Filer List. Only direct changes to a tax form are stored in the record history screen.

- B -

"B" Record
Contains the payment information from the information returns.

B-Notice
If after submitting files to the IRS, a mismatch is determined, (e.g., a recipient's name and TIN do not match the IRS records), the IRS sends the Filer a CP2100 or CP2100A Notice. The Filer must then issue a Form W-9 and a B Notice to the recipient in question unless the Filer determines the error was on their part (e.g., a typo).

Backup Data
The 1099 Pro Backup Wizard automatically copies all data files and compresses them into a WinZip format. By default, 1099 Pro prompts for a daily backup.
Blank Paper
Print Copy B &/or C directly onto blank copier paper. This is good in case of an emergency when Blank Laser Perforated paper is unavailable (might require special folding and/or cutting to fit in standard IRS approved envelopes). 1099 Pro, Inc. offers custom designed IRS regulation envelopes to fit copier paper.

Blank Laser Perforated
Print Copy B &/or C directly onto blank laser perforated stock (1099 Pro prints the necessary graphics). Easier to fold than blank copy paper because of the perforations, and since it is blank, it won't go out of date!

Bulk TIN Matching
TIN Matching is a pre-filing service offered to payers and/or authorized agents who submit any of six information returns subject to backup withholding (Forms 1099-B, INT, DIV, OID, PATR, and MISC). With Interactive TIN Matching authorized payers can match up to 25 payee TIN and name combinations against IRS records prior to submitting an information return. Bulk TIN Matching allows payers and/or authorized agents filing any of the six information returns to match up to 100,000 TIN and name combinations. In order to participate in TIN Matching, payers must be listed in the IRS Payer Account File (PAF) database. If your firm has not filed information returns with the IRS in one of the past two tax years, the application will not be available to you at this time.

Click here to learn how to use Bulk TIN Matching

Business Rules
Business Rules are formulated in conjunction with the compliance experts from IRS Compliance to check that data being processed in 1099 Pro’s software does not contain common formatting errors, form specific errors, is valid for State and Federal filing, and can be used to separate records with different levels of issues for processing.

- C -

"C" Record
Contains the total number of payees and the totals of the payment amount fields filed for each payer and/or particular type of return.

CFSF / CFSFP - Combined Federal State Filing Program
The Combined Federal/State Filing Program was established to simplify information return filings for taxpayers. The CF/SF Program allows the IRS to forward electronically-filed information returns to participating states free-of-charge for approved filers, thus eliminating separate reporting to those states.

Control Totals
The Control Totals report is an invaluable tool for reviewing recipient records. Information contained in this report includes:
- Form type
- Filer's Name and TIN
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Box by box totals
- Number of missing TINs and more....

Corrections
If you filed a return with the IRS and later discover you made an error on it, you must correct it as soon
as possible. For some corrections, you must file two returns with Form 1096 and for some only one return with Form 1096. In addition, you must provide statements to recipients showing the corrections as soon as possible. If you fail to file correct information returns or furnish a correct payee statement, you may be subject to a penalty.

- E -

Electronic Filing

EIN (Employer Identification Number)
An Employer Identification Number (EIN) is also known as a federal tax identification number, and is used to identify a business entity. Generally, businesses need an EIN.

Excel Spreadsheet Files
When saving data in Excel, use the ‘Save As’ method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files appear out of alignment when viewed from a text editor such as Notepad but look great when viewed from Excel. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

Export Database
The 1099 Pro Export Wizard simplifies the process of creating export files. Export files are written in ASCII format, delimited with a TAB character, and may be easily opened in Microsoft Excel, Access or Notepad.

- F -

"F" Record
End of Transmission

Filer
The individual or organization filing the 1099.

FIRE System
Use the Filing Information Returns Electronically (FIRE) System to electronically upload informational returns to the IRS. Electronic files created via the 1099 Pro Electronic File Wizard fully comply with required IRS record formats per Pub. 1220. The FIRE System is available 24 hours a day, 7 days a week to any transmitter and can be reached by visiting https://fire.irs.gov. The FIRE System can be accessed by opening a web browser, accessing the Internet and typing in the address https://fire.irs.gov.

Form Status
Users must select an import status for their data in the first step of the import routine, Import Data. Selecting the correct status is important because aside from Pending, the status of the session can only be reset by voiding (deleting) the entire session.

Forms
Fill-in forms allow you to enter information while the form is displayed 1099 Pro in the Enter, Update & view Screen. You can then print the completed form for your records and for filing with the IRS.

Forms Status Values
See topic on "Forms Status Values"
- G -

**Generating Account Numbers**

See Account Number Generation

**Group Actions**

Group Actions let you tag/select a number of items and then perform a single action on them. In all cases, you will be asked to confirm your choice before the action is taken.

- H -

**History**

1099 Pro lets you view a list of prior changes to a form. Records with a pending status display the Changing a Record screen. In the upper right corner of the form is a audit trails button. Click the "audit trails" button. This screen tracks all manual changes made directly to a record.

- I -

**Import**

Many database and spreadsheet applications such as Microsoft Excel, Access and Lotus 1-2-3 provide for the exporting of data to an ASCII file. These files can be imported into 1099 Pro, thus relieving the burden of manually entering the information onto the tax form. If your data has already been entered once, why type it again?

**INI Files**

The "Pro99T17.INI" file contains information specific to your installation and is located at `<% DEFAULTPATH%>\Admin`. If installing to a directory such as Program Files it may be placed in C:\Windows. The INI file may or may not be deleted during a custom uninstall. This file can be manually deleted if you want to totally remove 1099 Pro from your system or if you want to perform a clean reinstallation. This file can remain if you want to reinstall the software but retain your settings.

**Install**

See Instructions on Installing 1099 Pro.

**IRS/MCC**

The Internal Revenue Service, a division of the U.S. Treasury Dept. that is responsible for the assessment and collection of most federal taxes, except those relating to alcohol, tobacco, firearms, and explosives. Established in 1862, the IRS derives most of its revenues from the collection of corporate and individual income tax.

- K -

"K" **Records**

Contains the summary for a given payer and a given state in the Combined Federal/State Filing Program, used only when state-reporting approval has been granted.

**Keyboard Shortcuts**
Keyboard shortcuts allow you to quickly enter or carry out functions by applying a combination of ALT [SHIFT] or Ctrl + key Commands on your keyboard.

-L-

**Laser Forms**
When using preprinted laser forms you must select the copies to print. The Print Wizard pauses before printing each copy to prompt you to load the appropriate form into the printer. For use with Copy A, B, C &/or 1096. Forms are perforated, with each required copy preprinted with the necessary information (Copy A in red drop-out ink, Copy B in black, etc.). Saves toner and time!

-M-

**Master Tax Form**
In terms of Aggregating data in a tax form, the master tax form is considered to be the first tax form entered at the top of the list.

-O-

**Online Help Tutorials**
Flash enabled tutorials walk you through various tasks including importing, exporting, printing, Electronic File, queries, etc. Tutorials simplify the 1099 Pro learning curve - try one at [http://www.1099 Pro.com](http://www.1099 Pro.com)

**Online Knowledge Base**
Provides a searchable database of over 200 solutions for all 1099 Pro, Inc. software products. Access the Knowledge Base at [http://www.1099 Pro.com](http://www.1099 Pro.com).

-P-

**Passwords**
The Logon screen requires you to enter a new password. Passwords must be 3-8 characters, should not be case sensitive, and you cannot use the word "new."

**Payer Codes**
A Payer Code or PCode is an alphanumeric shorthand used to identify a Payer/Filer in the system. You might set up several Filers with the same TIN in the system and the Payer Code is an easy way to identify the business area you are dealing with. For example a Payer Code of ‘BOD’ where reporting for the Board of Directors takes place. Typically security and/or the return address would be different for each Payer Code.

Additionally, in an import file with recipient / tax form data for more than one Payer/Filer, Payer codes can be used to define which Payers / Filers the recipient / tax form data should be posted to. **Corporate Suite Only**: Payer Codes are automatically assigned as necessary.

**Penalties**
Penalties can be assessed by the IRS/SSA for various reasons including filing after a deadline, invalid Recipient Name/TIN combinations, etc. See [Errors & Warnings](#) and [Penalties](#) for more information.

**Pending**
These forms were inputted or imported. Forms with a **Pending** status can be changed or deleted.
Preferences
At the menu bar select File > Security and Administration > Program Options > Preference, Update and Program Options to access the Preferences screen. Preference items allow users to modify general settings which affect global software functions.

- Q -

Queries
The Query Wizard allows custom access to user data via an intuitive wizard driven interface. Users can quickly create and save customized queries.

- R -

Recipients
The receiver of Form 8966.

Reports
Reports are useful for tracking the status of forms and determining if records contain any errors or warnings. 1099 Pro offers three main reports including the Control Totals Report, Forms Issued by Filer, and Form Counts by Filer.

Restore
The 1099 Pro Backup Wizard automatically copies all data files and compresses them into a WinZip format. Use the shareware program WinZip to restore data to a location on your hard drive.

Rights Groups
Activity Groups are used to allow or deny users from performing various activities within the system. Examples may be rights to View tax forms or rights to Import/Export tax form data. Activity Groups assigned to users cause these users to inherit the rights assigned to the Group. Activity Groups consist of two types; a built-in group (denoted by the BLUE color) and custom groups created by Admin. Built-in groups cannot be deleted or modified except to add or remove users.

Roll Forward
During installation the wizard automatically looks for prior year data files. If files are located the wizard prompts to “Copy 2016 Filers to 1099 Pro 2017”. This is the only opportunity to roll forward prior year data into 1099 Pro 2017.

Rule-of-250
See Rule-of-250

- S -

Search
Access any recipient or filer via the Search Name field.

Security
1099 Pro offers two levels of security: On and Off.
- If security is enabled, access to 1099 Pro is limited to users with valid User ID/Password combinations. These users are restricted to specific tasks assigned by the Administrator. This performs a twofold method of protecting sensitive company data.
Service Bureau
1099 Pro has a proven track record of printing, mailing and electronic filing. For a fee, our 1099 Service Bureau relieves users of the burden of ordering supplies and arranging for the printing, stuffing and mailing of tax forms with sensitive data. Simply input your data into our software, schedule an appointment with the Service Bureau, and on your assigned data transmit an encrypted file via the Internet to a secured site where we:

- Print and mail all recipient copies
- File required Federal copies
- File State copies (if necessary)
- Print, Mail & File Corrections

SSN (Social Security Number)
The nine-digit Social Security number is divided into three parts:
- The first three digits are the area number. If your Social Security number was assigned before 1972 when Social Security cards were issued by local offices, the area number reflects the State where you applied for your number. If your number was assigned in 1972 or later when we began issuing Social Security cards centrally, the area number reflects the State as determined by the ZIP code in the mailing address on your application for the number.
- The middle two digits are the group number. They have no special geographic or data significance but merely serve to break the number into conveniently sized blocks for orderly issuance.
- The last four digits are serial numbers. They represent a straight numerical sequence of digits from 0001-9999 within the group

Spreadsheets
When saving data in Excel, use the ‘Save As’ method to save your file in .TXT (TAB delimited) format, not .XLS format. Sample import files in this format are included in your 1099 Pro installation and are very helpful. These files may appear out of alignment when viewed from a text editor such as Notepad but maintain formatting of data. To import .TXT (TAB delimited) files select TAB, CR LF and Double Quotes as your delimiters in the Import Wizard.

State ID Number
State ID numbers are assigned by the individual state. For example, in California the Employer Development Department (EDD) assigns a state ID number. Check with your accountant or attorney to determine your company’s state ID number. Many companies do NOT have one.

- T -

Transmitter "T" Record
Identifies the Transmitter of Electronic file information contained on Form 4419.

Tag
The act of selecting a Filer, Recipient or State.

TCC - Transmitter Control Code
A Transmitter Control Code number or (TCC) is required when filing electronically. A TCC is composed of five alpha-numeric characters. If filing electronically via the Service Bureau, a TCC is not required and this information need not be completed.

Technical Support
See Technical Support
TIN - Taxpayer Identification Number. **NOTE:** All Forms 1099 must include payee tax identification numbers (TINs). A TIN is a social security number issued by the Social Security Administration, an Employer Identification Number issued by the IRS, or an Individual Tax Identification Number issued by the IRS. Individual Tax Identification Numbers are generally restricted to certain foreign vendors who are not eligible for social security numbers.

**TIN Matching**
See *Bulk TIN Matching*

**Transmitter Information**
The Individual or Organization responsible for filing the tax forms electronically to the IRS. To obtain a TCC, file Form 4419 to request authorization to file forms electronically. Form 4419 must be mailed at least 30 days prior to the filing deadline for the electronic file. Form 4419 may be printed at the Print Blank Forms screen. For more information on TCC’s, contact the IRS-MCC at (304) 263-8700.

- **U** -

**Un-Installing**
The Select Uninstall Method screen offers two options for removing 1099 Pro from your hard drive:
- “Custom” allows the user to select files individually (recommended).
- “Automatic” initiates a default uninstall routine. This option retains your current data files under the main program directory in the Data folder, any Service Bureau uploads in the Uploads folder, the .INI file in the Admin folder and any miscellaneous .DLL files used by the software.

**User(s) / UserID**
A user is an individual who has access to the software. Rights and permissions which delegate what this user can and cannot do are assigned to the user and then the user freely uses the software either with or without restrictions.

**User Group(s)**
User Groups are created by attaching one or more Access Groups and one Activity Group to them. A user's rights are determined based on which User Groups they are a member of:
- Administrator/ALL Rights
- Tax Forms (Edit/Pending)
- Tax Forms (Full Rights)
- Tax Forms (View Only)
- Import Tax Form Data
- Export Tax Form Data
- All Tasks Except Security
- File Tax Forms with IRS
- Service Bureau Upload
- W-9 Tracking

- **V** -

**Virus Checkers**
Disable virus checkers (e.g., Norton, McAfee, ViruScan, etc.) PRIOR to installation to avoid potential corruption. Random errors in 1099 Pro are typically due to installation of software while running a virus checker. After a successful installation, re-enable the virus checker.
W-9
Use Form W-9 Request for Taxpayer Identification Number and Certification to request a recipient’s TIN if the recipient is a U.S. person or U.S. resident alien. If the recipient is a foreign person use the appropriate Form W-8. See How to Create a W-9 Request

Warnings
See Errors and Warnings

Web Updates
The Check for Updates feature uses the Internet to check the 1099 Pro, Inc. update servers for a newer version of this program. Instead of running the full Web Update procedure from your Windows Start->Programs menu, you can now quickly check for updates from within 1099 Pro, or even have the program automatically check for you. If there is a new version, a message will pop up to display the new version and a one line summary of what is included in the update.

27.1 Alignment

Alignment

Alignment adjustments are measured in hundredths of an inch from the default margin. For example, "0.25" would shift the top margin down 1/4-inch and "-0.25" would shift the top margin up 1/4-inch.

27.2 Business Rules

Business Rules

Business Rules are formulated in conjunction with the compliance experts from IRS Compliance to check that data being processed in 1099 Pro’s software does not contain common formatting errors, form specific errors, is valid for State and Federal filing, and can be used to separate records with different levels of issues for processing.

27.3 ASCII

ASCII

A simple text file where fields are delimited (or separated) with certain characters such as a tab, space or pipe. 1099 Pro's import capability allows for most any ASCII file. These files can be exported out of most database and spreadsheet applications as an ASCII file, comma separated value (CSV) or tab delimited. Need help? Contact Technical Support.

Phone: (888) PRO-1099, Select Option 2

Email: Click here to E-Mail Support

Technical support is available:
Monday thru Friday from 7am to 5pm (PST), Excluding Holidays
27.4 **Cascading updates**

Cascading updates

*Cascading updates* are changes made to a recipient's name or address at the Browse Recipients screen.

27.5 **Corrected options**

Corrected Options

The *Corrected Options* screen is accessed whenever a corrected form (or original form associated with a correction) is selected at the "Work with My Tax Forms" screen.

27.6 **End of Payer "C" Record**

End of Payer "C" Record

*End of Payer "C" Record*—Contains the total number of payees and the totals of the payment amount fields filed for each payer and/or particular type of return.

27.7 **End of Transmission "F" Record**

End of Transmission "F" Record

*End of Transmission "F" Record*—Contains a summary of the number of payers in the entire file.

27.8 **Filer**

Filer

The term *Filer* is used by the IRS for the person or organization filing an electronic file (magnetic media) or 1096/W-3/1042-T transmittal. The terms filer, employer and payer are sometimes used interchangeably.

27.9 **Hotspot**

Hotspot

*Hotspot* (or popup) items are indicated by a dotted line underneath a word or phrase. Click the hot spot to view a popup information box.

*Jump* items are indicated by a solid line underneath a word or phrase. Click the jump to link to a related help topic.

27.10 **Import Map**

Import Map

Import Maps describe the format and contents of external data files so that the information they contain can be imported into the program.
27.11 Location code

Location Code

Use to set up multiple filers with the same TIN; allows different return addresses for different forms.

27.12 Payee "B" Record

Payee "B" Record

Payee "B" Record - Contains the payment information from the information returns

27.13 Payer "A" Record

Payer "A" Record

Payer "A" Record - Identifies the person making payments

27.14 Pending Status

Pending Status

All records are assigned a print status that determines their position in the filing cycle.

Select this option to continue printing copies of these records. These records maintain their Pending print status and are available for edits and/or further printing. The terms "pending" and "not printed" are sometimes used interchangeably.

☐ See Print Status Overview

27.15 Recipient Employee

Recipient Employee

A recipient is an individual or business that receives a 1099 or a 1042-S. An employee receives a W-2. The terms recipient and employee are sometimes used interchangeably.

27.16 Rule-of-250

Rule-of-250

The Rule-of-250 states that any filer submitting 250 or more forms of any one type must submit those forms electronically. Failure to do so may result in fines of up to $100 per form. If you are not signed up for the IRS FIRE system or do not wish to do so our SSAE 16 SOC I TYPE II Service Bureau offers electronic filing services. Please call us at (866) 444-3559 to schedule an appointment and obtain pricing.

☐ Rule-of-250 Overview
27.17 SSAE 16 SOC I Type II

SSAE 16 SOC I TYPE II

Definitions
- SSAE 16 - Statement on Standards for Attestation Engagements No. 16.
- SOC I - Service Organization Control Report No. 1
- Type I - Audit of a system on a specified date
- Type II - Audit of a system throughout a specified time period

Overview
The SSAE 16 is an attestation standard put forth by the Auditing Standards Board (ASB) of the American Institute of Certified Public Accountants (AICPA).

SSAE 16 SOC I Type II is a high-level security certification requiring a stringent audit process. 1099 Pro's hosting and data facilities have passed this difficult audit without exception, ensuring that your data is secure when using any of our software or services. The SSAE 16 effectively replaces the SAS 70 for reporting periods ending on or after June 15, 2011.

This standard applies to engagements undertaken by a Service Auditor for reporting on controls at organizations like 1099 Pro which provide services to their customers. The controls in place at service organizations are likely to be relevant to a customer's internal control over financial reporting (ICFR).

Details
The SSAE 16 requires certain enhancements from the SAS 70 report - such as the service organization provide a description of its system. The description should include the services provided, control objectives, supporting processes, policies, procedures, personnel and operational activities that constitute the organization's core activities relevant to its customers.

Additionally, the SSAE 16 requires a Written Assertion by management be provided to the Service Auditor. In this document, management must assert that the system description and control objectives included therein are a fair presentation for the time period specified in the SOC 1 report.

SOC 1 reports are performed and issued under the Statement on Standards for Attestation Engagements No. 16 (SSAE 16) as explained above. The controls addressed in a SOC 1 report are those that a service organization like 1099 Pro implements to prevent, detect and correct errors or omissions in the information it provides to customers.

Type II indicates that the service organization's system was suitably designed to achieve stated control objectives and to operate effectively throughout a specified time period. Type I refers to a system designed for implementation on a specific date, rather than throughout a specified time period.

For further information, or report details, please contact the 1099 Pro Service Bureau.

The Service Bureau
Phone: 866-444-3559
Email: sb@1099pro.com

27.18 SSN

Social Security Numbers
Social security numbers (SSNs) should be formatted as ####-##-####. Dashes are required to differentiate EINs from SSNs. There are approximately 100,000 numbers that are identical except for the placement of the dash!

27.19 State Totals "K" Records

State Totals "K" Records

State Totals "K" Records—Contains the summary for a given payer and a given state in the Combined Federal/State Filing Program, used only when state-reporting approval has been granted.

27.20 Tag

Tag

Individually tag (select) a record, print session or filer. A tagged item is marked by a red checkmark.

27.21 Task Panel

Task Panel

The task panel is the blue bar on the left side of the 8966 Pro screen and provides quick access to common tasks. Click on the links for details on the options contained within each task panel area.

Select Filer

Preparing My Forms

Printing & Mailing

Filing My Forms

Help & Extras

27.22 TCC

TCC

TCC for IRS FIRE System
Transmitter Control Code. Assigned to a filer when they have filled out Form 4419 at least 30 days prior to the filing deadline for the electronic file. Print Form 4419 via the Help & Extras task panel > IRS Pubs & Links.

TCC for AIR (ACA)
The TCC for AIR is unique to filing ACA returns. The TCC issued for filing 1099 Informational Returns is suitable for the IRS FIRE System, not the AIR Site. See TCC for AIR for important information on registering to use IRS e-Services, applying for a Transmitter Control Code (TCC) and submitting Test Files.
27.23 TIN

**TIN**

Taxpayer identification number. An SSN (Social Security Number) has 9 digits divided by 2 hyphens, i.e. 333-22-4444. An EIN (Employer Identification Number) has 9 digits divided by 1 hyphen, i.e. 22-7777777. *The placement of the dash is critical!*

27.24 TIN (SSN) Masking

**TIN Masking**

What Is TIN Masking?
Internal Revenue Bulletin 2014-31 allows for the truncation of recipient identification numbers on statements. The goal of these regulations is to reduce the risk of identity theft that may arise from placing a taxpayer’s entire identifying number on a recipient statement. The regulations allow for the replacement of the first five digits of the nine digit number with Xs.

1099 Pro TIN Masking
As allowed, all 1099 Pro software products provide optional TIN Masking. Use of this option allows users to print recipient copies of forms with the TIN masked, for example "444-12-1234" prints as "XXX-XX-1234", for added security when mailing to the recipient. By default, all Filers have TIN Masking enabled. To disable TIN masking see Changing a Filer. TIN masking can also be temporarily set "On/Off" at the Advanced Print Options screen.

IRS Rules and Restrictions for use of TIN Masking*:
- A masked TIN has an 'X' for the first 5 digits. Example: XXX-XX-1234 or XX-XXX1234.
- Masking is only available for Recipient copies. If masking is enabled, all recipient copies will have the TIN masked. For example, if the recipient receives both a recipient and a state copy the TIN is masked on both copies.
- Masking is allowed on Forms 1098 series (except 1098-C), 1099 series, 5498 series and 1095-C as per IRS Bulletin 2014-31. **Masking is not allowed on Form W-2.** Masking is available for Calendar years 2009 onwards.
- Masking is NOT allowed on IRS Copy A.
- Filers may not mask their own TIN.

*This software automatically applies these rules as needed when TIN masking is selected.

27.25 Transmitter "T" Record

**Transmitter "T" Record**

Transmitter "T" Record—Identifies the Transmitter of Electronic file information contained on 4419.
Index

- 1 -
1042-S Pressure Seal 183
1095-B 13
1095-B Queries 92
1095-C Queries 92
1099 Aggregation Feature (CS Version only) 96
1099 Compliance Seminars 25
1099 Module Preferences 67
1099 Pro Central 20
1099 Seminars 25
1099-MISC Box 7 Filing Deadline 19
1099-MISC IRS Deadline 19
1099-MISC Optional Fields (CS) 83

- 4 -
4419 217
480.6B PR 185
480.7 185
480.7c 185

- 5 -
5113 Pressure Seal 185
592 CA Quarterly eFile Wizard 198
592 CA Resident and Nonresident Withholding 246

- 8 -
8966 IDES Reporting 101
8966 Pro 126

- 9 -
96 DPI Setting 35

- A -
Abandon Import Session 154, 164
About 1099 Pro, Inc. 13
About Corrections 48

ACA Compliance 13
Access Denied 225
access group 60, 237
account 232
Account Generation Wizard 56
Account Number Generation 56
ACL 80
Acrobat 25
Activation Code 17
Activity Report 88
Add a Filer 38
Add a Record 104
Add a Transmitter 218
Add a User 62
Add or Create Records 92
Add Recipients 44
Adding a Filer 38
Additional Services 203
Additional Transactions 96, 97
Address / Envelope Print Offsets 171
Address Type 155, 159, 160
ADDRESS VALIDATION 231
administration 56, 237
Adobe Acrobat 25
Advanced Print Options 171
Aggregate 167
Aggregating forms on a spreadsheet 167
Aggregation 96, 97, 167
Aggregation Rules - CS 85
Alias 155
Alignment Issues with text in tax forms 35
Alignment Preprinted Forms 183
Alternative 25
Alternative layout 25
Amend a Record 52
Amount/Totals Report 164
Antivirus Exceptions 219
Appearance 35
APPROVE SB CONTROL TOTALS 209, 213
ASCII File 256
Assign User Profiles 60
Assigning a Printed Status 177
Asterisk 132
Audit Trail Browser 89
Audit Trail Report Filters 90
Audit Trails 87
Audit Trails Activity Report 88
Authorization Code 17
Authorization Code Error 219  
Auto Capitalize 72  
Autocapitalization 103  
Automatic 56  

- B -  
Backup Data 33, 65  
Backup Settings 72  
Backup Wizard 33, 65  
BANNED PATRON LIST FOR CASINOS 231  
Blank 216  
Blank Copier Paper 216  
Blank Laser Perforated 216  
Blank Laser Perforated Stock 216  
Browse Filers 37  
Browse IRS Forms 93  
Browse Map List 136  
Browse Notes 99  
Browse Recipients 42  
Browse Records 92  
Browse Transmitter 217  
Browsing & Working with Entry Forms 94  
Browsing by Form 98  
BUILD Cancelled 225  
BUILD in Progress 225  
Bulk TIN Export Wizard 124  
BULK TIN MATCHING 231  
Bulk TIN Matching Overview 211  
Bulk TIN Matching Upload 211  
Bulk TIN Matching via Service Bureau 212  
Bulk TIN Matching Wizard 212  
Bulk TIN Results 125, 215  
Bump Code 17  
Business 73  
Business Rules 73  

- C -  
CA-592 Overview 246  
CA-592 Quarterly Electronic Filing Wizard 198  
Canada 25  
Canadian postal code rules 25  
Capitalization 103  
Carve-Out 219  
Cascading Changes 104  
Category 178  
Cayman Islands 126  
Certify Data 209, 213  
CFS Exception Rules 78  
CFS Exceptions 78  
CFS Filing Thresholds (CS) 75  
CFS Threshold Rules 78  
Change a Filer 38  
Change a Recipient 46  
Change a Record 92, 105  
Change TIN Type 94  
Changes: Revisions to a Tax Form 191  
Character Spaces 178  
Characters 178  
Checking for Updates 18  
City Names 111  
Clariion File Error 223  
Clariion Trappable Runtime Errors 225  
codes 244  
Codes - Form Status Error Status 133, 195  
Combine 167  
Combining Tax Forms 96, 97  
Common Error Messages & Solutions 219  
Compliance 25  
Compliance Seminars 25  
Composition 101  
Contact 27  
Contact Information 39, 40  
Context-Sensitive Help 28  
Control Totals Report 196  
Corporate Suite Dynamic Query 113  
Corr Status 132  
Correct a correction 49  
Corrected Box - Force an X 171  
Corrected Options 51  
Correction of a Correction 52  
Correction of a Correction (CS Version only) 49  
Corrections 48, 52  
Corrections Box 172  
Corrections Status 132  
Corrections/Late Add Report - CS 201  
Could not load the DLL library 225  
Country 155  
Country Codes Table 155  
CPE Units 25  
Create a Correction 52  
CREATE SB UPLOAD FILE 205  
Create Submitter 218  
Create Transmitter 218
Create XML Task Panel 23
Creates Duplicate Key 225
Current View 112
Custom Codes 80
Custom Dynamic Query 113
Custom Print Message 172
Custom Query 92, 193
Custom Query Values 133, 195
Custom Query Wizard 195
Custom Rules 78
Custom Sort Order 113
Custom Tax Form Validation Rules 73
Custom Threshold Rules 78
Custom View 112
Customize a Fixed Field 143

- D -

Daily 202
Daily totals 202
Data 73
Data Aggregation 96, 97
Data Backup 33, 65
Data Entry 108
Data Files 32
Data Restore 34, 66
Data Security 259
Dates 19
De Minimis Corrections 2016 52
DEADLINES 19
death master file 231, 235
Decrypt XML File (8966) 126
Define View 113
Delete a Filer 39
Delete a Record 92, 105
Delete audit trails 89
Delete Corrected Forms 53
Delete Corrections 53
Delete Recipients 46
Delete Software 31, 86
Deleted Record Detail 89
Delimited 119
Delimited Import Map Wizard 137
Delimited Import Mapping 137
Delimiters 164
DEMO 17
DENIED PERSONS LIST (DPL) 231
Department 107

- E -

EC002 - Unable to open files! 224
Edit, Post or Abandon Import Records 152
Edits 73
Education 25
Effects Settings 35
eFile Log Summary Report 130
electronic 205
Electronic Filing Deadline 19
Email 40
Email Forms 175
E-Mail tax Forms 175
Employee Listing Report 47
Encrypted PDF Option 174
Encrypted PDF Tax Forms 175
Enterprise Upgrade 28
Entry Forms 94
Entry Not Found 225
Envelope / Address Print Offsets 171
Envelopes 216
Error & Validation Checking 115
Error Messages 219
Error Status Values 133, 195
Error: Invalid Record Declaration (47) 220
Errors 225
Errors - Import Checking 115
Errors and Warnings by Recipient 196
Excel Spreadsheet Files 163
EXCLUDED PARTIES LIST (EPLS) VALIDATION 231
Exclusive Access Required 225
Expiration and Reuse Options 59
Export ASCII Files 119
Export Database 119
Export Import Maps 120, 141
Export Wizard 119
Expression Builder Queries 194
- F -

False Print 132
FAQs 27
Fax 40
FFI 101
Field Sizes 178
file 205
File Access Error 220
File Already Open 225
File Driver Error 225
File Is Already Locked 225
File Must Be Shared 225
File Not Found 219, 225
File Not Found Information Request 224
File Not Open 225
Filed 1096 Status 132
Filed Mag Status 132
Filer 38
Filer Master List Screen 37
Filer Name / Name Line 2 40
Filer Notes 99
Filer Record Details 40
Filer Reports 41
Filers List Report 41
Files already in use 230
Filing Addresses 19
Filing CA-592 246
Filing Deadlines 19
Filing Forms Task Panel 22
Filing My Forms 22
Filing Problems 117
Filing with the IRS 205
FIN Number 8966 217
FIN Numbers - 8966 218
Finding & Fixing Problem Records 115
Fixed Field Customizing 143
Fixed Length 119
Flat File 119
Force "X" 171
Forcing an X in the Corrected Box 172
Foreign Address - Filer 40
Form Control Totals Report 196
Form Counts by Filer Report 200
Form Counts Report 200
Form Limits 173
Form Status 130

Form Status Values 133, 195
Forms 216
Forms Issued By Filer Report 200
Forms Issued for Recipients 46
Forms Issued Report 46
Franchise Tax Board 198
Frequently Asked Questions 27
FWT 68

- G -

Gas & Oil Fields 83
General Options Toolbar 23
Generating Account Numbers 56
Getting Started 12
GIIN 101
GIIN Composition 101
Global Administrative Options 56
Global Intermediary Identification Number 101
Global Notes 99
Glossary 247
Group 60
Group - Deleting Pending Tax Forms 47
Group - Printing Pending Tax Forms 47
Group - Reprinting Printed or Filed Tax Forms 47
Group - Reset Printed Tax Forms to Pending 47
Group - Un-voiding Tax Forms 47
Group - Voiding Printed Tax Forms 47
Group Actions 47, 92

- H -

Halt 219
header records 160
Help & Extras 23
Help Tutorials 28
history 89, 236
Hours 27

- I -

IBN 80
IBN Print codes 80
IDES Help 128
IDES Overview 128
IDES Packager 126
IDES Testing 128
Illegal Expression 225
IMB Tracing 202
Implied Decimal Formatting 137
Import 56, 155, 178
Import - QuickBooks 165
Import Data 135, 147
Import Errors 115
Import File Conventions 160
Import Filers 147
Import Files - Sample Files 135
Import Map Reports 200
Import Multiple Form Types 142
Import Overview 134
Import Recipients 147
Import Records, Review Prior to Import 152
Import Session Status 150
Import Session Summary Report 164
Import Status Options 149
Import Wizard - Export Map 120, 141
IMPORT WIZARD Overview 136
IMPORT WIZARD—Step 1: Import Data, Filers or Recipients 147
IMPORT WIZARD—Step 2: Validate Data 151
IMPORT WIZARD—Step 3: Post Results 153
Important Dates 19
Incremental Index 109
independent contractor 246
INI Files 32
Initial PDF Options Window 174
Inserting a Custom Print Message 172
Install 81
Install Multi-User Software 29
Install Single-User Software 28
Insufficient Memory 225
Intelligent Mail Barcode Tracing 202
Intermediary / Sponsored Entity 39
Invalid Clarion File 219
Invalid Data File 225
Invalid Drive 225
Invalid Field Type Descriptor 225
Invalid Filename 225
Invalid Index String 225
Invalid Key File 225
Invalid Key Length 225
Invalid Memo File 225
Invalid Number Of Parameters 225
Invalid Record Declaration 225
Invalid Table Declaration 225
Invalid Tax Country 155
IRS Assistance 27
IRS Bulk TIN Matching Program 121
IRS Code 112
IRS codes 101
IRS Forms 93
IRS Help 27
IRS Incorrect TIN Flowchart 123
IRS Instructions 93
IRS Missing TIN Flowchart 124
IRS Telephone Numbers 93
IRS/MCC 19

- K-

Kaspersky 219
Keep Pending Status 258
Key (8966) 126
Key File Must Be Rebuilt 225
Keyboard Shortcuts 24
Knowledge Base 28

- L-

Late Add/Corrections Report - CS 201
layout 25
Letter Display Issues 35
Limits 68
Local 67
Location Code 40
Login as Different User 82
Logon as Different User 82
LOGOUT Already Active 225
Look up City 111
Look up City Name 111
Look up Zip Code 111

- M-

Maintain Pending Status 258
Making a Revision 191
manage 232, 235, 246
Manage Custom Codes and Text 56
Manage Filer Button 41
Manage Import Maps 136
Manage Profiles 60
Managed Services 246
Index 267

managing 232
Manual Override 194
Manual Transfer Options 209, 213
Manual Update 18
Map by Name Import 26
Map Street Addresses 140
Margin Alignments 179
masking 261
Master Audit Trail Browser 89
Master Recipient Record 48
Master Tax Form 26, 96, 97
Maximum Field 178
Maximum Printed 178
Maximum Size 178
McAfee 219
Memo File Missing 225
Memory Corrupted 225
Menu bar 26
Microsoft Access 167
Minimum Password Length 59
Modify Access Rights 60
Module Preferences - Corporate Suite 67
Multiple Recipients - One TIN 48
Multiple Transactions 96, 97
Multi-User Considerations 31
Multi-User Installations 29

- N -

Navigation 20
Network Import Error 147
Networks 29
NFFE Nil Report 129
NIL Filer 129
NIL Reporting 40
NIL Reports 129
No Create Attribute 225
No Email Client 177
No Logout Active 225
Non-Employee Compensation Box 7 19
Norton 219
Notes 99

- O -

OFAC 235
office of foreign assets control 235

Oil & Gas Fields 83
Online Help Options 28
Open Window Cutoff 68
Optional Fields - 1099-MISC Specific 83
Options for Tax Form Data Entry 108
Overview 16

- P -

Package XML File (8966) 126
Password - Individual Tax Forms 175
Password Expiration Options 59
Password Format Options 59
Password Lockout Reset 59
Password Options 59
Password Protected PDF Documents 174
Password Requirements 59
Passwords 63
Patches 18
Path Not Found 219, 225
Payer Code 40
PCL Printing 180
PCode 40
PDF File Generation Overview 173
PDF Print Options 174
PDF Recipient Forms 175
Penalties 16, 118
Pending Status 132
PFFI 101
Phone number 27
Post Results 153
Preferences 72
Preferences - Corporate Suite 67
Preparing My Forms Task Panel 21
Preprinted Forms Alignment 183
Preprinted Paper 217
Pressure Seal/Alternate Combined Layout 183
Pricing - Service Bureau 203
Print 189
Print an Import Map Report 200
Print Code 80
Print Codes 80
Print Corrections Myself 183
Print Forms Myself 183
Print IRS Form & Instructions 175
Print Options 171
Print Preview Toolbar 23
Print Session Report 182
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Status</td>
<td>132</td>
</tr>
<tr>
<td>Print Tax Forms</td>
<td>183</td>
</tr>
<tr>
<td>Print Users By Name Report</td>
<td>64</td>
</tr>
<tr>
<td>Print Wizard</td>
<td>183</td>
</tr>
<tr>
<td>Print Zeros Instead of Blanks</td>
<td>171</td>
</tr>
<tr>
<td>Print/View Record Reports</td>
<td>109</td>
</tr>
<tr>
<td>Printed Status</td>
<td>132</td>
</tr>
<tr>
<td>Printed Status - Shortcut</td>
<td>131</td>
</tr>
<tr>
<td>Printing</td>
<td>170</td>
</tr>
<tr>
<td>Printing &amp; Mailing Task Panel</td>
<td>21</td>
</tr>
<tr>
<td>Printing Blank Forms</td>
<td>175</td>
</tr>
<tr>
<td>Printing Tax Forms Wizard</td>
<td>183</td>
</tr>
<tr>
<td>Prior Year Corrections</td>
<td>52</td>
</tr>
<tr>
<td>Pro Tips</td>
<td>219</td>
</tr>
<tr>
<td>Professional to Enterprise Upgrade</td>
<td>28</td>
</tr>
<tr>
<td>Profiles</td>
<td>60</td>
</tr>
<tr>
<td>Program already in use</td>
<td>230</td>
</tr>
<tr>
<td>Program Areas/Functions Report</td>
<td>64</td>
</tr>
<tr>
<td>Protected Forms</td>
<td>53, 106</td>
</tr>
<tr>
<td>ProTips</td>
<td>219</td>
</tr>
<tr>
<td>Puerto Rico Printing</td>
<td>185</td>
</tr>
<tr>
<td>Puerto Rico Tax Forms</td>
<td>13</td>
</tr>
<tr>
<td>Purge</td>
<td>89</td>
</tr>
<tr>
<td>Purge Audit Trail</td>
<td>89</td>
</tr>
<tr>
<td>Purge Audit Trail Log Records</td>
<td>89</td>
</tr>
<tr>
<td>- Q -</td>
<td></td>
</tr>
<tr>
<td>Queries Dynamic</td>
<td>113</td>
</tr>
<tr>
<td>Query - Manual Override</td>
<td>194</td>
</tr>
<tr>
<td>Query Wizard</td>
<td>193</td>
</tr>
<tr>
<td>Quick</td>
<td>189</td>
</tr>
<tr>
<td>Quick Books</td>
<td>165</td>
</tr>
<tr>
<td>Quick Print</td>
<td>189</td>
</tr>
<tr>
<td>Quick Tour</td>
<td>16</td>
</tr>
<tr>
<td>QuickBooks Import Wizard</td>
<td>165</td>
</tr>
<tr>
<td>QuickBooks Troubleshooting</td>
<td>165</td>
</tr>
<tr>
<td>- R -</td>
<td></td>
</tr>
<tr>
<td>Raw Value</td>
<td>152</td>
</tr>
<tr>
<td>Recipient Listing Report</td>
<td>47</td>
</tr>
<tr>
<td>Recipient Notes</td>
<td>99</td>
</tr>
<tr>
<td>Recipient options</td>
<td>69</td>
</tr>
<tr>
<td>Recipient Record Details</td>
<td>44</td>
</tr>
<tr>
<td>Recipient TIN Code - 1042-S</td>
<td>160</td>
</tr>
<tr>
<td>Recipient TIN Unknown</td>
<td>44</td>
</tr>
<tr>
<td>Record Changed By Another Station</td>
<td>225</td>
</tr>
<tr>
<td>Record History</td>
<td>89</td>
</tr>
<tr>
<td>Record Is Already Held</td>
<td>225</td>
</tr>
<tr>
<td>Record Limit</td>
<td>17</td>
</tr>
<tr>
<td>Record Limit Exceeded</td>
<td>225</td>
</tr>
<tr>
<td>Record Locking</td>
<td>31</td>
</tr>
<tr>
<td>Record Not Available</td>
<td>225</td>
</tr>
<tr>
<td>Record Not Found</td>
<td>225</td>
</tr>
<tr>
<td>Region Code Update - CS</td>
<td>79</td>
</tr>
<tr>
<td>Region Code W-2 - CS</td>
<td>79</td>
</tr>
<tr>
<td>Region Codes Form W-2 (CS)</td>
<td>79</td>
</tr>
<tr>
<td>Registration &amp; Upgrades</td>
<td>17</td>
</tr>
<tr>
<td>Registration code</td>
<td>26</td>
</tr>
<tr>
<td>Reject Errors</td>
<td>115</td>
</tr>
<tr>
<td>Reject Imports</td>
<td>165</td>
</tr>
<tr>
<td>Remove audit trails</td>
<td>89</td>
</tr>
<tr>
<td>Remove Software</td>
<td>31, 86</td>
</tr>
<tr>
<td>Report: Electronic File Log Summary</td>
<td>130</td>
</tr>
<tr>
<td>Reporting F1 Task Panel</td>
<td>22</td>
</tr>
<tr>
<td>Reporting Thresholds</td>
<td>75</td>
</tr>
<tr>
<td>Reports</td>
<td>47</td>
</tr>
<tr>
<td>Reports Overview</td>
<td>196</td>
</tr>
<tr>
<td>Reprint Corrections</td>
<td>55</td>
</tr>
<tr>
<td>Reprint Originals</td>
<td>55</td>
</tr>
<tr>
<td>Reprint Print Sessions</td>
<td>190</td>
</tr>
<tr>
<td>requests</td>
<td>236</td>
</tr>
<tr>
<td>Reset (Void) Import Session</td>
<td>154, 164</td>
</tr>
<tr>
<td>Reset (Void) Upload</td>
<td>210</td>
</tr>
<tr>
<td>Reset Import Session</td>
<td>164</td>
</tr>
<tr>
<td>Reset Print Session</td>
<td>191</td>
</tr>
<tr>
<td>Reset to Pending</td>
<td>132, 191</td>
</tr>
<tr>
<td>Residence State</td>
<td>108</td>
</tr>
<tr>
<td>Restore Data</td>
<td>34, 66</td>
</tr>
<tr>
<td>results</td>
<td>235, 236</td>
</tr>
<tr>
<td>Review Import Data</td>
<td>151</td>
</tr>
<tr>
<td>Review Import Records</td>
<td>152</td>
</tr>
<tr>
<td>Revising a Tax Form</td>
<td>191</td>
</tr>
<tr>
<td>Revisions</td>
<td>132, 191</td>
</tr>
<tr>
<td>RFID</td>
<td>52</td>
</tr>
<tr>
<td>Rights Summary Report</td>
<td>64</td>
</tr>
<tr>
<td>Roll Forward Error</td>
<td>224</td>
</tr>
<tr>
<td>Roll Forward Utility</td>
<td>34</td>
</tr>
<tr>
<td>Roll Over</td>
<td>34</td>
</tr>
<tr>
<td>Rollup</td>
<td>96, 97, 167</td>
</tr>
<tr>
<td>Rollup Option</td>
<td>85</td>
</tr>
<tr>
<td>RTN</td>
<td>40</td>
</tr>
<tr>
<td>Rules</td>
<td>73</td>
</tr>
<tr>
<td>Rules for Aggregation</td>
<td>85</td>
</tr>
</tbody>
</table>
Index

Runtime Errors  225

- S -

sample import files  135, 160
SB Filed Status  132
SB Print+Mail Status  132
SB Step 1 - Create an Upload File  205
SB Step 2 - Submit Service Bureau Upload  209, 213
Scheduled  56
Scheduler  56
SDN  235
Search  109
Section 6721  118
security  56, 237
Security - Access Group: Step 2  60
Security - Add Users to a Profile: Step 5  62
Security - Add/Update Individual Users: Step 4  62
Security - Manage Profiles: Step 3  60
Security Access Log  64
Security Audit  259
Security Password Options  59
Security Reports  64
Security Settings  59
Select a City/Zip/State  111
Select a Form  110
Select a Recipient  45
Select a User  196
Select Country  155
Select Department  107
Select Fields for Aggregation  85
Select Filer  41
Select Form Type  110
Select IRS Code  112
Select States  159
Seminars  25
Service Bureau Overview  202
Service Bureau Packages  203
Service Bureau Toolbar  21
Service Bureau Upload Reports  204
Service Bureau Wizard
  Step 1 - Creating an Upload File  205
  Step 2 - Approve Control Totals  205
  Step 3 - File Upload Transfer & Completion  205
services  203, 246
Set Password Requirements  59
Setting Aggregation Rules  85
Setting Rollup Options  85
Sharing Violation  225
Shortcut  132
Shortcut - Pending to Printed Status  131
Single User Version Error  230
sizes  178
Small Fonts  35
Social Security Number  261
social security number masking  261
Software Updates  18
Sophos  219
Spaces  178
Special print  80
Specially Designated Nationals  235
Spon ENT Type Codes  39
Sponsored Entity Import  39
Spreadsheets  163
SSAE 16 SOC I Type II  259
SSN  261
SSN Masking  261
SSN Matching  212
Standard (Custom) Rules  78
Standard Rules  78
Standard Threshold Rules  78
State Filing Deadlines  19
State Filing Thresholds  78
State Limits  78
State Reporting - Manage State CFS Limits and
  Settings (Corporate Suite Only)  78
State Reporting Thresholds  78
state status  98
State Status Legend  98
state subset  98
State Threshold Rules  78
States Code Table  159
status  244
status codes  133, 195, 244
Status Overview  53, 106
Step 1 - Create Bulk TIN Upload File  212
Step 2 - Validate your Data  151
Step 3: Final Import / Post Results  153
Stream Error  225
Submitter Information  217, 218
supersceded  98
SUTA State Table  79
SUTA State Update - CS  79
SWIFT Code H Error  198
SWIFT Filing System  198
Using Rollup Options   96, 97

- V -
Validate your data during import  151
Validation   73, 101
Validation Checking   115
Variable Not Found   225
Video Display Issues   35
Video Tutorials   28
Videos   27
View a Map Report   200
View Deleted Records   105
Viewing Transactions (CS Version only)   96
Virtual Mapping   140
Virus Checkers   28, 81
Void Box - Force an X   171
Void Import Session   154, 164
Void Records   99

- W -
W-2 Filing Deadline   19
Warnings   115
Welcome Wizard   26
When To File?   19
Where To File?   19
WIKI Download Site   18
Windows "Effects" button   35
Windows Operating Systems   19
Withholding   68
Withholding State   108
Work With My Tax Forms   92

- X -
X - Correction Box   172
XLS Data Shells   135
XML File (8966)   126

- Y -
YouTube Channel Videos   28

Zeros in Boxes   171
Zip Code Look up   111